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บทคดัย่อ 

 

วตัถุประสงคก์ารวจิยัคร้ังน้ีเพือ่ 1) หาประสิทธิภาพบทเรียนผ่านสมาร์ทโฟนตามแนวคิด

องคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซตส์าํหรับนักเรียนชั้นประถมศึกษาปีที่ 6 2) หาผลสัมฤทธ์ิ

ทางการเรียนดว้ยบทเรียนผา่นสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์

สาํหรับนักเรียนชั้นประถมศึกษาปีที่ 6 และ 3) หาความพึงพอใจของนักเรียนชั้นประถมศึกษาปีที่ 6     

ที่ไดเ้รียนตามบทเรียนผา่นสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์  

กลุ่มตวัอยา่งในการวิจยัเป็นนักเรียนชั้นประถมศึกษาปีที่ 6 โรงเรียนโชคชยัรังสิต สังกัด

สาํนกังานเขตพื้นที่การศึกษาประถมศึกษาปทุมธานี เขต 2 ปีการศึกษา 2557 จาํนวน 30 คน เคร่ืองมือ

ที่ใช้ในการวิจัย ประกอบด้วย บทเรียนผ่านสมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้ เร่ือง       

การพฒันาเวบ็ไซต ์ แบบทดสอบก่อนเรียนและหลงัเรียน แบบประเมินความพึงพอใจของนักเรียนที่มี

ต่อบทเรียนผา่นสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ืองการพฒันาเวบ็ไซต ์สถิติในการวิจยั 

ไดแ้ก่ ค่าร้อยละ ค่าเฉล่ีย ค่าเบี่ยงเบนมาตรฐาน และการทดสอบค่าที ของกลุ่มตวัอยา่งไม่อิสระจากกนั 

(t-test for dependent sample)   

ผล กา รวิจ ัยพบ ว่า  บทเรียนผ่านสมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้ เร่ือง       

การพฒันาเว็บไซต์ มีประสิทธิภาพตามเกณฑ์เฉล่ียเท่ากับ 82.07/80.67 ผลสัมฤทธ์ิทางการเรียน      

ของนักเรียนหลงัเรียนสูงกว่าก่อนเรียนอย่างมีนัยสําคญัทางสถิติที่ระดบั 0.05 และความพึงพอใจ   

ของนักเรียนที่มีต่อบทเรียนผ่านสมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้ เร่ือง การพฒันา

เวบ็ไซต ์มีค่าเฉล่ียเท่ากบั 4.49 อยูใ่นระดบัมาก ค่าเบี่ยงเบนมาตรฐานเท่ากบั 0.29  

 

คาํสําคญั: ประสิทธิภาพ สมาร์ทโฟน บทเรียน แนวคิดองคก์รแห่งการเรียนรู้  
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ABSTRACT 
 

The objectives of this study are to 1) gain the efficiency of Website Development 

lessons for teaching Grade 6 students through smartphones based on Learning Organization 

Concept, 2) find out the learning achievement of the students who studied Website Development 

based on Learning Organization Concept, and 3) find out the student satisfaction on learning 

Website Development through smartphones based on Learning Organization Concept.   

The samples used in the study were 30 Grade 6 students studying at Chok Chai 

Rangsit School under Pathumthani Primary Educational Service Area Office 2 in the academic year 

2014. The research instruments included teaching materials of Website Development lessons 

through smartphone based on Learning Organization Concept, the pretest and posttest scores of 

Website Development, and the questionnaires on student satisfaction on learning through 

smartphone lessons. The statistical devices used in the study were percentage, mean, standard 

deviation, and t – test for dependence samples.   

The findings revealed that the efficiency of Website Development lessons for teaching 

Grade 6 students through smartphones based on Learning Organization Concept was 82.07/80.67 

which was efficient according to the criteria set. The students’ learning achievement after learning 

Website Development by using smartphones was significantly higher than the achievement before 

the learning at the .05 level of significance. The student satisfaction on learning Website 

Development through smartphones based on Learning Organization Concept was 4.49 on average 

and the standard deviation was at 0.29 a high level.   
 

Keywords: efficiency, smartphone, lessons, learning organization concept 
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บทที่ 1 

บทนํา 

 

1.1  ความเป็นมาและความสําคญัของปัญหา 

องคก์รแห่งการเรียนรู้เป็นการสร้างและการพฒันาคนในสังคมให้มีคุณภาพที่เกิดจากการเรียนรู้ 

ร่วมกนัเป็นการนาํความรู้มาปรับปรุงและเปล่ียนแปลงพฤติกรรมนาํไปสู่เป้าหมายที่กาํหนดไวร่้วมกนั

ตามกระบวนทศัน์และวิธีการจดัการเรียนการสอนรูปแบบของ “เครือข่ายสังคมแห่งการเรียนรู้” 

(Social Network) (ประธาน เสนีวงศ ์ณ อยธุยา, 2546, น. 3; แผนพฒันาเศรษฐกิจและสังคมแห่งชาติ

ฉบบัที่ 11 พ.ศ.2555 – 2559, 2554, น. 39) เครือข่ายสังคมแห่งการเรียนรู้ในยคุศตวรรษที่ 21 มีการใชส่ื้อ

อิเล็กทรอนิกส์ที่มีรูปแบบการเรียนรู้ การนาํเทคโนโลยสีารสนเทศมาเช่ือมโยงการเรียนรู้ทั้งในห้องเรียน 

และนอกหอ้งเรียนเพือ่แบ่งปันข่าวสารแลกเปล่ียนขอ้มูล บอกเล่าประสบการณ์ รูปภาพและคลิปวิดีโอ 

ผา่นทางเครือข่ายอินเทอร์เน็ตเช่นการสอนผา่นสมาร์ทโฟนเป็นรูปแบบหน่ึงของการเรียนรู้ดว้ยตนเอง

ที่ใช้โทรศพัท์มือถือข่ายถ่ายทอดเร่ืองราวและถ่ายทอดเน้ือหาที่ผูเ้รียนมีปฏิสัมพนัธ์กันเป็นชุมชน             

ในเครือข่าย (สามมิติ สุขบรรจง, 2554, น. 19) การใชเ้ครือข่ายอินเทอร์เน็ตเป็นเครือข่ายทางการศึกษา

ให้มีการปฏิสัมพนัธ์กนักบัการสอนเช่นการสอนผ่านสมาร์ทโฟนซ่ึงเคร่ืองมือและเป็นส่ือกลางที่มี

ความสะดวกสามารถเขา้ถึงไดไ้ม่จาํกดัเวลาและสถานที่เรียนรู้ไดต้ลอดชีวติ สอดคลอ้งกบัรายงานวิจยั

การพฒันาบทเรียนผ่านเครือข่ายไร้สายช่วยให้ช่วยประหยดัเวลาและอาํนวยความสะดวกในเร่ือง         

การทบทวนบทเรียนในเวลาที่ตอ้งการโดยปราศจากขอ้จาํกดัของเวลาและสถานที่ผูเ้รียนสามารถ

เรียนรู้ไดจ้ากโทรศพัทเ์คล่ือนที่ในเวลาและสถานท่ีตอ้งการมีความเป็นส่วนตวัสูงในการใชง้านซ่ึงเป็น

การกระตุ้นและเพิ่มความยืดหยุ่นในการเรียนรู้มากยิ่งขึ้ น ตอบสนองความต้องการของผูเ้รียน                  

ช่วยเสริมสร้างบรรยากาศในการเรียนรู้ที่ดี ทาํให้ผูเ้รียนไดเ้รียนรู้วิธีที่จะแสวงหาความรู้ท่ียดึผูเ้รียน

เป็นศูนยก์ลาง ผูเ้รียนไดท้าํงานร่วมกนัจนประสบความสาํเร็จตามจุดมุ่งหมายของการเรียนร่วมกนัทุกคน 

ช่วยเพิม่ผลสมัฤทธ์ิทางการเรียน และเพิม่ทกัษะการทาํงานกลุ่มร่วมกนั เกิดการเรียนรู้อยา่งมีประสิทธิภาพ 

สนุกในการเรียนชอบที่ไดช่้วยเหลือเพือ่น มีความมัน่ใจในการเรียนมีความรักและเขา้ใจเพื่อนมากยิง่ขึ้น 

นอกจากน้ีผลการวจิยัของแบค็ตา้ (Becta) ในปี 2005 พบวา่สมาร์ทโฟนช่วยใหน้ักเรียนรวบรวมขอ้มูล

และสะทอ้นส่ิงที่พวกเขาไดเ้รียนนอกหอ้งเรียนไดแ้ละงานวจิยัของฟุทเทอร์แลป์ (Futurelab) เป็นองคก์ร

การกุศลเพือ่พฒันาการเรียนการสอนดว้ยนวตักรรมกล่าววา่สมาร์ทโฟนสามารถช่วยพฒันาการทาํงาน

เป็นกลุ่มได้ และได้มีการจดัการเรียนรู้การคน้หาขอ้มูลสารสนเทศจากแหล่งขอ้มูลทางสารสนเทศ                

ที่หลากหลายวิธีการ (วิวฒัน์ มีสุวรรณ์, 2012, น. 2; เจษฏากร ทองแสวง, 2553, น. 5) องคก์รแห่ง               



 
 

การเรียนรู้เป็นแนวทางหน่ึงของการจดัการเรียนการสอนที่มุ่งเน้นพฒันาคนทุกช่วงวยัให้เขา้สู่การเรียนรู้

ตลอดชีวติอยา่งย ัง่ยนื การกระตุน้เร้าและจูงใจใหก้ระตือรือร้นใฝ่หาความรู้ และพฒันาตนเองอยูต่ลอดเวลา 

(Senge, 1990, p. 5; ศศกร ไชยคาํหาญ, 2550, น. 106; นฤมล พุ่มฉัตร์, 2551, น. 6) สอดคลอ้งกบัการส่งเสริม 

ใหก้ารจดัการเรียนการสอนที่มุ่งเนน้กิจกรรมการทาํงานเป็นทีมซ่ึงเป็นวธีิการหน่ึงที่ใชใ้นการแลกเปล่ียน 

ประสบการณ์ ยอมรับความคิดเห็นซ่ึงกนัและกนั เปิดโอกาสให้ทุกคนไดแ้สดงความคิดเห็นอยา่งเป็น

กนัเอง ส่งเสริมความคิดสร้างสรรค์ มีโลกทศัน์ใหม่ๆ ช่วยกันตดัสินใจ และอยูใ่นพื้นฐาน ของเหตุผล 

ความถูกตอ้ง สร้างเจตคติใหม่ใฝ่เรียนรู้ส่ิงใหม่ใชไ้หวพริบในการแกปั้ญหามีการปฏิบติังานอยา่งมี

ขั้นตอน มีการจดัลาํดบัความรู้และประสบการณ์ ท่ีไดรั้บมาเช่ือมโยงกบัการทาํงานอยา่งเป็นระบบส่งผล

ใหอ้งคก์รบรรลุเป้าหมาย ทาํให้สามารถเรียนรู้ไดด้ว้ยตนเองมีการแลกเปล่ียนความรู้และประสบการณ์ 

ของผูเ้รียนเส่งเสริมใหมี้การเรียนการสอนผ่านเครือข่ายอินเทอร์เน็ตเป็นช่องทางสาํหรับการแสดงออก 

อยา่งสร้างสรรค ์(แผนพฒันาการศึกษาของกระทรวงศึกษาธิการ ฉบบัที่ 11 พ.ศ. 2555-2559, น. 16)  

อยา่งไรก็ตามถึงแมห้น่วยงานการศึกษาต่างๆจะเร่งส่งเสริมและเน้นกิจกรรมการจดัการเรียน

การสอนผ่านส่ืออิเล็คทรอนิกส์เป็นที่แพร่หลายก็ตาม แต่ส่ือต่างๆ ไม่มีรูปแบบการเรียนที่ส่งเสริม          

การเรียนรู้ที่มีลักษณะเป็นองค์กรแห่งการเรียนรู้ ซ่ึงเน้นการจดัการเรียนการสอนที่เพิ่มพูนความรู้ 

ความสามารถแลกเปล่ียนประสบการณ์เพื่อปรับเปล่ียนตนเอง จากผลการสาํรวจความคิดเห็นของครู

คอมพวิเตอร์ของสาํนักงานเขตพื้นที่การศึกษาปทุมธานีเขต 2 จาํนวน 57 คน มีความคิดเห็นเก่ียวกบั

การจดัสภาพแวดลอ้มทางการเรียนที่ผ่านสมาร์ทโฟน เร่ืองการพฒันาเวบ็ไซต ์ค่าเฉล่ียเท่ากบั 3.86 

โดยมีระดบัคะแนนความคิดเห็นมากที่สุดการออกแบบการสอนตามรูปแบบองคก์รแห่งการเรียนรู้ 

จากการเก็บรวบรวมสถิติขอ้มูลสภาพปัญหาการจดัการเรียนการสอนกลุ่มสาระการงานอาชีพและ

เทคโนโลย ี(คอมพวิเตอร์) โรงเรียนโชคชยัรังสิต เป็นเวลา 5 ปี พบว่า นักเรียนระดบัชั้นประถมศึกษา

ปีที่ 6  ที่เรียนวชิา การงานอาชีพและเทคโนโลย ี(คอมพิวเตอร์)โดยเฉพาะเร่ืองการพฒันาเวบ็ไซตซ่ึ์ง

ประสบปัญหาการทาํแบบฝึกหัดนอกชั่วโมงเรียนและไม่สามารถแก้ปัญหานั้ นได้ จึงทาํให้ท ํา

แบบฝึกหดัไม่สาํเร็จ ไม่ไดส่้งการบา้นตามกาํหนดเวลาไม่สามารถคน้ควา้หาความรู้จากแหล่งขอ้มูล

อ่ืนๆ ได้ดว้ยตนเองประกอบกบัการไม่กล้าแสดงความคิดเห็นซ่ึงหน้าต่อหน้าครูและเพื่อนๆ ไม่มี                 

การแลกเปล่ียนเรียนรู้เพือ่แกปั้ญหาต่างๆ อนัเกิดจากความไม่เขา้ใจการเรียนการสอนในชั้นเรียน และ

ไม่มีกลุ่มเครือข่ายการสร้างองค์กรแห่งการเรียนรู้ในรายวิชาดังกล่าวระหว่างเพื่อนและครู เม่ือไม่

เขา้ใจก็ละทิ้งและไม่สนใจในส่ิงที่ทาํให้สาํเร็จขาดความรับผิดชอบดงันั้นนักเรียนจึงไม่มีคุณลกัษณะ 

ที่สอดคลอ้งกับลกัษณะที่พึงประสงคต์ามหลักสูตรการศึกษาขึ้นพื้นฐานที่ไดก้าํหนดไว ้โดยเฉพาะ
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เร่ืองการสร้างการทาํงานเป็นทีมการช่วยเหลือซ่ึงกนัและกนัทั้งในชัว่โมงและนอกชัว่โมง เพื่อพฒันา

ขีดความสามารถตนเองไดอ้ยา่งเตม็ศกัยภาพ 

จากความสาํคญัและปัญหาดงักล่าวขา้งตน้ ผูว้ิจยัจึงทาํวิจยัการพฒันาบทเรียนผ่านสมาร์ทโฟน 

ตามแนวคิดองค์กรแห่งการเรียนรู้ เร่ืองการพฒันาเวบ็ไซต ์ สาํหรับนักเรียนชั้นประถมศึกษาปีที่ 6           

เพือ่ช่วยใหน้กัเรียนดาํเนินการเรียนรู้อยา่งมีขั้นตอนตามแนวคิดองคก์รแห่งการเรียนรู้ผ่านสมาร์ทโฟน          

ที่จะสร้างขึ้นช่วยใหผู้เ้รียนสามารถสร้างองคค์วามรู้ดว้ยตนเองสามารถแกไ้ขปัญหาการเผชิญกบัสภาวะ

ไม่แน่นอนของสงัคมปัจจุบนัได ้ตลอดถึงการเสริมแรงกระตุน้ให้เกิดการพฒันาร่วมกนัในการเรียนรู้

ร่วมกบัผูอ่ื้นอยา่งจริงจงั เช่น มีการแบ่งปันและถ่ายทอดความรู้อยา่งเป็นเครือข่าย และเพือ่เป็นการพฒันา

ทั้งความสามารถดา้นทกัษะ ดา้นพฤติกรรม ดา้นความคิดและจิตใจเพื่อเพิ่มพูนสมรรถนะทาํให้เกิด

การเรียนรู้ที่จะนาํไปสู่วถีิทางแห่งการพฒันาที่ย ัง่ยนื นอกจากน้ียงัช่วยใหน้กัเรียนมีความกระตือรือร้น

และเพิม่ศกัยภาพของตนเองถ่ายทอดองคค์วามรู้ที่ไดใ้ห้แก่สังคมหรือขององคก์รให้คนในสังคมหรือ

องคก์รสามารถนาํความรู้นั้นๆไปประยกุตใ์ชใ้นการดาํเนินงานในชีวิตประจาํวนั ประกอบกบัมีการใช้

เทคโนโลยสีารสารเทศและการส่ือสารเพือ่การศึกษาเขา้มามีบทบาทในการจดัเรียนรู้ไดอ้ยา่งเหมาะสม

นั้นนอกจากน้ีจะช่วยนักเรียนให้สามารถทาํแบบฝึกหัดและคน้ควา้หาความรู้จากแหล่งขอ้มูลอ่ืนๆได้

ดว้ยตนเองตามขั้นตอนของแนวคิดองคก์รแห่งการเรียนรู้ผ่านสมาร์ทโฟนที่จะส่งเสริมให้นักเรียนกลา้

แสดงความคิดเห็น มีการแลกเปล่ียนเรียนรู้เพื่อแกปั้ญหาต่างอนัเกิดจากการเรียน นักเรียนมีคุณลกัษณะ 

ที่พึงประสงคเ์ป็นไปตามนโยบายของสถานศึกษา สามารถส่งเสริม การทาํงานเป็นทีม การช่วยเหลือ          

ซ่ึงกันและกันทั้งในห้องเรียนและนอกห้องเรียนเพื่อพฒันาความสามารถ ตนเองไดอ้ยา่งเต็มศกัยภาพ

ต่อไปในอนาคต 

 

1.2  วตัถุประสงค์ของการวจิยั 

1.2.1 เพื ่อหาประสิทธิภาพบทเรียนผ่านสมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้   

เร่ือง การพฒันาเวบ็ไซต ์สาํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6 

1.2.2 เพื่อหาผลสัมฤทธ์ิทางการเรียนด้วยบทเรียนผ่านสมาร์ทโฟนตามแนวคิดองค์กร             

แห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์สาํหรับนกัเรียนชั้นประถม ศึกษาปีที่ 6 

1.2.3 เพือ่หาความพงึพอใจของนักเรียนชั้นประถมศึกษาปีที่ 6 ที่ไดเ้รียนตามบทเรียนผ่าน

สมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์
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1.3  สมมติฐานการวจิยั 

1.3.1 บทเรียนผา่นสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต์

สาํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6 ที่มีประสิทธิภาพตามเกณฑ์มาตรฐาน 80/80 

1.3.2 ผลสมัฤทธ์ิทางการเรียนดว้ยบทเรียนผา่นสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ 

เร่ือง การพฒันาเวบ็ไซตส์าํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6 อยา่งมีนยัสาํคญัทางสถิติระดบัที่ .05 

1.3.3 ความพึงพอใจของนักเรียนชั้นประถมศึกษาปีที่ 6 ต่อบทเรียนผ่านสมาร์ทโฟน              

ตามแนวคิดองค์กรแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซตส์ําหรับนักเรียนชั้นประถมศึกษาปีที่ 6              

มีความพงึพอใจในระดบัมาก 

 

1.4  ขอบเขตของการวจิยั 

1.4.1 ขอบเขตด้านเน้ือหาในการวิจยัคร้ังน้ีเป็นวิชาคอมพิวเตอร์ชั้นประถมศึกษาปีที่ 6

ภาคเรียนที่ 2 หน่วยการเรียนรู้ที่ 6 การพฒันาเวบ็ไซต ์

1.4.2 ขอบเขตดา้นประชากรและกลุ่มตวัอยา่ง 

ประชากรที่ใชใ้นการวจิยัคร้ังน้ี เป็นนกัเรียนท่ีเรียนรายวิชาคอมพิวเตอร์กลุ่มสาระ

การเรียนรู้การงานอาชีพและเทคโนโลยี ชั้นประถมศึกษาปีท่ี 6 ภาคเรียนที่ 2 ปีการศึกษา 2557

โรงเรียนโชคชัยรังสิต ตาํบลบึงยี่โถ อาํเภอธัญบุรี จงัหวดัปทุมธานี สํานักงานเขตพื้นที่การศึกษา

ประถมศึกษาปทุมธานี เขต 2 จาํนวน 8 หอ้งจาํนวน 264 คน ปีการศึกษา 2557 

กลุ่มตวัอยา่งที่ใชใ้นการวิจยัคร้ังน้ี ไดแ้ก่นักเรียนชั้นประถมศึกษาปีที่ 6/8 โรงเรียน

โชคชัยรังสิตจังหวดัปทุมธานีซ่ึงได้มาโดยใช้วิธีการสุ่มกลุ่มตวัอย่างแบบเฉพาะเจาะจง (Purposive 

Sampling) จาํนวน 30 คน 

1.4.3 ตวัแปรที่ศึกษา 

การวจิยัในคร้ังน้ีผูว้จิยัไดก้าํหนดตวัแปรที่ศึกษาดงัน้ี 

1.4.3.1 ตวัแปรตน้ (Independent Variable) ไดแ้ก่ บทเรียนผ่านสมาร์ทโฟนตามแนวคิด 

องคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซตส์าํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6 

1.4.3.2 ตวัแปรตาม (Dependent Variable) ไดแ้ก่ 

1) ผลสัมฤทธ์ิทางการเรียนดว้ยบทเรียนผ่านสมาร์ทโฟนตามแนวคิดองคก์ร            

แห่งการเรียนรู้ เร่ือง การพฒันาเว็บไซต์สาํหรับนักเรียนชั้นประถมศึกษาปีที่ 6 อย่างมีนัยสําคญั                 

ทางสถิติที่ .05 

16 



 
 

2) ความพงึพอใจของนักเรียนชั้นประถมศึกษาปีที่ 6 ต่อบทเรียนผ่านสมาร์ทโฟน 

ตามแนวคิดองค์กรแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซตส์ําหรับนักเรียนชั้นประถมศึกษาปีที่ 6                 

มีความพงึพอใจในระดบัมาก 

1.4.4 สถานที่ทาํการศึกษา 

โรงเรียนโชคชยัรังสิตจงัหวดัปทุมธานี 

1.4.5 ระยะเวลาทาํการศึกษา 

การวจิยัใชเ้วลาระหวา่งเดือน 23 ธนัวาคม 2557  ถึง 13 มกราคม 2558 

1.4.6 ขอ้ตกลงเบื้องตน้ 

ลกัษณะของ Smart Phone มีดงัน้ี 

1.4.6.1 ระบบปฏิบติัการ Android 

1.4.6.2 หน่วยประมวลผล ไม่ตํ่ากวา่Dual Core  

1.4.6.3 ความเร็วไม่ตํ่ากวา่ 1.0 GHz 

1.4.6.4 หนา้จอความกวา้งไม่ตํ่ากวา่ 5 น้ิว 

1.4.6.5 จอแสดงผลไม่ตํ่ากว่าความละเอียด 1280 x 720 พิกเซล ระบบสัมผสั Multi 

Touch 

1.4.6.6 หน่วยความจาํตวัเคร่ือง ไม่ตํ่ากวา่ 8 GB 

1.4.6.7 รองรับการเช่ือมต่อ อินเตอร์เน็ต 

1.4.6.8 พื้นที่เก็บ Application ไม่นอ้ยกวา่ 3 Mb 

 

1.5  คาํจาํกดัความในการวจิยั 

1.5.1 บทเรียนผ่านสมาร์ทโฟนหมายถึงการจดัการเรียนการสอนผ่านโทรศพัท์ที่มีลักษณะ

เป็น Application ที่ใชร้ะบบเครือข่ายอินเทอร์เน็ตเป็นช่องทางในการส่ือสารเรียนรู้ท่ีติดต่อระหว่าง

นกัเรียนกบัครูผูส้อนซ่ึงสามารถส่ือสารไดด้ว้ยตวัอกัษร เสียง ภาพน่ิง และภาพเคล่ือนไหวผ่านหน้าจอ

ของโทรศพัทเ์คล่ือนที่ 

1.5.2 องค์กรแห่งการเรียนรู้ หมายถึง แนวคิดในการจดัการเรียนการสอนที่มีการพฒันา

ผูเ้รียน ให้มีคุณลกัษณะและความสามารถดาํเนินการเรียนรู้ให้บรรลุเป้าหมายที่ตั้งไวไ้ดส้ําเร็จโดย

ดาํเนินการสอนตามขั้นตอน ดงัน้ี 
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1.5.2.1 ศึกษาคน้ควา้ เพื่อสร้างให้เป็นบุคคลรอบรู้ (Personal Mastery) หมายถึง

ส่งเสริมให้ผูเ้รียนสามารถเรียนรู้ และพฒันาตนเองผ่านบทเรียนผ่านสมาร์ทโฟนเพื่อให้ผูเ้รียนเกิด          

การเรียนรู้ส่ิงต่างๆ  

1.5.2.2 เขียนแผนผงัความคิดเพื่อสร้างกรอบแนวคิด (Mental Models) หมายถึง 

ผูเ้รียนมีกรอบแนวคิดของตนเองผงัความคิดและพยายามพฒันารูปแบบของตนเองผ่านบทเรียนเพื่อ

ความสอดคลอ้งของผงัความคิดกบัการปรับเปล่ียนกรอบความคิดของตนได ้

1.5.2.3 แสดงวิสัยทัศน์ร่วมกัน (Shared Vision) หมายถึง กาํหนดกรอบความคิด

เก่ียวกบัสภาพอนาคตของกลุ่มงาน ที่มีความปรารถนาร่วมกนั ช่วยกนัสร้างวิสัยทศัน์และพนัธกิจของ

กลุ่มงานร่วมกนั 

1.5.2.4 เรียนรู้ร่วมกนัเป็นทีม (Team Learning) หมายถึง แลกเปล่ียนความรู้ประสบการณ์ 

และทกัษะวิธีคิด เพื่อพฒันาความรู้ความสามารถและศกัยภาพของทีมงานรวมทั้งการเรียนรู้เก่ียวกบั

การทาํงานร่วมกนัเป็นทีม 

1.5.2.5 สร้างความคิดเชิงระบบ (Systems Thinking) หมายถึง สามารถมองเห็นวิธี

คิดถึงความเช่ือมโยงต่อเน่ืองของเหตุการณ์ต่างๆ มีการพึ่ งพาอาศัยกัน มองปัญหาที่เกิดขึ้ นได้ เพื่อ

เปล่ียนแปลงระบบไดอ้ยา่งมีประสิทธิภาพสอดคลอ้งกบัความเป็นไปได ้

1.5.3 การพฒันาเว็บไซต์หมายถึงเน้ือหาสาระกลุ่มสาระการงานอาชีพและเทคโนโลย ี

(คอมพวิเตอร์) ระดบัชั้นประถมศึกษาปีที่ 6 เร่ือง การพฒันาเวบ็ไซตช์ั้นประถมศึกษาปีที่ 6 ประกอบดว้ย 

การออกแบบ การสร้างเวบ็เพจ การนาํเสนอเน้ือหา ขอ้ความ ภาพกราฟิก ภาพน่ิงภาพเคล่ือนไหว และ

เสียง 

1.5.4 นักเรียนชั้นประถมศึกษาปีที่ 6 หมายถึง นักเรียนชั้นประถมศึกษาปีที่ 6 โรงเรียน          

โชคชยัรังสิต อ.ธญับุรี จ.ปทุมธานี ภาคเรียนที่ 2 ปีการศึกษา 2557 

 

1.6  กรอบแนวคดิของการวจิัย 

ผูว้ิจยัประยกุตแ์ละผสมสานแนวคิดองคก์รแห่งการเรียนรู้ทฤษฎีของ Peter Senge (Senge. P, 

1990, p. 3) และกาํหนดกรอบทเรียนผา่นสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันา 

เวบ็ไซตส์าํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6 ดงัภาพที่ 1.1 
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ภาพที่ 1.1 กรอบแนวคิดการพฒันาบทเรียนตามแนวคิดองคก์รแห่งการเรียนรู้ (Learning Organization) 

 

1.7  ประโยชน์ทีค่าดว่าจะได้รับ 

1.7.1 ไดบ้ทเรียนผา่นสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต์

สาํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6 มีประสิทธิภาพ 

 1.7.2 ใชเ้ป็นแนวทางในการพฒันาบทเรียนผา่นสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้

กลุ่มสาระเน้ือหาวชิาอ่ืนๆต่อไป 

ผลสัมฤทธ์ิทางการเรียนด้วยบทเรียน

ผ่านสมาร์ทโฟนตามแนวคิดองค์กร

แห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์

สาํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6 

ออกแบบขั้นตอนการเรียนตามแนวคิดองคก์รแห่งการเรียนรู้  (Learning Organization) 

1.  ศึกษาคน้ควา้ เพือ่สร้างให้เป็นบุคคลรอบรู้ (Personal Mastery) 

2.  เขียนแผนผงัความคิดเพือ่สร้างกรอบแนวคิด (Mental Models) 

3.  แสดงวสิัยทศัน์ร่วมกนั (Shared Vision) 

4.  เรียนรู้ร่วมกนัเป็นทีม (Team Learning) 

5.  สร้างความคิดเชิงระบบ (Systems Thinking) 

การเก็บรวบรวมขอ้มูล 

บทเรียนผา่นสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ 

สรุปและหาประสิทธิภาพแนวคิดองคก์รแห่งการเรียนรู้ผา่นสมาร์ทโฟน 

เร่ือง การพฒันาเวบ็ไซตส์าํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6 
 

ความคิดเห็นของนกัเรียนชั้นประถมศึกษาปีที่ 6 

ที่ได้เรียนตามบทเรียนผ่านสมาร์ทโฟนตาม

แนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันา

เวบ็ไซตส์าํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6 
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บทที่ 2 

เอกสารและงานวจิัยที่เกีย่วข้อง 

 

การวิจยัเร่ืองการพฒันาบทเรียนผ่านสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง     

การพฒันาเวบ็ไซตส์าํหรับนักเรียนชั้นประถมศึกษาปีท่ี 6 ผูว้ิจยัไดศึ้กษาคน้ควา้เอกสารและงานวิจยั          

ที่เก่ียวขอ้งดงัต่อไปน้ี 

2.1 แนวคิดและทฤษฎีที่เก่ียวขอ้งกบัองคก์รแห่งการเรียนรู้ 

2.2 กรอบแนวคิดเก่ียวกบัการกาํหนดรูปแบบองคก์รแห่งการเรียนรู้ 

2.3 แนวคิดและทฤษฎีที่เก่ียวขอ้งกบัอีเลิร์นน่ิงและสมาร์ทโฟน 

2.4 การสอนผา่นออนไลน์ 

2.5 การพฒันาเวบ็ไซต ์

2.6 หลกัสูตรแกนกลางการศึกษาขั้นพื้นฐานพทุธศกัราช 2551 

2.7 งานวจิยัที่เก่ียวขอ้ง 

 

2.1  แนวคดิและทฤษฎทีีเ่กีย่วข้องกบัองค์กรแห่งการเรียนรู้ 

2.1.1 ความหมายขององคก์รแห่งการเรียนรู้ 

วรรณะ บุษบา (2553, น. 15) กล่าวไวว้่าองคก์รแห่งการเรียนรู้ (Learning Organization) 

ที่มีการจดักระบวนการเรียนรู้จากการแลกเปล่ียนประสบการณ์ ความรู้ที่มีการดาํเนินการส่งเสริมให้

บุคคล ทีมงานหรือกลุ่มบุคคลในองคก์รไดมี้การเพิ่มพูนความรู้ ความสามารถแลกเปล่ียนประสบการณ์

เพือ่ปรับเปล่ียนตนเองแลว้นาํความรู้ความสามารถที่เพิม่ขึ้นมาพฒันาองคก์รไปสู่เป้าหมายที่กาํหนดไว้

อยา่งต่อเน่ืองโดยอาศยัปัจจยัต่างๆ ที่เกิดขึ้นจากตวับุคคลและส่ิงแวดลอ้มที่อยูใ่นองคก์ร 

มาลี  สืบกระแส (2552, น. 16) กล่าวไวว้า่ เป็นสถาบนัที่มีลกัษณะการสร้างความรู้ใช้

เองโดยอาศยัความรู้ของบุคลากรในองคก์ารเป็นฐานในการพฒันาเพื่อนาํไปสู่จุดหมายร่วมกนัของ

องคก์าร บุคลากรจะมีลกัษณะมุ่งมัน่ท่ีจะเรียนรู้พฒันาศกัยภาพของตนเองอยา่งต่อเน่ืองเป็นการเรียนรู้

ตลอดชีวติ มีการเพิม่อาํนาจการเรียนรู้ และการทาํงานของบุคลากรโดยใชว้ิธีการเรียนรู้ร่วมกนัทั้งจาก

ภายในและภายนอกองคก์าร มีการจดัการความรู้อยา่งเป็นระบบ ควบคู่กบัการใชเ้ทคโนโลยท่ีีทนัสมยั 

ทั้งในระดบับุคคลกลุ่มและองคก์าร 

ศนัสนีย ์จะสุวรรณ์ (2550, น. 19) กล่าวไวว้่า องคก์รแห่งการเรียนรู้ว่าเป็นองคก์รที่เอ้ือ

ให้บุคลากรทุกคนมีการเช่ือมโยงความสัมพนัธ์ของทุกคนในองค์กร ที่กระตุน้ให้เกิดการพฒันา



ร่วมกนัในการเรียนรู้ร่วมกบัผูอ่ื้นอยา่งจริงจงั มีการแบ่งปันและถ่ายทอดความรู้เป็นเครือข่ายภายใต้

สภาพแวดล้อมที่ปรับเปล่ียนอยู่ตลอดเวลาทาํให้เกิดการเรียนรู้ที่จะนําไปสู่วิถีทางแห่งการพฒันา                

ที่ย ัง่ยนื และเตม็ไปดว้ยจิตสาํนึกที่ดีของบุคลากรทัว่ทั้งองคก์รเป็นการกระตุน้และจูงใจใหส้มาชิกทุกคน

ในองคก์ารมีความกระตือรือร้นที่จะเรียนรู้และพฒันาตนเองอยูต่ลอดเวลา เพื่อขยายศกัยภาพของตนเอง 

และขององค์การที่จะดําเนินกิจกรรมต่างๆ ในองค์การให้สําเร็จตามวิสัยทศัน์ วตัถุประสงค์และ

เป้าหมายที่กาํหนดไวใ้ห้สําเร็จด้วยดีโดยอาศัยรูปแบบของการทาํงานเป็นทีมการเรียนรู้ร่วมกัน 

ตลอดจนมีความคิดความเข้าใจเชิงระบบท่ีจะต้องประสานกัน เพื่อให้เกิดความได้เปรียบที่ย ัง่ยืน                   

ต่อการแข่งขนัท่ามกลางกระแสโลกาภิวตัน์ไดต้ลอดไป 

พชันี ธระเสนา, บุริมโอทกานนท์ (2551, น. 2) กล่าวไวว้่า องค์กรแห่งการเรียนรู้                 

เป็นองค์กรที่สามารถรับรู้ส่ิงเร้าต่างๆ เช่น ข่าวสาร ขอ้มูล ความรู้และการเปล่ียนแปลงทั้งภายนอก             

และภายในตวัองคก์รมีความสามารถในการประมวลผล ตีความออกมาเป็นแนวคิด นโยบาย มาตรการ 

นวตักรรม และแนวปฏิบติัที่สามารถนาํไปประยกุตใ์ชใ้นการดาํเนินงานไดอ้ยา่งถูกตอ้งรวดเร็วทนักาล 

และเหมาะสมกบัสภาพการณ์ และสามารถท่ีจะเรียนรู้จากประสบการประยกุตใ์ชค้วามรู้นั้น เพื่อสั่งสม 

ไวเ้ป็นสินทรัพยท์างปัญญา สาํหรับเลือกมาใชไ้ดต้่อไปในอนาคต 

ฐิติกร พูลภทัรชีวิน (2554, น. 8) กล่าวไวว้่า องคก์ารท่ีมีลกัษณะเอ้ืออาํนวยต่อการให้

บุคลากรทัว่ทั้งองคก์ารสามารถแลกเปล่ียนเรียนรู้กนัไดอ้ยา่งสะดวกทัว่ถึง ทาํให้บุคลากรในองคก์าร

เกิดการพฒันาร่วมกนัอยา่งต่อเน่ือง พร้อมทั้งเปิดโอกาสให้นาํผลจากการแลกเปล่ียนเรียนรู้มาใชใ้น

การปรับปรุงแกไ้ขปัญหาที่องคก์ารเผชิญอยู ่ตลอดจนนาํมาใชเ้พื่อพฒันาต่อยอดผลิตภณัฑ ์กระบวน            

การ นวตักรรมใหม่ๆในองคก์าร อนัจะส่งผลใหอ้งคก์ารสามารถบรรลุเป้าหมายท่ีตั้งไวไ้ดส้าํเร็จ 

เจษฎากร ทองแสวง (2553, น. 5-6) กล่าวไวว้่า องค์กรแห่งการเรียนรู้ส่งเสริมให้

บุคลากรในองคก์รเกิดการเรียนรู้อยูต่ลอดเวลา มีการพฒันาทั้งดา้นความคิด และจิตใจมีการถ่ายโอน

ความรู้สู่บุคคลให้แก่กนัอยา่งทัว่ถึง และมีการทาํงาน ร่วมกนัเป็นทีม มีการแกปั้ญหาการปฏิบติังาน

อยา่งสร้างสรรค ์รวมถึงเทคโนโลยมีาใชใ้นการเรียนรู้และเพิม่ผลผลิตและการพฒันางานอยา่งต่อเน่ือง

ไปสู่เป้าหมายร่วมกันขององค์กร และมีการปรับตวัให้ทนัต่อการเปล่ียนแปลงที่เกิดขึ้นตลอดเวลา              

ซ่ึงอยูภ่ายใตอ้งคก์รที่มีบรรยากาศการเรียนรู้รายบุคคลและกลุ่ม 

กรพินธ์ ศรีสุภา (2550, น. 77) กล่าวไวว้่า องคก์ารแห่งการเรียนรู้เป็นซ่ึงสมาชิกใน

องค์การเพิ่มขีดความสามารถตนเองอย่างต่อเน่ืองทั้งในระดับบุคคลระดับกลุ่ม และระดับองค์การ           

เพือ่นาํไปสู่จุดมุ่งหมายที่บุคคลในระดบัต่างๆ ตอ้งการอยา่งแทจ้ริง เป็นองคก์ารที่ส่งเสริมการเรียนรู้
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ร่วมกนัเป็นทีมเพื่อการเปล่ียนแปลงความรู้ และประสบการณ์ให้ทนักับความเปล่ียนแปลงความรู้  

และมีการพฒันาองคก์ารอยา่งต่อเน่ือง 

เริงฤดี หนูขาํ (2553, น. 9) กล่าวไวว้่า องคก์รแห่งการเรียนรู้เป็นองคก์รท่ีมีบรรยากาศ

เอ้ือต่อการเรียนรู้ร่วมกนัของสมาชิกทุกระดบัในองคก์รอยูต่ลอดเวลา เพื่อพฒันาเป็นทีมและองคก์ร

ในที่สุด นอกจากน้ียงัเป็นการเรียนรู้ในส่ิงใหม่ๆ โดยมีการถ่ายโอนความรู้และจดัการความรู้รวมทั้งใช้

เทคโนโลยเีขา้มามีบทบาทในการเรียนรู้และการทาํงานไดอ้ยา่งเหมาะสม อนันาํมาซ่ึงการเปล่ียนแปลง

และทาํการปฏิบติังานใดๆ ใหเ้กิดประสิทธิภาพสูงสุดโดยมีรูปแบบการทาํงานที่สอดประสานเช่ือมโยง 

เก้ือหนุนซ่ึงกนัและกนั และพฒันาตนเองอยา่งต่อเน่ืองภายใตว้ฒันธรรมองคก์รที่ยดึถือปฏิบติัร่วมกนั 

เมตตา เทพประทุน (2551, น. 22) กล่าวไวว้่า องคก์รแห่งการเรียนรู้เป็นองคก์รที่มี

บรรยากาศที่เอ้ือต่อการเรียนรู้หรือการแสวงหาความรู้ ในการยกระดบัความสามารถในการเรียนรู้โดย

เร่ิมตั้งแต่ระดบับุคคล พฒันาเป็นระดับกลุ่มหรือทีมและองค์กรในที่สุด นอกจากน้ียงัเก่ียวขอ้งกับ          

การแบ่งปันความรู้ การถ่ายโอนความรู้และการจดัการความรู้ รวมทั้งใชเ้ทคโนโลยีเขา้มามีบทบาท           

ในการเรียนรู้และการทาํงานไดอ้ยา่งเหมาะสม ทั้งน้ีเพื่อขยายขีดความสามารถ ศกัยภาพของตนเอง

และองคก์ร โดยอาศยัรูปแบบของการทาํงานเป็นทีมและการเรียนรู้ร่วมกนั ตลอดจนมีความคิดความ

เขา้ใจเชิงระบบที่จะประสานกนั เพือ่ใหเ้กิดเป็นความไดเ้ปรียบที่ย ัง่ยนืต่อการแข่งขนัท่ามกลางกระแส

โลกาภิวฒัน์ตลอดไป 

จารุณี ตนัติเวชวุฒิกุล (2549, น. 32) กล่าวไวว้่า องค์กรแห่งการเรียนรู้ เป็นองค์กร            

หรือหน่วยงานที่สมาชิก หรือบุคลากรทุกคนมีความรู้ ความสามารถ และมีการใฝ่เรียนรู้ของตนมาร่วมกนั          

ในการพฒันาองคก์รหรือหน่วยงานใหมี้การเปล่ียนแปลงท่ีมีขึ้นในอนาคต 

อัมพร ปัญญา (2553, น. 17) กล่าวไวว้่า องค์กรแห่งการเรียนรู้มุ่งเน้นการพฒันา

ศกัยภาพของคนในองคก์รด้านความคิดใหม่ๆ ดา้นความสามารถดา้นทกัษะและด้านพฤติกรรมที่แสดง

ออกมาเพื่อก่อให้เกิดผลการปฏิบติังาน (Performance) ที่ดีเยี่ยมโดยจะตอ้งส่งเสริมกระบวนการเรียนรู้

ร่วมกนั (Collective learning) ในทุกๆ ระดับทั้งระดับบุคคล (Individual) ระดบักลุ่ม (Groups) และ

ระดบัองคก์ร (Organization) 

ประธาน เสนีวงศ์ ณ อยธุยา (2546, น. 12) กล่าวไวว้่า องค์กรแห่งการเรียนรู้สามารถ

เปล่ียนพฤติกรรมขององคก์รโดยกระบวนการการเรียนรู้ร่วมกนัของบุคลากรทั้งหมดในองคก์รบุคลากร

ทุกคนในองคก์รมีอิสระในการเรียนรู้ร่วมกนัมีการสร้างองคท์ี่หลากหลาย มีการคิดคนและเปล่ียนแปลง

การปฏิบัติงานร่วมกัน มีการแบ่งปันความรู้เพื่อเพิ่มพูน สมรรถนะและศกัยภาพท่ีจะก่อให้เกิด

ความกา้วหนา้ในการดาํเนินกิจการไปสู่เป้าหมายอยา่งต่อเน่ือง 
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Peter Senge (1990, p. 5) กล่าวว่า องคก์รแห่งการเรียนรู้ เกิดจากบุคลากรในองคก์ร                       

มีความมุ่งมัน่ แสวงหาความรู้เพือ่พฒันาขีดความสามารถของตนเองไดอ้ยา่งต่อเน่ือง มีหัวใจรักการเรียนรู้ 

เป็นแรงบนัดาลให้สร้างสรรคผ์ลงานใหม่ๆ เกิดขึ้น ทาํให้บุคลากรในองคก์รเกิดกระบวนการเรียนรู้

ร่วมกนั อนัส่งผลใหอ้งคก์รบรรลุเป้าหมายได ้

สรุปได้ว่า องค์กรแห่งการเรียนรู้ หมายถึงส่งเสริมให้บุคคลมีการเพิ่มพูนความรู้ 

ความสามารถแลกเปล่ียนประสบการณ์เพื่อปรับเปล่ียนตนเองสร้างความรู้ใช้เองสามารถเผชิญกับ

สภาวะไม่แน่นอนได ้มีการกระตุน้ให้เกิดการพฒันาร่วมกันในการเรียนรู้ร่วมกับผูอ่ื้นอย่างจริงจงั      

มีการแบ่งปันและถ่ายทอดความรู้อยา่งเป็นเครือข่าย พฒันาทั้งความสามารถดา้นทกัษะดา้นพฤติกรรม 

ดา้นความคิดและจิตใจเพื่อเพิ่มพูนสมรรถนะทาํให้เกิดการเรียนรู้ท่ีจะนาํไปสู่วิถีทางแห่งการพฒันา           

ที่ย ัง่ยนื มีความกระตือรือร้นเพื่อขยายศกัยภาพของตนเองและขององคก์รสามารถนาํไปประยกุตใ์ช ้ 

ในการดาํเนินงาน ควบคู่กบัการใชเ้ทคโนโลยเีขา้มามีบทบาทในการเรียนรู้ไดอ้ยา่งเหมาะสมเพื่อสั่งสม

ไวเ้ป็นสินทรัพยท์างปัญญา  

2.1.2 องคป์ระกอบของการเป็นองคก์รแห่งการเรียนรู้ 

Marquardt (1996, p. 39) กล่าวไวว้่า รูปแบบขององคก์รการเรียนรู้ โดยการวิเคราะห์

บทความและหนงัสือเก่ียวกบัองคก์รแห่งการเรียนรู้ สามารถรวบรวมองคป์ระกอบของการเป็นองคก์ร

แห่งการเรียนรู้ วา่มีทั้งส้ิน 5 องคป์ระกอบหลกั คือ 

1) ดา้นการเรียนรู้ (Learning) ซ่ึงเป็นลกัษณะของพลวตัการเรียนรู้ (Learning Dynamics) 

2) ด้านองค์กร (Organization) ซ่ึงมุ่งเน้นการปรับเปล่ียนขององค์กร (Organization 

Transformation) 

3) ดา้นบุคคล (People) ซ่ึงเป็นการเสริมอาํนาจบุคคล (People Empowerment) 

4) ดา้นการจดัการความรู้ (Knowledge Management)  

5) ดา้นเทคโนโลย ี(Technology) ซ่ึงเป็นการปรับใชเ้ทคโนโลยภีายในองคก์ร 

สกล บุญสิง (2555, น. 7) ศาสตราจารยด์า้นการพฒันาทรัพยากรมนุษยแ์ห่งมหาวิทยาลยั 

จอร์จวอชิงตนัประธานสมาคมแห่งการเรียนรู้ของโลก (Global Learning Association) เป็นนักวิชาการที่

มีช่ือเสียงทางการศึกษาเก่ียวกบัองคก์ารแห่งการเรียนรู้ไดเ้สนอองคป์ระกอบอยู ่5 ดา้น ไดแ้ก่ 

1) ระบบยอ่ยดา้นองคก์าร (Organization Subsystem) เป็นองคป์ระกอบที่สาํคญั ไดแ้ก่ 

วิสัยทศัน์ (Vision) เป็นเสมือนเข็มทิศนาํองค์การไปยงัเป้าหมายที่พึงประสงคก์ลยทุธ์ (Strategy) เป็น

วธีิการที่จะทาํใหไ้ปถึงยงัเป้าหมายตามวสิยัทศัน์โครงสร้างองคก์าร (Structure) เป็นปัจจยัสนับสนุนให้

มีการทาํหน้าที่ในทุกภาคส่วนอย่างเหมาะสมและท่ีสําคญัคือวฒันธรรมองค์การ (Organization 
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Culture) ซ่ึงเป็นความเช่ือหรือค่านิยมของคนในองคก์ารท่ีตอ้งเอ้ือต่อการสร้างองคก์ารแห่งการเรียนรู้ 

เช่น ค่านิยมการทาํงานเป็นทีม การบริหารจดัการตนเอง การมอบอาํนาจกระจายอาํนาจเป็นตน้ 

2) ระบบยอ่ยดา้นคน (People Sub System) เป็นระบบที่ประกอบดว้ยผูจ้ดัการและผูน้าํ

พนกังาน ลูกคา้ หุน้ส่วนและพนัธมิตรทางธุรกิจ ซัพพลายเออร์และผูข้ายรวมถึงชุมชนท่ีอยูแ่วดลอ้ม

ซ่ึงทุกกลุ่มมี คุณค่าต่อองคก์ารแห่งการเรียนรู้และตอ้งไดรั้บการเอ้ืออาํนาจและการเรียนรู้เช่นเดียวกนั 

3) ระบบยอ่ยดา้นเทคโนโลย ี(Technology Subsystem) การมีเคร่ืองมือหรือเทคโนโลยทีี่

ทนัสมยัถือเป็นส่ิงอาํนวยความสะดวกที่ช่วยให้การสร้างองคก์ารแห่งการเรียนรู้มีความสะดวกมาก

ยิง่ขึ้นโดยประเภทของเทคโนโลย ีที่ช่วยในการสร้างองคก์ารแห่งการเรียนรู้มี 2 ประเภทไดแ้ก่เทคโนโลย ี

สาํหรับการจดัการความรู้ (Manage Knowledge) เป็นการใช ้เพื่อการจดัเก็บและแลกเปล่ียนความรู้แก่

กนัและเทคโนโลย ีที่ใชใ้นการเพิ่มพูนความรู้ (Enhance Learning) เป็นการใชเ้คร่ืองมืออุปกรณ์ในการ

สร้างการเรียนรู้แก่ผูเ้รียนไดอ้ยา่งสะดวกมากขึ้นเช่น Computer-Based Training, E-Learning, Web-

Based Learning 

4) ระบบยอ่ยดา้นความรู้ (Knowledge Sub System) ระบบยอ่ยดา้นความรู้ของการเรียนรู้

ขององค์การน้ีจะบริหารจดัการความรู้ต่างๆ ขององค์การซ่ึงประกอบไปด้วยการแสวงหาความรู้               

การสร้างความรู้การเก็บรักษาความรู้การวิเคราะห์และการทาํ Data Mining การถ่ายโอนและการเผยแพร่

ความรู้การนาํไปประยกุตใ์ชแ้ละการทาํใหข้อ้มูลมีความเท่ียงตรง 

5) ระบบยอ่ยดา้นการเรียนรู้ (Learning Sub System) เป็นระบบหลกัที่เป็นแกนสาํคญั

ของการสร้างองคก์ารแห่งการเรียนรู้ซ่ึงสามารถจาํแนกการเรียนรู้ได ้3 ระดบัไดแ้ก่ระดบับุคคลระดบั

กลุ่มและระดบัองคก์ารซ่ึงในแต่ละระดบัของการเรียนรู้นั้นตอ้งเร่ิมที่ทกัษะของตวับุคลากรแต่ละคน

ซ่ึงตอ้งมี 5 ประการเพื่อสามารถเรียนรู้ไดอ้ยา่งมี ประสิทธิภาพไดแ้ก่ความคิดเชิงระบบ(Systematic 

Thinking) แบบแผนความคิด (Mental Model) ความรอบรู้แห่งตน (Personal Mastery) การเรียนรู้ดว้ย

ตนเอง (Self-Directed Learning) และการสนทนาส่ือสารกนั (Dialogue)โดยวิธีในการเรียนรู้ที่มี

ความสาํคญัในการสร้างการเรียนรู้ในบริบทขององคก์ารแห่งการเรียนรู้มี 3 ประเภท  เช่น การเรียนรู้

เพื่อการปรับตวั (Adaptive Learning) เป็นการเรียนรู้จากประสบการณ์ในอดีตเพื่อการปรับปรุง                      

ในอนาคตการเรียนรู้โดยการกระทาํ (Action Learning) เป็นการเรียนรู้ที่นาํเอาสถานการณ์หรือสภาพ

ปัญหาที่เกิดขึ้นจริงมาเป็นฐานของการเรียนรู้และสุดทา้ยคือระบบการเรียนรู้เพื่อมุ่งสู่เป้าหมายของ

องคก์าร (Anticipatory Learning) และการเรียนรู้ท่ีมุ่งสนองตอบความสาํเร็จของเป้าหมายองคก์าร เช่น

วสิยัทศัน์ (Vision) เป็นตน้ 
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สุรพงศ ์ เอ้ือศิริพรฤทธ์ิ (2547, น. 45-46) กล่าวว่า องคก์รเรียนรู้ตอ้งเป็นองคก์รออกแบบ

เพือ่การเรียนรู้ที่ต่อเน่ืองโดยพจิารณาจากองคป์ระกอบ 5 องคป์ระกอบดงัน้ี 

1)โครงสร้าง (Structure)โครงสร้างเป็นโครงสร้างท่ีมีการติดต่อสัมพนัธ์กันเป็น

แนวนอน (Horizontal) โดยพิจารณาความล่ืนไหลของงาน (Work  Flow) มากกว่าการพิจารณาดา้น

การแบ่งแยกเป็นหนา้ที่ตามแผนกงาน (Departmental Functions)  

2) การเสริมอาํนาจ (Empowerment) เน้นโดยเฉพาะการเสริมอาํนาจให้แก่บุคลากร

มากกวา่เนน้ดา้นงาน (Task) โดยเสริมอาํนาจใหแ้ก่บุคลากรทุกคนในองคก์ารเพือ่ไดมี้โอกาสตดัสินใจ

เนน้การทาํงานเป็นทีม 

3) การสร้างเครือข่าย (Network) เน้นการสร้างระบบเอ้ืออาํนวยต่อการเช่ือมโยงเป็น

เครือข่ายและการแลกขอ้มูล ข่าวสาร (Shared Information)  

4) กลยทุธ ์(Strategy) ใชค้วามร่วมมือทั้งภายในและภายนอกองคก์าร 

5) วฒันธรรมที่ปรับตวั (Adaptive Culture) เน้นวฒันธรรมส่วนรวมมากกว่าส่วนยอ่ย 

ความเสมอภาค การเปล่ียนแปลง การกลา้เส่ียง และการปรับปรุงอยา่งต่อเน่ือง 

วรรณะ บุษบา (2553, น. 30-31) สรุปไดว้่า ความเป็นองคก์รแห่งการเรียนรู้ประกอบดว้ย 

องคป์ระกอบหลกัและองคป์ระกอบยอ่ยดงัน้ี 

1) องคป์ระกอบหลกัดา้นองคก์ร (Organization) ประกอบดว้ยองคป์ระกอบยอ่ย 

(1.1) องคป์ระกอบยอ่ยโครงสร้างขององคก์ร (Structure) 

(1.2) องคป์ระกอบยอ่ยวฒันธรรมองคก์ร (Culture) 

(1.3) องคป์ระกอบยอ่ยวสิยัทศัน์องคก์ร (Strategy) 

2) องคป์ระกอบหลกัดา้นภาวะผูน้าํ ประกอบดว้ยองคป์ระกอบยอ่ยดงัน้ี 

(2.1) องคป์ระกอบยอ่ยภาวะผูน้าํแบบเปล่ียนสภาพ (Transformational  Leadership) 

3) องคป์ระกอบหลกัดา้นการเรียนรู้ ประกอบดว้ยองคป์ระกอบยอ่ยดงัน้ี 

(3.1) องคป์ระกอบยอ่ยระดบัการเรียนรู้ (Level of Learning) 

(3.2) องคป์ระกอบยอ่ยรูปแบบการเรียนรู้ (Types of  Learning) 

(3.3) องคป์ระกอบยอ่ยวนิยัของการเรียนรู้ (Disciplines) 

4)  องคป์ระกอบหลกัดา้นการจดัการเรียนรู้ ประกอบดว้ยองคป์ระกอบยอ่ยดงัน้ี 

(4.1) องคป์ระกอบยอ่ยการแสวงหาความรู้ (Knowledge Acquisition) 

(4.2) องคป์ระกอบยอ่ยการสร้างความรู้ (Knowledge Creation) 
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(4.3) องคป์ระกอบยอ่ยการถ่ายโอนและการใชค้วามรู้ (Knowledge Transfer and 

Utilization) 

(4.4) องคป์ระกอบยอ่ยการจดัเก็บความรู้ (Knowledge Storage) 

5)  องคป์ระกอบหลกัดา้นเทคโนโลย ีประกอบดว้ยองคป์ระกอบยอ่ยดงัน้ี 

(5.1) องคป์ระกอบยอ่ยการใชเ้ทคโนโลยเีพือ่การเรียนรู้ 

เสาวนิต คาํจนัทา (2006, น. 33) กล่าววา่ องคป์ระกอบองคก์รแห่งการเรียนรู้ประกอบดว้ย  

1) มุมมองในเชิงองคก์ร (Organizational Perspective) ไดแ้ก่  

(1.1) มีมุมมองที่เป็นระบบโดยภาพรวม เขา้ใจถึงกระบวนการและความสัมพนัธ ์

ของระบบต่างๆ ทัว่ทั้งองคก์ร  

(1.2) มีวสิยัทศัน์ เป้าหมายและค่านิยมร่วมกนัทั้งองคก์ร  

(1.3) เป็นการมองวา่องคก์รสามารถเรียนรู้และเติบโตได ้ 

2) มุมมองในเชิงกระบวนการ (Process Perspective) ไดแ้ก่  

(2.1) การเล็งเห็นโอกาสในความไม่แน่นอนเพือ่สร้างความเจริญกา้วหนา้  

(2.2) ความสามารถปรับตวัและสอดรับกบักระแสการเปล่ียนแปลงไดดี้  

(2.3) การสร้างวฒันธรรมของการเสริมแรงและการเปิดเผยขอ้มูลในองคก์ร 

(2.4) การกระจายอาํนาจการตดัสินใจการเพิม่อาํนาจการปฏิบติังานแก่พนกังาน 

(2.5) การสร้างเครือข่ายภายในและภายนอกองคก์ร (คนงานเทคโนโลย ีและชุมชน)  

(2.6) การให้รางวลัสาํหรับความคิดริเร่ิมสร้างสรรค ์และจดัตั้งโครงงานเพื่อรองรับ

ความคิดดงักล่าว  

(2.7) การสร้างความไวเ้น้ือเช่ือใจใหเ้กิดทัว่ทั้งองคก์ร  

(2.8) การมุ่งสู่การปรับปรุงแกไ้ขอยา่งต่อเน่ือง  

(2.9) การใชร้ะบบการสาํรวจและประเมินทกัษะสมรรถนะของการเรียนรู้  

(2.10) การมีระบบต่างๆ เพือ่การเรียนรู้และใชป้ระโยชน์ร่วมกนัในองคก์ร  

3) มุมมองที่เก่ียวกบัคน (Human Perspective) ไดแ้ก่  

(3.1) การสนบัสนุนใหพ้นกังานในระดบัล่างไดมี้โอกาสและสามารถอธิบายความ

คืบหนา้และอุปสรรคในการทาํงานได ้ 

(3.2) การสนับสนุนให้ผูบ้ริหารทาํหน้าที่เป็นผูช้ี้แนะ พี่เล้ียง ที่ปรึกษา และเป็นผู ้

เก้ือหนุนการเรียนรู้แก่สมาชิกขององคก์ร  

(3.3) การมีผูท้ี่เป็นแม่แบบเก่ียวกบัการกลา้เส่ียง กลา้ทดลองในส่ิงที่คิดดีแลว้  
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(3.4) การใหก้ารสนบัสนุนและส่งเสริมการจดัตั้งทีมปฏิบติังานทุกรูปแบบ  

(3.5) การใชค้ณะทาํงานท่ีมีผูป้ฏิบติัมาจากหลายๆ ส่วนงาน  

สรุปไดว้า่ ความเป็นองคก์รแห่งการเรียนรู้ ประกอบดว้ย 5 องคป์ระกอบหลกัๆ ดงัน้ี 

ดา้นองคก์าร (Organization) ดา้นบุคคล (People) ดา้นเทคโนโลย ี(Technology) ดา้นความรู้ (Knowledge) 

ดา้นการเรียนรู้ (Learning)  

2.1.3 ลกัษณะสาํคญัขององคก์รแห่งการเรียนรู้ 

Senge, P. M. (1990, p. 9) กล่าวว่า องคก์ารมีลกัษณะขององคก์รแห่งการเรียนรู้ 5 ประการ 

ต่อไปน้ี  

1) ความคิดเชิงระบบ (Systems Thinking) มีความสามารถในการมองแบบองคร์วม

(Holism) โดยตอ้งรู้วา่ส่วนต่างๆ ในองคก์ารมีความสัมพนัธ์กนัอยา่งเป็นระบบผลของการเปล่ียนแปลง 

ในส่วนหน่ึงๆ จะส่งผลใหส่้วนอ่ืนๆ เปล่ียนแปลงไปดว้ย 

2) การเป็นบุคคลรอบรู้ (Personal Mastery) ผูบ้ริหารหรือสมาชิกในองคก์ารจะตอ้ง

พฒันาความรู้ ทกัษะ และความชาํนาญเฉพาะตวัขึ้นเพื่อให้เป็นผูรู้้จริงในเร่ืองหน่ึงๆ เพราะการรู้จริง   

จะทาํให้สามารถความคุมสถานการณ์ต่างๆ ไดแ้ละรู้ถึงผลลัพธ์หรือผลกระทบที่จะเกิดกับองคก์าร           

ทาํใหส้ามารถป้องกนัปัญหาที่อาจเกิดขึ้นไดล่้วงหนา้ หรือสามารถบริหารจดัการไดอ้ยา่งมีประสิทธิภาพ 

3) การมีแบบแผนความคิด (Mental Models) ผูบ้ริหารและสมาชิกขององคก์ารตอ้งมี

ความเช่ือหรือทศันคติที่ถูกตอ้ง ความเช่ือหรือทศันคติบางอยา่งเป็นอุปสรรคต่อการเรียนรู้ บางเร่ือง

อาจขดัขวางพฒันาการขององคก์ารดว้ย 

4) การมีวิสัยทศัน์ร่วมกนั (Shared Vision) คือ การทาํให้สมาชิกทุกคน ขององคก์าร

สามารถมองเห็นภาพขององค์การที่ต้องการจะได้ตอ้งการจะเห็น และตอ้งการจะเป็นในอนาคต

ร่วมกนัได ้

5) การเรียนรู้ร่วมกนัเป็นทีม (Team Learning) ผูบ้ริหารตอ้งสร้างบรรยากาศและส่งเสริม 

การทาํงานเป็นทีม ให้สมาชิกในทีมแต่ละคนเกิดการเรียนรู้ และเติบโตไปพร้อมๆ กนัซ่ึงจะช่วยลด

ปัญหาความขดัแยง หรือชิงดีชิงเด่นกันไปในตวั แต่เน่ืองจากการศึกษาเก่ียวกบัการพฒันารูปแบบ            

การบริหารองคก์ารใหเ้ป็นองคก์ารแห่งการเรียนรู้ในปัจจุบนั ยงัไม่ปรากฏมากนักโดยเฉพาะองคก์าร

ทางการศึกษา 

Gephart, Marsick, Van Buren, & Spiro (1996, p. 21) กล่าวไวว้่า องคก์รแห่งการเรียนรู้ 

ควรมีลกัษณะที่สาํคญั 5 ประการ ดงัน้ี 
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1) มีการเรียนรู้อย่างต่อเน่ืองในทุกระดับของระบบภายในองคก์ร โดยผูค้นร่วมกัน

เรียนรู้และถ่ายโอนการเรียนรู้แก่กนั และร่วมกนัผลกัดนัใหเ้กิดผลในทางปฏิบติั 

2) มีการสร้างองคค์วามรู้และมีการแบ่งปันความรู้ไม่ใช่แต่เพียงมุ่งสร้างหรือจบักระแส

ใหม่  ๆเท่านั้น แต่ยงัมีการส่งผา่นความรู้แก่กนัอยา่งรวดเร็วตลอดจนเผยแพร่ใหแ้ก่ผูอ่ื้นท่ีตอ้งการใชไ้ด้

อยา่งรวดเร็วทนัที และในเวลาที่กาํหนด 

3) สนบัสนุนการคิดอยา่งเป็นระบบและสามารถวิพากษว์ิจารณ์ให้ผูค้นไดรู้้จกัคิดวิธี

ใหม่ๆ เพือ่ตรวจสอบความคิดความเช่ือและค่านิยมของคน 

4) สร้างวัฒนธรรมการเรียนรู้โดยให้รางวัลกับความคิดสร้างสรรค์วฒันธรรม                  

การบริหารงาน และวฒันธรรมขององคก์รระบบการประเมินผลการปฏิบติังานตลอดจนเกื้อหนุน

ความเป็นผูท้าํหนา้ที่เป็นบุคคลที่สอนงานหรือถ่านโอนความรู้ซ่ึงกนัและกนั 

5) เนน้คนเป็นศูนยก์ลางโดยคาํนึงถึงความเป็นปกติสุข ซ่ึงจะมีส่วนให้องคก์รไดรั้บ

การพฒันาตามไปดว้ย 

ธนัยกร อารีรัชชกุล (2009, น. 13) กล่าววา่ ลกัษณะองคก์รแห่งการเรียนรู้ ประกอบดว้ย 

1) Sensitivity to changes in the external environment มีสาํนึกต่อสภาพแวดลอ้มภายนอก 

ที่เปล่ียนแปลงไป 

2) Agility & Flexibility in responding to change มีความเร็วและความยดึหยุน่ในการ

ตอบสนองต่อการเปล่ียนแปลง 

3) Open honest communication มีการติดต่อส่ือสารแบบเปิดเผย ซ่ือตรง 

4) No fear ไม่มีความกลวั 

5) Trust and respect for all members มีความไวว้างใจและเคารพในซ่ึงกนัและกนัของ

สมาชิกในองคก์รทั้งหมด 

6) Alignment around shared vision & values วิสัยทศัน์ร่วมสอดคลอ้งกบัค่านิยมของ

องคก์ร 

7) Commitment to achieving the vision regardless of the restrictions of job descriptions มี

พนัธสัญญา มุ่งมัน่ที่จะบรรลุวิสัยทศัน์ร่วมกนัโดยไม่คาํนึงถึงเฉพาะหน้าท่ีหลกัท่ีตอ้งรับผิดชอบแต่

เพยีงอยา่งเดียว 

8) Understanding of the complexity of interrelationship in the systemic structure เขา้ใจ 

ถึงความสลบัซบัซอ้นของความสมัพนัธใ์นระบบโครงสร้าง 
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พชันี ธระเสนา,บุริม โอทกานนท ์(2551, น. 2) กล่าวว่า รูปแบบขององคก์รแห่งการเรียนรู้ 

โดยการวิเคราะห์ บทความและหนังสือเกี่ยวกับองค์ความรู้ สามารถรวบรวมลักษณะสําคัญของ               

การเป็นองคก์รแห่งการเรียนรู้ มี 5 องคป์ระกอบ ดงัน้ี 

1) Personal Mastery มีวินัยในตัวเอง ควบคุมตนเอง ปรับปรุงตนเองสมํ่าเสมอ 

กระตือรือร้นที่จะเรียนรู้ ใฝ่รู้ใฝ่เรียน 

2) Mental Model ส่งการเรียนรู้ทาํความเขา้ใจความเป็นไปต่างๆ และสามารถที่จะ

บริหารปรับเปล่ียน กรอบความคิดของตนเองใหท้นักบัการเปล่ียนแปลงของโลกได ้

3) Shared Vision ความคิด เก่ียวกบสภาพในอนาคตขององคก์ารที่ทุกคนในองคก์ารมี

ความปรารถนาร่วมกนั ที่จะมุ่งมัน่ทาํให้กลายเป็นความจริง ทั้งน้ีก็เพื่อให้การเรียนรู้ริเร่ิมทดลองส่ิง

ใหม่ๆ ของคนในองคก์าร 

4) Team Learning มีการแบ่งปันแลกเปล่ียน ถ่ายทอดขอ้มูล ในระหว่างกนัและกนัทั้ง

ในเร่ืองของความรู้ใหม่ๆ ที่ได้มาจากการคน้คิด หรือจากภายนอก และในด้านของประสบการณ์             

การเรียนรู้ ซ่ึงอาจจะมีทั้งความสาํเร็จ และความลม้เหลว 

5) Systemic Thinking เห็นภาพรวมและสามารถเช่ือมโยงกบัส่ิงที่เกิดและผลลพัธ์ใน

แต่ละส่วนที่จะเกิดตามมาซ่ึงมีความสัมพนัธ์ถูกโยงกนัเป็นระบบเป็นเครือข่ายซ่ึงถูกโยงดว้ยสภาวะ

การพึ่งพาอาศยักนั 

สรุปไดว้่าลกัษณะขององคก์รแห่งการเรียนรู้ ประกอบดว้ย การเรียนรู้อยา่งต่อเน่ือง 

การสร้างองคค์วามรู้ สนบัสนุนการคิดอยา่งเป็นระบบ การเรียนรู้เป็นทีม มีวสิยัทศัน์ร่วมกนั 

 

2.2  กรอบแนวคดิเกีย่วกบัการกาํหนดรูปแบบองค์กรแห่งการเรียนรู้ 

Deming and Excellence Models (Deming, W. Edwards, 2011, pp. 1-4)  เสนอวา่คุณภาพ

จะปรับปรุงผลผลิตและความสามารถในการแข่งขนัคุณภาพจะทาํใหอ้งคก์ารอยูร่อดในระยะยาวและ  

Dr. William Edwards Deming สนบัสนุนการวดัคุณภาพโดยใชว้ธีิสถิติวดัผลผลิตโดยตรงเป้าหมาย

การปรับปรุงคุณภาพในทศันะของ Dr.William Edwards Deming เป็นการลดความแปรปรวนของ

กระบวนการผลิตเพือ่การปรับปรุงงานอยา่งต่อเน่ืองทุกคร้ังที่วงจรหมุนครบรอบก็จะเป็นแรงส่งให้

หมุนในรอบต่อไป วธีิการใหม่ ๆที่ทาํใหเ้กิดการปรับปรุงก็จะถูกจดัทาํเป็นมาตรฐานการทาํงานซ่ึงจะ

ทาํใหก้ารทาํงานมีการพฒันาอยา่งไม่ส้ินสุด ก่อนท่ีจะกา้วไปสู่การปรับปรุงการดาํเนินงานในระดบั

บริษทั จนกระทัง่ในระดบัสถาบนัการศึกษาหรือที่นาํมาใชใ้นระบบประกนัคุณภาพการศึกษา คือวงจร
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คุณภาพ PDCA เป็นการดาํเนินงานอยา่งมีระบบ มีการวางแผนการดาํเนิน การตรวจสอบ และปฏิบติั มี 4 

ขั้นตอนดงัน้ี 

1) ขั้นตอนการเตรียมการ (Plan) คือศึกษาทฤษฏีหลกัการของรูปแบบองคก์รแห่งการเรียนรู้ 

วางแผนการดาํเนินการ 

(1.1) ศึกษาเน้ือ ขอ้มูล 

(1.2) วางแผนดาํเนินการโดยกาํหนดระยะเวลาในการเก็บขอ้มูล สถานที่ในการทาํวิจยั 

กาํหนดสุ่มกลุ่มตวัอยา่งนกัเรียนที่เรียน 

(1.3) วางแผนการดาํเนินการโดยการศึกษาหาความรู้เร่ืองที่เก่ียวขอ้งกบังานวิจยั ทบทวน

วรรณกรรม 

(1.4) วางแผนการดาํเนินการวจิยั โดยติดต่อประสานงานในส่วนที่เก่ียวขอ้ง 

2) ขั้นตอนปฏิบติัตามแผน (DO) ปฏิบติัใหเ้ป็นไปตามแผนที่กาํหนดไวต้ามรูปแบบองคก์ร

แห่งการเรียนรู้ตามแนวคิดทฤษฎีของ Peter Senge ดงัน้ี 

(2.1) การเป็นบุคคลรอบรู้ (Personal Mastery) 

(2.2) การมีแบบแผนความคิด (Mental Models) 

(2.3) การมีวสิยัทศัน์ร่วมกนั (Shared Vision) 

(2.4) การเรียนรู้ร่วมกนัเป็นทีม (Team Learning) 

(2.5) ความคิดเชิงระบบ (Systems Thinking) 

3) ขั้นตอนการติดตามผล (Check) คือการประเมินผลท่ีไดรั้บการปรับปรุงเปล่ียนแปลง 

การดาํเนินการประเมินผลบทเรียนวา่สามารถบรรลุเป้าหมายหรือวตัถุประสงคท่ี์ไดก้าํหนดไวห้รือไม่ 

4) ขั้นตอนการสรุปผล (Act) การดาํเนินงานให้เหมาะสมพิจารณาผลจากการตรวจสอบ 

บทเรียนใหบ้รรลุวตัถุประสงคท์ี่วางไวส้รุปและหาประสิทธิภาพ เพือ่นาํแนวทางหรือกระบวนการปฏิบติั 

นั้นมาจดัทาํใหเ้ป็นมาตรฐานพร้อมทั้งหาวธีิการที่จะปรับปรุงใหดี้ยิง่ขึ้น 

 

2.3  แนวคดิและทฤษฎทีีเ่กีย่วข้องกบัอเีลร์ินน่ิงและสมาร์ทโฟน 

2.3.1 ความหมายของอีเลิร์นน่ิง 

สุชาดา สามสวสัด์ิ (2550, น. 1) กล่าวไวว้่า อีเลิร์นน่ิง (E-Learning) หรือ Electronic 

Learning เป็นกระบวนการถ่ายทอดเน้ือหาผ่านเทคโนโลยสีารสนเทศและการส่ือสาร (ICT) เป็นส่ือ

อิเล็กทรอนิกส์ที่มีจดัการเรียนการสอนที่ช่วยลดขอ้จาํกัดด้านเวลาและสถานท่ี ระหว่างผูเ้รียนและ

ผูส้อนช่วยใหผู้เ้รียนสามารถเรียนไดต้ามความตอ้งการไดต้ลอดเวลา 
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วุฒิชยั ใจซ่ือ (2553, น. 9) กล่าวไวว้่า E-Learning หมายถึง รูปแบบการเรียนการสอน 

แบบใหม่มีการประยกุตใ์ชเ้ทคโนโลยส่ืีออิเล็กทรอนิกส์สมยัใหม่ มีการศึกษาเน้ือหาในลกัษณะออนไลน์ 

มีกระบวนการเรียนการสอนที่มีความยดืหยุน่ทางการเรียนรู้ (Flexible Learning) สนับสนุนการเรียนรู้

ในลกัษณะผูเ้รียนเป็นศูนยก์ลาง (Learner-Centered) มีวตัถุประสงคเ์อ้ืออาํนวยให้ผูเ้รียนสามารถเรียนรู้

องคค์วามรู้ (Knowledge)ไดด้ว้ยตนเองโดยไม่จาํกดัเวลาและสถานที่ (Anywhere-Anytime Learning) 

และส่งเสริมการเรียนรู้ตลอดชีวิต เพื่อให้ระบบการเรียนการสอนเป็นไปไดอ้ยา่งมีประสิทธิภาพมาก

ขึ้นนอกจากน้ีไม่จาํเป็นตอ้งใชส้ําหรับการเรียนการสอนทางไกลเสมอ ผูเ้รียนสามารถนําไปใช้ใน

ลกัษณะการผสมผสานกบัการสอนในชั้นเรียนได ้

นพพร จินตานนท ์(2553, น. 74) กล่าวไวว้่า E-Learning หมายถึง การเรียนการสอน

ผา่นส่ืออิเล็กทรอนิกส์หรือคอมพิวเตอร์ผ่านระบบเคร่ืองข่ายอินเตอร์เน็ต โดยการนาํเสนอเน้ือหาหรือ

บทเรียนในรูปของส่ือผสมต่างๆ เช่น ภาพน่ิง ภาพเคล่ือนไหว ภาพกราฟิก ภาพสามมิติ วีดีทศัน์ และ

เสียง ฯลฯ มีเคร่ืองมือส่ือสารต่างๆ มีแบบทดสอบหลังจากเรียนจบ รวมทั้งมีระบบบนัทึก ติดตาม 

ตรวจสอบ และประเมินผลการเรียนเพือ่ใหร้ะบบการเรียนการสอนเป็นไปยา่งมีประสิทธิภาพ 

อุมารินทร์ คาํญา (2553, น. 35) กล่าวไวว้่า E-Learning คือการเรียนการสอนในลกัษณะ 

หรือรูปแบบใดก็ได ้ซ่ึงการถ่ายทอดเน้ือหานั้นกระทาํผา่นทางส่ืออิเล็กทรอนิกส์เช่น ซีดีรอม เครือข่าย

อินเทอร์เน็ต อินทราเน็ต เอ็กซทราเน็ต หรือสัญญาณโทรทศัน์ สัญญาณดาวเทียม (Satellite) เป็นตน้ 

ซ่ึงอาจจะเป็นการเรียนในลกัษณะที่ผ่านคอมพิวเตอร์ดว้ยซีดีรอม, การเรียนการสอนบนเวบ็ (Web-

Based Learning), การเรียนออนไลน์ (On-Line Learning)การเรียนทางไกลผา่นดาวเทียมหรือการเรียน

ดว้ยวดีีโอผา่นออนไลน์ เป็นตน้ 

ถนอมพร เลาหจรัสแสง (2545, น. 4) กล่าวไวว้่า E-Learning โดยทัว่ๆ ไปจะครอบคลุม

ความหมายที่กวา้งมาก กล่าวคือ การเรียนในลกัษณะใดก็ไดซ่ึ้งใชก้ารถ่ายทอดเน้ือหาผ่านทางอุปกรณ์

อิเล็กทรอนิกส์ ไม่วา่จะเป็น คอมพวิเตอร์ เครือข่ายอินเทอร์เน็ต อินทราเน็ต เอ็กซทราเน็ต ทางสัญญาณ

โทรทศัน์ หรือสญัญาณดาวเทียม (Satellite) ก็ได ้ซ่ึงเน้ือหาสารสนเทศอาจอยูใ่นรูปแบบการเรียนที่เรา

คุน้เคยกนั เช่น คอมพวิเตอร์ช่วยสอน (Computer-Assisted Instruction) การสอนบนเวบ็ (Web-Based 

Instruction) การเรียนออนไลน์ (On-Line Learning) การเรียนทางไกลผ่านดาวเทียม หรืออาจอยูใ่น

ลกัษณะที่ยงัไม่ค่อยเป็นที่แพร่หลายนัก เช่น การเรียนจากวีดีทศัน์ตามอธัยาศยั (Video On-Demand) 

เป็นตน้ 

พรพรรณ เรืองไรรัตนโรจน์ (2554, น. 5) กล่าวไวว้่า E-Learning ส่ืออิเล็กทรอนิกส์                

มีความสาํคญัและความจาํเป็นสาํหรับการศึกษาไทยเป็นอยา่งมากเพราะการพฒันาของโลกในปัจจุบนั
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มุ่งสู่ทิศทางของสังคมความรู้ซ่ึงเน้นคุณค่าทางทรัพยากรมนุษยท์ี่มีศกัยภาพผ่านการเรียนรู้ตลอดชีวิต

อยา่งไม่จบส้ิน วธีิการหาความรู้ของมนุษยจึ์งตอ้งมีการปรับเปล่ียนให้ทนัยคุทนัสมยัและเขา้กนัไดก้บั

ส่ิงแวดลอ้ม ดงันั้น ส่ืออิเล็กทรอนิกส์จึงมีบทบาทสาํคญัในการถ่ายทอดความรู้ดว้ยกระบวนการต่างๆ

หลากหลายไปสู่กลุ่มเป้าหมายที่มีความตอ้งการและวถีิชีวติที่แตกต่าง 

ศิริชยั นามบุรี (2550, น. 18) กล่าวไวว้่า อีเลิร์นน่ิงเป็นรูปแบบที่มีการออกแบบการเรียน

การสอนไวอ้ยา่งเป็นระบบมีการกาํหนดวตัถุประสงคห์รือเป้าหมายการจดัการเรียนการสอนไวอ้ยา่ง

ชดัเจนจดัการเรียนการสอนตามหลักทฤษฎีทางการศึกษาหลักการเรียนการรู้และจิตวิทยาการศึกษา               

การถ่ายทอดความรู้การนาํเสนอเน้ือหาการจดักิจกรรม การเรียนการสอนและถ่ายทอดกลยทุธ์การสอน

ใชเ้ทคโนโลยสีารสนเทศและการส่ือสารเป็นเคร่ืองมือซ่ึงในปัจจุบนัเน้นไปที่การใชร้ะบบเครือข่าย

อินเทอร์เน็ตจึงทาํใหผู้เ้รียนสามารถเขา้ถึงและเรียนรู้โดยไม่จาํกดัสถานที่และเวลาเน้ือหาบทเรียนของ

อีเลิร์นน่ิงจะอยู่ในรูปแบบส่ือผสมอิเล็กทรอนิกส์ (Electronic Multimedia) ซ่ึงออกแบบไวใ้นลักษณะ

ซอฟตแ์วร์รายวิชาหรือคอร์สแวร์ (Courseware) ประกอบดว้ยส่ือผสมไดแ้ก่ ขอ้ความ ภาพน่ิง เสียง

ภาพเคล่ือนไหว และที่สาํคญัผูเ้รียนสามารถโตต้อบกบับทเรียนและผูส้อนไดก้ารบริหารจดัการระบบ

อีเลิร์นน่ิงใชซ้อฟท์แวร์ประเภทบริหารจดัการการเรียนรู้ (Learning Management System : LMS)            

ทาํหน้าที่ในการบริหารจดัการอย่างอตัโนมติัเกือบทุกขั้นตอนแทนการปฏิบติัดว้ยมือตั้งแต่ขั้นตอน    

การลงทะเบียนเรียนจนถึงขั้นตอนการวดัและประเมินผลการเรียนการสอน 

สรุปไดว้า่ E-Learning หมายถึง กระบวนการเรียนการสอนที่การถ่ายทอดเน้ือหาผ่าน

ทางอุปกรณ์อิเล็กทรอนิกส์ เช่ือมต่อกบัระบบเครือข่ายอินเทอร์เน็ตอินทราเน็ตเอ็กซทราเน็ต หรือทาง

สญัญาณโทรทศัน์ หรือ สญัญาณดาวเทียม (Satellite) มีการศึกษาเน้ือหาในลกัษณะออนไลน์ มีความ

ยดืหยุ่นทางการเรียนรู้ (Flexible Learning) เน้นผูเ้รียนเป็นศูนยก์ลาง (Learner-Centered) ผูเ้รียน

สามารถเรียนรู้องค์ความรู้ (Knowledge) ไดด้้วยตนเองโดยไม่จาํกดัเวลาและสถานที่ (Anywhere-

Anytime Learning) และส่งเสริมการเรียนรู้ตลอดชีวติ 

2.3.2 องคป์ระกอบของอีเลิร์นน่ิง 

วลยัพร วงศก์องแกว้ (2554, น. 27) กล่าวไวว้า่ องคป์ระกอบของ E-Learning มี 4 ส่วน  

1) เน้ือหา (Content) สาํหรับการเรียนการศึกษา 

2) ระบบบริหารการเรียน (LMS : Learning Management System) ทาํหน้าที่เป็น

ศูนยก์ลางในการติดต่อส่ือสารและการกาํหนดลาํดบัของเน้ือหาในบทเรียนแลว้นาํส่งผ่านเครือข่ายไป

ยงัผูเ้รียนรวมไปถึงขั้นตอนการประเมินผล ควบคุม และสนับสนุนการให้บริการแก่ผูเ้รียน ระบบ

บริหารการเรียนจะทาํหนา้ที่ตั้งแต่ผูเ้รียนเร่ิมเขา้มาเรียนโดยจดัเตรียมหลกัสูตรให้ผูเ้รียนไดเ้ขา้มาเรียน
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ผูเ้รียนได้เร่ิมต้นบทเรียนระบบจะเร่ิมทํางานโดยส่งบทเรียนตามคาํขอของผูเ้รียนผ่านเครือข่าย

คอมพวิเตอร์ไปแสดงที่ Web Browser ของผูเ้รียน จากนั้นระบบจะติดตามบนัทึกความกา้วหนา้รายงาน

กิจกรรมและผลการเรียนของผูเ้รียนในทุกหน่วยการเรียนอยา่งละเอียด จนจบหลกัสูตร 

3) การติดต่อส่ือสารเป็นเคร่ืองมือช่วยให้ผูเ้รียนไดติ้ดต่อสอบถาม ปรึกษาหารือ และ

แลกเปล่ียนความคิดเห็นระหว่างตวัผูเ้รียนกบัครู อาจารยผ์ูส้อน และระหว่างผูเ้รียนกบัเพื่อนร่วมชั้น

เรียนคนอ่ืนๆ โดยเคร่ืองมือใชใ้นการติดต่อส่ือสารอาจแบ่งไดเ้ป็น 2 ประเภทดงัน้ี 

(3.1) ประเภทช่วงเวลาเดียวกนั (Synchronous) ไดแ้ก่  Chat 

(3.2) ประเภทช่วงเวลาต่างกนั (Asynchronous) ไดแ้ก่  Web-Board, E-mail 

4) การสอบ/วดัผลการเรียนเป็นส่วนประกอบสาํคญัการเรียนแบบ E-Learning  ตอ้งวดั

ระดบัความรู้ก่อนเขา้เรียน เพือ่ใหผู้เ้รียนไดเ้ลือกเรียนในบทเรียน หลกัสูตรท่ีเหมาะสมกบัตนมากท่ีสุด 

จะทาํใหก้ารเรียนที่จะเกิดขึ้นเป็นการเรียนที่มีประสิทธิภาพสูงสุดเม่ือเขา้สู่บทเรียนในแต่ละหลกัสูตร

จะมีการสอบยอ่ยทา้ยบท และการสอบหลงัเรียนก่อนที่จะจบหลกัสูตร 

วารสารวทิยาศาสตร์และเทคโนโลย ีปีที่ 10 ฉบบัที่ 1 มหาวทิยาลยัราชภฏัยะลา (2549, 

น. 8) Khan กล่าวไวว้า่ องคป์ระกอบของอีเลิร์นน่ิงไวอ้ยา่งครอบคลุม 8 ดา้น องคป์ระกอบแต่ละดา้น 

มีรายละเอียดกรอบงาน ดงัน้ี 

1) ดา้นวธีิสอน (Pedagogical) เป็นกระบวนการสอน เก่ียวขอ้งกบัการวิเคราะห์เน้ือหา 

วิเคราะห์ผู ้เรียน กิจกรรมและส่ือการสอน การออกแบบวิธีการสอนกําหนดกลยุทธการสอน

สภาพแวดลอ้มแบบอีเลิร์นน่ิงใหมี้ประสิทธิภาพและประสิทธิผล  

2) ด้านเทคโนโลยี (Technological) เป็นการสาํรวจ การวางแผน การพฒันา และ           

การบาํรุงรักษาโครงสร้างพื้นฐานดา้นเทคโนโลยสีารสนเทศ ไดแ้ก่ เครือข่ายคอมพิวเตอร์ฮาร์ดแวร์

และซอฟตแ์วร์คอมพวิเตอร์ สถานที่บริการเพือ่ใหอ้งคก์รสามารถรองรับการใชอี้เลิร์นน่ิงได ้

3) ด้านการออกแบบส่วนเช่ือมต่อ (Interface Design) เป็นการออกแบบภาพรวม               

การออกแบบการนาํเสนอเน้ือหา การออกแบบการติดต่อกบัผูเ้รียนขณะสืบคน้และเรียนเน้ือหาของ

ระบบอีเลิร์นน่ิงใหเ้หมาะสมและน่าสนใจ (Look and Feel)  

4) ดา้นการประเมินผล (Evaluation) เป็นการประเมินผลผูเ้รียน ประเมินการสอนและ

การประเมินสภาพการจดัการเรียนการสอนแบบอีเลิร์นน่ิง 

5) ด้านการบริหารจัดการ(Management) เป็นการบาํรุงดูแลรักษาระบบอีเลิร์นน่ิง

สามารถดาํเนินการเรียนการสอนในระบบสารสารสนเทศไดอ้ยา่งมีประสิทธิภาพตลอดเวลา 
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6) ดา้นทรัพยากรสนับสนุน (Resource Support) เป็นการจดัเตรียมทรัพยากรต่างๆ 

เพือ่สนบัสนุนการเรียนอยา่งมีคุณภาพเหมาะสมและเพยีงพอ ทาํใหก้ารเรียนการสอนบรรลุวตัถุประสงค ์

7) ดา้นจริยธรรม (Ethical) มีความเหมาะสมดา้นจริยธรรมคุณธรรมเน่ืองจากอีเลิร์นน่ิง 

มีผูเ้รียนหลากหลายและแตกต่างกนัจึงตอ้งคาํนึงผลกระทบดา้นจริยธรรมท่ีเก่ียวขอ้งดว้ย 

8) ดา้นหน่วยงานรับผิดชอบ (Institutional) เป็นการจดัการเรียนการสอนในระบบ           

อีเลิร์นน่ิง ตอ้งมีหน่วยงานรับผดิชอบในดา้นต่างๆ ขององคก์รอยา่งชดัเจน เช่น ฝ่ายบริหาร ฝ่ายวิชาการ 

และฝ่ายสวสัดิการนักศึกษา การพฒันาระบบอีเลิร์นน่ิงให้ครอบคลุมทุกองคป์ระกอบและสามารถ

ทาํงานร่วมกนัอยา่งเป็นระบบ 

สามมิติ สุขบรรจง (2554, น. 19-20) กล่าวไวว้า่ องคป์ระกอบของ E-Learning มีดงัน้ี 

1) ระบบการจดัการศึกษา (Management Education System) เพื่อทาํหน้าที่ควบคุม 

และประสานงานให้ระบบดาํเนินไปอย่างถูกตอ้ง องค์ประกอบน้ีสําคญัท่ีสุด เพราะทาํหน้าท่ีใน               

การวางแผน กาํหนดหลกัสูตร ตารางเวลาแผนด้านบุคลากร แผนงานบริการ แผนดา้นงบประมาณ 

แผนอุปกรณ์เครือข่าย แผนประเมินผลการดาํเนินงาน และทาํให้แผนทั้งหมดดาํเนินไปอยา่งถูกตอ้ง

รวมถึงการประเมิน และตรวจสอบกระบวนการต่างๆ ในระบบ และหาแนวทางแกไ้ข เพื่อให้ระบบ

ดาํเนินต่อไปดว้ยดี 

2) เน้ือหารายวิชาเป็นบทและเป็นขั้นตอน (Contents) หน้าที่ของผูเ้ช่ียวชาญที่ไดรั้บ

มอบหมายให้เป็นผูส้อนเขียนคาํอธิบายรายวิชา วางแผนการสอน ให้เหมาะสมกับเวลาตรงกบั

ความตอ้งการของสงัคม สร้างส่ือการสอนที่เหมาะสม แยกบทเรียนเป็นบท มีการมอบหมายงานเม่ือ

จบบทเรียน และทาํการสรุปเน้ือหาไวต้อนทา้ยของแต่ละบท พร้อมแนะนาํแหล่งอา้งอิงเพิ่มเติมให้ไป

ศึกษาคน้ควา้ 

3) ส่ือสารระหว่างผูเ้รียนและผูส้อน หรือระหว่างผูเ้รียนด้วยกัน (Communication)   

ทุกคนในชั้นเรียนสามารถติดต่อส่ือสารกนั เพือ่หาขอ้มูลช่วยเหลือ แลกเปล่ียนความคิดเห็น หรือตอบ

ขอ้ซักถาม เพื่อให้การศึกษาไดป้ระสิทธิผลสูงสุด ส่ือที่ใช้อาจเป็น E-mail, โทรศพัท,์ Chat Board, 

WWW Board หรือ ICQ เป็นตน้ ผูส้อนสามารถตรวจงานของผูเ้รียนพร้อมแสดงความคิดเห็นต่องาน

ของผูเ้รียนอย่างสมํ่ าเสมอ เปิดเผยผลงานและตรวจงาน เพื่อให้ทุกคนทราบว่างานแต่ละแบบ                

มีจุดบกพร่องอยา่งไร เม่ือแต่ละคนทราบจุดบกพร่องของตน จะสามารถกลบัไปปรับปรุงตวั หรืออ่าน

เร่ืองใดเพิม่เติมเป็นพเิศษได ้
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4) วดัผลการเรียน (Evaluation) งานที่มอบหมาย หรือแบบฝึกหัดทา้ยบทจะทาํให้

ผูเ้รียนมีประสบการณ์ และเขา้ใจเน้ือหาวชิามากขึ้นจนสามารถนาํไปประยกุตแ์กปั้ญหาในอนาคตได ้

เป็นเกณฑม์าตรฐานของบทเรียนที่มีการวดัผลการเรียนเพือ่รับรองผูเ้รียนไดผ้า่นมาตรฐานการวดัผล 

สรุปไดว้า่องคป์ระกอบของอีเลิร์นน่ิงประกอบดว้ย 4 ส่วน 

1) ระบบบริหารการจัดการ (Management) คือการจัดการระบบสารสนเทศเป็น

ศูนยก์ลางในการติดต่อส่ือสารใหแ้ก่ผูเ้รียน 

2) เน้ือหา (Content) คือบทเรียนสาํหรับการเรียนการศึกษา 

3) การติดต่อส่ือสาร (Communication) คือการติดต่อส่ือสารกนั เพื่อหาขอ้มูลช่วยเหลือ 

แลกเปล่ียนความคิดเห็น หรือตอบขอ้ซกัถาม 

4) การสอบ/วดัผลการเรียน (Evaluation) คือการประเมินการสอน การจดัการเรียน        

การสอนแบบอีเลิร์นน่ิง 

2.3.3 ส่วนประกอบของอีเลิร์นน่ิง 

มนตช์ยั เทียนทอง (2547, น. 63-64) กล่าวไวว้า่ ส่วนประกอบของ E-Learning มีดงัน้ี 
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4) Test Management System (TMS) หมายถึงระบบจดัการดา้นการทดสอบเพื่อประเมิน 

ความกา้วหนา้ของผูเ้รียนโดยจดัเก็บไวใ้นระบบฐานขอ้มูล 

2.3.4 ลกัษณะของอีเลิร์นน่ิง 

ถนอมพร เลาหจรัลแสง (2545, น. 6)กล่าวไวว้า่ ลกัษณะของ E-Learningไวด้งัน้ี 

1) ไม่จาํกัดสถานที่และเวลา (Anywhere-Anytime) ช่วยขยายโอกาสในการเขา้ถึง

เน้ือหาการเรียนรู้ของผูเ้รียนสามารถเรียกดูเน้ือหาตามความสะดวกของผูเ้รียน ในระบบอินเทอร์เน็ต 

หรืออินทราเน็ต 

2) ส่ือประสม (Multimedia) การนาํเสนอเน้ือหาโดยใชป้ระโยชน์จากส่ือประสมเพื่อ

ช่วยในการประมวลผลสารสนเทศ ของผูเ้รียนเพือ่ใหเ้กิดความคงทนในการเรียนรู้ไดดี้ขึ้น 

3) นาํเสนอเน้ือหาในรูปแบบไม่เป็นตรง (Non-linear) การนาํเสนอเน้ือหาในลกัษณะ

ที่ไม่เป็นเชิงเส้นตรง ผูเ้รียนสามารถเขา้ถึงเน้ือหาตามความตอ้งการโดยมีจุดเช่ือมโยงที่ยืดหยุน่แก่

ผูเ้รียนสามารถเรียกดูเน้ือหายอ้นหลงั หรือตามความสนใจของผูเ้รียนได ้

4) ปฏิสมัพนัธ ์(Interaction) ควรตอ้งมีการเปิดโอกาสให้ผูเ้รียนโตต้อบมีปฏิสัมพนัธ์กบั

เน้ือหาหรือกบัผูอ่ื้นได ้ดงัน้ี 

(4.1) มีการออกแบบกิจกรรมซ่ึงผูเ้รียนสามารถโตต้อบกับเน้ือหา การจดัเตรียม

แบบฝึกหดัและแบบทดสอบใหผู้เ้รียนสามารถตรวจสอบความเขา้ใจดว้ยตนเองได ้

(4.2) มีการจดัหาเคร่ืองมือในการให้ช่องทางในการติดต่อส่ือสารให้แก่ผูเ้รียนเพื่อ

ปรึกษา อภิปราย ซกัถาม แสดงความคิดเห็นระหวา่งผูเ้รียนกบัผูเ้รียน 

5) ให้ผลป้อนกลบัโดยทนัที (Immediate Response) หมายถึง E-Learning ควรตอ้ง          

มีการออกแบบใหมี้การทดสอบ การวดัผลและประเมินผล ซ่ึงใหผ้ลป้อนกลบัโดยทนัทีแก่ผูเ้รียนไม่ว่า

จะอยูใ่นลกัษณะของแบบทดสอบก่อนเรียน (Pre-test) หรือแบบทดสอบหลงัเรียน (Post-test) 

ศิริชยั นามบุรี (2550, น. 19) กล่าวไวว้่า ลกัษณะสาํคญัของการจดัการเรียนการสอนใน

ระบบอีเลิร์นน่ิงไดด้งัน้ี 

1) อีเลิร์นน่ิงเป็นการเรียนการสอนด้วยส่ืออิเล็กทรอนิกส์รูปแบบการจดัการเรียน           

การสอนในสภาพแวดล้อมที่ใชค้อมพิวเตอร์เครือข่ายคอมพิวเตอร์หรือเครือข่ายอินเทอร์เน็ตเป็น

ช่องทางและเป็นเคร่ืองมือในการนาํเสนอและถ่ายทอดเน้ือหารวมทั้งกลยทุธก์ารสอนไปยงัผูเ้รียน 

2) เน้ือหาและวิธีการสอนของอีเลิร์นน่ิงจะใช้ส่ือผสมอิเล็กทรอนิกส์ (Electronics 

Multimedia) ไดแ้ก่ภาพน่ิงภาพเคล่ือนไหวภาพยนตร์เสียงขอ้ความและเคร่ืองมือต่างๆที่ระบบบริหาร

จดัการการเรียนรู้ไดจ้ดัเตรียมไวใ้หม้าประยกุตใ์ชร่้วมกนัอยา่งเหมาะสม 
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3) กิจกรรมการเรียนการสอนของอีเลิร์นน่ิงไดก้าํหนดวตัถุประสงคแ์ละออกแบบไว้

อยา่งเป็นระบบโดยอาศยัทฤษฎีการเรียนการสอนและการเรียนรู้เป็นแนวคิดสาํคญั 

4) ระบบการเรียนการสอนมีการจดัเตรียมเคร่ืองมือสนับสนุนในการสร้างปฏิสัมพนัธ์ 

ระหว่างผูเ้รียนกบัผูส้อนผูเ้รียนกบัผูเ้รียนและผูเ้รียนกบัระบบเพื่อให้เกิดการแลกเปล่ียนองค์ความรู้

และเรียนรู้ร่วมกนั (Collaborative) ทั้งการมีปฏิสัมพนัธ์แบบประสานเวลา (Synchronous Interaction) 

และการโตต้อบแบบไม่ประสานเวลา (Asynchronous Interaction) 

5) กระบวนการจดัการบริหารการเรียนการสอนเน้นการนาํซอฟตแ์วร์จดัระบบบริหาร 

การจดัการเน้ือหาและจดัการการเรียนการสอน (Learning Content ManagementSystem : LCMS) 

หรือระบบบริหารจดัการการเรียนรู้ (Learning Management System : LMS) มาบริหารจดัการอยา่ง

อตัโนมติัเป็นสาํคญัตั้งแต่เร่ิมตน้ลงทะเบียนเรียนจนถึงขั้นตอนการประเมินผล 

6) ลกัษณะการจดัการเรียนการสอนแบบทางไกล (Distance Learning) สามารถเรียน

ไดทุ้กสถานที่ทุกเวลาทุกเร่ืองเน่ืองจากเน้ือหาบทเรียนและกิจกรรมนาํเสนอไวต้ลอดเวลา (On-Line) 

ทาํใหไ้ม่มีขอ้จาํกดัดา้นสถานที่และเวลาในการเรียนเกิดกระบวนการท่ีเรียกว่าการเรียนรู้แบบร่วมกนั

เป็นกลุ่ม (Group Collaboration) 

7) วิธีของการศึกษาแนวใหม่ (New Education Approaches) เป็นการจดัการเรียน           

การสอนที่มีผูเ้ช่ียวชาญสาขาต่างๆเป็นผูส้อนทัว่โลกร่วมมือกันแลกเปล่ียนความรู้ซ่ึงกันและกัน

รวมทั้งมีส่ือและแหล่งเรียนรู้มากมายนอกเหนือจากที่ไดรั้บจากผูส้อนกาํหนดให้เหมือนในชั้นเรียน

ปกติ 

สรุปไดว้า่ลกัษณะของอีเลิร์นน่ิงเป็นการเรียนการสอนดว้ยส่ืออิเล็กทรอนิกส์รูปแบบ

การจดัการเรียนการสอนที่ใชค้อมพวิเตอร์เครือข่ายคอมพวิเตอร์หรือเครือข่ายอินเทอร์เน็ตเป็นช่องทาง

และเป็นเคร่ืองมือในการนําเสนอและถ่ายทอดเน้ือหาไม่จาํกดัสถานที่และเวลา (Anywhere-Anytime) 

ช่วยขยายโอกาสใหผู้เ้รียนสามารถเขา้ถึงเน้ือหาตามความตอ้งการ เป็นส่ือประสม (Multimedia) กาํหนด 

การวตัถุประสงคแ์ละออกแบบไวอ้ยา่งเป็นระบบ มีการนําเสนอเน้ือหาในลกัษณะท่ียดืหยุน่แก่ผูเ้รียน

สามารถเรียกดูเน้ือหายอ้นหลงั หรือตามความสนใจของผูเ้รียนไดมี้ปฏิสัมพนัธ์ (Interaction) เปิดโอกาส 

ให้ผูเ้รียนโตต้อบกับเน้ือหาหรือผูอ่ื้นได้ มีการทดสอบ การวดัผลและประเมินผลโดยทนัทีแก่ผูเ้รียน              

ไม่ว่าจะอยูใ่นลกัษณะของแบบทดสอบก่อนเรียน (Pre-test) หรือแบบทดสอบหลงัเรียน (Post-test)โดย

อาศยัทฤษฎีการเรียนการสอนและการเรียนรู้ตามองคก์รแห่งการเรียนรู้เป็นแนวคิดการศึกษาแนวใหม่ 

(New Education Approaches) ซ่ึงเป็นการจดัการเรียนการสอนที่มีผูเ้ช่ียวชาญสาขาต่างๆเป็นผูส้อนทัว่
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โลกร่วมมือกนัแลกเปล่ียนความรู้ซ่ึงกนัและกนัรวมทั้งมีส่ือและแหล่งเรียนรู้มากมายมหาศาลนอกเหนือ 

จากที่ไดรั้บจากผูส้อนกาํหนดใหเ้หมือนในชั้นเรียนปกติ 

2.3.5 รูปแบบของอีเลิร์นน่ิง 

เจษฎา เมฆะสุวรรณโรจน์ (2549, น. 9) รูปแบบ E-Learning มีดงัน้ี 

1) Synchronous หมายถึงผูเ้รียนและผูส้อนอยูใ่นเวลาเดียวกนัเป็นการเรียนการสอน 

แบบเรียลไทม์เน้นผูเ้รียนเป็นศูนยก์ลาง เช่นห้องเรียนที่มีอาจารยส์อนนักศึกษาอยูแ่ลว้แต่นาํไอทีมา

เสริมการสอนรูปแบบที่ดีจะตอ้งทาํให้ผูเ้รียนสามารถเรียนรู้ไดต้รงตามวตัถุประสงค ์โดย Synchronous 

มีเคร่ืองมือที่จาํเป็นมีดงัน้ี 

(1.1) Discussion Groups เป็นเคร่ืองมือที่ทาํให้นักเรียนพบปะกันและแลกเปล่ียน

ความคิดซ่ึงกนัและกนั 

(1.2) Audio or Conferencing เป็นเคร่ืองมือที่ทาํให้เห็นหน้าและไดย้นิเสียงกัน              

มีลกัษณะเสมือนกบัเขา้หอ้งเรียนจริงๆ สามารถถามและโตต้อบไดท้นัทีทนัใด 

(1.3) Chat เป็นเคร่ืองมือที่ทาํให้การแลกเปล่ียนข่าวสารไดท้นัทีทนัใด แต่เน้น            

การแลกเปล่ียนลกัษณะของขอ้ความและแฟ้มขอ้มูล 

2) Asynchronous หมายถึง ผูเ้รียนและผูส้อนไม่ไดอ้ยูใ่นเวลาเดียวกนัไม่มีปฏิสัมพนัธ ์

แบบเรียลไทม ์เนน้ศูนยก์ลางที่ผูเ้รียนเป็นการเรียนดว้ยตนเอง ผูเ้รียน เรียนจากท่ีใดก็ไดท่ี้มีอินเทอร์เน็ต 

โดยสามารถเขาไปยงัโฮมเพจเพื่อเรียน ทาํแบบฝึกหัดและสอบ มีห้องให้สนทนากบัเพื่อนร่วมชั้น          

มีเวบ็บอร์ดและอีเมล์ให้ถาม รูปแบบที่ดีจะตอ้งทาํให้ผูเ้รียนสามารถเรียนรู้ไดต้รงตามวตัถุประสงค ์

โดย Asynchronous มีเคร่ืองมือที่จาํเป็นสาํหรับการเรียนรู้ ดงัน้ี 

(2.1) BulletinBoards นักเรียนสามารถตั้งคาํถามไวแ้ละครูหรือผูมี้ความรู้สามารถ

ตอบคาํถามได ้

(2.2) File Exchanges นักเรียนสามารถให้บริการแลกเปล่ียนไฟล์ดว้ยกนัเองหรือ

อาจมีการแลกเปล่ียนไฟลร์ะหวา่งครูกบันกัเรียน 

(2.3) On-Demand Audio or Video นักเรียนสามารถทบทวนการบรรยายที่ผ่านมา

ทางวดีีทศัน์ 

(2.4) E-mail นักเรียนสามารถแลกเปล่ียนขอ้มูลระหว่างกันหรือระหว่างครูกับ

นกัเรียนได ้ 

2.3.6 ระดบัการนาํไปใช ้
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สามมิติ สุขบรรจง (2554, น. 21) นาํ E-Learning ไปใชป้ระกอบกบัการเรียนการสอน 

สามารถทาํได ้3 ระดบั ดงัน้ี 

1) ส่ือเสริม (Supplementary) หมายถึงการนาํ E-Learning ไปใช้ในลกัษณะส่ือเสริม 

โดยผูเ้รียนยงัสามารถศึกษาเน้ือหาเดียวกนัในลกัษณะอ่ืนๆ ไดจ้ากเอกสาร (Sheet) ประกอบการสอน 

จากวดีีทศัน์ (Video Tape) การใชE้-Learning ในลกัษณะน้ีผูส้อนตอ้งการ จดัหาทางเลือกใหม่อีกทาง

หน่ึงสาํหรับผูเ้รียนในการเขา้ถึงเน้ือหาเพือ่ใหป้ระสบการณ์พเิศษเพิม่เติมแก่ผูเ้รียนเท่านั้น 

2) ส่ือเติม(Complementary) หมายถึง การนาํ E-Learning ไปใชใ้นลกัษณะเพิม่เติมจาก

วิธีการสอนนอกจากการบรรยายในห้องแล้ว ผูส้อนยงัออกแบบเน้ือหาให้ผูเ้รียนเขา้ไปศึกษาเน้ือหา

เพิม่เติมจาก E-Learning ในความคิดของผูเ้ขียนแลว้ ในประเทศไทยหากสถาบนัใดตอ้งการที่จะลงทุน

ในการนาํ E-Learning ไปใชก้บัการเรียน การสอนตามปรกติ(ที่ไม่ใช่ทางไกล) แลว้อยา่งน้อยควรตั้ง

วตัถุประสงคใ์นลกัษณะของส่ือเติม (Complementary) มากกว่าแค่เป็นส่ือเสริม (Supplementary) เช่น 

ผูส้อนจะตอ้งให้ผูเ้รียนศึกษาเน้ือหาจาก E-Learning เพื่อวตัถุประสงคใ์ดวตัถุประสงคห์น่ึง เป็นตน้ 

ทั้งน้ี เพือ่ให้เหมาะสมกบัลกัษณะของผูเ้รียนในบา้นเราซ่ึงยงัตอ้งการคาํแนะนาํจากครูผูส้อนรวมทั้ง

การที่ผูเ้รียนส่วนใหญ่ยงัขาดการปลูกฝังใหมี้ความใฝ่รู้ โดยธรรมชาติ 

3) ส่ือหลกั (Comprehensive Replacement) หมายถึง การนาํ E-Learning ใชใ้นลกัษณะ

แทนที่การบรรยายในห้องเรียน ผูเ้รียนตอ้งศึกษาเน้ือหาทั้งหมดแบบออนไลน์ ใน E-Learning ส่วน

ใหญ่ในต่างประเทศจะได้รับการพฒันาขึ้นเพื่อวตัถุประสงคใ์นการใช้เป็นส่ือหลักสําหรับแทนครู              

ในการสอนทางไกล ด้วยแนวคิดที่ว่า มัลติมีเดีย ที่นําเสนอทาง E-Learning สามารถช่วยถ่ายทอด

เน้ือหาไดใ้กลเ้คียงกบัการสอนจริงของครูผูส้อนโดยสมบูรณ์ได ้

2.3.7 ประสิทธิภาพของระบบอีเลิร์นน่ิง 

Khan (2005, p. 43) กล่าวไวว้่า ลกัษณะของระบบอีเลิร์นน่ิงท่ีมีประสิทธิภาพว่าควร         

มีลกัษณะดงัต่อไปน้ี 

1) ง่ายต่อการใช้งาน (Ease of Use) มีการออกแบบสภาพแวดล้อมของระบบให้

เอ้ืออาํนวยต่อผูเ้รียนผูเ้รียนเกิดความพึงพอใจในสภาพการเรียนการสอนไม่สร้างความยุง่ยากให้แก่

ผูเ้รียนส่ือการเรียนการสอนเปิดโอกาสใหผู้เ้รียนเลือกเรียนไดต้ามความตอ้งการของแต่ละคนมีสภาพ

อาํนวยความสะดวกในการเรียนตลอดเวลาไม่เกิดความล่าชา้ในการตอบสนอง 

2) การโตต้อบ (Interactivity) นบัเป็นลกัษณะสาํคญัของกิจกรรมการเรียนการสอนใน

ระบบอีเลิร์นน่ิงผูเ้รียนสามารถโตต้อบกบัผูเ้รียนคนอ่ืนๆผูส้อนและทรัพยากรในระบบไดอ้ยา่งสะดวก

ผูส้อนหรือผูเ้ช่ียวชาญมีบทบาทเป็นผูอ้าํนวยความสะดวก (Facilitators) ระบบตอ้งจดัเตรียมเคร่ืองมือ
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สาํหรับการโตต้อบทั้งประเภทประสานเวลา (Synchronous) เช่นห้องสนทนา (Chat Room) การประชุม 

ออนไลน์ (Conferencing Tools) และแบบไม่ประสานเวลา เช่น จดหมายอิเล็กทรอนิกส์ (E-mail) 

กระดานเสวนา (Web Board) 

3) ผูเ้ช่ียวชาญหลากหลาย (Multiple Expertise) ในระบบอีเลิร์นน่ิงสามารถมีผูส้อน

หรือผูเ้ช่ียวชาญหลายๆ คนความรู้ความเช่ียวชาญและประสบการณ์หลายดา้นทาํการสอนในระบบ            

อีเลิร์นน่ิงไดโ้ดยใชท้รัพยากรการสอนประสบการณ์ของผูส้อนนาํเสนอผา่นเครือข่ายอินเทอร์เน็ตจาก

ที่ใดก็ไดอ้นัจะเป็นประโยชน์อยา่งยิง่ต่อผูเ้รียน 

4) การเรียนรู้แบบร่วมมือ (Collaborative Learning) ระบบอีเลิร์นน่ิงเป็นช่องทางใน

การเรียนรู้แบบร่วมมือกนัผา่นการสนทนาการอภิปรายการส่ือสารและการแลกเปล่ียนความคิดความรู้

ประสบการณ์การเรียนรู้แบบร่วมมือกนัส่งเสริมใหก้ารเรียนประสบความสาํเร็จไปพร้อมๆกนัระหว่าง

ผูเ้รียนดว้ยกนัสภาพแวดลอ้มที่สนบัสนุนการเรียนรู้แบบร่วมมือกนัทาํให้ผูเ้รียนมีการพฒันาทางดา้น

สงัคมการส่ือสารความคิดเห็นภาวการณ์เป็นผูน้าํการเจรจาต่อรองรวมทั้งไดรั้บประสบการณ์ในการ

ทาํงานร่วมกบัผูอ่ื้น 

5) ระบุตวัตนได ้(Authenticity) ควรที่มีลกัษณะเสมือนจริงระบุตวัตนผูเ้รียนไดเ้ช่น 

เดียวกบัระบบการเรียนในหอ้งเรียนปกติโดยใชเ้ทคโนโลยท่ีีชาญฉลาด เช่นการใชเ้ทคโนโลยกีารประชุม 

ทางไกลร่วมกบัการจดัการเรียนการสอนแบบอีเลิร์นน่ิงเพือ่ลดขอ้จาํกดัหรือขอ้แตกต่างระหว่างสภาพ

การเรียนแบบเสมือนกบัการเรียนในหอ้งเรียนปกติ 

6) ควบคุมการเรียนดว้ยตนเอง (Learner Control) การเรียนการสอนแบบอีเลิร์นน่ิง

อนุญาตให้ผูเ้รียนที่มีความพร้อมและมีความสามารถที่แตกต่างกันคือสามารถเลือกเรียนเน้ือหาที่

แตกต่างกนัในช่วงเวลาที่แตกต่างกนัและใหผ้ลยอ้นกลบัท่ีแตกต่างกนัสาํหรับผูเ้รียนแต่ละคนได ้

สรุปไดว้า่ประสิทธิภาพของระบบอีเลิร์นน่ิงง่ายต่อการใชง้านมีเคร่ืองมือสาํหรับสร้าง

กิจกรรมโตต้อบระหวา่งผูเ้รียนกบับทเรียนหรือผูส้อนอยา่งเพียงพอมีผูเ้ช่ียวชาญหลายดา้นสนับสนุน

การเรียนการสอนรูปแบบองคก์รแห่งการเรียนรู้และผูเ้รียนควบคุมความกา้วหน้าทางการเรียนดว้ย

ตนเอง 

2.3.8 สมาร์ทโฟน 

Smart Phones หมายถึง โทรศพัทมื์อถือที่บรรจุหน้าที่ของ PDA เขา้ไปดว้ยเพียงแต่           

ไม่มี Stylus แต่สามารถลงโปรแกรมเพิ่มเติมเหมือนกบั PDA และ PDA Phone ไดข้อ้ดีของอุปกรณ์

กลุ่มน้ีเป็นส่วนที่มีขนาดเล็กพกพาสะดวกประหยดัไฟและราคาไม่แพงมากนักคาํว่าโทรศพัทมื์อถือ

ตรงกบัภาษาองักฤษวา่ Hand Phone ซ่ึงใชค้าํน้ีแพร่หลายใน Asia Pacific ส่วนในอเมริกานิยม เรียกว่า 
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Smart Phones 

Cell Phone ซ่ึงยอ่มาจาก Cellular Telephone ส่วนประเทศอ่ืนๆนิยมเรียกว่า Mobile Phone เป็นอุปกรณ์ 

คอมพิวเตอร์แบบพกพาขนาดเล็กหรือขนาดประมาณฝ่ามือที่รู้จกักนัทัว่ไปเช่น Pocket PC กบั Palm 

เคร่ืองมือส่ือสารในกลุ่มน้ียงัรวมถึง PDA Phone ซ่ึงเป็นเคร่ือง PDA ที่มีโทรศพัทใ์นตวัสามารถใช้

งานการควบคุมดว้ย Stylus เหมือนกบั PDA ทุกประการและยงัหมายรวมถึงเคร่ืองคอมพิวเตอร์ขนาด

เล็กอ่ืนๆ เช่น Lap Top, Note book และ Tablet PC อีกดว้ยสถาบนัการศึกษาไดเ้ร่งเห็นจุดเด่นของ

อุปกรณ์คอมพิวเตอร์แบบพกพาขนาดเล็กน้ีเพื่อพฒันารูปแบบการเรียนการสอนผ่านส่ือที่ใช้

เทคโนโลยสีารสนเทศในการจดัการระบบ ที่เรียกว่า  M-Learning เป็น E-Learning ที่ผูเ้รียนใชอุ้ปกรณ์ 

คอมพวิเตอร์แบบพกพาเพือ่เขา้ถึงบทเรียนและเพิ่มพูนความรู้ให้กบัตนเองไดน้อกจากน้ีตามหลกัการ

แลว้ E-Learning เป็นส่วนหน่ึงของ D-Learning หรือคาํเต็ม Distance Learning ซ่ึงหมายถึง การเรียน

ทางไกล 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพที่ 2.2 Smart Phones 

2.3.8 เอ็มเลิร์นน่ิง 

มนตช์ยั เทียนทอง (2547, น. 3) กล่าวไวว้่า เอ็มเลิร์นน่ิงเป็นการเรียนการสอนที่ใช้

เทคโนโลยสีารสนเทศการจดัการบทเรียนสาํเร็จรูปที่นาํเสนอผา่นเคร่ืองมือส่ือสารที่สามารถนาํพกติด

ตวัไดส้ะดวกเช่นโทรศพัทมื์อถือ คอมพิวเตอร์แบบพกพารวมถึงคอมพิวเตอร์แบบโน้ตบุ๊ก เพื่อสนับสนุน

การทาํงานร่วมกนั การเรียนการสอนในลกัษณะน้ีมีความเป็นส่วนตวัและมีความเป็นปัจจุบนั 
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1) เทคโนโลยทีี่ใชใ้นเอ็มเลิร์นน่ิงเป็นเทคโนโลยเีครือข่ายโทรศพัทไ์ร้สายที่แพร่หลาย

ทัว่โลก คือ จีเอสเอ็ม (GSM : Global System for Mobile Communication) ซ่ึงออกแบบขึ้นมาในคร้ัง

แรกเพื่อใช้ในการรับส่งสัญญาณเสียงเป็นหลกั แต่ต่อมาได้มีการพฒันาให้มีการรับส่งขอ้ความใน

ลกัษณะของขอ้ความสั้น (SMS: Short Message Service) เช่น โทรสาร จดหมายอิเล็กทรอนิกส์ และ

ขอ้ความสั้นๆ ดว้ยความเร็วในการรับส่งสัญญาณ 160 ตวัอกัษรต่อวินาทีหลงัจากนั้นไดมี้การพฒันา

โพรโตคอลไร้สาย (Wireless Protocol) ขึ้นมาเพื่อรองรับการใชง้านโปรแกรมประยกุตต์่างๆ ผ่าน

เครือข่ายอินเทอร์เน็ตเรียกว่า WAP (Wireless Application Protocol) ทาํให้เกิดการต่ืนตวัอยา่งมากใน

การท่องอินเทอร์เน็ตโดยใชเ้วบ็เบราเซอร์ (Web Browse) ผา่นโทรศพัทมื์อถือหรือคอมพิวเตอร์พกพา

แต่ส่วนใหญ่ยงัเป็นการการนาํเสนอดว้ยขอ้ความเป็นหลกัการนาํเสนอภาพภาพเคล่ือนไหวและวีดิทศัน์

ผ่าน WAP โพรโตคอลดงักล่าวไดพ้ฒันาเครือข่ายโทรศพัทดิ์จิทลัไดก้า้วหน้าอยา่งต่อเน่ืองส่งผลให้

การรับส่งภาพน่ิงภาพเคล่ือนไหวและวีดีทศัน์เป็นเร่ืองที่ง่ายขึ้นเทคโนโลยเีหล่าน้ีไดแ้ก่จีพีอาร์เอส 

(GPRS) เอชเอสซีเอสดี (HSCSD) เอ็ดจ ์(EDGE) และบลูทูธ (Bluetooth) เป็นตน้ 

2) ข่ายงานของเอ็มเลิร์นน่ิง (M-Learning Framework) Knowledge Anywhere (2002, 

น. 6) ซ่ึงเป็นองคก์รที่จดัการเรียนการสอนแบบอีเลิร์นน่ิงและเอ็มเลิร์นน่ิงไดน้าํเสนอข่ายงานของ           

เอ็มเลิร์นน่ิงไวด้งัภาพที่ 2.3 

 

 

 

 

 

 

 

 

 

ภาพที่ 2.3 ข่ายงานของเอ็มเลิร์นน่ิงตามแนวความคิดของ Knowledge Anywhere 

3) ส่วนประกอบข่ายงานของเอ็มเลิร์นน่ิงประกอบดว้ย 

(3.1) ขอ้มูลคาํอธิบายต่างๆเก่ียวกบับทเรียน (Context Data) หมายถึง คาํอธิบาย

บทเรียน คู่มือการใช้งาน การช่วยเหลือ และขอ้มูลที่จาํเป็นอ่ืนๆ เพื่อสนับสนุนอาํนวยความสะดวก

ใหก้บัผูเ้รียนในระหวา่งการเรียนรู้ 
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(3.2) เคร่ืองมือสนับสนุนชาญฉลาด (Intelligent Support Engine) หมายถึง เทคโนโลย ี

เครือข่ายไร้สายรวมถึงซอฟต์แวร์ที่ทาํหน้าบริหารและจดัการบทเรียนเร่ิมตั้งแต่การลงทะเบียนนําเสนอ

จดัการติดต่อส่ือสารติดตามผลและประเมินผลรวมถึงอุปกรณ์ประกอบต่างๆเพื่อใชส้นับสนุนการเรียน

การสอนผา่นจอภาพของโทรศพัทมื์อถือคอมพวิเตอร์แบบพกพาส่วนน้ีจะทาํสัมพนัธ์กบั Task Model 

และ User Model ที่ไดมี้การออกแบบไวก่้อนเก่ียวกบัรูปแบบการดาํเนินการเก่ียวกบัภารกิจหรือกิจกรรม

การเรียนรู้ที่จะเสนอใหก้บัผูเ้รียน 
(3.3) หน่วยเก็บเน้ือหาบทเรียน (Content Repository) ไดแ้ก่ส่วนของเน้ือหาบทเรียน 

รวมทั้งแบบฝึกหดั แบบทดสอบ และส่วนขอ้มูลต่างๆ ที่เป็นองคค์วามรู้เพือ่ถ่ายทอดไปยงัผูเ้รียน 

(3.4) การติดต่อกบัผูเ้รียน (Interface) ไดแ้ก่ส่วนของการปฏิสมัพนัธ์กบัผูเ้รียนผ่าน

แป้นพมิพแ์ละจอภาพของเคร่ือง 

4) ขอ้ดีของบทเรียนเอ็มเลิร์นน่ิงการใชค้อมพิวเตอร์แบบพกพาเพื่อนาํเสนอบทเรียน

เอ็มเลิร์นน่ิง 

(4.1) ผูเ้รียนสามารถมีปฎิสัมพนัธ์ร่วมกันได้โดยการถ่ายทอดประสบการณ์ตรง

ร่วมกนัแทนที่จะนัง่อยูห่นา้จอภาพเหมือนการใชไ้มโครคอมพวิเตอร์ 

(4.2) ใชพ้ื้นที่ไม่มากเหมือนกบัการใชไ้มโครคอมพิวเตอร์ภายในห้องปฏิบติัการ

เน่ืองจากคอมพวิเตอร์แบบพกพาสามารถต่อเช่ือมดว้ยระบบเครือข่ายไร้สายผูเ้รียนจะใชง้านที่ใดก็ได ้

(4.3) สะดวกต่อการพกติดตวัไปไหนมาไหนเม่ือเปรียบเทียบกบัคอมพิวเตอร์แบบ

โนต้บุก๊หรือเปรียบเทียบกบัหนงัสือแบบเดิมในปริมาณของขอ้มูลที่เทียบเคียงกนั 

(4.4) ระบบการรู้จาํลายมือ (Handwriting Recognition System) ท่ีสามารถป้อนขอ้มูล

ดว้ยลายมือเขา้ทางแป้นเขียน (Tablet) ไปยงัคอมพวิเตอร์ไดง้่ายรวดเร็วและมีประสิทธิภาพ 

(4.5) การใช้ปากกาเข็มเป็นอุปกรณ์นําเขา้ขอ้มูลของคอมพิวเตอร์แบบพกพาซ่ึง

เป็นวิธีการที่เป็นธรรมชาติมากกว่าการใช้แป้นพิมพห์รือการใช้เมาส์ทาํให้ผูเ้รียนเกิดความคุน้เคย

มากกวา่การนาํเขา้ขอ้มูลส่วนน้ียงัรวมถึงการร่างภาพเขียนภาพเซ็นเช่ือโน้ตยอ่และการขีดเขียนอ่ืนๆ

ดว้ยลายมือมีความสะดวกมากกวา่การใชแ้ป้นพมิพเ์น่ืองจากเขียนในสถานท่ีและเวลาใดก็ได ้

(4.6) การศึกษาบทเรียนเอ็มเลิร์นน่ิงผ่านคอมพิวเตอร์แบบพกพาเกิดขึ้นได้ง่าย

ตลอดเวลาผูเ้รียนสามารถลงทะเบียนศึกษาบทเรียนวิเคราะห์ปัญหาร่วมกับเพื่อนร่วมชั้นเรียนทาํ

แบบฝึกหดัและทาํการทดสอบไดข้ณะท่ีตวัเองมีความพร้อมในขณะที่ไมโครคอมพิวเตอร์ตอ้งใชง้าน

เป็นเวลา 
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(4.7) การเรียนรู้แบบร่วมกัน (Collaborative Learning) ท่ีอาศยัผูเ้รียนหลายคน

ปฏิสัมพนัธ์กับบทเรียนในเวลาเดียวกันซ่ึงกระทาํได้ง่ายกว่าการใช้ไมโครคอมพิวเตอร์เน่ืองจาก

คอมพวิเตอร์แบบพกพาใชเ้ครือข่ายไร้สายเป็นช่องทางในการส่งผา่นองคค์วามรู้การแบ่งปันทรัพยากร

และการกระจายองคค์วามรู้เกิดขึ้นไดง่้ายกวา่ 

(4.8) ใชใ้นสถานที่ใดในเวลาใดๆ ก็ไดไ้ม่ว่าจะเป็นบา้นพกัสถานที่ทาํงานหรือใน

ระหวา่งการประกอบภารกิจการงานหรือการประชุมเน่ืองจากการใชค้อมพิวเตอร์แบบพกพาไม่เป็น

การรบกวนผูใ้ดจดัวา่เป็นการใชง้านแบบ Work Based Learning ที่แทจ้ริง 

(4.9) ช่วยกระตุน้และเรียกร้องความสนใจโดยเฉพาะผูเ้รียนที่เป็นวยัรุ่นการเรียนรู้

ด้วยบทเรียนเอ็มเลิร์นน่ิงผ่านโทรศพัท์มือถือซ่ึงเป็นเคร่ืองส่วนตวัจะช่วยเรียกร้องความสนใจให้

ติดตามเน้ือหาบทเรียนไดม้ากกวา่การใชไ้มโครคอมพวิเตอร์ซ่ึงสร้างความรู้สึกเหมือนกบัการเล่นเกม

คอมพวิเตอร์ 

(4.10) เป็นการเรียนรู้แบบเวลาจริงเน้ือหาบทเรียนมีความยืดหยุนกว่าบทเรียน            

อีเลิร์นน่ิงซ่ึงค่อนขา้งตายตวัทาํให้การเรียนรู้ไดรั้บขอ้มูลท่ีทนัสมยัและยงัสอดคลอ้งกบัสถานการณ์

ปัจจุบนัมากกวา่ 

(4.11) สามารถมีปฏิสัมพนัธ์ไดท้นัทีกบัผูส้อนหรือเพื่อนร่วมชั้นเรียนโดยการส่ง

ขอ้ความสั้นๆ (SMS) สนทนาเวลาจริง (Real Time Chat) หรือส่งจดหมายอิเล็กทรอนิกส์ไม่ตอ้งเสียเวลา

รอคอยเหมือนการเรียนการสอนปกติหรือการเรียนดว้ยบทเรียนแบบออฟไลน์ (Off Line)  

(4.12) มีค่าใชจ่้ายโดยรวมถูกกวา่บทเรียนที่นาํเสนอบนไมโครคอมพวิเตอร์ทั้งดา้น

ฮาร์ดแวร์และซอฟแวร์ 

5) ขอ้จาํกัดของบทเรียนเอ็มเลิร์นน่ิงไดก้ล่าวถึงการใชค้อมพิวเตอร์แบบพกพาเพื่อ

นาํเสนอบทเรียนเอ็มเลิร์นน่ิงไวด้งัน้ี 
(5.1) จอภาพโทรศพัทมื์อถือหรือคอมพิวเตอร์แบบพกพามีขนาดเล็กจึงมีขอ้จาํกดั

ในการนาํเสนอขอ้มูลทาํใหข้าดความต่อเน่ืองในการนาํเสนอ 

(5.2) ขนาดของหน่วยความจาํมีนอ้ยกวา่ไมโครคอมพวิเตอร์ 

(5.3) ไม่มีมาตรฐานในแพลตฟอร์ม (Platform) โทรศพัทมื์อถือหรือคอมพิวเตอร์

แบบพกพาในปัจจุบนัมีขนาดจอภาพและระบบหลากหลาย (ไม่เหมือนขนาดจอภาพของไมโคร 

คอมพวิเตอร์ที่กาํหนดไวเ้ป็นมาตรฐานตายตวั) จึงเป็นการยากมากที่จะพฒันาบทเรียนกบัเคร่ืองหน่ึง

และนาํไปใชไ้ดก้บัโทรศพัทมื์อถือหรือคอมพวิเตอร์แบบพกพาอีกเคร่ืองหน่ึง 
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(5.4) จดัการและนาํเสนอกราฟิกยากกว่าการใชไ้มโครคอมพิวเตอร์แมว้่าจะพฒันา

ถึงยคุที่ 3 หรือยคุที่ 4 ก็ตามเน่ืองจากขอ้จาํกดทางดา้นฮาร์ดแวร์ของเคร่ือง 

(5.5) ยากต่อการทาํงานขา้มแพลตฟอร์มและการต่อเช่ือมต่างระบบแม้ว่าจะใช้

เทคโนโลยโีดยเฉพาะรุ่นเก่านอกจากจะตกรุ่นง่ายแลว้ยงัไม่สามารถต่อเช่ือมเขา้กบัระบบใหม่ๆ ไดอี้ก

ดว้ยเน่ืองจากตลาดดา้นน้ีกาํลงัอยูใ่นยคุของการเปล่ียนแปลง 

(5.6) การอัพเกรดทาํได้ยากกว่าไมโครคอมพิวเตอร์เน่ืองจากขอ้จาํกัดทางด้าน

ขนาดของตัวเคร่ืองและเทคโนโลยีท่ีใช้ซ่ึงมีความหลากหลายซ่ึงเป็นขอ้จาํกัดในการใช้งานกับ

โปรแกรมประยกุตส์มยัใหม่ 

(5.7) ความเร็วของเครือข่ายจะเป็นอุปสรรคสําคญัต่อการใช้งานหากมีผูเ้รียน

ต่อเช่ือมเขา้กบัระบบเป็นจาํนวนมากในเวลาเดียวกนัเน่ืองจากจะเกิดการแบ่งปันแถบกวา้งความถ่ี 

(Bandwidth) ใหค้รอบคลุมผูเ้รียนทุกๆคน 

(5.8) การใชง้านยากกวา่ไมโครคอมพวิเตอร์จาํเป็นตอ้งมีการฝึกฝนการใชง้านก่อน

จึงจะใชง้านไดอ้ยา่งมีประสิทธิภาพและคุม้ค่าโดยเฉพาะการใชร้ะบบการรู้จาํลายมือผูเ้รียนตอ้งฝึกฝน

ทกัษะการเขียนเพือ่ใหเ้คร่ืองรู้จกัลายมือก่อน 

(5.9) ยุ่งยากต่อการพิมพอ์อกเป็นเอกสารเน่ืองจากจะตอ้งต่อเช่ือมเขา้กบัระบบ

เครือข่ายเท่านั้นจึงจะสามารถใชเ้คร่ืองพมิพไ์ด ้

(5.10) ไม่ทนทานต่อการใชง้านหนักเหมือนกบัไมโครคอมพิวเตอร์เน่ืองจากตอ้ง

ออกแบบใหมี้ขนาดเล็กและมีนํ้ าหนกัเบาจึงมีขอ้จาํกดัทางดา้นการระบายความร้อนนอกจากน้ียงัเกิด

การหลงลืมหรือสูญหายง่าย 

สรุปไดว้า่แมจ้ะมีขอ้จาํกดัอยูบ่างประการทางดา้นขนาดและความสามารถของระบบแต่เม่ือ

พจิารณาทางดา้นความเป็นส่วนตวัในการใชง้านแลว้บทเรียนเอ็มเลิร์นน่ิงที่นาํเสนอผ่านโทรศพัทมื์อถือ 

หรือคอมพิวเตอร์แบบพกพามีลักษณะเด่นและขอ้ได้เปรียบกว่าบทเรียนอีเลิร์นน่ิงทาํให้มีการวิจยั  

และพฒันาบทเรียนเอ็มเลิร์นน่ิงอย่างต่อเน่ืองในปัจจุบนัเน่ืองจากมีการใชง้านโทรศพัท์มือถือหรือ

คอมพิวเตอร์แบบพกพาอยา่งแพร่หลายมากกว่าไมโครคอมพิวเตอร์สาเหตุก็คือมีราคาถูกกว่าและมี

ความเป็นส่วนตวัมากกวา่โดยเฉพาะอยา่งยิง่ผูเ้รียนที่มีความพกิารทางร่างกายสามารถใชโ้ทรศพัท ์มือถือ 

หรือคอมพวิเตอร์แบบพกพาง่ายกว่าการใชไ้มโครคอมพิวเตอร์สามารถติดตั้งไวก้บัรถเข็นเพื่อศึกษา

บทเรียนเอ็มเลิร์นน่ิงไดง่้ายกวา่การศึกษาบทเรียนจากไมโครคอมพวิเตอร์ 
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2.4  การสอนผ่านออนไลน์ 

2.4.1 การสอนผา่นออนไลน์ 

การเรียนการสอนผ่านเครือข่ายอินเทอร์เน็ต มีลักษณะการจดัการเรียน ที่ผูเ้รียนจะ

เรียนผ่านจอคอมพิวเตอร์ที่เช่ือมต่อกับเครือข่ายอินเทอร์เน็ต และสามารถเขา้สู่ระบบเครือข่ายเพื่อ

การศึกษาเน้ือหาบทเรียนจากที่ใดก็ได ้และผูเ้รียนแต่ละคนสามารถติดต่อส่ือสารกบัผูส้อนหรือผูเ้รียน

คนอ่ืนๆได้ทนัทีทนัใด เหมือนการเผชิญหน้ากันจริงๆหรือเป็นการส่งขอ้ความฝากไวก้ับบริการ

ไปรษณียอิ์เล็กทรอนิกส์ ในการติดต่อส่ือสารกบัผูเ้รียนดว้ยกนัเองหรือกบัผูส้อน 

การเรียนรู้บนเครือข่ายอินเทอร์เน็ต หรือการเรียนรู้บนเวบ็ กระทาํไดห้ลายลักษณะ 

เช่นการทาํโครงการร่วมกนั การแลกเปล่ียนความคิดร่วมกนัในกระดานข่าว การแสดงความคิดเห็นใน

กระทูท้างวิชาการการทาํงานที่ได้รับมอบหมายเป็นกลุ่ม การทาํโครงงานร่วมกนั เป็นการร่วมกัน

สร้างสรรคผ์ลงานในเร่ืองที่สนใจร่วมกนั นอกจากน้ี วธีิการเรียนรู้บนเวบ็มีประสิทธิผล คือ การเรียนรู้

ร่วมกนับนเวบ็ ซ่ึงเป็นวธีิที่ผูเ้รียนทาํงานดว้ยกนัเป็นคู่ หรือเป็นกลุ่มเล็ก เพื่อให้บรรลุจุดมุ่งหมายของ

งานร่วมกนั ผูเ้รียนแต่ละคนรับผดิชอบการเรียนรู้ของผูอ่ื้นเท่ากบัของตนเอง 

การเรียนรู้บนเครือข่ายอินเทอร์เน็ต เป็นการศึกษาท่ีใช้เทคโนโลยี อะซิงโครนัส 

(Asynchronous Technology) ซ่ึงเป็นเทคโนโลยทีี่ทาํให้การเรียนการสอนดาํเนินไปโดยไม่จาํกดัเวลา

และสถานที่ ประกอบด้วยเคร่ืองมือที่มีอยู่ ในอินเทอร์เน็ตและเว็บ เช่น กระดานข่าว ไปรษณีย ์

อิเล็กทรอนิกส์ การประชุมทางไกล เคร่ืองมือเหล่าน้ีทาํให้เกิดการเรียนรู้ที่ไม่พร้อมกนั (Asynchronous 

Learning)  การเรียนไม่พร้อมกนัน้ี มีความหมายมากกว่าคาํว่า “ใครก็ได ้ที่ไหนก็ได้ เวลาใดก็ได้” 

เพราะเก่ียวขอ้งกบัการเรียนอยา่งมีปฏิสัมพนัธ์ (Interactive Learning) และการเรียนรู้ร่วมกนั โดยใช้

แหล่งความรู้ที่อยูห่่างไกล และการเขา้ถึงขอ้มูลที่ตอ้งการทั้งน้ีเพราะการเรียนรู้จะเกิดขึ้นไดดี้หากผูเ้รียน

ไดมี้โอกาสถาม อธิบาย สงัเกต รับฟัง สะทอ้นความคิดตนเองและตรวจสอบความคิดของผูอ่ื้น 

บทเรียนผา่นเครือข่ายอินเทอร์เน็ตเป็นส่ือการเรียนการสอนแบบมลัติมีเดียโดยบทเรียนที่

พฒันาขึ้ นสามารถทาํงานได้หลายรูปแบบเน่ืองจากใช้โปรแกรมเว็บบราวเซอร์ เช่น เน็ทสเคป

(Netscape Navigator) หรือไมโครซอฟตอิ์นเทอร์เน็ตเอ็กซ์พรอเรอร์(Microsoft Internet Explorer) 

รวมทั้งโปรแกรมเสริมอ่ืนๆในการจดัทาํ โดยมีพื้นฐานของบทเรียนเป็นภาษา HTMLโดยสามารถใช้

ร่วมกบัส่ืออ่ืนๆไดท้ั้งอินทราเน็ต เครือข่ายอินเทอร์เน็ต และสามารถบนัทึกลงแผ่นซีดีรอม (CD-Rom) 

เพื่อนําไปศึกษาได้เม่ือไม่ได้เช่ือมต่อกับอินเทอร์เน็ตบทเรียนที่ผลิตได้จะมีลักษณะของเว็บเพจที่มี

ไฮเปอร์เทก็ซ์ (Hypertext) และไฮเปอร์มีเดีย(Hypermedia) เป็นตวัหลกัในการนาํเสนอ ผูอ้่านสามารถ

เลือกอ่าน ดูวดีีทศัน์ หรือทาํแบบทดสอบ ไดต้ามความตอ้งการ 
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2.4.2 ลกัษณะของกิจกรรมการเรียนการสอนผ่านเครือข่ายอินเทอร์เน็ต (WBI) การเรียน        

การสอนผา่นเวบ็จะตอ้งอาศยับทบาทของระบบอินเทอร์เน็ตเป็นสาํคญัการใชอิ้นเทอร์เน็ตในลกัษณะ

ของโปรแกรมการเรียนการสอนผา่นเวบ็จะมีวธีิการใชใ้น 3 ลกัษณะ  

2.4.2.1 การนาํเสนอ (Presentation) เป็นไปในแบบเวบ็ไซดท์ี่ประกอบไปดว้ยขอ้ความ

ภาพกราฟิก ซ่ึงสามารถนาํเสนอไดอ้ยา่งเหมาะสมในลกัษณะของส่ือ คือ 
1. การนาํเสนอแบบส่ือทางเดียว เช่น เป็นขอ้ความ 

2. การนาํเสนอแบบส่ือคู่ เช่น ขอ้ความภาพกราฟิก บางคร้ังจะอยูใ่นรูปแบบ

PDF ผูเ้รียนสามารถดาวน์โหลดไฟลไ์ด ้ 

3. การนาํเสนอแบบมลัติมีเดีย คือ ประกอบดว้ยขอ้ความ ภาพกราฟิก ภาพยนตร์ 

เสียง และภาพเคล่ือนไหว หรือวดีีโอ (แต่ความเร็วจะไม่เร็วเท่ากบัวดีีโอเทป) 

2.4.2.2 การส่ือสาร (Communication) การส่ือสารเป็นส่ิงจาํเป็นที่จะตอ้งใชทุ้กวนัใน

ชีวติซ่ึงเป็นลกัษณะสาํคญัของอินเทอร์เน็ต โดยมีการส่ือสารบนอินเทอร์เน็ตหลายแบบ เช่น 
1. การส่ือสารทางเดียว โดยดูจากเวบ็เพจ 

2. การส่ือสารสองทาง เช่น การส่งไปรษณียอิ์เล็กทรอนิกส์โตต้อบกนั 

2.4.2.3 การก่อใหเ้กิดปฏิสมัพนัธ์ (Dynamic Interaction) เป็นคุณลกัษณะที่สาํคญัของ

อินเทอร์เน็ตประกอบดว้ย 3 ลกัษณะ คือ 
1. การสืบคน้ 

2. การหาวธีิการเขา้สู่เวบ็ 

3. การตอบสนองของมนุษยใ์นการใชเ้วบ็ 

2.4.3 การจดัการเรียนการสอนผา่นเวบ็ 

2.4.3.1 การจดัการเรียนการสอนโดยทัว่ไปแล้ว ควรส่งเสริมให้ผูเ้รียนและผูส้อน

สามารถติดต่อ ส่ือสารกนัไดต้ลอดเวลา การติดต่อระหว่างผูเ้รียนและผูส้อนมีส่วนสาํคญัในการสร้าง

ความกระตือรือร้นกบัการเรียนการสอน โดยผูส้อนสามารถให้ความช่วยเหลือผูเ้รียนได้ตลอดเวลา

ในขณะกาํลังศึกษา ทั้ งยงัช่วยเสริมสร้างความคิดและความเข้าใจ ผูเ้รียนที่เรียนผ่านเว็บสามารถ

สนทนาแลกเปล่ียนความคิดเห็นรวมทั้งซกัถามขอ้ขอ้งใจกบัผูส้อนไดท้นัทีทนัใด เช่น การมอบหมาย

งานส่งผา่นอินเทอร์เน็ตจากผูส้อน ผูเ้รียนเม่ือไดรั้บมอบหมายก็จะสามารถทาํงานท่ีไดรั้บมอบหมาย

และส่งผ่านอินเทอร์เน็ต กลบัไปยงัอาจารยผ์ูส้อน หลังจากนั้นอาจารยผ์ูส้อนสามารถตรวจและให้

คะแนนพร้อมทั้งส่งผลยอ้นกลบัไปยงัผูเ้รียนไดใ้นเวลาอนัรวดเร็วหรือในทนัทีทนัใด 
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2.4.3.2 การจดัการเรียนการสอนควรสนับสนุนให้มีการพฒันาความร่วมมือระหว่าง

ผูเ้รียน ความร่วมมือระหวา่งกลุ่มผูเ้รียนจะช่วยพฒันาความคิดความเขา้ใจไดดี้กว่าการทาํงานคนเดียว 

ทั้งยงัสร้างความสมัพนัธเ์ป็นทีมโดยการแลกเปล่ียนความคิดเห็นระหว่างกนัเพื่อหาแนวทางที่ดีที่สุด 

เป็นการพฒันาการแกไ้ขปัญหาการเรียนรู้และการยอมรับความคิดเห็นของคนอ่ืนมาประกอบเพื่อหา

แนวทางที่ดีที่ สุด ผูเ้ รียนที่เรียนผ่านเว็บแม้ว่าจะเรียนจากคอมพิวเตอร์ที่อยู่กันคนละที่แต่ด้วย

ความสามารถของเครือข่ายอินเทอร์เน็ตท่ีเช่ือมโยงเครือข่ายคอมพิวเตอร์ทัว่โลกไวด้ว้ยกัน ทาํให้

ผูเ้รียนสามารถติดต่อส่ือสารกนัไดท้นัทีทนัใด เช่น การใชบ้ริการสนทนาแบบออนไลน์ที่สนับสนุน

ใหผู้เ้รียนติดต่อส่ือสารกนัไดต้ั้งแต่ 2 คนขึ้นไปจนถึงผูเ้รียนท่ีเป็นกลุ่มใหญ่ 
2.4.3.3 สนับสนุนให้ผูเ้รียนรู้จกัแสวงหาความรู้ดว้ยตนเอง (Active Learners) หลีกเล่ียง 

การกาํกบัให้ผูส้อนเป็นผูป้้อนขอ้มูลหรือคาํตอบ ผูเ้รียนควรเป็นผูข้วนขวายใฝ่หาขอ้มูลองคค์วามรู้

ต่างๆ เองโดยการแนะนาํของผูส้อน เป็นที่ทราบดีอยูแ่ลว้ว่าอินเทอร์เน็ตเป็นแหล่งขอ้มูลที่ใหญ่ที่สุด

ในโลก ดงันั้นการจดัการเรียนการสอนผา่นเวบ็น้ี จะช่วยให้ผูเ้รียนสามารถหาขอ้มูลไดด้ว้ยความสะดวก

และรวดเร็ว ทั้งยงัหาขอ้มูลไดจ้ากแหล่งขอ้มูลทัว่โลกเป็นการสร้างความกระตือรือร้นในการใฝ่หา

ความรู้ 
2.4.3.4 การใหผ้ลยอ้นกลบัแก่ผูเ้รียนทนัทีทนัใดช่วยให้ผูเ้รียนทราบถึงความสามารถ

ของตนอีกทั้งยงัช่วยใหผู้เ้รียนสามารถปรับแนวทางวิธีการหรือพฤติกรรมให้ถูกตอ้งได ้ผูเ้รียนที่เรียน

ผา่นเวบ็สามารถไดรั้บผลยอ้นกลบัจากทั้งผูส้อนเองหรือแมก้ระทัง่จากผูเ้รียนคนอ่ืนๆ ไดท้นัทีทนัใด 

แมว้า่ผูเ้รียนแต่ละคนจะไม่ไดน้ัง่เรียนในชั้นเรียนแบบเผชิญหนา้กนัก็ตาม 
2.4.3.5 ควรสนับสนุนการจดัการเรียนการสอนที่ไม่มีขีดจาํกดั สาํหรับบุคคลที่ใฝ่หา

ความรู้ การเรียนการสอนผ่านเวบ็เป็นการขยายโอกาสให้กบัทุกๆคนที่สนใจศึกษา เน่ืองจากผูเ้รียน            

ไม่จาํเป็นจะตอ้งเดินทางไปเรียนณ ที่ใดที่หน่ึง ผูท้ี่สนใจสามารถเรียนไดด้ว้ยตนเองในเวลาที่สะดวก 

จะเห็นไดว้่าการเรียนการสอนผ่านเว็บน้ีมีคุณลกัษณะที่ช่วยสนับสนุนหลักพื้นฐานการจดัการเรียน

การสอนทั้ง 5 ประการไดอ้ยา่งมีประสิทธิภาพ 
2.4.4 ประโยชน์การเรียนการสอนผา่นเวบ็ 

2.4.4.1 การที่เว็บเปิดโอกาสให้เกิดการปฏิสัมพนัธ์ (Interactive) ระหว่างผูเ้รียนกับ

ผูส้อนและผูเ้รียนกบัผูเ้รียนหรือผูเ้รียนกบัเน้ือหาบทเรียน 
2.4.4.2 เวบ็สามารถนาํเสนอเน้ือหาในรูปแบบของส่ือประสม (Multimedia) 
2.4.4.3 เว็บเป็นระบบเปิด (Open System) ซ่ึงอนุญาตให้ผูใ้ช้มีอิสระในการเขา้ถึง

ขอ้มูลไดท้ัว่โลก 
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2.4.4.4 เวบ็อุดมไปดว้ยทรัพยากร เพือ่การสืบคน้ออนไลน์ (Online Search/Resource) 
2.4.4.5 ความไม่มีขอ้จาํกดัสถานที่และเวลาของการสอนบนเวบ็ (Device, Distance 

and Time Independent) ผูเ้รียนที่มีคอมพิวเตอร์ในระบบใดก็ได ้ซ่ึงต่อเขา้กบัอินเทอร์เน็ตจะสามารถ

เขา้เรียนจากที่ใดก็ไดใ้นเวลาใดก็ได ้
2.4.4.6 เวบ็อนุญาตให้ผูเ้รียนเป็นผูค้วบคุม (Learner Controlled) ผูเ้รียนสามารถเรียน

ตามความพร้อมความถนดัและความสนใจของตน 
2.4.4.7 เวบ็มีความสมบูรณ์ในตนเอง (Self-contained) ทาํให้สามารถจดักระบวนการเรียน

การสอนทั้งหมดผ่านเว็บได้ การที่เว็บอนุญาตให้มีการติดต่อส่ือสารทั้งแบบเวลาเดียว (Synchronous 

Communication) เช่น Chat และต่างเวลากนั (Asynchronous Communication) เช่น Web Board เป็นตน้ 
 

2.5  การพฒันาเวบ็ไซต์ 

หัสนัย ริยาพนัธ์ (2554, น. 12) การพฒันาเวบ็ไซตเ์ป็นการกาํหนดโครงสร้างหลกัที่ใชใ้น   

การพฒันาเวบ็ไซตท์ี่ประกอบดว้ย ขอ้ความเสียง ภาพน่ิง ภาพวีดิทศัน์ ที่เก่ียวขอ้งและเช่ือมโยงหรือ

ลิงคไ์ปยงัแบนเนอร์ (Banner) แหล่งเรียนรู้ออนไลน์กระดานสนทนา (Web board) และสมุดเยีย่ม 

(Guestbook) ในเครือข่ายซ่ึงประกอบดว้ยการเช่ือมโยงภายในเวบ็เพจเดียวกนัการเช่ือมโยงกบัเวบ็เพจ

อ่ืนที่อยูภ่ายในเวบ็ไซตเ์ดียวกนัเช่ือมโยงไปยงัเวบ็ไซตอ่ื์นๆ 

2.5.1 ขั้นตอนในการพฒันาเวบ็ไซตด์งัน้ี 

2.5.1.1 การกาํหนดแหล่งเก็บขอ้มูลสาํหรับเวบ็ไซตท่ี์สร้างขึ้นผูว้ิจยักาํหนดให้จดัเก็บไว้

ที่ตวับริการเวบ็ของสาํนกัการศึกษาต่อเน่ืองและส่วนกลางของมหาวทิยาลยัสุโขทยัธรรมาธิราช 
2.5.1.2 การกาํหนดโฟล์เดอร์ (Folder) สาํหรับจดัเก็บขอ้มูลและกาํหนดประเภท

แฟ้มขอ้มูล (File) ที่ใชใ้นการพฒันาเวบ็ไซตป์ระกอบดว้ย โฟลเ์ดอร์ 
 

โฟลเ์ดอร์ (Folder) ขอ้มูล 

salaphumkhaobin 

rama 7 

stou 

image 

sound 

video 

web board 

รวบรวมขอ้มูลทั้งหมด 

พระบาทสมเด็จพระปกเกลา้เจา้อยูห่วั 

มหาวทิยาลยัสุโขทยัธรรมาธิราช 

รูปภาพ 

เสียง 

ภาพเคล่ือนไหว 

กระดานสนทนา 
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โฟลเ์ดอร์ (Folder) ขอ้มูล 

guestbook 

css 

include 

สมุดเยีย่ม 

รูปแบบตวัอกัษร 

เมนูหลกัเมนูยอ่ยและส่วนทา้ยเวบ็เพจ 

 

 แฟ้มขอ้มูล 
 

เวบ็ไซต ์(Web Site)  ประเภทแฟ้มขอ้มูล 

โฮมเพจ 

เวบ็เพจ 

รูปภาพ 

ภาพเคล่ือนไหว 

เสียง 

.html 

.html 

.jpg, .gif 

.avi, .wov, .wmv 

.rm, mp3 
 

2.5.1.2 การกาํหนดโฟล์เดอร์ (Folder) สําหรับจดัเก็บขอ้มูลและกาํหนดประเภท

แฟ้มขอ้มูล (File) ที่ใชใ้นการพฒันาเวบ็ไซตป์ระกอบดว้ย 
2.5.1.3 การกาํหนดรูปแบบของคาํสัง่หลกัที่ใชใ้นการพฒันาเวบ็ไซต ์ 

อินคลูด (Includes) ใชใ้นการจดัการกบัเมนูหลกัเมนูยอ่ยและส่วนทา้ย (Footer) ของทุกๆ 

เว็บเพจช่วยให้การบริหารจัดการเว็บไซต์ง่ายและสะดวกลดการซํ้ าซ้อนในการทาํงานลดความ

ผดิพลาดในการเขียนคาํสัง่การแกไ้ขทาํไดง่้ายและรวดเร็ว (รุจกาสุภาพนัธ,์ 2543, น. 71) 
แผ่นแบบ (Cascading style sheets หรือ CSS) ใชใ้นการกาํหนดการแสดงผลของตวัอกัษร           

มีรูปแบบและขนาดเหมือนๆกนัผูดู้แลเวบ็ไซตส์ามารถควบคุมรูปแบบของตวัอกัษรให้เป็นมาตรฐาน

เดียวกันทั้งเว็บไซต์ทาํให้ไม่ตอ้งเสียเวลาในการดาวน์โหลดเว็บเพจนานสามารถจัดรูปแบบการ

แสดงผลภายในเวบ็เพจไดต้ามที่ออกแบบไว ้(อติพงศจุ์ลโพธิ, 2545, น. 156-157) 
โปรแกรมการพฒันาเวบ็เพจเป็นการสร้างเวบ็เพจหนา้ต่างๆโดยการนาํเน้ือหาท่ีทาํการศึกษา 

และรวบรวมมาสร้างเว็บเพจตามรูปแบบที่ก ําหนดด้วยโปรแกรมแมโครมีเดียดรีมวีพเวอร์ 

(Macromedia Dreamweaver) ดงัแสดงในภาพที่ 2.4 การพฒันาเวบ็ไซต ์

 

 

 

50 



 

 

 

 

 

 

 

 

ภาพที่ 2.4 การพฒันาเวบ็ไซต ์

 

2.6  หลกัสูตรแกนกลางการศึกษาขั้นพืน้ฐานพทุธศักราช 2551 

2.6.1  หลกัการที่สาํคญัของหลกัสูตรแกนกลางการศึกษาขั้นพื้นฐาน พ.ศ. 2551 

2.6.1.1 เป็นหลักสูตรการศึกษาเพื่อความเป็นเอกภาพของชาติ มีจุดมุ่งหมายและ

มาตรฐานการเรียนรู้เป็นเป้าหมายสําหรับพฒันาเด็กและเยาวชนให้มีความรู้ ทกัษะเจตคติ และ

คุณธรรม บนพื้นฐานของความเป็นไทยควบคู่กบัความเป็นสากล 

2.6.1.2 เป็นหลกัสูตรการศึกษาเพื่อปวงชนท่ีประชาชนทุกคนมีโอกาสไดรั้บการศึกษา 

อยา่งเสมอภาคและมีคุณภาพ 

2.6.1.3 เป็นหลกัสูตรการศึกษาที่สนองการกระจายอาํนาจให้สังคมมีส่วนร่วมในการ

จดัการศึกษาใหส้อดคลอ้งกบัสภาพแลความตอ้งการของทอ้งถิ่น 

2.6.1.4 เป็นหลกัสูตรการศึกษาที่มีโครงสร้างยดืหยุน่ทั้งดา้นสาระการเรียนรู้ เวลา

และการจดัการเรียนรู้ 

2.6.1.5 เป็นหลกัสูตรการศึกษาท่ีเนน้ผูเ้รียนเป็นสาํคญั 

2.6.1.6 เป็นหลักสูตรการศึกษาสาํหรับการศึกษาในระบบ นอกระบบ และตาม

อธัยาศยัครอบคลุมทุกกลุ่มเป้าหมาย สามารถเทียบโอนผลการเรียนรู้ และประสบการณ์ 

2.6.2 จุดหมายของหลกัสูตรแกนกลางการศึกษาขั้นพื้นฐาน 

หลกัสูตรแกนกลางการศึกษาขั้นพื้นฐานมุ่งพฒันาผูเ้รียนทุกคน มีความสมดุลทั้งดา้น

ร่างกาย ความรู้ คุณธรรม และทกัษะพื้นฐาน รวมทั้ง เจตคติ ที่จาํเป็นต่อการศึกษาต่อการประกอบอาชีพ

และการศึกษาตลอดชีวิต โดยมุ่งเน้นผูเ้รียนเป็นสาํคญับนพื้นฐานความเช่ือว่า ทุกคนสามารถเรียนรู้

การออกแบบโฮมเพจ 

การออกแบบเวบ็เพจ 

องคป์ระกอบภายในเวบ็เพจ 

การเช่ือมโยง 
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และพฒันาตนเองไดเ้ต็มตามศกัยภาพจึงกาํหนดเป็นจุดหมาย เพื่อให้เกิดกบัผูเ้รียนเม่ือจบการศึกษา 

ขั้นพื้นฐาน ดงัน้ี 

2.6.2.1 มีคุณธรรม จริยธรรม และค่านิยมที่พึงประสงค์ เห็นคุณค่าของตนเองมี

วินัยและปฏิบติัตนตามหลกัธรรมของพระพุทธศาสนา หรือศาสนาที่ตนนับถือ ยดึหลกัปรัชญาของ

เศรษฐกิจพอเพยีง 

2.6.2.2 มีความรู้อนัเป็นสากลและมีความสามารถในการส่ือสาร การคิด การแกปั้ญหา

การใชเ้ทคโนโลย ีและมีทกัษะชีวติ 

2.6.2.3 มีสุขภาพกายและสุขภาพจิตที่ดี มีสุขนิสยั และรักการออกกาํลงักาย 

2.6.2.4 มีความรักชาติ มีจิตสาํนึกในความเป็นพลเมืองไทยและพลโลกยึดมั่น 

ในวิถีชีวติ และการปกครองตามระบอบประชาธิปไตยอนัมีพระมหากษตัริยท์รงเป็นประมุข 

2.6.2.5 มีจิตสาํนึกในการอนุรักษว์ฒันธรรมและภูมิปัญญาไทย การอนุรักษแ์ละพฒันา 

ส่ิงแวดลอ้ม มีจิตสาธารณะที่มุ่งทาํประโยชน์และสร้างส่ิงท่ีดีงามในสังคม และอยู่ร่วมกนัในสังคม

อยา่งมีความสุข 

2.6.3 หลกัสูตรกลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ี

สาระและมาตรฐานการเรียนรู้ของกลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ี

ในหลกัสูตรแกนกลางการศึกษาขั้นพื้นฐานพุทธศกัราช 2551ท่ีเป็นองคค์วามรู้ของกลุ่มการงานอาชีพ

และเทคโนโลยปีระกอบดว้ย 4 สาระคือสาระท่ี 1: การดาํรงชีวิตและครอบครัวสาระท่ี 2: การออกแบบ

และเทคโนโลย ีสาระที่ 3: เทคโนโลยสีารสนเทศและการส่ือสาร สาระที่ 4: อาชีพ 

ในการศึกษาวิจยัคร้ังน้ีจะขอกล่าวถึงเฉพาะสาระและมาตรฐานการเรียนรู้ในระดับ

ช่วงชั้นที่เก่ียวขอ้งกบัการวจิยัเท่านั้นมีรายละเอียดดงัต่อไปน้ี 

สาระที่ 3 เทคโนโลยสีารสนเทศและการส่ือสาร 

เทคโนโลยีสารสนเทศและการส่ือสารเป็นสาระเกี่ยวกับกระบวนการเทคโนโลยี

สารสนเทศการติดต่อส่ือสารการคน้หาขอ้มูลการใชข้อ้มูลและสารสนเทศการแกปั้ญหาหรือการสร้าง

งานคุณค่าและผลกระทบของเทคโนโลยสีารสนเทศและการส่ือสาร 

มาตรฐาน ง3.1 เขา้ใจเห็นคุณค่าและใช้กระบวนการเทคโนโลยีสารสนเทศใน

การสืบค้นข้อมูลการเรียนรู้การส่ือสารการแก้ปัญหาการทาํงาน และอาชีพอย่างมีประสิทธิภาพ  

ประสิทธิผลและมีคุณธรรม 

ตวัช้ีวดัที่ 1 บอกหลกัการเบ้ืองตน้ของการแกปั้ญหา 

ตวัช้ีวดัที่ 2 ใชค้อมพวิเตอร์ในการคน้หาขอ้มูล 
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ตวัช้ีวดัที่ 3 เก็บรักษาขอ้มูลที่เป็นประโยชน์ในรูปแบบต่างๆ 

ตวัช้ีวดัที่ 4 นาํเสนอขอ้มูลในรูปแบบที่เหมาสมโดย เลือกใชซ้อฟตแ์วร์ประยกุต ์

ตวัช้ีวดัที่ 5 ใชค้อมพวิเตอร์ช่วยสร้างช้ินงานจากจิตนาการหรืองานที่ทาํในชีวิตประจาํวนั 

อยา่งมีจิตสาํนึก และความรับผดิชอบ 

กล่าวโดยสรุป กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยีเป็นสาระที่เน้น

พฒันาผูเ้รียนแบบองค์รวม เพื่อให้มีความรู้ ความสามารถ มีทักษะในการทาํงานเห็นแนวทาง                       

การประกอบอาชีพและการศึกษาต่อไดอ้ยา่งมีประสิทธิภาพ มีเป้าหมายเพือ่พฒันาใหผู้เ้รียนเห็นคุณค่า

และมีเจตคติที่ดีต่อการงานอาชีพและเทคโนโลย ีมีคุณธรรม มีความใฝ่รู้ใฝ่เรียน มุ่งมัน่ในการทาํงาน 

มีวนิยั อยูอ่ยา่งพอเพยีง ซ่ือสัตยสุ์จริต การทาํงานอยา่งมีจิตสาํนึก ความรับผิดชอบ สาํรวจตนเองเพื่อ

วางแผนในการเลือกอาชีพ มีคุณธรรมที่สัมพนัธ์กับอาชีพที่สนใจเพื่อให้ผูเ้รียนมีวิธีการวดัผลและ

ประเมินผลหลากหลายตามสภาพความเป็นจริง 

ผูว้ิจยัได้ยึดหลักสูตรกลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยีโดยเฉพาะสาระ                 

การเรียนรู้ที่ 3 เทคโนโลยสีารสนเทศและการส่ือสาร มาตรฐาน ง3.1 เขา้ใจเห็นคุณค่าและใชก้ระบวน                

การเทคโนโลยสีารสนเทศในการสืบคน้ขอ้มูลการเรียนรู้ การส่ือสาร การแก้ปัญหา การทาํงานและ

อาชีพอย่างมีประสิทธิภาพประสิทธิผลและมีคุณธรรม ตวัช้ีวดัที่ 1 บอกหลกัการเบ้ืองตน้ของการ

แกปั้ญหา ตวัช้ีวดัที่ 2 ใชค้อมพิวเตอร์ในการคน้หาขอ้มูล ตวัช้ีวดัที่ 5 ใชค้อมพิวเตอร์ช่วยสอนสร้าง

ช้ินงานจากจิตนาการหรืองานที่ทาํในชีวติประจาํวนัอยา่งมีจิตสาํนึกและความรับผดิชอบ 

 

2.7  งานวจิยัทีเ่กีย่วข้อง 

มาลี สืบกระแส (2552) ไดท้าํการวิจยัเร่ืองการพฒันารูปแบบองคก์ารแห่งการเรียนรู้ของ

สาํนกังานเขตพื้นที่การศึกษา ผลการวจิยัพบว่า (1) สภาพปัจจุบนัการเป็นองคก์ารแห่งการเรียนรู้ของ

สาํนกังานเขตพื้นที่การศึกษา พบวา่ระดบัการเป็นองคก์ารแห่งการเรียนรู้ของสาํนักงานเขตพื้นที่การศึกษา 

โดยเฉล่ียอยูใ่นระดับมากและระดบัปัจจยัที่ส่งผลต่อการเป็นองคก์ารแห่งการเรียนรู้ โดยเฉล่ียอยูใ่น

ระดบัมาก (2) ปัจจยัที่ส่งผลต่อการเป็นองคก์ารแห่งการเรียนรู้ และสามารถพยากรณ์การเป็นองคก์าร

แห่งการเรียนรู้ได ้พบวา่ ตวัแปรพยากรณ์ทุกตวั พยากรณ์องคก์ารแห่งการเรียนรู้ไดโ้ดยมีค่าสัมประสิทธ์ิ 

การพยากรณ์อยู่ในระดบัมาก ร้อยละ 65.30 (R2 = 0.653) ปัจจยัที่สามารถพยากรณ์ องค์การแห่ง            

การเรียนรู้อยา่งมีนยัสาํคญัทางสถิติคือการสร้างวสิัยทศัน์พนัธกิจและยทุธศาสตร์ (Vision Mission and 

Strategies การจดัทาํโครงสร้างและการบริหารงาน (Structure and Administration) การมีภาวะผูน้าํทาง

วิชาการ (Instructional Leadership) และการกาํกบัติดตามการดาํเนินงาน (Monitoring) (3) รูปแบบ
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องค์การแห่งการเรียนรู้ของสาํนักงานเขตพื้นที่การศึกษาที่ผูว้ิจยัพฒันาขึ้นสอดคลอ้งกับขอ้มูลเชิง

ประจกัษโ์ดยตวัแบบสุดทา้ยมีค่าสถิติดงัต่อไปน้ี χ2 = 74.27, df = 44, P-value = 0.34 GFI = .95, AGFI 

= .91 RMSEA = 0.05, CN = 218.74 

ประธาน เสนีวงศ ์ณ อยธุยา (2546) ไดท้าํการวิจยัเร่ือง การพฒันาสถานศึกษาสู่องคก์รแห่ง

การเรียนรู้ของผูบ้ริหารโรงเรียนเอกชน เขตการศึกษา 1 ปริญญาศึกษาศาสตรมหาบณัฑิต (การบริหาร

การศึกษา) สาขาการบริหารการศึกษา ภาควิชาการศึกษา ผลการวิจยัพบว่า การพฒันาสถานศึกษา           

สู่องค์กรแห่งการเรียนรู้ของผูบ้ริหารโรงเรียนเอกชน เขตการศึกษา 1 ตามแนวคิดวินัย 5 ประการ               

โดยเรียงลาํดบัจากมากไปหาน้อย ไดแ้ก่ (1) การสร้างและสานวิสัยทศัน์ มีการสานประโยชน์กบัผูมี้

ส่วนเก่ียวขอ้งทุกฝ่าย สร้างความสัมพนัธ์ ความสามคัคี (2) การเรียนรู้การทาํงานเป็นทีม ทุกคนได้

แลกเปล่ียนประสบการณ์ความคิดเห็นซ่ึงกันและกัน มีการระดมพลังสมองมีการร่วมกันคิดอย่าง

กวา้งขวางจนนาํไปสู่การตดัสินใจ (3) วธีิการคิดและมีมุมมองที่เปิดกวา้งไดเ้ปิดโอกาสให้บุคลากรได้

แสดงความคิดเห็นอยา่งเป็นกนัเอง หลากหลาย ส่งเสริมความคิดท่ีสร้างสรรค ์และมีโลกทศัน์ใหม่ๆ 

(4) การมุ่งสู่ความเป็นเลิศได้พิจารณาสภาพแวดล้อมเพื่อช่วยในการตดัสินใจและอยู่พื้นฐานของ

เหตุผล ความถูกตอ้ง สร้างเจตคติใหม่ว่า ทาํได้ เปล่ียนแปลงได้ ใฝ่หาที่จะเรียนรู้ส่ิงใหม่สร้างแรง

บนัดาลใจใฝ่ดี ใชป้ฏิภาณไหวพริบต่อการแกปั้ญหา ปลูกฝังจิตสาํนึกในการทาํงานและปฏิบติัตนเอง

เป็นตวัอยา่งที่ดี (5) การคิดและเขา้ใจเชิงระบบ มีการปฏิบติังานอยา่งมีขั้นตอนมีการจดัลาํดบัความสาํคญั

ของงานบุคลากรไดน้าํเอาความรู้และประสบการณ์ที่ไดรั้บมาเช่ือมโยงกบัการทาํงานอยา่งเป็นระบบ 

และในส่วนการพฒันาสถานศึกษาไปสู่องคก์รแห่งการเรียนรู้นั้น ผูบ้ริหารโรงเรียนเอกชนได้สร้าง

บรรยากาศที่เปิดโอกาสทุกคนไดท้ราบถึงความจาํเป็นและประโยชน์ของการเปล่ียนแปลงท่ีมุ่งไปสู่

พฒันาสถานศึกษาเป็นองคก์รแห่งการเรียนรู้ต่อไป 

สุรศกัด์ิ พองพรหม (2552) ไดท้าํการวิจยัเร่ือง การศึกษาการพฒันาความเป็นองคก์ารแห่ง

การเรียนรู้ตามการรับรู้ของพนักงานครูในโรงเรียนเทศบาล กลุ่มการศึกษาทอ้งถ่ินที่ 11 ผลการวิจยั

พบวา่ (1) พนกังานครูในโรงเรียนเทศบาล กลุ่มการศึกษาทอ้งถ่ินท่ี 11 โดยภาพรวมการรับรู้การพฒันา

ความเป็นองคก์ารแห่งการเรียนรู้มาก เม่ือพจิารณาเป็นรายระบบ พบวา่ มีการรับรู้มาก จาํนวน 4 ระบบ 

และมีการรับรู้ปานกลาง  จาํนวน 1 ระบบ โดยระบบที่มีค่าเฉล่ียสูงสุดคือ คน รองลงมา คือ การเรียนรู้ 

และองคก์าร ตามลาํดบั ส่วนระบบที่มีค่าเฉล่ียตํ่าสุด คือ เทคโนโลย ี(2) ผลการเปรียบเทียบการพฒันา

ความเป็นองค์การแห่งการเรียนรู้ตามการรับรู้ของพนักงานครูในโรงเรียนเทศบาล กลุ่มการศึกษา

ทอ้งถ่ินที่ 11 จาํแนกตามสถานภาพการดาํรงตาํแหน่งระหว่างผูบ้ริหารกบัครูผูส้อน พบว่า ทั้งโดยภาพรวม 

และรายระบบไม่แตกต่างกันอย่างมีนัยสําคญัทางสถิติที่ระดบั .05 ส่วนผลการเปรียบเทียบการพฒันา
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ความเป็นองค์การแห่งการเรียนรู้ตามการรับรู้ของพนักงานครูในโรงเรียนเทศบาล กลุ่มการศึกษา

ทอ้งถ่ินที่ 11 จาํแนกตามขนาดโรงเรียน ระหวา่งโรงเรียนขนาดเล็กและขนาดกลางกบัโรงเรียนขนาด

ใหญ่ โดยภาพรวมไม่แตกต่างกนัอย่างมีนัยสําคญัทางสถิติที่ระดบั .05 เม่ือพิจารณาเป็นรายระบบ 

พบวา่ แตกต่างกนัอยา่งมีนยัสาํคญัทางสถิติที่ระดบั .05 จาํนวน 1 ระบบ คือ การเรียนรู้ โดยพนักงาน

ครูในโรงเรียนขนาดเล็กและขนาดกลาง มีการรับรู้ระบบการเรียนรู้ดงักล่าวน้อยกว่าพนักงานครูใน

โรงเรียนขนาดใหญ่ 

นฤมล พุ่มฉัตร์ (2551) ไดท้าํการวิจยัเร่ือง การพฒันาพนักงานขององค์กรแห่งการเรียนรู้ 

ผลการวจิยัพบวา่ วธีิการที่องคก์รใชพ้ฒันาพนกังานเพือ่ใหเ้ป็นองคก์รแห่งการเรียนรู้ ไดแ้ก่ การอบรม

ในห้องฝึกอบรม การฝึกอบรมระหว่างปฏิบติังานจริง (การสอนงาน การดูงาน การมอบหมายงาน  

การสบัเปล่ียนงาน การแลกเปล่ียนความรู้ประสบการณ์ การเขา้แคมป์) การเรียนรู้ดว้ยตนเอง (การเรียนรู้ 

ดว้ยตวัเองผา่นส่ืออิเล็กทรอนิกส์หอ้งสมุด) การใหทุ้นการศึกษาต่อ การทดสอบความรู้และความสามารถ 

ของผูเ้รียนแต่ละคน (การทดสอบความรู้เก่ียวกบังานท่ีทาํอยู)่ วิธีที่ไดผ้ลให้ความสนใจมากที่สุด คือ 

การเรียนรู้ดว้ยตนเอง การสนบัสนุนของหน่วยงาน ไดแ้ก่ การใหง้บประมาณสนับสนุนและการประเมิน 

ผลการเรียนรู้ของพนกังาน ปัจจยัที่สาํคญัในการท่ีจะพฒันาแต่ละวธีิใหไ้ดผ้ล ไดแ้ก่ ผูน้าํ 

ลือชยั จนัทร์โป๊ (2546) ทาํการวจิยัเร่ืองรูปแบบการเป็นองคก์ารแห่งการเรียนรู้ของโรงเรียน

อาชีวศึกษาคาทอลิกในประเทศไทยผลการวิจยัพบว่าปัจจยัที่มีอิทธิพลรวมต่อการเป็นองคก์ารแห่ง 

การเรียนรู้ของโรงเรียนอาชีวศึกษาคาทอลิกในประเทศไทยเรียงลาํดบัจากมากไปหาน้อยดงัน้ีพนัธกิจ

และยทุธศาสตร์วฒันธรรมองคก์ารภาวะผูน้าํบรรยากาศในการทาํงานโครงสร้างองคก์ารการดาํเนินงาน 

ด้านการจดัการและระบบองค์การสภาพของปัจจยัท่ีมีอิทธิพลต่อการเป็นองค์การแห่งการเรียนรู้            

ของโรงเรียนอาชีวศึกษาคาทอลิกในประเทศไทยตามความคิดเห็นของผูบ้ริหารพบว่าอยูใ่นระดบัมาก

ซ่ึงพบว่าด้านความเป็นเลิศของบุคคลอยู่ในระดับมากเน่ืองจากผูบ้ริหารโรงเรียนท่ีบริหารโดย

บาทหลวงนักบวชไดรั้บการศึกษาอบรมมาเป็นระยะเวลายาวนานและต่อเน่ืองรวมทั้งเป็นผูอุ้ทิศตน

เพื่อผูอ่ื้นโดยไม่หวงัผลตอบแทนและผูบ้ริหารที่เป็นฆราวาสตอ้งพฒันาศกัยภาพให้มีความกา้วหน้า

เพื่อความอยูร่อดในภาวะที่มีการแข่งขนัสูงและการเปล่ียนแปลงอยา่งรวดเร็วดา้นรูปแบบวิธีการคิด

เน่ืองจากภาวะในปัจจุบนัภาวะเศรษฐกิจก่อปัญหาต่อการดาํเนินงานของโรงเรียนในระดบัอาชีวศึกษา

เอกชนที่ตอ้งเสียค่าใชจ่้ายมากทาํให้ผูป้กครองไม่สามารถส่งบุตรเขา้เรียนไดม้ากเหมือนก่อนทาํให้

การบริหารจดัการภายในตอ้งมีการปรับเปล่ียนการบริหารจดัการให้เหมาะสมกบัสถานการณ์จริงโดย

ผูบ้ริหารและครูยอมรับการเปล่ียนแปลงอยา่งรวดเร็วเพราะรูปแบบวิธีคิดเก่าๆไม่เป็นเคร่ืองประกัน
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ความสาํเร็จปัจจุบนัไดแ้ลว้ตอ้งปรับเปล่ียนพฒันารูปแบบวิธีคิดให้เกิดการสร้างสรรคใ์หม่มียทุธศาสตร์ 

ใหม่เพือ่นาํมาปฏิบติังานใหเ้กิดประสิทธิภาพเป็นตน้ 

สังคม ภูมิพนัธุ์ (2549) ได้ทาํการวิจัยเร่ือง แนวทางการพฒันาการเรียนการสอนทาง

อิเล็กทรอนิกส์ (E-Learning) สาํหรับสถาบนัอุดมศึกษาในประเทศไทยผลการวิจยัพบว่า (1) สภาพ

ของการเรียนการสอนทางอิเล็กทรอนิกส์ (E-Learning) สาํหรับสถาบนัอุดมศึกษาในประเทศไทยยงัมี

ค่อนขา้งน้อยและใชเ้ป็นส่ือเสริมในบางสถาบนัก็ยงัไม่ไดมี้การใชอ้ยา่งจริงจงัและเหตุผลที่สถาบนั 

อุดมศึกษาจดัการเรียนการสอนทางอิเล็กทรอนิกส์ (E-Learning) เพราะเช่ือว่าประหยดัทรัพยากรใน

ระยะยาวมีองค์ความรู้สามารถเรียนรู้มากขึ้นและเป็นนวตักรรมใหม่ทางการศึกษาสามารถสร้าง

โอกาสและความเท่าเทียมดา้นการศึกษาสนองความแตกต่างระหว่างบุคคลลดปัญหาเร่ืองระยะทาง

เวลาและสถานที่ได้และองค์ประกอบที่สาํคญัของการเรียนการสอนทางอิเล็กทรอนิกส์ (E-Learning) 

ประกอบดว้ยดา้นเน้ือหาเป็นส่ิงที่สาํคญัที่สุดรองลงมาคือดา้นบุคลากรดา้นการจดัการเรียนการสอน

และด้านการบริหารจดัการการเรียนการสอนสาํหรับสภาพการเรียนการสอนทางอิเล็กทรอนิกส์ใน

ระดบัมหาวิทยาลยั (E-Learning) ของต่างประเทศในปัจจุบนัมีความพร้อมมากทั้งในดา้นโครงสร้าง

พื้นฐานดา้นบุคคลากรดา้นฮาร์ดแวร์และซอฟแวร์มีหน่วยงานท่ีรับผิดชอบมีกฎระเบียบการประกนั

คุณภาพทางการศึกษาโดยเฉพาะและมีแนวทางการรับรองวิทยฐานะที่ชดัเจนอาทิมหาวิทยาลยัโทร

สารสนเทศมิชิแกน (Michigan Virtual University, น. MVU) และ The Open University (OU) สาํหรับ

ในแถบเอเชียนั้นประเทศสิงคโปร์มีการพฒันาอุตสาหกรรมเทคโนโลยสีารสนเทศมาเกือบ 20 ปีทาํให้

มีความพร้อมกว่าชาติอ่ืนๆคือโครงการสิงคโปร์วนั (Singapore One) ให้เป็นเครือข่ายคอมพิวเตอร์ที่

มุ่งเนน้งานดา้นเน้ือหาสาระทางมลัติมีเดียและปฏิสัมพนัธ์ระหว่างผูใ้ชก้บัมลัติมีเดีย (Interactivity) ที่

ครอบคลุมการใหบ้ริการหลายๆดา้นทั้งการบริหารรัฐกิจการศึกษาธุรกิจและอุตสาหกรรมสาํหรับแผน

แม่บทเทคโนโลยสีารสนเทศเพื่อการศึกษานั้นได้กาํหนดวตัถุประสงคไ์วอ้ยา่งชัดเจนว่าทั้งครูและ

ผูเ้รียนตอ้งใชเ้ทคโนโลยสีารสนเทศอยา่งมีประสิทธิผล(2)องคป์ระกอบเชิงระบบในการจดัการเรียน

การสอนทางอิเล็กทรอนิกส์ (E-Learning) สาํหรับสถาบนัอุดมศึกษาในประเทศไทยประกอบดว้ยดา้น

โครงสร้างพื้นฐานมีคอมพวิเตอร์เพือ่ใหบ้ริการในสถานศึกษาอยา่งเพียงพอใชโ้ปรแกรมสาํเร็จรูปที่มี

ความเป็นมาตรฐานสากลและเป็นที่ยอมรับดา้นระบบการผลิตชุดการสอนทางอิเล็กทรอนิกส์ตอ้งได้

มาตรฐานและดา้นระบบการจดัการเรียนตอ้งไดม้าตรฐานและปรับปรุงตลอดเวลา (3) กฎระเบียบและ

แนวทางการรับรองวิทยฐานะการเรียนการสอนทางอิเล็กทรอนิกส์ (E-Learning) ของสถาบัน 

อุดมศึกษาในประเทศไทยปัจจุบนัยงัคลุมเครือไม่ชดัเจนควรจดัใหมี้องคก์รหรือหน่วยงานของรัฐอาทิ

สํานักงานคณะกรรมการการอุดมศึกษาหรือหน่วยงานเอกชนขึ้ นมาดูแลการรับรองวิทยฐานะมี
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ขอ้เสนอแนะว่าควรใชร้ะบบอเมริกันมาพฒันาใชใ้นการรับรองวิทยฐานะและการประกนัคุณภาพ              

การเรียนการสอนทางอิเล็กทรอนิกส์ (E-Learning) (4) ทิศทางในอนาคตของการเรียนการสอนทาง

อิเล็กทรอนิกส์ (E-Learning) ของสถาบนัอุดมศึกษาในประเทศไทยมีแนวโน้ม 2 ลกัษณะคือเรียนอยู่

บา้นเพือ่รับปริญญาและเรียนที่สถาบนัการศึกษาของตนเองหรืออยูว่ิทยาเขตทั้งเรียนในห้องและผ่าน

เครือข่ายกลุ่มเป้าหมายส่วนใหญ่เป็นนกัศึกษาปริญญาโทและปริญญาเอกบทบาทของผูส้อนจะเปล่ียน 

ไปจะเน้นการทาํกิจกรรมร่วมกับผูเ้รียนมากขึ้นปัญหาที่ตอ้งรีบแกไ้ขคือเร่ืองลิขสิทธ์ิของผูพ้ฒันา                

E-Learning ทุกสถาบนัตอ้งเตรียมการด้านเทคโนโลยีผูพ้ฒันา E-Learning และโครงสร้างพื้นฐาน                 

รัฐควรกาํหนดนโยบายใหช้ดัเจนและมีหน่วยงานที่รับผดิชอบในเร่ืองน้ีโดยเฉพาะ 

วรัญญา มีฮะ (2553) ไดท้าํการวิจยัเร่ือง การพฒันาบทเรียนอีเล็กทรอนิกส์ (E-Learning) 

เร่ืองการส่ือสารขอ้มูลและเครือข่ายคอมพวิเตอร์ ชั้นมธัยมศึกษาปีท่ี 3 โรงเรียนนวมินทราชินูทิศ สตรี

วิทยา 2 ผลการวิจยัพบว่า บทเรียนอิเล็กทรอนิกส์ (E-Learning) เร่ืองการส่ือสารขอ้มูลและเครือข่าย

คอมพิวเตอร์ มีคุณภาพอยู่ในระดบัดีมาก และมีประสิทธิภาพ 94.67/90.00 ผลสัมฤทธ์ิทางการเรียน 

เร่ืองการส่ือสารขอ้มูลและเครือข่ายคอมพวิเตอร์ แตกต่างกนัอยา่งมีนยัสาํคญัทางสถิติระดบั 0.05 โดย

ผลสัมฤทธ์ิของนักเรียนที่เรียนดว้ยบทเรียนอิเล็กทรอนิกส์ (E-Learning) สูงกว่านักเรียนที่เรียนแบบ

ปกติ ความพงึพอใจของนกัเรียนที่เรียนโดยใชบ้ทเรียนโดยใชบ้ทเรียนอิเล็กทรอนิกส์ (E-Learning) อยู่

ในระดบัมาก ซ่ึงมีค่าเฉล่ียเท่ากบั 4.49  

อนุชา วิปุลากร (2552) ไดท้าํการวิจยัเร่ือง การพฒันาส่ือเสริมแบบโมบายเลิร์นน่ิง เร่ืองขอ้

ปฏิบติัในการกินอาหารเพื่อสุขภาพที่ดีสาํหรับการสอนทางไกลของมหาลยัทกัษิณ ผลการวิจยัพบว่า 

(1) คุณภาพของส่ือเสริมแบบโมบายเลิ ร์นน่ิงเร่ืองข้อปฏิบัติในการกินอาหารเพื่อสุขภาพท่ีดีมี

ประสิทธิภาพเท่ากบั 87.06/87.13 ซ่ึงสูงกว่าเกณฑ ์80/80 ที่กาํหนดไว ้(2) คะแนนทดสอบหลงัเรียน

ของกลุ่มตวัอยา่งที่เรียนดว้ยส่ือเสริมแบบโมบายเลิร์นน่ิงเร่ืองขอ้ปฏิบติัในการกินอาหารเพื่อสุขภาพที่

ดีสูงกวา่คะแนนทดสอบก่อนเรียน อยา่งมีนัยสาํคญัทางสถิติที่ระดบั .05 และ (3) ความพึงพอใจของ

นิสิตที่มีต่อส่ือเสริมแบบโมบายเลิร์นน่ิงเร่ืองขอ้ปฏิบติัในการกินอาหารเพื่อสุขภาพที่ดีอยูใ่นระดับ

มาก  

จากแนวคิดเก่ียวกับรูปแบบองค์กรแห่งการเรียนรู้จะเห็นว่าเป็นรูปแบบท่ีเหมาะสมต่อ                  

การจัดการเรียนการสอนผ่านสมาร์ทโฟนผูเ้รียนมีการศึกษาคน้ควา้ด้วยตนเองผ่านสมาร์ทโฟน                 

เพือ่สร้างวสิยัทศัน์สร้างความสมัพนัธ ์ความสามคัคี กบัผูมี้ส่วนเก่ียวขอ้งทุกฝ่าย การเรียนรู้การทาํงาน

เป็นทีม มีวธีิการคิดหลากหลายที่สร้างสรรค ์และมีโลกทศัน์ใหม่ๆสร้างเจตคติใหม่ใฝ่หาที่จะเรียนรู้ส่ิง

ใหม่มีไหวพริบต่อการแกปั้ญหา ปลูกฝังจิตสํานึกในการทาํงานและปฏิบติัตนเองเป็นตวัอย่างที่ดี             
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การคิดอยา่งมีขั้นตอนมีการจดัลาํดบัความสาํคญันาํเอาความรู้และประสบการณ์ท่ีไดรั้บมาเช่ือมโยง       

กบัการทาํงานอย่างเป็นระบบและจะตอ้งมีการปฏิสัมพนัธ์กัน แลกเปล่ียนเรียนรู้ทั้งระหว่างผูเ้รียน            

กบัผูส้อนและระหว่างผูเ้รียนด้วยกันเองดังนั้นการเรียนรู้ดว้ยรูปแบบองค์กรแห่งการเรียนรู้จึงเป็น

แนวคิดหน่ึงที่สนบัสนุนในการวจิยัน้ี 
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บทที่  3 

วธีิดาํเนินการวจิัย 

 

การพฒันาบทเรียนผ่านสมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้ เร่ือง การพฒันา   

เวบ็ไซต ์สาํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6 โดยมีขั้นตอนการดาํเนินงานวจิยัดงัน้ี 

3.1  ประชากรและกลุ่มตวัอยา่ง 

3.2  เคร่ืองมือที่ใชใ้นการวจิยั 

3.3  การเก็บรวบรวมขอ้มูล 

3.4  การวเิคราะห์ขอ้มูล 

 

3.1  ประชากรและกลุ่มตัวอย่าง 

ประชากรที่ใช้ในการวิจัยคร้ังน้ีเป็นนักเรียนระดับชั้ นประถมศึกษาปีท่ี  6 โรงเรียน          

โชคชยัรังสิต ตาํบลบึงยีโ่ถ อาํเภอธญับุรี จงัหวดัปทุมธานี สาํนักงานเขตพื้นที่การศึกษาประถมศึกษา

ปทุมธานี เขต 2 ภาคเรียนที่ 2 ปีการศึกษา 2557 จาํนวน 8 หอ้ง นกัเรียนทั้งส้ิน จาํนวน 264 คน 

กลุ่มตัวอย่างที ่ใชใ้นการวิจยัคร้ังน้ี เป็นนักเรียนที่ เรียนกลุ่มสาระการงานอาชีพและ

เทคโนโลย ี(คอมพิวเตอร์) ชั้นประถมศึกษาปีที่ 6 โรงเรียนโชคชยัรังสิต ตาํบลบึงยีโ่ถ อาํเภอธญับุรี 

จงัหวดัปทุมธานี สาํนกังานเขตพื้นที่การศึกษาประถมศึกษาปทุมธานี เขต 2 ภาคเรียนที่ 2 ปีการศึกษา 

2557 ที่ไดม้าดว้ยวิธีการสุ่ม คละระดบัสติปัญญา เก่ง ปานกลาง อ่อน จาํนวน 1 ห้อง นักเรียนทั้งส้ิน 

จาํนวน 30 คน  

 

3.2  เคร่ืองมอืทีใ่ช้ในการวจิยั 

เคร่ืองมือที่ใชใ้นการวจิยัคร้ังน้ีมีดงัน้ี 

3.2.1 บทเรียนผา่นสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์

สาํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6 มีวธีิสร้าง ดงัน้ี 

3.2.1.1 ศึกษาคน้ควา้และรวบรวมขอ้มูลจากเอกสารงานวิจยัที่เก่ียวขอ้งกับทฤษฎี 

แนวคิด และหลกัการของรูปแบบองค์กรแห่งการเรียนรู้ และโปรแกรมการสร้างแอพพลิเคชนับน

ระบบปฏิบติัการ Android  

 



 

 

3.2.1.2 ออกแบบหน้าจอคอมพิวเตอร์ โดยการทาํแผนผงัการเช่ือมโยงต่อประสาน             

ในบทเรียนผา่นสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์ 

3.2.1.3 ดําเนินการสร้างส่ือ  บทเรียนผ่านสมาร์ทโฟนตามแนวคิดองค์กรแห่ง                

การเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์สาํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6  

3.2.1.4 นาํส่ือไปให้ผูเ้ช่ียวชาญตรวจสอบคุณภาพโดยใชแ้บบสอบถามความคิดเห็น

เก่ียวกบั เน้ือหาสาระ การออกแบบ การนาํเสนอ ดว้ยแบบสอบถามประเมินค่าวดัระดบัความคิดเห็น   

5 ระดบัโดยใชเ้ป็นแบบ IC (Index of Consistency) ภาคผนวก ช 

3.2.1.5 นาํผลที่ไดม้าสรุปและปรับปรุง 

3.2.2 แบบสอบถามความคิดเห็นเก่ียวกบับทเรียนผ่านสมาร์ทโฟนตามแนวคิดองคก์รแห่ง

การเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์สาํหรับนักเรียนชั้นประถมศึกษาปีที่ 6 สาํหรับผูเ้ช่ียวชาญ มีวิธี

สร้าง ดงัน้ี 

3.2.2.1 ศึกษาคน้ควา้และรวบรวมข้อมูลจากเอกสารงานวิจยัที่เก่ียวข้องกับทฤษฎี 

แนวคิด และหลกัการของรูปแบบองคก์รแห่งการเรียนรู้  

3.2.2.2 วิเคราะห์องคป์ระกอบและขั้นตอนรูปแบบองค์กรแห่งการเรียนรู้ และสร้าง  

ขอ้คาํถามเพื่อใช้สร้างแบบสอบถามปลายเปิดเพื่อให้ผูเ้ช่ียวชาญแสดงความคิดเห็นแล้วนําผลของ

ความคิดเห็นไปหาค่า (IC: Index of Consistency) นาํขอ้คาํถามที่ผูเ้ช่ียวชาญท่ีมีประสบการณ์ดา้น

เทคโนโลยีการศึกษาหรือเทคโนโลยีสารสนเทศ จาํนวน 3 ท่าน เลือกและเสนอแนะให้ปรับปรุง

แกไ้ข เพือ่นาํไปสร้างแบบสอบถามมาตราส่วนประเมินค่า 5 ระดบั  

คะแนน +1  คือ   แน่ใจวา่ขอ้คาํถามน้ีมีความสอดคลอ้ง 

                              กบัการประเมินเพือ่การออกแบบส่ือใหเ้ป็นไปตาม 

                              รูปแบบองคก์รแห่งการเรียนรู้ 

คะแนน    0    คือ  ไม่แน่ใจวา่ขอ้คาํถามน้ีสอดคลอ้งตรง 

                              กบัการประเมินเพือ่การออกแบบส่ือใหเ้ป็นไปตาม 

                              รูปแบบองคก์รแห่งการเรียนรู้ 

คะแนน   -1   คือ   แน่ใจวา่ขอ้สอบน้ีไม่สอดคลอ้งตรง 

                               กบัการประเมินการออกแบบส่ือใหเ้ป็นไปตาม 

                              รูปแบบองคก์รแห่งการเรียนรู้ 

หมายเหตุ ค่าดชันีความสอดคลอ้งที่ยอมรับไดต้อ้งมีค่าตั้งแต่ 0.60 ขึ้นไป 
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3.2.2.3 สร้างแบบสอบถามตามมาตราส่วนประเมินค่า 5 ระดบั (Rating Scale) (Likert, 

Rensis 1967, pp. 90-95) เพื่อให้ผูเ้ช่ียวชาญพิจารณาให้นํ้ าหนักที่ตรงกบัความคิดเห็นของผูเ้ช่ียวชาญ

มากที่สุด มาตราส่วนประเมินค่า 5 ระดบั โดยมีระดบัความคิดเห็นมีความหมาย ดงัน้ี 

ระดบัความคิดเห็น  5  หมายถึง   เห็นดว้ยอยา่งยิง่ 

ระดบัความคิดเห็น  4  หมายถึง   เห็นดว้ยมาก 

ระดบัความคิดเห็น  3  หมายถึง   เห็นดว้ย 

ระดบัความคิดเห็น  2  หมายถึง   เห็นดว้ยนอ้ย 

ระดบัความคิดเห็น  1  หมายถึง   เห็นดว้ยนอ้ยท่ีสุด 

3.2.2.4 นาํแบบสอบถามความคิดเห็นให้ผูเ้ช่ียวชาญประเมินและแสดงความคิดเห็น

พจิารณาบทเรียนผา่นสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์สาํหรับ

นกัเรียนชั้นประถมศึกษาปีที่ 6 ใหเ้ป็นไปตามรูปแบบองคก์รแห่งการเรียนรู้ 

3.2.2.5 วิเคราะห์ระดบัความคิดเห็นของผูเ้ช่ียวชาญที่มีต่อบทเรียนผ่านสมาร์ทโฟน 

ตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต์ สําหรับนักเรียนชั้นประถมศึกษาปีที่ 6    

ให้เป็นไปตามรูปแบบองค์กรแห่งการเรียนรู้ โดยวิเคราะห์ด้วยสถิติ ค่าเฉล่ีย และส่วนเบี่ยงเบน

มาตรฐาน 

3.2.3 แบบทดสอบก่อนเรียนและหลงัเรียน เพือ่หาผลสมัฤทธ์ิทางการเรียนผ่านสมาร์ทโฟน 

ตามแนวคิดองคก์รแห่งการเรียนรู้ กบัการเรียนในห้องเรียน เร่ืองการพฒันาเวบ็ไซต ์สาํหรับนักเรียน

ชั้นประถมศึกษาปีที่ 6 มีขั้นตอนการสร้าง ดงัน้ี 

3.2.3.1 ศึกษาเอกสารที่เก่ียวข้องกับการสร้างแบบทดสอบผลการเรียนรู้บทเรียน             

ผ่านสมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้ เร่ือง การพฒันาเว็บไซต์ สําหรับนักเรียนชั้น

ประถมศึกษาปีที่ 6 โดยใหส้อดคลอ้งกบัเน้ือหาที่กาํหนดไว ้ 

3.2.3.2 ดาํเนินการสร้างแบบทดสอบก่อนเรียน และแบบทดสอบหลงัโดยวิเคราะห์             

จากเน้ือหาและว ัตถุประสงค์เชิงพฤติกรรม จากนั้นสร้างแบบทดสอบแบบเลือกตอบ 4 ตวัเลือก 

จาํนวน 60 ขอ้ ที่ประเมินผลตามวตัถุประสงคเ์ชิงพฤติกรรมเดียวกนั ขอ้สอบที่ไดจ้ะนาํมาจาํแนกเป็น 

แบบทดสอบก่อนเรียน จาํนวน 10 ขอ้ แบบฝึกหัดระหว่างเรียน จาํนวน 10 ขอ้ และแบบทดสอบหลงั

เรียน จาํนวน 10 ขอ้  

3.2.3.3  นาํข้อสอบที่จะสร้างแบบทดสอบก่อนเรียน และแบบทดสอบหลัง

ไปให้ผู ้เ ช่ียวชาญตรวจสอบความตรงของเน้ือหาเหมาะสมกบัรูปแบบองคก์รแห่งการเรียนรู้ โดยใช้
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ค่าดชันีความสอดคลอ้งสัมประสิทธ์ระหว่างขอ้คาํถามกับวตัถุประสงค ์ (Index of Item Objective 

Congruence : IOC) (สรายทุธ กนัหลง, 2555) มีเกณฑก์ารใหค้ะแนนตามเกณฑ ์ดงัน้ี 

คะแนน +1  คือ  แน่ใจวา่แบบทดสอบน้ีสอดคลอ้งตรงกบั 

  เน้ือหาตามวตัถุประสงค ์

คะแนน    0    คือ  ไม่แน่ใจวา่แบบทดสอบน้ีสอดคลอ้งตรงกบั 

  เน้ือหาตามวตัถุประสงค ์

คะแนน   -1   คือ    แน่ใจวา่ขอ้สอบน้ีไม่สอดคลอ้งตรงกบัเน้ือหา 

  ตามวตัถุประสงค ์

                                 หมายเหตุ ค่าดชันีความสอดคลอ้งที่ยอมรับไดต้อ้งมีค่าตั้งแต่ 0.50 ขึ้นไป 

3.2.3.4 นาํขอ้สอบที่ผู ้เ ช่ียวชาญตรวจสอบความตรงของเน้ือหาเหมาะสมกบัรูปแบบ

องคก์รแห่งการเรียนรู้มาเพื่อหาระดบัความยากง่าย (p) และอาํนาจจาํแนก (r) โดยนาํแบบทดสอบ          

ที่ไดผ้่านการตรวจสอบคุณภาพเป็นรายขอ้จากผูเ้ช่ียวชาญแล้ว ไปทดลองกบันักเรียนท่ีเคยเรียนมาแล้ว 

(ลว้น สายยศ และองัคณา สายยศ, 2538, น. 210) ผูว้จิยัไดพ้จิารณาขอ้สอบแต่ละขอ้ตามเกณฑ ์ต่อไปน้ี 

0.81 – 1.00 หมายถึง  ขอ้สอบที่ง่ายมากไม่ควรใชห้รือปรับปรุง 

0.61 – 0.80  หมายถึง  ขอ้สอบที่ค่อนขา้งง่ายแต่ใชไ้ด ้

0.41 – 0.60  หมายถึง  ขอ้สอบความยากปานกลางเป็นขอ้สอบที่ดีมาก 

0.20 – 0.40  หมายถึง  ขอ้สอบที่ค่อนขา้งยากแต่ใชไ้ด ้

0.00 – 0.19  หมายถึง  ขอ้สอบที่ยากมากไม่ควรใช ้หรือปรับปรุง 

ดงันั้น ขอบเขตของค่าความยากง่ายของแบบทดสอบที่ยอมรับ คือ ระหว่าง  

0.20 – 0.80 ในการวจิยัคร้ังน้ีแบบทดสอบที่ใชมี้ค่าความยากง่ายอยูร่ะหวา่ง 0.44 – 0.75  

3.2.3.5 ค ัดเลือกขอ้สอบที่มีค่าความยากง่าย (p) ระหว่าง 0.20-0.80 จาํนวน 30 ขอ้ 

นาํมาใชเ้ป็นขอ้สอบคู่ขนานที่การประเมินผลตามวตัถุประสงคเ์ชิงพฤติกรรมเดียวกนัโดยมีหลกัเกณฑ ์          

การพจิารณาคะแนนที่ไดม้าจากการวิเคราะห์หาค่าความยากง่าย (p) และค่าอาํนาจจาํแนก (r) มีความหมาย 

ดงัน้ี p < .20 หมายถึง ขอ้คาํถามยาก และ p > .80 หมายถึง ขอ้คาํถามง่าย (ลว้น สายยศ และองัคณา 

สายยศ, 2538, น. 210) ผูว้จิยัไดพ้จิารณาขอ้สอบแต่ละขอ้ตามเกณฑ ์ต่อไปน้ี 

0.40 ขึ้นไป อาํนาจจาํแนกสูง  คุณภาพของขอ้สอบดีมาก 

0.30 – 0.39  อาํนาจจาํแนกปานกลาง คุณภาพของขอ้สอบดีพอสมควร 

0.20 – 0.29  อาํนาจจาํแนกค่อนขา้งตํ่า คุณภาพของขอ้สอบพอใช ้

0.00 – 0.19  อาํนาจจาํแนกตํ่า       คุณภาพของขอ้สอบใชไ้ม่ได ้
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ดังนั้ น ขอบเขตของค่าอํานาจจาํแนกของแบบทดสอบท่ียอมรับ คือ       

0.20 ขึ้นไป ในการวจิยัคร้ังน้ีแบบทดสอบที่ใชมี้ค่าอาํนาจจาํแนก ระหวา่ง 0.25 – 1.00   

3.2.3.6 วิเคราะห์ค่าความเช่ือมั่นของแบบทดสอบวดัผลการเรียนรู้ทั้ งหมดโดย

ใชสู้ตร KR-20 ของ Kuder Richardson กาํหนดขอบเขตของค่าความเช่ือมัน่แบบทดสอบมีความหมาย ดงัน้ี 

ค่าความเช่ือมัน่ของแบบทดสอบมีค่าตั้งแต่ –1.00 ถึง +1.00 (ลว้น สายยศ และองัคณา สายยศ, 2538, น. 198) 

+1.00    หรือเขา้ใกล ้+1.00  แสดงวา่ แบบทดสอบมีความเช่ือมัน่สูงสุด 

0.00     หรือใกลเ้คียงกบั 0.00  แสดงวา่ แบบทดสอบไม่มีความเช่ือมัน่ 

–1.00     แสดงวา่ แบบทดสอบมีความเช่ือมัน่ต ํ่าดงันั้น ขอบเขตค่าความเช่ือมัน่

ที่ยอมรับ เท่ากับ 0.80 ขึ้ นไปค่าความเชื่อมั ่นของแบบทดสอบวดัผลการเ รียนบทเรียนผ่าน     

สมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ จาํนวน 30 ขอ้ 

3.2.3.7 นาํแบบทดสอบก่อนเรียน  แบบฝึกหัดระหว่างเรียน และแบบทดสอบ

หลังเรียนไปประเมินผลการเรียนรู้จากนักเรียนที่เรียนด้วยบทเรียนผ่านสมาร์ทโฟนตามแนวคิด

องคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์สาํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6 จาํนวน 30 ขอ้  

3.2.4 แบบสอบความพึงพอใจของนักเรียนท่ีเรียนดว้ยบทเรียนผ่านสมาร์ทโฟนตามแนวคิด

องคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์สาํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6 

3.2.4.1 ศึกษาหลกัการสร้างแบบสอบถามความพึงพอใจจากเอกสารต่างๆ และตาํรา 

แบบสอบถามความพงึพอใจของผูเ้รียน 

3.2.4.2 แบบสอบความพงึพอใจไปให้ผูเ้ช่ียวชาญตรวจสอบความถูกตอ้งของขอ้คาํถาม            

ที่เหมาะสมกบัการออกแบบบทเรียนผา่นสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันา 

เวบ็ไซต ์สาํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6 ให้ตรงกบัขั้นตอนการเรียนรู้ตามรูปแบบองคก์รแห่ง

การเรียนรู้ โดยใช ้ค่าดชันีความสอดคลอ้งสัมประสิทธ์ระหว่างขอ้คาํถามกบัการออกแบบบทเรียน

ผ่านสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ (IOC: Index of Item Objective Congruence)               

(สรายทุธ กนัหลง, 2555) มีเกณฑก์ารใหค้ะแนน ดงัน้ี 

                               +1  หมายถึง     แน่ใจวา่ขอ้คาํถามน้ีมีสอดคลอ้งตรงกบัการออกแบบบทเรียน 

                                                       ผ่านสมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้ เ ร่ือง 

  การพฒันาเวบ็ไซต ์สาํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6 

 0  หมายถึง   ไม่แน่ใจว่าข้อค ําถามน้ีมีสอดคล้องตรงกับการออกแบบ 

                                                        บทเรียนผ่านสมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้  

                                                        เร่ือง การพฒันาเวบ็ไซต ์สาํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6 
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 -1 หมายถึง     แน่ใจว่าขอ้สอบน้ีไม่สอดคลอ้งกบัการออกแบบบทเรียนผ่าน 

                                                       สมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันา 

  เวบ็ไซต ์สาํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6 ตรงกบัเน้ือหา 

  ตามวตัถุประสงค ์

                                 หมายเหตุ ค่าดชันีความสอดคลอ้งที่ยอมรับไดต้อ้งมีค่าตั้งแต่ 0.50 ขึ้นไป 

3.2.4.3 สร้างตารางแบบสอบถามความพงึพอใจของผูเ้รียน แบบมาตราส่วนประมาณ

ค่า (Rating Scale) ระดบัคะแนนมี 5 ระดบั (Likert, Rensis 1967, pp. 90-95) ดงัน้ี 

   5 หมายถึง    มีความคิดเห็นอยูใ่นระดบัมากที่สุด 

   4 หมายถึง    มีความคิดเห็นอยูใ่นระดบัมาก 

   3 หมายถึง    มีความคิดเห็นอยูใ่นระดบัปานกลาง 

   2 หมายถึง    มีความคิดเห็นอยูใ่นระดบันอ้ย 

1       หมายถึง    มีความคิดเห็นอยูใ่นระดบันอ้ยที่สุด 

3.2.4.4 กาํหนดเกณฑก์ารแปลความหมาย ดงัน้ี (ระพินทร์ โพธ์ิศรี, 2549, น. 39 อา้งถึง

ใน รุ่งพวิา แควง้อินทร์, 2551, น. 42)  

3.51 – 4.00 หมายถึง     มีความพงึพอใจมากที่สุด  

2.51 – 3.50    หมายถึง     มีความพงึพอใจมาก  

1.51 – 2.50    หมายถึง     มีความพงึพอใจปานกลาง  

1.00 – 1.50    หมายถึง     มีความพงึพอใจนอ้ย  

0.00 – 0.99   หมายถึง     มีความพงึพอใจนอ้ยที่สุด 

3.2.4.5  นาํแบบสอบความพงึพอใจไปให้นักเรียนแสดงความคิดเห็นต่อบทเรียนผ่าน

สมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้ เ ร่ือง การพัฒนาเว็บไซต์ สําหรับนักเรียนชั้ น

ประถมศึกษาปีที่ 6 โดยวเิคราะห์ดว้ยสถิติ ค่าเฉล่ีย และส่วนเบ่ียงเบนมาตรฐาน 

 

3.3  การเกบ็รวบรวมข้อมูล 

3.3.1 การดาํเนินการทดลอง 

ผูว้ิจยัได้ดาํเนินการทดลองตามรูปแบบ One - Group Pretest - Posttest Design                   

โดยทดลองแบบกลุ่มเดียว (One Group Pretest-Posttest Design) เป็นการทดลองที่มีการวดัก่อน      

การทดลอง 1 คร้ัง หลงัการทดลอง 1 คร้ัง ที่ O1 และ O2 ใชเ้คร่ืองมือวดัดว้ยแบบทดสอบก่อนเรียน 

และหลงัเรียน ฉบบัเดียวกนัหรือคู่ขนานกนั 
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ผูว้จิยัเลือกกลุ่มตวัอยา่งโดยวธีิการวธีิการสุ่มกลุ่มตวัอยา่งแบบเจาะจง ทาํการทดสอบ

ก่อนการทดลอง แลว้นาํบทเรียนผ่านสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันา

เวบ็ไซตท์ี่ทาํขึ้นไปใชท้ดลองกบันกัเรียนท่ีเรียนกลุ่มสาระการงานอาชีพและเทคโนโลย ี(คอมพิวเตอร์) 

ชั้นประถมศึกษาปีที่ 6 โรงเรียนโชคชยัรังสิต ตาํบลบึงยีโ่ถ อาํเภอธญับุรี จงัหวดัปทุมธานี สาํนักงาน

เขตพื้นที่การศึกษาประถมศึกษาปทุมธานี เขต 2 คละระดบัสติปัญญา เก่ง ปานกลาง อ่อน จาํนวน 1 ห้อง 

จาํนวน 30 คน และทาํการทดสอบอีกคร้ังดว้ยเคร่ืองมือการเก็บรวบรวมขอ้มูลชุดเดิม เพื่อดูผลหลงั

การทดลอง และนาํผลการวดั O1 และ O2 มาคาํนวณหาค่าเฉล่ีย ( x ) และนาํเปรียบเทียบกนัโดยใชส้ถิติ 

t-test  แบบ (Dependent) ถา้ผลการวดัของ O2 สูงกวา่ O1 แสดงวา่บทเรียนผา่นสมาร์ทโฟนตามแนวคิด

องคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซตท์ี่ทาํขึ้นนั้นใชไ้ดผ้ล หรือกล่าวไดว้่าสามารถนาํไปส่ือ

การสอนไดอ้ยา่งมีประสิทธิภาพจริง  
 

กลุ่มตวัอยา่ง ก่อนเรียน ทดลอง หลงัเรียน 

                E O1 X O2 
                          

สญัลกัษณ์ที่ใชใ้นแบบแผนการทดลอง  

E แทน  กลุ่มตวัอยา่ง 

O1 แทน  การทดสอบก่อนเรียน 

X          แทน  การเรียนบทเรียนสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้  

                เ ร่ืองการพัฒนาเว็บไซต์  

O2 แทน  การทดสอบหลงัเรียน 

    แทน  การทดสอบหลงัเรียน 
 

3.3.2 การเก็บรวบรวมขอ้มูลดาํเนินการดงัน้ี 

3.3.2.1 ทาํหนังสือขอความร่วมมือในการวิจยั จากคณะครุศาสตร์อุตสาหกรรม 

มหาวทิยาลยัเทคโนโลยรีาชมงคลธญับุรี ไปยงัผูอ้าํนวยการโรงเรียนโชคชยัรังสิต สาํนักงานเขตพื้นที่

การศึกษาประถมศึกษาปทุมธานี เขต 2 สงักดัสาํนกังานคณะกรรมการการส่งเสริมการศึกษาเอกชน 

3.3.2.2 เตรียมสถานที่และเคร่ืองมือที่ใช้ในการทดลองคร้ังน้ีคือห้องปฏิบัติการ

คอมพิวเตอร์โรงเรียนโชคชยัรังสิต โดยมีการจดัเตรียมสมาร์ทโฟนให้พร้อมต่อการทดลองกบักลุ่ม

ตวัอยา่ง คือนกัเรียนระดบัชั้นประถมศึกษาปีที่ 6 โรงเรียนโชคชยัรังสิต จาํนวน 30 คน   

3.3.2.3 อธิบายการใชแ้ละสาธิตขั้นตอนต่างๆ ในการเรียนพร้อมทั้งแจง้จุดมุ่งหมายใน

การเรียน และเง่ือนไขในการเรียนใหก้บักลุ่มตวัอยา่งทราบ 

65 



 

 

3.3.2.4 ดาํเนินการสอนบทเรียนผ่านสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ 

เร่ือง การพฒันาเวบ็ไซต ์ 

3.3.2.5 ทาํการทดสอบก่อนเรียน (Pretest) ดว้ยแบบทดสอบวดัประเมินผลการเรียนรู้

ทางการเรียนที่ไดต้รวจคุณภาพแลว้จาํนวน 10 ขอ้ 

3.3.2.6 หลงัจากทาํแบบทดสอบก่อนเรียนเสร็จเรียบร้อยแลว้ ให้กลุ่มตวัอยา่งศึกษา

เน้ือหาบทเรียนผ่านสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์

3.3.2.7 เม่ือกลุ่มตวัอยา่งเรียนดว้ยบทเรียนผ่านสมาร์ทโฟนตามแนวคิดองคก์รแห่ง

การเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์ใหท้าํแบบทดสอบหลงัเรียน (Posttest) จาํนวน 20 ขอ้ 

3.3.2.8 รวบรวมขอ้มูลที่ไดจ้ากการทดลองมาตรวจให้คะแนนและวิเคราะห์หาค่าทาง

สถิติเพือ่หาขอ้สรุปผลการศึกษา และเสนอแนะแนวคิดที่ไดจ้ากการศึกษา 

 

3.4  การวเิคราะห์ข้อมูล 

ผูว้ิจยัใช้เคร่ืองมือในการวิจยั ไดแ้ก่ บทเรียนผ่านสมาร์ทโฟน  เร่ืองการพฒันาเวบ็ไซต ์ 

แบบทดสอบก่อนและหลงัเรียน และแบบสอบถามความพึงพอใจ ของนักเรียนชั้นประถมศึกษาปีที่ 6  

โรงเรียนโชคชยัรังสิต ที่มีต่อบทเรียนผ่านสมาร์ทโฟน  เร่ืองการพฒันาเวบ็ไซต ์ ผูว้ิจยัไดน้าํสถิติที่

ใชใ้นการวเิคราะห์ขอ้มูล ดงัต่อไปน้ี 

3.4.1 สถิติที่ใชใ้นการวจิยั 

ในงานศึกษาคน้ควา้คร้ังน้ีใชส้ถิติเพือ่ทดสอบค่าทางสถิติ ดงัน้ี 

3.4.1.1 หาประสิทธิภาพของบทเรียนผ่านสมาร์ทโฟน เร่ืองการพฒันาเวบ็ไซต ์

โดยใช้สูตรการหาประสิทธิภาพ   E1 /E2  (ชยัยงค ์พรหมวงศ,์ 2520, น. 35-147) 

 E1   =  100×∑

A

N
X

 

เม่ือ E1 คือ ประสิทธิภาพของกระบวนการ 

   ∑ X  คือ คะแนนรวมของแบบฝึกหดัหรืองาน 

A  คือ คะแนนเตม็ของแบบฝึกหดัหรืองาน 

N คือ จาํนวนนกัเรียนทั้งหมด 

66 



 

 

E2  =  100×∑

B

N
F

 

เม่ือ E2 คือ ประสิทธิภาพของผลลพัธ ์

   ∑F  คือ คะแนนรวมของผลลพัธห์ลงัเรียน 

B  คือ คะแนนเตม็ของการทดสอบหลงัเรียน 

N คือ จาํนวนนกัเรียน 

3.4.1.2 หาผลสมัฤทธ์ิทางการการเรียนของนักเรียนที่เรียนดว้ยบทเรียนผ่านสมาร์ทโฟน 

เร่ือง การพฒันาเวบ็ไซต ์โดยใชแ้บบทดสอบวดัผลการเรียนรู้ก่อนเรียนและหลงัเรียนเป็นเคร่ืองมือ

วจิยั ผูว้จิยัไดส้ร้างเคร่ืองมือและวเิคราะห์ขอ้มูล โดยใชส้ถิติ ดงัน้ี  

1. หาค่าดชันีความสอดคลอ้งสัมประสิทธ์ิระหว่างขอ้คาํถามกบัวตัถุประสงค ์

(Index of Item Objective Congruence: IOC) แบบทดสอบวดัผลการเรียนรู้ก่อนเรียนและหลงัเรียน 

(สรายทุธ กนัหลง, 2555) มีรายละเอียด ดงัน้ี 

             IOC  =  
∑R
N

 

                                  โดยที่   IOC   แทน ค่าความเหมาะสมของเน้ือหาและหลกัสูตร 

 ΣR     แทน  ผลรวมของคะแนนความคิดเห็นของผูเ้ช่ียวชาญ 

 N    แทน  จาํนวนผูเ้ช่ียวชาญทั้งหมด 

                                กาํหนดเกณฑก์ารแปลความหมาย ดงัน้ี 

+1   แน่ใจวา่เน้ือหาของหลกัสูตรมีความเหมาะสม 

  0      ไม่แน่ใจวา่เน้ือหาของหลกัสูตรมีความเหมาะสมให้ 

 -1  แน่ใจวา่เน้ือหาของหลกัสูตรไม่มีความเหมาะสม 

                               หมายเหตุ  เกณฑค์่า  IOC แต่ละรายขอ้ตอ้งมากกวา่หรือเท่ากบั 0.50 

2. หาค่าความยากง่าย (p) และอาํนาจค่าจาํแนก (r) ของแบบทดสอบผลสัมฤทธ์ิ 

ทางการเรียน โดยใชสู้ตร ดงัน้ี 

1) หาความยากง่าย (p) แบบทดสอบโดยใช้สูตร ดังน้ี p < .20 หมายถึง 

ขอ้คาํถามยาก และ p > .80 หมายถึง ขอ้คาํถามง่าย (ลว้น สายยศ และองัคณา สายยศ, 2538, น. 210) 

ผูว้จิยัไดพ้จิารณาขอ้สอบแต่ละขอ้ตามเกณฑ ์ต่อไปน้ี 

                    P  =  
 

N
R
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เม่ือ p  แทน ค่าความยากง่ายของคาํถามแต่ละขอ้ 

 R  แทน   จาํนวนผูต้อบถูกในแต่ละขอ้ 

 N  แทน   จาํนวนผูเ้ขา้สอบทั้งหมด 

                                หมายเหตุ การเลือกขอ้สอบจะพจิารณาค่า  p เท่ากบั  0.20 – 0.80  

2) หาค่าอาํนาจจาํแนก (r) ของแบบทดสอบ โดยใช้สูตร  

(ลว้น สายยศ และองัคณา สายยศ, 2538, น. 210) 

1)  

 

เม่ือ r คือ ค่าอาํนาจจาํแนกเป็นรายขอ้ 

 Ru คือ จาํนวนผูต้อบถูกในขอ้นั้นในกลุ่มเก่ง 

 Re คือ จาํนวนผูต้อบถูกในขอ้นั้นในกลุ่มอ่อน 

 N คือ จาํนวนคนในกลุ่มตวัอยา่งทั้งหมด 

                           หมายเหตุ  เกณฑอ์าํนาจจาํแนกท่ียอมรับไดจ้ะมีค่าอยูร่ะหว่าง 0.20 – 1.00 ถา้ค่า

อาํนาจจาํแนก ตํ่ากวา่ 0.20 จะตอ้งปรับปรุงแบบทดสอบขอ้นั้น หรือตดัทิ้งไป  

3. หาค่าความเช่ือมัน่ของแบบทดสอบผลสมัฤทธ์ิทางการเรียน โดยคาํนวณ

จากสูตร KR-20 ของ Kuder Richardson ใชสู้ตรดงัน้ี (ลว้น สายยศ และองัคณา สายยศ, 2538, น. 198) 

Rtt       =   

















−







−
∑

S

pq
n

n

2
1

1
 

โดยที่ Rtt
 คือ   ความเช่ือมัน่ของแบบทดสอบ 

 n คือ   จาํนวนขอ้สอบทั้งหมด 

 S 2  คือ   ความแปรปรวนของคะแนนรวมทั้งฉบบั 

 p คือ   จาํนวนคนท่ีถูกทั้งหมด 

 q คือ   สดัส่วนของคนทาํผดิแต่ละขอ้ (q = 1 – p) 

      หมายเหตุ เกณฑก์ารแปลผลค่าความเช่ือมัน่ของแบบทดสอบมีรายละเอียดการแปลผล ดงัน้ี 

  0.00 – 0.20  หมายถึง  ความเช่ือมัน่ต ํ่ามากหรือไม่มีเลย 

  0.21 – 0.40  หมายถึง  ความเช่ือมัน่ต ํ่า 

  0.41 – 0.70  หมายถึง  ความเช่ือมัน่ปานกลาง 

0.71 – 1.00 หมายถึง  ความเช่ือมัน่สูง 

2

-
N

eRuR
r =
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t = 

4. การทดสอบนัยสําคัญทางสถิติ โดยการแจกแจงของ ที (t-test) ผูว้ิจัยได้

วเิคราะห์เปรียบเทียบการทดสอบสมมติฐานเปรียบเทียบ ผลการเรียนรู้จากบทเรียนผ่านสมาร์ทโฟนตาม

แนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์จากกลุ่มตวัอยา่ง กลุ่มเดียวกนั แลว้ ทาํขอ้สอบ

คู่ขนานที่วดัวตัถุประสงคเ์ชิงพฤติกรรมเดียวกนัซ่ึงสถิติที่นาํมาใชใ้นการวิเคราะห์สมมติฐานการวิจยั

คร้ังน้ี คือ t-test Dependent ที่มีค่าระดบันัยสาํคญั 0.05 (ลว้น สายยศ และองัคณา สายยศ, 2538, น. 104) 

โดยใชสู้ตร ดงัน้ี   

                        
( )

( )1

22

−

−∑ ∑
∑

n
Dn

D

D
 

โดยที่  t    คือ    ค่าสถิติทดสอบ 

D คือ เป็นความแตกต่างของคะแนนแตล่ะคู ่

∑D  คือ    ผลรวมของคะแนนความแตกต่างระหวา่งคะแนน 

  การทดสอบหลงัเรียนกบัก่อนเรียนผา่นบทเรียน  

  ผา่นสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ 

  เร่ือง การพฒันาเวบ็ไซต ์

∑ 2D       คือ    ผลรวมของกาํลงัสองของแตกต่างระหวา่งคะแนน 

  หลงักบัก่อนการเรียนผ่านบทเรียนผา่นสมาร์ทโฟนตาม 

  แนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์

n       คือ    จาํนวนนกัเรียนท่ีเป็นกลุ่มตวัอยา่ง 

df คือ   องศาความเป็นอิสระ มีค่าเท่ากบั n -1 

5. สถิติพื้นฐานการวจิยั ไดแ้ก่ 

1) ค่าเฉล่ีย (Mean) 

𝑥�   =   
∑ X
n

 

เม่ือ 𝑥�  แทน ค่าเฉล่ีย 

   ∑ X แทน ผลรวมของคะแนนทั้งหมด 

   n  แทน จาํนวนนกัเรียนในกลุ่มตวัอยา่ง 

2) ค่าส่วนเบ่ียงเบนมาตรฐาน (S.D. : Stand Deviation) โดยใชสู้ตร ดงัน้ี 

S. D. =  �
N ∑ X2 −  (∑ X)

N(N− 1)  
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เม่ือ S.D. แทน ส่วนเบี่ยงเบนมาตรฐาน 

   n  แทน จาํนวนนกัเรียนในกลุ่มตวัอยา่ง 

ΣX2  แทน ผลรวมของคะแนนทั้งหมด 

                     (ΣX)2      แทน ผลรวมของคะแนนแต่ละตวัยกกาํลงัสอง 

3.4.1.3 หาความพึงพอใจของนักเรียนชั้นประถมศึกษาปีที่ 6 ที่มีต่อบทเ รียนผ่าน

สมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์โดยใชแ้บบสอบถามความ

พึงพอใจนักเรียนชั้นประถมศึกษาปีที่ 6 ที่มีต่อบทเ รียนผ่านสมาร์ทโฟนตามแนวคิดองคก์รแห่ง

การเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์โดยใชค้่าสถิติในการวิเคราะห์ ดังต่อไปน้ี 

1. สถิติส่วนที่นาํมาใชห้าค่าดชันีความสอดคลอ้งสมัประสิทธ์ิระหว่างขอ้คาํถาม 

กบัวตัถุประสงค ์(Index of Item Objective Congruence: IOC) (สรายทุธ กนัหลง, 2555) มีรายละเอียด 

ดงัน้ี 

                                                    IOC    =    
∑R
N

 
 

โดยที่  IOC  แทน  ค่าความเหมาะสมของเน้ือหาและหลกัสูตร 

 ΣR แทน  ผลรวมของคะแนนความคิดเห็นของผูเ้ช่ียวชาญ 

 N แทน  จาํนวนผูเ้ช่ียวชาญทั้งหมด 

หมายเหตุ กาํหนดเกณฑก์ารพจิารณา ดงัน้ี 

 +1   แน่ใจวา่เน้ือหาของขอ้คาํถามสอดคลอ้งกบัวตัถุประสงค ์ 

มีความเหมาะสม 

   0  ไม่แน่ใจว่าเน้ือหาของขอ้คาํถามสอดคลอ้งกบัวตัถุประสงค ์

มีความเหมาะสมให ้

 - 1 แน่ใจวา่เน้ือหาของขอ้คาํถามสอดคลอ้งกบัวตัถุประสงค์

ไม่มีความเหมาะสม 

เกณฑค์่า  IOC แต่ละรายขอ้ตอ้งมากกวา่หรือเท่ากบั 0.50 

แบบสอบถามให้ผูเ้ช่ียวชาญทั้ง 3 ท่านเป็นผูป้ระเมินนั้นใช้แบบสอบถาม          

ที่สร้างขึ้นมาเองโดยมีมาตราส่วนประมาณค่า (Rating Scale) 5 ระดบั (Likert, Rensis 1967, pp. 90-95) 

ไดแ้ก่ มากที่สุด มาก ปานกลาง นอ้ย และนอ้ยที่สุด โดยกาํหนดระดบัการประเมิน ดงัน้ี 

คะแนน  5 หมายถึง     มากที่สุด 

คะแนน  4 หมายถึง     มาก 
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คะแนน  3 หมายถึง     ปานกลาง 

คะแนน  2 หมายถึง     นอ้ย 

คะแนน  1 หมายถึง     นอ้ยที่สุด 

โดยที่การประเมินใช้วิธีหาค่าคะแนนเฉล่ียและส่วนเบ่ียงเบนมาตรฐาน  

โดยกาํหนดผลการประเมินระดับความพึงพอใจต่อบทเรียนผา่นสมาร์ทโฟนตามแนวคิดองคก์ร

แห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์จากผลการหาค่าคะแนนเฉล่ียของนักเรียนชั้นประถมศึกษา  

ปีที่ 6 เป็นผูต้อบแบบประเมิน ดงัน้ี 

คะแนนเฉล่ีย  4.50 – 5.00   หมายถึง     ระดบัมากที่สุด 

คะแนนเฉล่ีย  3.50 – 4.49   หมายถึง     ระดบัมาก 

คะแนนเฉล่ีย  2.50 – 3.49   หมายถึง     ระดบัปานกลาง  

คะแนนเฉล่ีย  1.50 – 2.49   หมายถึง     ระดบันอ้ย  

คะแนนเฉล่ีย  1.00 – 1.49   หมายถึง     ระดบันอ้ยที่สุด 

2. แบบสอบถามความคิดเห็นสาํหรับผูเ้ช่ียวชาญ ผูว้จิยัสร้างแบบสอบถามตาม

มาตราส่วนประมาณค่า (Rating Scale) 5 ระดบั ไดแ้ก่ มากที่สุด มาก ปานกลาง น้อย และน้อยที่สุด  

โดยกาํหนดเกณฑร์ะดบัการประเมิน ดงัน้ี 

คะแนน  5 หมายถึง     มากที่สุด 

คะแนน  4 หมายถึง     มาก 

คะแนน  3 หมายถึง     ปานกลาง 

คะแนน  2 หมายถึง     นอ้ย 

คะแนน  1 หมายถึง     นอ้ยที่สุด 

ใช้ค่าสถิติโดยวิธีหาค่าคะแนนเฉล่ีย และส่วนเบ่ียงเบนมาตรฐานโดย

กาํหนดผลการประเมินระดับความคิดเห็นของผู ้เ ช่ียวชาญที่ มีต่อบทเรียนผา่นสมาร์ทโฟนตาม

แนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์จากผลการหาค่าคะแนนเฉลี่ยของนักเรียน

ระดับชั้นประถมศึกษาปีที่ 6 เป็นผูต้อบแบบประเมิน ดงัน้ี 

คะแนนเฉล่ีย  4.50 – 5.00 หมายถึง     ระดบัมากที่สุด 

คะแนนเฉล่ีย  3.50 – 4.49    หมายถึง     ระดบัมาก 

คะแนนเฉล่ีย  2.50 – 3.49    หมายถึง     ระดบัปานกลาง  

คะแนนเฉล่ีย  1.50 – 2.49    หมายถึง     ระดบันอ้ย  

คะแนนเฉล่ีย  1.00 – 1.49   หมายถึง     ระดบันอ้ยที่สุด 
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บทที่  4 

ผลการวิเคราะห์ข้อมูล  

 

การวิจัยคร้ังน้ี  ผู ้วิจัยได้ท ําวิจัย เ ร่ือง บทเรียนผ่านสมาร์ทโฟนตามแนวคิดองค์กร               

แห่งการเรียนรู้ เ ร่ือง การพัฒนาเว็บไซต์ สําหรับนักเรียนชั้ นประถมศึกษาปีที่  6 โดยขั้นตอน             

ในการวจิยัประกอบไปดว้ย 

4.1  การนาํเสนอผลการวเิคราะห์ขอ้มูล 

4.2  ผลการวเิคราะห์ 

 

4.1  การนําเสนอผลการวเิคราะห์ข้อมูล 

ผูว้จิยัไดด้าํเนินการวเิคราะห์ขอ้มูลตามขั้นตอนดงัน้ี 

ตอนที่ 1 หาประสิทธิภาพบทเรียนผา่นสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้   เร่ือง 

การพฒันาเวบ็ไซต ์สาํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6    

ตอนที่ 2 หาผลสมัฤทธ์ิก่อนเรียนและหลงัเรียนของนักเรียนที่เรียนจากบทเรียนผ่านสมาร์ทโฟน 

ตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์สาํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6 

ตอนที่ 3 หาความพึงพอใจของนักเรียนชั้นประถมศึกษาปีท่ี 6 ท่ีเรียนจากบทเรียนผ่าน

สมาร์ทโฟน ตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์

 

4.2  ผลการวเิคราะห์ 

ตอนที่ 1 หาประสิทธิภาพบทเรียนผ่านสมาร์ทโฟน ตามแนวคิดองคก์รแห่งการเรียนรู้   

เร่ือง การพฒันาเวบ็ไซต ์สาํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6    

จากวตัถุประสงคข์องการวิจยัในเร่ืองการหาประสิทธิภาพของบทเรียนผ่านสมาร์ทโฟน 

ตามแนวคิดองค์กรแห่งการเรียนรู้ เร่ือง การพฒันาเว็บไซต์สําหรับนักเรียนชั้นประถมศึกษาปีที่ 6              

ใหต้อ้งเป็นไปตามเกณฑท์ี่ตั้งไวค้ือ 80/80 ผูว้จิยัไดท้าํการศึกษาหาประสิทธิภาพของการเรียนการสอน                     

หาประสิทธิภาพบทเรียนผา่นสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์

ดงัตารางที่ 4.1 

 

 

 



ตารางที่  4.1  รายงานสรุปผลการหาประสิทธิภาพบทเรียนผ่านสมาร์ทโฟนตามแนวคิด

องคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์สาํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6     

รายการ คะแนน

เตม็ 

คะแนน

เฉล่ีย 

ร้อยละ เกณฑม์าตรฐาน E1/ E2 

 

คะแนนใบงาน

ระหวา่งเรียน 
50 41.03 82.07 80 82.07 

คะแนนทดสอบ 

หลงัเรียน 
20 16. 13 80.67 80 80.67 

 

จากตารางที่  4.1 แสดงใหเ้ห็นวา่ บทเรียนผา่นสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ 

เร่ือง การพฒันาเว็บไซต์ สําหรับนักเรียนระดับชั้ นประถมศึกษาปีที่  6 แล้วนําผลของคะแนน                     

จากการทาํใบงานของนกัเรียน 30 คน คิดเป็นค่าเฉล่ียร้อยละได ้82.07 และค่าเฉล่ียร้อยละของคะแนน

ทดสอบหลังเรียนเท่ากับ 80.67 แสดงให้เห็นว่า บทเรียนผ่านสมาร์ทโฟนตามแนวคิดองค์กร                    

แห่งการเรียนรู้ เร่ือง การพฒันาเว็บไซต์ สําหรับนักเรียนชั้นประถมศึกษาปีท่ี 6 มีประสิทธิภาพ      

ตามเกณฑ ์E1/ E2 มีค่าเท่ากบั 82.07/80.67 จึงเป็นไปตามสมมติฐาน 

ตอนที่ 2 เปรียบเทียบผลสัมฤทธ์ิก่อนเรียนและหลงัเรียนของนักเรียนที่เรียนจากบทเรียน

ผ่านสมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้ เ ร่ือง การพฒันาเว็บไซต์ สําหรับนักเรียน                    

ชั้นประถมศึกษาปีที่ 6 

ผลการวเิคราะห์บทเรียนผ่านสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันา 

เวบ็ไซตส์าํหรับนักเรียนชั้นประถมศึกษาปีที่ 6 โดยการทดสอบก่อนเรียนแลว้ให้นักเรียนไดเ้รียนรู้ 

การสอนบทเรียนผา่นสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์แลว้ทาํ

การทดสอบหลงัเรียน ซ่ึงสอดคลอ้งกบัวตัถุประสงคข์อ้ที่ 2 แสดงผลการวเิคราะห์ ดงัตารางที่ 4.2 
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ตารางที่  4.2  การเปรียบเทียบคะแนนเฉล่ียระหวา่งก่อนเรียนและหลงัเรียนดว้ยบทเรียนผ่านสมาร์ทโฟน 

ตามแนวคิดองค์กรแห่งการเรียนรู้ เร่ือง การพัฒนาเว็บไซต์ สําหรับนักเรียนชั้ น

ประถมศึกษาปีที่ 6   

 

คะแนนเต็ม        คะแนนเฉลี่ย 
ค่า 

S.D. 

t 

t-test 

Sig.(2-tailed) 

 การทดสอบก่อนเรียน 20                     10.03 1.56 

*21.71 0.00 

การทดสอบหลงัเรียน 20                    16.13 1.63 

 

จากตารางที่ 4.2 แสดงให้เห็นว่าผลการใช้บทเรียนผ่านสมาร์ทโฟน ตามแนวคิดองคก์ร  

แห่งการเรียนรู้ เร่ือง การพฒันาเว็บไซต์ สําหรับนักเรียนชั้นประถมศึกษาปีที่ 6  ในการทดสอบ      

ก่อนเรียน มีคะแนนเฉล่ียเท่ากบั 10.03 มีค่า S.D. เท่ากบั 1.56 หลงัจากท่ีนกัเรียนไดเ้รียนรู้จากบทเรียน

ผ่านสมาร์ทโฟน ตามแนวคิดองค์กรแห่งการเรียนรู้ เร่ือง การพฒันาเว็บไซต์ สําหรับนักเรียน            

ชั้นประถมศึกษาปีที่ 6  แลว้ทาํการทดสอบหลงัเรียน นักเรียนมีคะแนนเฉล่ียสูงขึ้น มีคะแนนเฉล่ีย

เท่ากบั 16.13 มีค่า S.D. เท่ากบั 1.63 การวิเคราะห์ t - test Dependent ระหว่างก่อนเรียนและหลงัเรียน

เท่ากบั 21.71 มีความแตกต่างอยา่งมีนยัสาํคญัทางสถิติที่ระดบั 0.05 

ตอนที่ 3 วิเคราะห์หาความพึงพอใจของนักเรียนชั้นประถมศึกษาปีที่ 6 ท่ีเรียนจากบทเรียน 

ผา่นสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์ 

ผลการวเิคราะห์ระดบัความพงึพอใจของนกัเรียนชั้นประถมศึกษาปีที่ 6 หลงัจาก   การเรียน

ดว้ยบทเรียนผ่านสมาร์ทโฟน ตามแนวคิดองค์กรแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์เป็นการ

ดาํเนินการตามวตัถุประสงคข์อ้ที่ 3 ดงัแสดงในตารางที่ 4.3 
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ตารางที ่ 4.3  ผลการประเมินระดบัความพงึพอใจของนกัเรียนชั้นประถมศึกษาปีที่ 6 จากบทเรียน 

ผา่นสมาร์ทโฟน ตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์  

รายการประเมิน X  S.D. แปลผล 

1. ดา้นการนาํเสนอดว้ยภาพ สี เสียงประกอบ และการเช่ือมโยงเน้ือหา 

1.1 ภาพประกอบสอดคลอ้งกบัเน้ือหา 4.60 .56 มากที่สุด 

1.2 ภาพประกอบมีความน่าสนใจสามารถส่ือสารได้

ชดัเจน 

4.77 .57 มากที่สุด 

1.3 มีภาพไอคอนสวยงามน่าสนใจ ส่ือความหมายชดัเจน 4.57 .63 มากที่สุด 

1.4 การเช่ือมโยงเน้ือเพือ่สร้างปฏิสมัพนัธ์ระหวา่งผูเ้รียน

กบับทเรียน 

4.47 .57 มาก 

1.5 การเช่ือมโยง (Link) เน้ือหาของการสอนบทเรียน

ผา่นสมาร์ทโฟนไดง่้าย 

4.53 .51 มากที่สุด 

 ค่าเฉล่ียรวม 4.59  มากที่สุด 

2.   ด้านส่ิงอาํนวยความสะดวก     

2.1 การติดต่อ ส่ือสารผ่านกระดานเสวนา  4.30 .75 มาก 

2.2 การติดต่อ ส่ือสารผ่านห้องสนทนา

อิ เล็กทรอนิกส์  

4.57 .57 มากที่สุด 

2.3 การติดต่อ ส่ือสารผ่านจดหมายอิ เล็กทรอนิกส์  4.53 .63 มากที่สุด 

2.4 การส่งขอ้ความ (Send Massage) โดยใชโ้ปรแกรม 

เฟสบุค๊ (Face book) 

4.63 .61 มากที่สุด 

 ค่าเฉล่ียรวม 4.51  มากที่สุด 

3. ดา้นเน้ือหา 

3.1 เน้ือหาวชิาในบทเรียนผา่นสมาร์ทโฟนมีความ           

สอดคลอ้งกบัวตัถุประสงคก์ารเรียนรู้ 

4.50 .51 มากที่สุด 

3.2 การลาํดบัเน้ือหาเรียงจากง่ายไปหายาก 4.40 .62 มาก 

3.3 ผูเ้รียนสามารถเขา้ถึงเน้ือหาไดร้วดเร็ว 4.67 .63 มากที่สุด 

3.4 ผูเ้รียนเขา้ใจเน้ือหาในบทเรียนไดง่้าย 4.43 .50 มาก 
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ตารางที ่ 4.3  ผลการประเมินระดบัความพงึพอใจของนกัเรียนชั้นประถมศึกษาปีที่ 6 จากบทเรียน 

ผา่นสมาร์ทโฟน ตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์

รายการประเมิน X  S.D. แปลผล 

3.5 ผูเ้รียนนาํความรู้ที่ไดไ้ปประยกุตใ์ชใ้นชีวติประจาํวนั

ได ้

4.37 .76 มาก 

3.6 ผูเ้รียนตระหนกัถึงคุณค่าและประโยชน์ของความรู้   

ที่ไดรั้บ 

4.47 .51 มาก 

 

 ค่าเฉล่ียรวม 4.46  มาก 

4.   ด้านแบบทดสอบและการประเมินผล  

4.1 บทเรียนผา่นสมาร์ทโฟนมีแบบทดสอบหลงัเรียน

ช่วยใหผู้เ้รียนไดต้รวจสอบความเขา้ใจในเน้ือหา

บทเรียนไดเ้หมาะสม 

4.27 .78 มาก 

4.2 คาํถามมีความชัดเจน  4.23 .68 มาก 

4.3 แบบทดสอบสอดคล้องกับวัตถุประสงค์ 4.57 .73 มากที่สุด 

4.4 ความยากง่ายของแบบทดสอบเหมาะสม  4.43 .50 มาก 

4.5 สรุปผลคะแนนท้ายบทเรียนชัด เจน  4.53 .63 มากที่สุด 

 ค่าเฉล่ียรวม 4.49  มาก 

 ค่าเฉล่ียรวม 4.49   
 

จากตารางที่ 4.3  แสดงความพึงพอใจของนักเรียนชั้นประถมศึกษาปีที่ 6 ที่มีต่อบทเรียน

ผ่านสมาร์ทโฟน ตามแนวคิดองค์กรแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์จาํนวนทั้งหมด 30 คน 

ในภาพรวมมีความพงึพอใจอยูใ่นระดบัมาก ดว้ยค่าเฉล่ีย 4.49  
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บทที่  5 

สรุปผลการวจิัย  การอภปิรายผล  และข้อเสนอแนะ 

 

การศึกษาวจิยั เร่ือง บทเรียนผา่นสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันา 

เวบ็ไซต ์สาํหรับนกัเรียนระดบัชั้นประถมศึกษาปีที่ 6  มีวตัถุประสงคก์ารวิจยัเพื่อ 1) หาประสิทธิภาพ

ของบทเรียนผ่านสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต์ สําหรับ

นกัเรียนชั้นประถมศึกษาปีที่ 6 2) เปรียบเทียบผลสมัฤทธ์ิก่อนเรียนและหลงัเรียน 3) หาความพึงพอใจ

ของนกัเรียนชั้นประถมศึกษาปีที่ 6 ที่ใชบ้ทเรียนผ่านสมาร์ทโฟน ตามแนวคิดองคก์รแห่งการเรียนรู้ 

เร่ือง การพฒันาเว็บไซต์ สําหรับนักเรียนชั้นประถมศึกษาปีท่ี 6 โดยมีกลุ่มตวัอย่างเป็นนักเรียน

ระดบัชั้นประถมศึกษาปีที่ 6 โรงเรียนโชคชยัรังสิต ตาํบลบึงยีโ่ถ อาํเภอธญับุรี จงัหวดัปทุมธานี สังกดั

สาํนักงานเขตพื้นที่การศึกษาประถมศึกษาปทุมธานี เขต 2 จาํนวน 30 คน เลือกโดยวิธีการสุ่มกลุ่ม

ตวัอยา่งแบบเฉพาะเจาะจง (Purposive Sampling) มีเคร่ืองมือที่ใช ้ในการทดลอง ไดแ้ก่ บทเรียนผ่าน

สมาร์ทโฟน ตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันา เวบ็ไซตส์าํหรับนักเรียน ชั้นประถม 

ศึกษาปีที่ 6 แบบทดสอบก่อนเรียนและหลงัเรียน เป็นขอ้สอบแบบปรนัยชนิดเลือกตอบ 4 ตวัเลือก 

จาํนวน 20 ขอ้ และแบบสอบถามความพึงพอใจของนักเรียนชั้นประถมศึกษาปีท่ี 6 ที่เรียนจาก

บทเรียนผ่านสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์ สามารถสรุป

ผลการวจิยั การอภิปรายผลและขอ้เสนอแนะในการวจิยั ไดด้งัน้ี   

5.1  วธีิดาํเนินการวิจยั 

5.2  สรุปผลการวจิยั 

5.3  การอภิปรายผล 

5.4  ขอ้เสนอแนะ 

5.5  ขอ้เสนอแนะในการทาํวจิยัคร้ังต่อไป 

 

5.1  วธีิดาํเนินการวจิยั 

        ผูว้จิยัไดป้ฏิบติัดงัน้ี 

5.1.1 ศึกษาหลักสูตรกลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี ตามหลักสูตร

แกนกลางการศึกษาขั้นพื้นฐาน พ.ศ.2551 

5.1.2 ศึกษาแนวคิด หลกัการ ทฤษฎี ที่เก่ียวขอ้งกับการเรียนรู้ตามแนวคิดองคก์รแห่ง             

การเรียนรู้    



   

 

  5.1.3  นาํปัญหาที่ไดรั้บจากประสบการณ์ในการสอนคอมพิวเตอร์มาวิเคราะห์ถึงประเด็น

สําคัญของปัญหาและหาสาเหตุของปัญหาพบว่า ปัญหาท่ีสําคญั คือผูเ้รียนไม่ให้ความสนใจใน

บทเรียนเท่าที่ควร อีกทั้งนักเรียนส่วนใหญ่มีพื้นฐานในการใช้งานอินเทอร์เน็ต และนักเรียนรู้จัก

คอมพวิเตอร์เพยีงแค่มีไวใ้หเ้ล่นเกม   

  5.1.4  กาํหนดจุดประสงคส์าํคญัของการวจิยั 

  5.1.5  จดัทาํโครงสร้างของบทเรียนผา่นสมาร์ทโฟน โดยการวิเคราะห์เน้ือหาจากหลกัสูตร

แกนกลางและหลักสูตรสถานศึกษากลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี วิชา 

คอมพวิเตอร์ 

  5.1.6  จัดทาํบทเรียนผ่านสมาร์ทโฟน ตามโครงสร้างของเน้ือหาท่ีกําหนดไว  ้โดยยึด

หลกัสูตรแกนกลางกลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีวชิา คอมพวิเตอร์ 

  5.1.7  จดัทาํแบบทดสอบ และแบบประเมินความพึงพอใจของนักเรียนท่ีมีต่อบทเรียน   

ผ่านสมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้ เร่ือง การพฒันาเว็บไซต ์เพื่อใช้เป็นเคร่ืองมือ              

ในการวจิยั 

  5.1.8 นาํบทเรียนผ่านสมาร์ทโฟน และเคร่ืองมือที่ผูว้ิจยัสร้างขึ้นให้ผูเ้ช่ียวชาญตรวจสอบ

เพือ่หาความสอดคลอ้งระหวา่งเน้ือหา ภาษาที่ใช ้ขอ้คาํถาม กิจกรรมการเรียนการสอนกบัจุดประสงค์

ของการจดัทาํและหาประสิทธิภาพของเคร่ืองมือ แล้วนํามาปรับปรุงแก้ไขขอ้ผิดพลาดให้ถูกตอ้ง

สมบูรณ์ตามที่ผูเ้ช่ียวชาญแนะนาํทุกประการ 

  5.1.9  นาํบทเรียนผ่านสมาร์ทโฟน ไปทดลองใชก้บันักเรียนชั้นปะถมศึกษาปีท่ี 6 ที่ไม่ใช่

กลุ่มตัวอย่างเพื่อหาประสิทธิภาพของบทเรียนผ่านสมาร์ทโฟน แล้วได้ท ําการแก้ไขปรับปรุง                         

จนมีประสิทธิภาพที่ยอมรับได ้

  5.1.10  นาํบทเรียนผ่านสมาร์ทโฟน ไปใชก้บักลุ่มตวัอยา่งไดแ้ก่นักเรียนชั้นประถมศึกษา 

ปีที่ 6 โรงเรียนโชคชยัรังสิต สาํนักงานเขตพื้นท่ีการศึกษาประถมศึกษาปทุมธานี เขต 2 ซ่ึงผูว้ิจยัได้

ดาํเนินการใชบ้ทเรียนผ่านสมาร์ทโฟนในภาคเรียนท่ี 2 ปีการศึกษา 2557 หาประสิทธิภาพของบทเรียน 

ผา่นสมาร์ทโฟน โดยใชค้่า E1/E2 กาํหนดไวเ้ท่ากบั 80/80 หาส่วนเบี่ยงเบนมาตรฐาน โดยใช ้S.D. นาํ

ผลสัมฤทธ์ิทางการเรียนของนักเรียนชั้นประถมศึกษาปีท่ี 6 ท่ีเรียนจากบทเรียนผ่านสมาร์ทโฟน             

ตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์มาเปรียบเทียบโดยใชค้่าเฉล่ีย ( Χ ) และ          

t-test Dependent 
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5.2  สรุปผลการวจิยั 

        ในการวิเคราะห์ขอ้มูลทั้งหมดที่ผ่านมาขา้งตน้ ผูว้ิจยัได้สรุปผลการวิจยัตามวตัถุประสงค ์    

ที่ไดต้ั้งไว ้ดงัต่อไปน้ีคือ 

         5.2.1 ประสิทธิภาพของบทเรียนผ่านสมาร์ทโฟน ตามแนวคิดองค์กรแห่งการเรียนรู้        

เร่ือง การพฒันาเวบ็ไซต ์ที่ไดท้าํการสร้างและพฒันามีประสิทธิภาพตามเกณฑ ์80/80 กล่าวคือ จาก

การหาประสิทธิภาพไดค้่าร้อยละของคะแนนระหว่างเรียนเท่ากบั 82.07 (E1) และร้อยละของคะแนน

จากแบบทดสอบหลงัเรียนเท่ากบั 80.67 (E2)   

    5.2.2 ผลการเปรียบเทียบผลสัมฤทธ์ิก่อนเรียนและหลงัเรียน พบว่า คะแนนหลงัการเรียนรู้

จากบทเรียนผา่นสมาร์ทโฟน ตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์มีค่าสูงกว่า

คะแนนก่อนเรียน อยา่งมีนยัสาํคญัทางสถิติที่ระดบั 0.05 

    5.2.3 ผลการศึกษาความพึงพอใจของนักเรียนกลุ่มตวัอย่าง พบว่ามีความพึงพอใจอยู่ใน

ระดบัมาก 

 

5.3  การอภปิรายผล 

    การวจิยัเร่ือง บทเรียนผ่านสมาร์ทโฟน ตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันา

เวบ็ไซต ์สาํหรับนักเรียนชั้นประถมศึกษาปีที่ 6 ตามวตัถุประสงคแ์ละสมมติฐานของการวิจยัซ่ึงผล 

การวจิยันาํมาอภิปรายผลไดด้งัน้ี 

5.3.1 บทเรียนผา่นสมาร์ทโฟน ตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์

ประกอบดว้ย กิจกรรมการเรียนรู้ที่มีความสาํคญั ดงัน้ี การฝึกการใชแ้ละการส่ือสารผ่านสมาร์ทโฟน 

มีความสาํคญัอยา่งยิง่ต่อการเรียนรู้ตามแนวคิดองคก์รแห่งการเรียนรู้ เน่ืองจากหากผูเ้รียนไม่มีความ

พร้อมทางดา้นทกัษะการใชง้านคอมพวิเตอร์ทั้งในดา้นการใชโ้ปรแกรมการพฒันาเวบ็ไซตแ์ละการใช้

งานอินเทอร์เน็ตเบื้องตน้รวมทั้งความเขา้ใจในขั้นตอนและการทาํกิจกรรมการเรียนรู้ ตามแนวคิด

องคก์รแห่งการเรียนรู้ ในแต่ละขั้นตอนแลว้ ยอ่มส่งผลให้เกิดอุปสรรคในการเขา้ปฏิบติักิจกรรมการ

เรียนรู้ผูเ้รียนอย่างมากอาจทาํให้กระบวนการจดัการเรียนรู้ไม่เป็นไปตามวตัถุประสงคข์องการเรียนรู้ 
ดว้ยเหตุน้ีผูส้อนไดจ้ดัทาํคู่มือเพื่อเตรียมความพร้อมของผูเ้รียนให้มีความพร้อมมากที่สุดก่อนที่จะ

ปฏิบติักิจกรรมการเรียนรู้ตามแนวคิดองคก์รแห่งการเรียนรู้ผ่านสมาร์ทโฟน จากการพฒันาประสิทธิภาพ 

ของบทเรียนผ่านสมาร์ทโฟน ด้วยการเรียนรู้ตามแนวคิดองค์กรแห่งการเรียนรู้ ให้มีประสิทธิภาพ 

ตามเกณฑ ์80/80 ผลการวิจยัพบว่า นักเรียนที่เรียนดว้ยบทเรียนผ่านสมาร์ทโฟน ตามแนวคิดองคก์ร

แห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์ก่อนการใชบ้ทเรียนผ่านสมาร์ทโฟน ในการจดัการเรียน           
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การสอนนักเรียนทาํการทดสอบก่อนเรียน มีคะแนนเฉล่ีย ของคะแนนเต็ม 20 คะแนน เท่ากบั 10.03 

จากจาํนวนนกัเรียนทั้งหมด 30 คน หลงัจากที่ทาํการทดสอบก่อนเรียนเสร็จแลว้ ผูว้ิจยัไดน้าํบทเรียน

ผา่นสมาร์ทโฟน ตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์ท่ีไดอ้อกแบบสร้างไวม้า

ใช้ในการจัดการเรียนการสอนโดยกําหนดกิจกรรมให้นักเรียนได้เรียนรู้ซ่ึงประกอบด้วยความรู้

เบื้องตน้การใส่เน้ือความลงในเวบ็เพจ การใส่รูปภาพ การใส่ส่ือแบบมตัติมีเดีย การสร้างตาราง และ

การเช่ือมโยงเว็บเพจ เพื่อให้นักเรียนได้เรียนรู้ไดด้้วยตนเอง และให้นักเรียนทาํใบงานในแต่ละเร่ือง 

นกัเรียนมีความสนใจ มีความกระตือรือร้น สนใจเรียนมากขึ้น มีการบนัทึกผลคะแนนระหว่างเรียนไว้

แลว้นาํผลของคะแนนระหวา่งเรียนมาหาค่าเฉล่ียคิดเป็นร้อยละไดเ้ท่ากบั 82.07 หลงัจากที่นักเรียนได้

เรียนรู้ดว้ยบทเรียนผา่นสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์จึงทาํ

ใบงานจนครบ ทุกใบงาน จากนั้นนกัเรียนทาํการทดสอบหลงัเรียน พบว่าคะแนนทดสอบหลงัเรียนมี

ค่าเฉล่ียคิดเป็นร้อยละ  80.67 แสดงให้เห็นว่าบทเรียนผ่านสมาร์ทโฟน ตามแนวคิดองคก์รแห่งการ

เรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์ที่ผูว้จิยัสร้างขึ้นมีประสิทธิภาพเท่ากบั 82.07/80.67 ซ่ึงมีประสิทธิภาพ

ตามเกณฑ ์ที่กาํหนดคือ 80/80 สอดคลอ้งกบังานวจิยัของ กชพรรณ กนัทาทอง (2556, น. 117) ไดว้ิจยั

เร่ืองการสร้างบทเรียนอิเล็กทรอนิกส์บนเครือข่าย เร่ือง การสร้างแบบฝึกหัดด้วยโปรแกรมแฟลช 

สําหรับนักเรียนชั้นมัธยมศึกษาปีที่ 5 โรงเรียนนวมินทราชูทิศ พายพั ผลการศึกษาพบว่าบทเรียน

อิเล็กทรอนิกส์บนเครือข่ายมีประสิทธิภาพเท่ากบั 84.38/86.32 สูงกว่าเกณฑท์ี่คาดหวงัไว;้ ศุภาวรรณ 

ห่วงชา้ง (2556, น. 72) ไดว้จิยัเร่ืองการพฒันาความสามารถในการคิดแกปั้ญหาโดยการเรียนจากบทเรียน 

ออนไลน์ที่ใช้แนวคิดการสอนแบบสืบสอบ วิชาฟิสิกส์ ชั้นมธัยมศึกษาปีท่ี 6 เร่ืองฟิสิกส์นิวเคลียร์         

ที่มีความสามารถในการคิดแก้ปัญหา ผลการวิจัยพบว่าบทเรียนออนไลน์ มีประสิทธิภาพเท่ากับ 

90.35/90.63 สูงกวา่เกณฑท์ี่คาดหวงัไว;้ บูรพา วถีิปัญญา (2556, น. 68) ไดว้ิจยัเร่ืองการพฒันาแนวคิด

การจัดการเรียนการสอนผ่านเครือข่ายอินเทอร์เน็ตด้วยการวิจัยเชิงปฏิบัติการที่ทาํให้แนวคิด                     

การจัดการเรียนการสอนผ่านเครือข่ายอินเทอร์เน็ตพฒันาตามปัญหาและข้อมูลท่ีป้อนกลับมา                           

มีประสิทธิภาพเท่ากบั 84.56/82.64; หทยัรัตน์ ศรีวิโรจน์ (2556, น. 82) ไดว้ิจยั เร่ืองการสร้างบทเรียน

อิเล็กทรอนิกส์บนเครือข่าย เร่ืองการสร้างหนงัสืออิเล็กทรอนิกส์ สาํหรับนกัเรียนชั้นมธัยมศึกษาปีที่ 2 

โรงเรียนยพุราชวทิยาลยั พบว่าบทเรียนอิเล็กทรอนิกส์มีประสิทธิภาพเท่ากบั 88/86.6 สูงกว่าเกณฑท์ี่

กาํหนดไว ้

5.3.2 จากการวจิยัพบว่า ผลสัมฤทธ์ิทางการเรียนหลงัเรียนที่เรียนโดยใชก้ารสอนบทเรียน

ผา่นสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์สาํหรับนักเรียนชั้นประถม 

ศึกษาปีที่ 6 ในการทดสอบก่อนเรียนมีคะแนนเฉล่ียเท่ากบั 10.03 มีค่าเบ่ียงเบนมาตรฐาน (S.D.) เท่ากบั 
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1.56 หลงัจากที่นกัเรียนไดเ้รียนรู้จากบทเรียนผา่นสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง 

การพฒันาเวบ็ไซต ์แลว้ทาํการทดสอบหลงัเรียน นกัเรียนมีคะแนนเฉล่ียสูงขึ้นจากเดิม มีคะแนนเฉล่ีย

เท่ากบั 16.13 มีค่าเบี่ยงเบนมาตรฐาน (S.D.) เท่ากบั 1.63 การวิเคราะห์ t-test Dependent ระหว่างก่อน

เรียนและหลงัเรียนเท่ากบั 21.71 มีความแตกต่างอยา่งมีนัยสาํคญัทางสถิติที่ระดบั 0.05 ซ่ึงสอดคลอ้ง

กบังานวิจยัของ ธญันันท ์พงษา (2556, น. 108) ไดศึ้กษาวิจยัเร่ือง การพฒันาองคก์ารแห่งการเรียนรู้

ของพนกังานฝ่ายขายและบริการผูป้ระกอบการโทรคมนาคม บริษทั ทีโอที จาํกดั (มหาชน) ผลการวิจยั 
พบวา่ผลการเปรียบเทียบค่าเฉล่ียของคะแนนการพฒันาองคก์ารแห่งการเรียนรู้ของพนักงานฝ่ายขาย

และบริการผูป้ระกอบการโทรคมนาคม ของพนกังาน ดา้นแบบแผนความคิด ดา้นการสร้างวิสัยทศัน์

ร่วม ดา้นการเรียนรู้ร่วมกนัเป็นทีม อยา่งมีนยัสาํคญัทางสถิติท่ีระดบั .05 

5.3.3 จากการวิจยัพบว่าผลการวิเคราะห์ระดับความพึงพอใจของนักเรียนหลังการใช้

บทเรียนผา่นสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์สาํหรับนักเรียนชั้น

ประถม ศึกษาปีที่ 6 นักเรียนมีความพึงพอใจอยูใ่นระดบัมาก มีค่าเฉล่ีย 4.49 เพราะนักเรียนไดเ้รียนรู้

กิจกรรมที่ทางบทเรียนจดักิจกรรมไว ้ทาํใหผู้เ้รียนมีความพอใจต่อบทเรียนผ่านสมาร์ทโฟน เน่ืองจาก

บทเรียนผา่นสมาร์ทโฟนใหท้ั้งความรู้และความเพลิดเพลิน รวมทั้งช่วยใหรู้้จกัคิดและปฏิบติัอยา่งเป็น

ขั้นตอน ทั้งน้ีเน่ืองจากผูเ้รียนได้เรียนตามเน้ือหาท่ีผูเ้รียนต้องการ ได้ลงมือปฏิบัติ มีผลแสดง

ความก้าวหน้าทางการเรียนเป็นระยะๆ ทา้ทายให้ผูเ้รียนเกิดความสนใจ และเม่ือผูเ้รียนใช้ความ

พยายามถึงระดบัหน่ึงจะไดค้วามสาํเร็จทนัที ซ่ึงสอดคลอ้งกบังานวิจยัของ ธนินทร์ ระเบียบโพธ์ิ และ

เอกชยั แซ่จึง (2556, น. 49) ได้ศึกษาวิจยัการพฒันาระบบจดัการเรียนการสอนแบบ M-Learning 

ผลการวจิยัพบวา่ความพงึพอใจของนกัศึกษาวา่มีส่วนช่วยใหผู้เ้รียนเกิดความเขา้ใจในบทเรียนมากขึ้น 

และการสร้างบรรยากาศในหอ้งเรียนน่าสนใจ โดยรวมทั้งหมดอยูใ่นระดบัปานกลาง 

ขอ้สังเกตที่พบในระหว่างการเรียนรู้จากบทเรียนผ่านสมาร์ทโฟนตามแนวคิดองค์กร     

แห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์สาํหรับนักเรียนชั้นประถมศึกษาปีที่ 6 นักเรียนมีความตั้งใจ

และมีความกระตือรือร้นในการเรียน สามารถปฏิบติังานได้อย่างสนุกสนาน ถูกตอ้งเป็นระเบียบ        

มีความเช่ือมัน่ในการทาํงานมากขึ้นเพราะทุกคนไดป้ฏิบติัจริงช่วยให้เกิดการเรียนรู้ รวมทั้งสามารถ

เรียนรู้ได้เองโดยอิสระ อีกทั้ งยงัมีการแลกเปล่ียนเรียนรู้ซ่ึงกันและกัน  ทาํให้ผูเ้ รียนได้พัฒนา            

ตามศกัยภาพ โดยมีครูวางแผนร่วมกับผูเ้รียน กระตุน้ ทา้ทาย ให้กําลังใจ และช้ีแนะแนวทาง           

การแสวงหาความรู้ที่ถูกตอ้ง 
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5.4  ข้อเสนอแนะ 

ในการวจิยัคร้ังน้ี ผูว้จิยัมีขอ้เสนอแนะในการนาํผลการวจิยัไปใช ้ดงัน้ี 

5.4.1 การฝึกการใชง้านและการติดต่อส่ือสารผา่นสมาร์ทโฟนเป็นกิจกรรมที่สาํคญั ในการเรียนรู้

ตามแนวคิดองคก์รแห่งการเรียนรู้ ซ่ึงหากผูเ้รียนขาดความพร้อม จะส่งผลในการจดักิจกรรมการเรียน

การสอนใหบ้รรลุตามวตัถุประสงคท์ี่ไดต้ั้งไว ้ควรเตรียมความพร้อมของผูเ้รียน โดยการฝึกทกัษะการ

ใชค้อมพวิเตอร์ การใชง้านอินเทอร์เน็ต การสืบคน้ขอ้มูล การใชโ้ปรแกรมสาํหรับการติดต่อ ส่ือสาร 

รวมไปถึงวธีิการและขั้นตอนในการศึกษาบทเรียนผา่นสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้

อยา่งละเอียดในทุกขั้นตอนของจดักิจกรรมการเรียนรู้ 

5.4.2 การเรียนรู้ตามแนวคิดองคก์รแห่งการเรียนรู้ผ่านสมาร์ทโฟนสามารถนาํไปประยกุตใ์ช้

กบัการจดัการเรียนได้ทุกช่วงชั้นของการศึกษา และทุกกลุ่มสาระการเรียนรู้โดยการปรับกิจกรรม          

การเรียนรู้ใหส้อดคลอ้งกบักิจกรรมการเรียนรู้ในช่วงชั้นหรือกลุ่มสาระการเรียนรู้ ที่จะนาํไปใช ้ 

 

5.5  ข้อเสนอแนะในการทาํวจิยัคร้ังต่อไป 

 จากผลการวจิยัที่ไดส้รุปและอภิปรายผลผูว้จิยัมีแนวคิดเป็นขอ้เสนอแนะดงัน้ี 

5.5.1 ผูส้อนควรมีการโตต้อบกบัผูเ้รียนดว้ยบทเรียนผ่านสมาร์ทโฟนทนัที การพูดคุยผ่าน 

RMUTT ควรตอบอีเมลท์นัทีเม่ือผูเ้รียนส่งมาถึง เพราะจะทาํให้ผูเ้รียนรู้สึกว่ากาํลงัศึกษาโดยมีครูคอย

ดูแลอยู ่

5.5.2 ควรมีการกาํหนดให้ผูเ้รียนไดติ้ดต่อส่ือสารระหว่างผูเ้รียนกบัผูส้อน หรือระหว่าง

ผูเ้รียนดว้ยกนัเป็นประจาํ โดยใชเ้วบ็บอร์ด (Web Board) แช็ท (Chat) และอีเมล ์(E-Mail) 

5.5.3 มีการศึกษาผลของการนําแนวคิดการเรียนรู้ตามแนวคิดองค์กรแห่งการเรียนรู้       

ผ่านสมาร์ทโฟนไปใชก้ับทกัษะกระบวนการคิดของผูเ้รียนตามมาตรฐานของหลกัสูตรอ่ืนๆ เช่น 

ทกัษะกระบวนการคิดแบบสร้างสรรค ์ทกัษะกระบวนการคิดอยา่งเป็นระบบ ทกัษะกระบวนการคิด

แบบมีวจิารณญาณ เป็นตน้ 

5.5.4 ควรมีการศึกษาผลของการนาํแนวคิดการเรียนรู้ตามแนวคิดองคก์รแห่งการเรียนรู้ 

ผา่นสมาร์ทโฟนไปใชก้บัผูเ้รียนที่มีความสามารถในการเรียนต่างกนั เพือ่หาแนวทางในการเสริมสร้าง

ความสามารถของผูเ้รียน 
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ตัวอย่างการสอนผ่านสมาร์ทโฟน 

 

- ตัวอย่างการสอนผ่านสมาร์ทโฟนตามแนวคดิองค์กรแห่งการเรียนรู้                   

เร่ือง การพฒันาเว็บไซต์ 

 



 

ตัวอย่างการสอนผ่านสมาร์ทโฟนตามแนวคดิองค์กรแห่งการเรียนรู้  

เร่ืองการพฒันาเวบ็ไซต์ 
 

 

 

 

 

 

 

 

 

ภาพภาคผนวก ญ ที่ 1  หนา้ Login เขา้สู่ระบบ 

จากภาพภาคผนวก ญ ที่ 1  แสดงหนา้ Login เขา้สู่ระบบ โดยการสมคัรสมาชิกและทาํการ

เขา้สู่ระบบ เพือ่เขา้สู่หนา้เมนูหลกัของระบบ 
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จาํนวน 20  ขอ้ 
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เตม็ 20 คะแนนจากนั้นคลิกเลือกขั้นต่อไปเพือ่กลบัไปยงัหนา้เมนูหลกัแลว้เขา้สู่บทเรียน 
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จากภาพภาคผนวก ญ ที่ 11 แสดงคะแนนที่ไดห้ลงัทาํแบบทดสอบหลงัเรียน จากคะแนน

เตม็ 20 คะแนนจากนั้นคลิกเลือกขั้นต่อไปเพือ่กลบัไปยงัหนา้เมนูหลกัแลว้เขา้สู่บทเรียน 
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จากภาพภาคผนวก ญ ที่ 12 แสดงหนา้กระดานสนทนาเพือ่แลกเปล่ียนตอบปัญหาขอ้สงสยั 
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หลกัสูตรสาระการเรียนรู้การงานอาชีพและเทคโนโลยี 

 

-  คาํอธิบายรายวิชาพืน้ฐาน 

-  ตัวช้ีวดั  สาระการเรียนรู้แกนกลางและสาระการเรียนรู้ท้องถิ่น 
-  วเิคราะห์ตัวช้ีวดัและสาระการเรียนรู้แกนกลางการศึกษาขั้นพืน้ฐาน 

พุทธศักราช 2551 กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ี 

วชิาคอมพวิเตอร์ ช้ันประถมศึกษาปีที่ 6 

-  วเิคราะห์หน่วยการเรียนรู้ตามมาตรฐานการเรียนรู้ / ตัวช้ีวดั 

-  โครงสร้างรายวชิา หน่วยการเรียนรู้ที่ 6  การพฒันาเวบ็ไซต์ 

-  กาํหนดการสอนรายช่ัวโมง 
-  การวเิคราะห์วตัถุประสงค์เชิงพฤติกรรม 

 



 
  

 

คาํอธิบายรายวิชาพืน้ฐาน 

 

ง 16101  การงานอาชีพและเทคโนโลย ี                  กลุ่มสาระการงานอาชีพและเทคโนโลยี 

ช้ันประถมศึกษาปีที่ 6                                                                     เวลาเรียน  80  ช่ัวโมง       

 

ศึกษา อธิบาย สํารวจ เลือก ระบุ หลกัการทาํงานและปรับปรุง แนวทางในการทาํงานแต่ละ

ขั้นตอนรวมถึงการววิฒันาการของเทคโนโลย ีเช่น งานบา้น งานประดิษฐ์ งานเกษตร และงานธุรกิจ

ส่วนประกอบของระบบเทคโนโลยี การปฏิบติัตนกับครอบครัวและผูอ่ื้นของการทาํงานร่วมกัน                    

ในลักษณะที่ขยนั อดทน รับผิดชอบ ซ่ือสัตย ์มีมารยาท แสดงความคิดเห็นเกี่ยวกบัการใช้พลงังาน 

ทรัพยากรและส่ิงแวดลอ้มอยา่งประหยดัและคุม้ค่าของประเทศสมาชิกอาเซียนและมีจิตสาํนึกในการ

ใช้ทรัพยากร ค้นหา รวบรวม จดัทาํ เก็บรักษา เอกสาร ข้อมูลในรูปแบบเทคโนโลยีต่างๆใน

ชีวิตประจาํวนัและ กําหนดปัญหาหรือความตอ้งการ วางแผน ออกแบบ สร้าง เลือกใช้ นําเสนอ 

ประเมินผล ช้ินงาน ความรู้เก่ียวกบัภาษา วฒันธรรม การเมืองการปกครอง อาชีพประจาํชาติในกลุ่ม

ประเทศอาเซียนและทกัษะต่างๆ ใชก้ระบวนการเทคโนโลยถ่ีายทอดความคิดเป็นภาพร่าง 3 มิติ หรือ

แผนที่ความคิด กราฟ ตาราง แผนภาพ รูปภาพ  เทคโนโลยไีปประยกุตใ์ชอ้ยา่งสร้างสรรคป์ลอดภยั 

ต่อชีวิต และ สังคม โดยใช้ทักษะการส่ือสาร กระบวนการคิด การแก้ปัญหา การใช้ทักษะชีวิต        

และกระบวนการเทคโนโลยี เห็นคุณค่าและมีเจตคติที่ ดีต่อการงานอาชีพและเทคโนโลย ี                   

รักใฝ่รู้ใฝ่เรียน มุ่งมัน่ในการทาํงาน มีวนิยั อยูอ่ยา่งพอเพยีง ซ่ือสัตยสุ์จริต  การทาํงานอยา่งมีจิตสาํนึก  

ความรับผิดชอบ  สํารวจตนเองเพื่อวางแผนในการเลือกอาชีพ เพื่อให้เกิดความรู้ความสามารถ        

และคุณธรรมที่สัมพนัธ์กบัอาชีพตามความสนใจเป็นแนวทางในการพฒันาอาชีพ และมีเจตคติที่ดี    

ต่ออาชีพ   

 

รหัสตัวช้ีวัด 

 ง 1.1 ป.6/1, ป.6/2, ป.6/3  

 ง 2.1  ป.6/1, ป.6/2, ป.6/3   

 ง 3.1  ป.6/1, ป.6/2, ป.6/3, ป.6/4, ป.6/5 

 ง 4.1  ป.6/1, ป.6/2 

รวมทั้งหมด  13  ตัวช้ีวัด 
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ตัวช้ีวัด  สาระการเรียนรู้แกนกลางและสาระการเรียนรู้ท้องถิ่น 

 
สาระที่ 1  การดํารงชีวิตและครอบครัว   

มาตรฐาน ง 1.1  เขา้ใจการทาํงาน มีความคิดสร้างสรรค ์มีทกัษะกระบวนการทาํงาน ทกัษะการจดัการ 

ทกัษะกระบวนการแกปั้ญหา ทกัษะการทาํงานร่วมกนั และทกัษะการแสวงหาความรู้  

มีคุณธรรม และลกัษณะนิสัยในการทาํงาน มีจิตสาํนึกในการใชพ้ลงังาน ทรัพยากร 

และส่ิงแวดลอ้ม เพือ่การดาํรงชีวติและครอบครัว 

 

ตัวช้ีวัด สาระการเรียนรู้แกนกลางและสาระการเรียนรู้ท้องถิ่น 

1. อภิปรายแนวทางในการทาํงาน  

    และปรับปรุงการทาํงานแต่ละ   

    ขั้นตอน 

2. ใชท้กัษะการจดัการในการทาํงาน  

     และมีทกัษะการทาํงานร่วมกนั 

3. ปฏิบติัตนอยา่งมีมารยาทในการ 

    ทาํงานกบัครอบครัวและผูอ่ื้น 

• การทาํงานและการปรับปรุงการทาํงาน เช่น 

- การดูแลรักษาสมบติัภายในบา้น 

- การปลูกไมด้อก หรือ ไมป้ระดบั หรือปลูกผกั หรือ

เล้ียงปลาสวยงาม 

- การบนัทึกรายรับ – รายจ่ายของหอ้งเรียน 

- การจดัเก็บเอกสารการเงิน                             

• การจดัการในการทาํงานและทกัษะการทาํงานร่วมกนั 

เช่น 

- การเตรียม ประกอบ จดัอาหารใหส้มาชิกในครอบครัว 

- การติดตั้ง  ประกอบของใชใ้นบา้น 

     - การประดิษฐข์องใช ้ ของตกแต่ง  โดยใชว้สัดุใน  

        ทอ้งถ่ินใหส้มาชิกในครอบครัวหรือเพือ่นในโอกาส  

        ต่าง ๆ                        

 •  มารยาท  เช่น 

- การทาํงานกบัสมาชิกในครอบครัวและผูอ่ื้น                       

 
 
 

 

 

 

104 



 
  

 

สาระที่ 2 การออกแบบและเทคโนโลยี 

มาตรฐาน ง 2.1  เขา้ใจเทคโนโลยแีละกระบวนการเทคโนโลย ีออกแบบและสร้างส่ิงของเคร่ืองใช ้ 

                        หรือวธีิการ ตามกระบวนการเทคโนโลยอียา่งมีความคิดสร้างสรรค ์เลือกใช ้

                        เทคโนโลยใีนทางสร้างสรรคต์่อชีวติ สงัคม ส่ิงแวดลอ้ม และมีส่วนร่วมในการ 

                        จดัการเทคโนโลย ีที่ย ัง่ยนื 

 

 

 

 

 

 

ตัวช้ีวัด สาระการเรียนรู้แกนกลางและสาระการเรียนรู้ท้องถิ่น 

1. อธิบายส่วนประกอบของระบบ 

    เทคโนโลย ี

2. สร้างส่ิงของเคร่ืองใชต้ามความ 

    สนใจ อยา่งปลอดภยั โดยกาํหนด 

    ปัญหา หรือ ความตอ้งการ   

    รวบรวมขอ้มูล เลือก วธีิการ   

    ออกแบบโดย ถ่ายทอดความคิด  

    เป็นภาพร่าง 3 มิติ หรือแผนที่  

    ความคิด  ลงมือสร้าง และ        

    ประเมินผล 

3. นาํความรู้และทกัษะการสร้าง 

    ช้ินงานไป ประยกุตใ์นการสร้าง 

    ส่ิงของ เคร่ืองใช ้

 

• ระบบเทคโนโลย ีประกอบดว้ย ตวัป้อน (Input)  

กระบวนการ (Process) และผลลพัธ ์(Output) 

• การสร้างส่ิงของเคร่ืองใช ้ อยา่งเป็นขั้นตอนตั้งแต่

กาํหนดปัญหา หรือความตอ้งการ รวบรวมขอ้มูล 

เลือกวธีิการ ออกแบบโดยถ่ายทอดความคิดเป็นภาพ

ร่าง  3 มิติ  หรือแผนที่ความคิด ก่อนลงมือสร้าง และ

ประเมินผล ทาํใหผู้เ้รียนทาํงานอยา่งเป็น

กระบวนการ 

• ภาพร่าง  3 มิติ  ประกอบดว้ย  ดา้นกวา้ง  ดา้นยาว   

    และดา้นสูง เป็นการถ่ายทอดความคิดหรือ

จินตนาการ 

• แผนที่ความคิด เป็นการลาํดบัความคิดใหเ้ห็นเป็น

ขั้นตอน  และเป็นการถ่ายทอดความคิดหรือ

จินตนาการรูปแบบหน่ึง 

• ทกัษะการเจาะเป็นความสามารถพื้นฐานในการ

สร้างช้ินงานอีกดา้นหน่ึง  ซ่ึงเกิดจากการฝึกฝนจน

สามารถปฏิบติังานไดค้ล่องแคล่ว รวดเร็ว 
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สาระที่ 3 เทคโนโลยีสารสนเทศและการส่ือสาร 

มาตรฐาน ง 3.1 เขา้ใจ เห็นคุณค่า และใชก้ระบวนการเทคโนโลยสีารสนเทศในการสืบคน้ขอ้มูลการ   

  เรียนรู้ การส่ือสาร การแกปั้ญหา การทาํงาน และอาชีพอยา่งมีประสิทธิภาพ ประสิทธิผล  

  มีคุณธรรม  

ตัวช้ีวัด สาระการเรียนรู้แกนกลางและสาระการเรียนรู้ท้องถิ่น 

1. บอกหลกัการเบื้องตน้ของการ 

    แกปั้ญหา 

2. ใชค้อมพวิเตอร์ในการคน้หาขอ้มูล 

3. เก็บรักษาขอ้มูลที่เป็นประโยชน์ใน 

    รูปแบบต่างๆ 

4. นาํเสนอขอ้มูลในรูปแบบที่  

    เหมาะสม โดยเลือกใชซ้อฟตแ์วร์  

    ประยกุต ์

5. ใชค้อมพวิเตอร์ช่วยสร้างช้ินงาน  

    จากจินตนาการหรืองานที่ทาํใน 

    ชีวติประจาํวนัอยา่งมีจิตสาํนึก   

    และความรับผดิชอบ 

•  หลกัการเบ้ืองตน้ของการแกปั้ญหา  

     -   พจิารณาปัญหา -   วางแผนแกปั้ญหา 

     -   แกปั้ญหา  -   ตรวจสอบและปรับปรุง 

•  การใชค้อมพิวเตอร์ในการคน้หาขอ้มูล  เช่น คน้หา

ข้อมูลในเคร่ืองคอมพิว เตอ ร์ ค้นหาข้อมูลจา ก

อินเทอร์เน็ต  คน้หาขอ้มูลจากซีดีรอม 

•  การเก็บรักษาขอ้มูลในรูปแบบต่างๆ  

-   สาํเนาถาวร  เช่น  เอกสาร แฟ้มสะสมงาน 

-   ส่ือบนัทึก   เช่น เทป แผน่บนัทึก ซีดีรอม   

•   หน่วยความจาํแบบแฟลช 

• การจดัทาํขอ้มูลเพือ่การนาํเสนอ รูปแบบของ 

  ขอ้มูลใหเ้หมาะสมกบัการส่ือ ความหมายที่เขา้ใจ 

  ง่ายและชดัเจน เช่น กราฟ ตาราง แผนภาพ รูปภาพ  

• การใช้ซอฟต์แวร์นําเสนอ เช่น การสร้างสไลด ์        

      การตกแต่งสไลด ์การกาํหนดเทคนิคพเิศษ 

• การเลือกใช้ซอฟต์แวร์ประยุกต์ให้เหมาะสมกับ   

รูปแบบการนาํเสนอ เช่น นาํเสนอรายงานเอกสาร

โดยใช้ซอฟต์แวร์  ประมวลคํา  นํา เสนอแบบ

บรรยายโดยใชซ้อฟตแ์วร์นาํเสนอ 

• การสร้างช้ินงานต้องมีการวางแผนงานและการ 

      ออกแบบอยา่งสร้างสรรค ์ 

• ใช้คอมพิวเตอร์ช่วยสร้างช้ินงาน เช่น แผ่นพับ           

       ป้ายประกาศ เอกสารแนะนาํช้ินงาน สไลด ์
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สาระที่ 4 การอาชีพ   

มาตรฐาน ง 4.1  เขา้ใจ มีทกัษะที่จาํเป็นมีประสบการณ์เห็นแนวทางในงานอาชีพ  ใชเ้ทคโนโลย ี

  เพือ่พฒันาอาชีพ  มีคุณธรรม และมีเจตคติท่ีดีต่ออาชีพ 

 

ตัวช้ีวัด สาระการเรียนรู้แกนกลางและสาระการเรียนรู้ท้องถิ่น 

 1.  สาํรวจตนเองเพือ่วางแผนในการเลือก 

      อาชีพ 

 2. ระบุความรู้  ความสามารถ   และ 

     คุณธรรมที่สมัพนัธก์บัอาชีพที่สนใจ 

•  การสาํรวจตนเอง 

          -  ความสนใจ  ความสามารถ และทกัษะ 

•  คุณธรรมในการประกอบอาชีพ  เช่น 

         -  ความซ่ือสตัย ์

         -  ความขยนั  อดทน 

         -   ความยติุธรรม 

         -  ความรับผดิชอบ                

 

 

 

 

 

 

 

 

 

 

 

 

ตัวช้ีวัด สาระการเรียนรู้แกนกลางและสาระการเรียนรู้ท้องถิ่น 

        นาํเสนอ ขอ้มูล โดยมีการอ้างอิงแหล่งขอ้มูล ใช ้

       ทรัพยากร อย่างคุม้ค่า ไม่คดัลอกผลงานผูอ่ื้น ใช ้

      คาํสุภาพและไม่สร้างความเสียหายต่อผูอ่ื้น 
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วิเคราะห์ตัวช้ีวัดและสาระการเรียนรู้แกนกลางการศึกษาข้ันพืน้ฐาน พุทธศักราช  2551 

กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลยี วิชาคอมพิวเตอร์ ช้ันประถมศึกษาปีที่ 6 

    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

สาระที่ 1 การดํารงชีวิตและครอบครัว 

1.1 อภิปรายแนวทางในการทาํงานและปรับปรุงการทาํงานแต่ละขั้นตอน    

1.2 ใชท้กัษะการจดัการในการทาํงาน และมีทกัษะการทาํงานร่วมกนั   

1.3 ปฏิบติัตนอยา่งมีมารยาทในการทาํงานกบัครอบครัวและผูอ่ื้น        

 

 

วิชา 

คอมพิวเตอร์ 

สาระที่ 2 การออกแบบและเทคโนโลย ี

2.1 อธิบายส่วนประกอบของระบบเทคโนโลยี   

2.2 สร้างส่ิงของเคร่ืองใช้ตามความสนใจ อย่างปลอดภัย โดยกําหนด 

      ปัญหา หรือความต้องการ รวบรวมขอ้มูล เลือกวิธีการ ออกแบบโดย 

      ถ่ายทอดความคิดเป็นภาพร่าง 3 มิติ หรือแผนท่ีความคิด ลงมือสร้าง  

      และ ประเมินผล   

2.3 นาํความรู้และทกัษะการสร้างช้ินงานไป ประยุกต์ในการสร้างส่ิงของ 

      เคร่ืองใช ้

 
สาระที่ 3 เทคโนโลยสีารสนเทศและการส่ือสาร 

3.1 บอกหลกัการเบ้ืองตน้ของการแกปั้ญหา     

3.2 ใชค้อมพิวเตอร์ในการคน้หาขอ้มูล  

3.3 เก็บรักษาขอ้มูลท่ีเป็นประโยชน์ในรูปแบบต่างๆ 

3.4 นาํเสนอขอ้มูลในรูปแบบท่ีเหมาะสม โดยเลือกใชซ้อฟต์แวร์ประยุกต ์  

3.5 ใช้คอมพิวเตอร์ช่วยสร้างช้ินงานจากจินตนาการหรืองานท่ีทําใน 

      ชีวิตประจาํวนัอยา่งมีจิตสาํนึก และความรับผิดชอบ 

 

 สาระที่ 4 การอาชีพ 

4.1 สาํรวจตนเองเพ่ือวางแผนในการเลือกอาชีพ 

4.2 ระบุความรู้ ความสามารถ และคุณธรรมท่ีสมัพนัธ์กบัอาชีพท่ีสนใจ 
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วิเคราะห์หน่วยการเรียนรู้ตามมาตรฐานการเรียนรู้ / ตัวช้ีวัด 

กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ีวชิาคอมพวิเตอร์ ชั้นประถมศึกษาปีที่ 6      

จากโรงเรียนต่างๆ ของสาํนักงานเขตพื้นที่การศึกษาประถมศึกษาปทุมธานี เขต 2 จาํนวน 

67 โรงเรียน  ซ่ึ งมีผลสรุปความคิดเห็นไปในทิศทางเดียวกันให้เ ลือกทําการสอนบทเรียน                 

ผา่นสมาร์ทโฟน รายวชิา คอมพวิเตอร์ ชั้นประถมศึกษาปีท่ี 6  ซ่ึงผูว้ิจยัวิเคราะห์ สาระการเรียนรู้ที่ 3 

เทคโนโลยสีารสนเทศและการส่ือสาร เน่ืองจากผลการสาํรวจความคิดเห็นของผูเ้ช่ียวชาญทางดา้น

เน้ือหาของครูคอมพิวเตอร์ ที่อยูใ่นสาระการเรียนรู้ที่ 3  หัวขอ้ที่ 3.4 นําเสนอขอ้มูลในรูปแบบท่ี

เหมาะสมโดยเลือกใชซ้อฟตแ์วร์ประยกุตด์ว้ยโปรแกรม Adobe Dreamweaver CS5 โดยไดว้ิเคราะห์

หน่วยการเรียนรู้ตามมาตรฐาน การเรียนรู้ / ตวัช้ีวดั กลุ่มสาระการเรียนรู้การงานอาชีพและเทคโนโลย ี

วิชา คอมพิวเตอร์ชั้นประถมศึกษาปีที่ 6  ตามหลกัสูตรแกนกลางการศึกษาขั้นพื้นฐาน พุทธศกัราช 

2551 ดงัรายละเอียดต่อไปน้ี 

 

 

 
 
 
 
 
 
 
 

มาตรฐาน 
การเรียนรู้ / ตัวช้ีวัด 

สาระสําคญั/ 
ความคดิรวบยอด 

เวลา  

ช่ัวโมง 
นํ้าหนัก

คะแนน 
ภาระงาน / 

ช้ินงานรวบยอด 
ง 3.1 ป.6/4 

 

การใชค้อมพวิเตอร์ในการนาํเสนอ

ขอ้มูลโดยใช ้Adobe Dreamweaver 

CS5 จะตอ้งพจิารณา ถึงรูปแบบที่

เหมาะสม จึงจะทาํใหก้ารนาํเสนอ

ขอ้มูลมีความน่าสนใจ ส่ือความหมาย 

ไดอ้ยา่งชดัเจน และถูกตอ้ง 

8 20 - ใบงาน 
- แบบทดสอบ 
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โครงสร้างรายวิชา หน่วยการเรียนรู้ที ่6 การพัฒนาเว็บไซต์ 

กลุ่มสาระการเรียนรู้  การงานอาชีพและเทคโนโลย ี รหสัวชิา ง 16101   

รายวชิาคอมพวิเตอร์  ชั้นประถมศึกษาปีที่ 6     

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

แผนการจดัการเรียนรู้ที่ 2  

การใส่รูปภาพลงในเวบ็เพจ 

เร่ืองท่ี 2.1 การตกแต่งเวบ็เพจดว้ยรูปภาพและการจดัการรูปภาพ 

เร่ืองท่ี 2.2 การเปล่ียนพ้ืนหลงัเวบ็เพจและการใส่กรอบให้รูปภาพ 

หน่วยการเรียนรู้ที่ 6 

การพฒันาเวบ็ไซต ์ 

แผนการจดัการเรียนรู้ที่ 1  

การใส่ขอ้ความลงในเวบ็เพจ 

เร่ืองท่ี 1.1 การสร้างขอ้ความในหนา้เวบ็ไซต ์

 

แผนการจดัการเรียนรู้ที่ 3  

การใส่ส่ือแบบมลัติมีเดียลงในเวบ็เพจ 

เร่ืองท่ี 3.1 การแทรกส่ือแบบมลัติมีเดียในเวบ็ไซต ์

 

แผนการจดัการเรียนรู้ที่ 4  

  การสร้างตารางลงในเวบ็เพจ 

เร่ืองท่ี 4.1 การสร้างตารางและการปรับแต่งตาราง  

เร่ืองท่ี 4.2 การตกแต่งตารางในหนา้เวบ็เพจ 

แผนการจดัการเรียนรู้ที่ 5  

  การเช่ือมโยงเวบ็เพจ 

เร่ืองท่ี 5.1 การสร้างลิงคจ์ากขอ้ความและขอ้ความ 

เร่ืองท่ี 5.2 การสร้างลิงคย์งัเวบ็ไซตอ่ื์น 
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กําหนดการสอนรายช่ัวโมง 
 หน่วยการเรียนรู้ท่ี 6 การพฒันาเวบ็ไซต ์

กลุ่มสาระการเรียนรู้  การงานอาชีพและเทคโนโลย ี รหสัวชิา ง 16101 

 รายวิชาคอมพวิเตอร์  ชั้นประถมศึกษาปีที่ 6 เวลา  8  ชัว่โมง 

หน่วย 

การเรียนรู้ 
แผนการจัดการเรียนรู้ 

เวลา 

(ช่ัวโมง) 

หน่วย 

การเรียนรู้ 

ที่ 6 

 

1. การใส่ขอ้ความลงในเวบ็เพจ 

เร่ืองที่ 1.1 การสร้างขอ้ความในหนา้เวบ็ไซต ์ 1 

2. การใส่รูปภาพลงในเวบ็เพจ  

เร่ืองที่ 2.1 การตกแต่งเวบ็เพจดว้ยรูปภาพและการจดัการรูปภาพ 1 

เร่ืองที่ 2.2 การเปล่ียนพื้นหลงัเวบ็เพจและการใส่กรอบใหรู้ปภาพ 1 

3. การใส่ส่ือแบบมลัติมีเดียลงในเวบ็เพจ 

เร่ืองที่ 3.1 การแทรกส่ือแบบมลัติมีเดียในเวบ็ไซต ์ 1 

4. การสร้างตารางลงในเวบ็เพจ 

เร่ืองที่ 4.1 การสร้างตารางและการปรับแต่งตาราง 1 

เร่ืองที่ 4.2 การตกแต่งตารางในหนา้เวบ็เพจ 1 

5. การเช่ือมโยงเวบ็เพจ 

เร่ืองที่ 5.1 การสร้างลิงคจ์ากขอ้ความและขอ้ความ 1 

เร่ืองที่ 5.2 การสร้างลิงคย์งัเวบ็ไซตอ่ื์น 1 

 

 

 

 

 

 

 

 

 

 

111 



 
  

 

การวิเคราะห์วัตถุประสงค์เชิงพฤติกรรม 

แผนการจดัการเรียนรู้ที่ 1 การใส่ขอ้ความลงในเวบ็เพจ 

 

สาระสําคญั/ความคดิรวบยอด 

             การสร้างข้อความในหน้าเว็บไซต์จะมีลักษณะคล้ายกับการพิมพ์เอกสารในโปรแกรม

ไมโครซอฟต์เวิร์ด ซ่ึงสามารถพิมพ์ข้อความลงในหน้า เว็บเพจได้ทันที  โดยที่สามารถปรับ                

และใส่ลูกเล่นให้กบัขอ้ความได ้คือการเปล่ียนรูปแบบขอ้ความ เปล่ียนสี เปล่ียนขนาดของขอ้ความ    

จดัตาํแหน่งของขอ้ความใหส้วยงามและเป็นระเบียบเป็นท่ีน่าสนใจแก่ผูเ้ขา้ชมเวบ็ไซตไ์ด ้

 

จุดประสงค์การเรียนรู้เชิงพฤติกรรม สาระการเรียนรู้ เวลา 

(2 ช่ัวโมง) 

1) รู้และเขา้ใจการสร้างขอ้ความบนเวบ็เพจ  

ไดอ้ยา่งถูกตอ้ง 

2) สร้างขอ้ความลงบนเว็บเพจได้อย่าง

ถูกตอ้ง 

3) นําความรู้เก่ียวกับการสร้างข้อความ    

ไปใชใ้นชีวิตประจาํวนัได้อย่างถูกตอ้ง

เหมาะสม 

เร่ืองที่ 1.1 การสร้างขอ้ความในหนา้

เวบ็ไซต ์

1 
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การวิเคราะห์วัตถุประสงค์เชิงพฤติกรรม 

แผนการจดัการเรียนรู้ที่ 2  การใส่รูปภาพลงในเวบ็เพจ 

 

สาระสําคญั/ความคดิรวบยอด 
          การสร้างเวบ็เพจ จาํเป็นตอ้งมีความรู้เบื้องตนเก่ียวกบัการแทรกรูปภาพลงในเวบ็เพจ การปรับ

ขนาดรูปภาพ การเขียนขอ้ความอธิบายรูปภาพ และการใส่ลูกเล่นให้กับรูปภาพ เพราะช่วยทาํให ้    

เวบ็เพจมีความสวยงาม มีสีสันที่หน้าสนใจ และส่ือความหมายไดดี้ขึ้น ดังนั้นการออกแบบเว็บเพจ    

จึงจํา เป็นต้องรู้วิ ธีการใส่รูปภาพพื้นหลังของเว็บเพจ และการใส่กรอบให้รูปภาพ เพื่อเพิ่ม             

ความสวยงามใหเ้วบ็ไซตน่์าสนใจมากยิง่ขึ้น 

 

จุดประสงค์การเรียนรู้เชิงพฤติกรรม สาระการเรียนรู้ เวลา 

(2 ช่ัวโมง) 

1)  รู้และเข้าใจหลักการแทรกรูปภาพ        

ไดอ้ยา่งถูกตอ้ง 

2) แทรกรูปภาพและการจัดการรูปภาพ      

ไดอ้ยา่งถูกตอ้ง 

3) นาํความรู้เก่ียวกบัการแทรกรูปภาพ    

ไปใชใ้นชีวติประจาํวนัไดอ้ยา่ง

เหมาะสม 

เร่ืองที่ 2.1 การตกแต่งเวบ็เพจดว้ย

รูปภาพและการจดัการรูปภาพ 

1 

เร่ืองที่ 2.2 การเปล่ียนพื้นหลงัเวบ็เพจ

และการใส่กรอบใหรู้ปภาพ 

1 

 

 

 

 

 

 

 

 

 

 

113 



 
  

 

การวิเคราะห์วัตถุประสงค์เชิงพฤติกรรม 

แผนการจดัการเรียนรู้ที่ 3  การแทรกส่ือแบบมลัติมีเดียลงในเวบ็เพจ 

 
สาระสําคญั/ความคดิรวบยอด 
 การสร้างเว็บไซตส์ามารถแทรกมัลติมีเดียในเว็บไซต์ในหน้าเวบ็เพจได้ คือการแทรกวีดีโอ 

เสียงเพลง ตัวหนังสือแบบแฟลช ซ่ึงทาํให้เว็บเพจท่ีเราสร้างขึ้นได้ มีความสวยงามและมีความ

น่าสนใจแก่ผูเ้ยีย่มชมมากยิง่ขึ้น 

 

จุดประสงค์การเรียนรู้เชิงพฤติกรรม สาระการเรียนรู้ เวลา 

(2ช่ัวโมง) 

1) รู้และเขา้ใจการแทรกส่ือแบบมลัติมีเดีย

ในเวบ็เพจไดอ้ยา่งถูกตอ้ง 

2) การแทรกส่ือแบบมลัติมีเดียในเวบ็เพจ  

ไดอ้ยา่งถูกตอ้ง 

3) แทรกส่ือแบบมัล ติมี เดียในเว็บ เพจ     

ไปใชใ้นชีวติประจาํวนัไดอ้ยา่งถูกตอ้ง 

เร่ืองที่ 3.1 การแทรกส่ือแบบมลัติมีเดีย

ในเวบ็ไซต ์

1 
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การวิเคราะห์วัตถุประสงค์เชิงพฤติกรรม 

แผนการจดัการเรียนรู้ที่ 4  การสร้างตารางลงในเวบ็เพจ 

                                                                                       
สาระสําคญั/ความคดิรวบยอด 
 การสร้างหนา้เวบ็เพจ มีขั้นตอนการทาํงานที่หลากหลาย ส่ิงที่ควรรู้เก่ียวกบัการสร้างหน้าเวบ็เพจ 

คือ การสร้างตาราง การใส่ขอ้มูล และคาํสั่งต่างๆ ท่ีใชใ้นการตกแต่งตารางซ่ึงขอ้ดีการสร้างเวบ็เพจ   

ด้วยตารางคือ หน้าเว็บเพจเป็นระเบียบเรียบร้อย ทาํให้การจัดหน้าเว็บเพจเป็นสัดส่วน ง่ายต่อ           

การออกแบบเวบ็เพจและสามารถสร้างเวบ็เพจไดอ้ยา่งมีประสิทธิภาพมากยิง่ขึ้น  

 

จุดประสงค์การเรียนรู้เชิงพฤติกรรม สาระการเรียนรู้ เวลา 

(ช่ัวโมง) 

1) รู้และเขา้ใจการสร้างตารางลงในเวบ็เพจ  

     ไดอ้ยา่งถูกตอ้ง 

2)  ใชค้าํสัง่สร้างตารางลงในเวบ็เพจ                 

ไดอ้ยา่งถูกตอ้ง 

3) นาํความรู้เก่ียวกบัการสร้างตารางลงใน

เวบ็เพจไดอ้ยา่งเหมาะสมกบัสถานการณ์ 

 

เร่ืองที่ 4.1 การสร้างตารางและการ

ปรับแต่งตาราง 

1 

เร่ืองที่ 4.2 การตกแต่งตารางในหน้า

เวบ็เพจ 

1 
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การวิเคราะห์วัตถุประสงค์เชิงพฤติกรรม 

แผนการจดัการเรียนรู้ที่ 5  การเช่ือมโยงเวบ็เพจ 

                                                                                       
สาระสําคญั/ความคดิรวบยอด 
 การสร้างเว็บไซต์ มีส่ิงที่สําคญัท่ีสุดในการสร้างเว็บเพจ คือการสร้างลิงค์หรือการเช่ือมโยง

ระหว่างเวบ็เพจ เพื่อการศึกษาขอ้มูลของผูเ้ขา้ชมเวบ็ไซตมี์ความต่อเน่ือง โดยกรสร้างลิงค ์(Link) ใน

เวบ็ไซตจ์ะมีอยูท่ ั้งหมด 3 แบบ คือการสร้างลิงคข์อ้ความ การสร้างลิงคจ์ากรูปภาพ และการสร้างลิงค์

ไปยงัเวบ็ไซตอ่ื์น  

 

จุดประสงค์การเรียนรู้เชิงพฤติกรรม สาระการเรียนรู้ เวลา 

(ช่ัวโมง) 

1) รู้และเขา้ใจการเช่ือมโยงลงในเวบ็เพจ  

     ไดอ้ยา่งถูกตอ้ง 

2)  ใชค้าํสัง่การเช่ือมโยงลงในเวบ็เพจ      

ไดอ้ยา่งถูกตอ้ง 

3) นาํความรู้เก่ียวกบัการเช่ือมโยงลงในเวบ็

เพจไดอ้ยา่งเหมาะสมกบัสถานการณ์ 

เร่ืองที่ 5.1 การสร้างลิงค์จากขอ้ความ

และขอ้ความ 

1 

เร่ืองที่ 5.2 การสร้างลิงคย์งัเวบ็ไซตอ่ื์น 1 
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ภาคผนวก ค 

แผนการจัดการเรียนรู้ 

 

- แบบบันทกึแผนการจัดการเรียนรู้

 



 
  

 

แบบบันทึกแผนการจัดการเรียนรู้ 

 

หน่วยการเรียนรู้ที่  6  การพัฒนาเว็บไซต์                       8  ช่ัวโมง    

แผนการจัดการเรียนรู้ที่ 1  เร่ือง การสร้างข้อความในหน้าเว็บเพจ       เวลาเรียน  1  ช่ัวโมง 

สอนวันที่ .........เดือน ................................. พ.ศ.2557           ภาคเรียนที่ 1/2557 

 

1.  มาตรฐานการเรียนรู้/ตัวช้ีวัด 

 มาตรฐาน 3.1  เขา้ใจ เห็นคุณค่า และใชก้ระบวนการเทคโนโลยีสารสนเทศในการสืบคน้ขอ้มูล

การเรียนรู้ การส่ือสาร การแกปั้ญหา การทาํงาน และอาชีพอยา่งมีประสิทธิภาพ ประสิทธิผล มีคุณธรรม 

 ตัวช้ีวัด 

 ง3.1 ป6/4 นาํเสนอขอ้มูลในรูปแบบที่เหมาะสมโดยเลือกใชซ้อฟตแ์วร์ประยกุต ์

2.  จุดประสงค์การเรียนรู้ 

 1. รู้และเขา้ใจการสร้างขอ้ความบนเวบ็เพจไดอ้ยา่งถูกตอ้ง 

 2. สร้างขอ้ความลงบนเวบ็เพจไดอ้ยา่งถูกตอ้ง 

 3. นาํความรู้เก่ียวกบัการสร้างขอ้ความไปใชใ้นชีวติประจาํวนัไดอ้ยา่งถูกตอ้งเหมาะสม 

3. สาระสําคญั/ความคดิรวบยอด 

 การสร้างข้อความในหน้า เว็บไซต์จะมีลักษณะคล้ายกับการพิมพ์เอกสารในโปรแกรม

ไมโครซอฟต์เวิร์ด ซ่ึงสามารถพิมพ์ข้อความลงในหน้าเว็บเพจได้ทันที โดยที่สามารถปรับ                

และใส่ลูกเล่นให้กบัขอ้ความได ้คือการเปล่ียนแนวคิดขอ้ความ เปล่ียนสี เปล่ียนขนาดของขอ้ความ    

จดัตาํแหน่งของขอ้ความใหส้วยงามและเป็นระเบียบเป็นท่ีน่าสนใจแก่ผูเ้ขา้ชมเวบ็ไซตไ์ด ้

2. ตัวช้ีวัด/จุดประสงค์การเรียนรู้ 

 2.1 ตัวช้ีวัด  

               ง 3.1  ป.6/4  นาํเสนอขอ้มูลในแนวคิดที่เหมาะสมโดยเลือกใชซ้อฟตแ์วร์ประยกุต ์   

 2.2 จุดประสงค์การเรียนรู้ 

  1. รู้และเขา้ใจการสร้างขอ้ความบนเวบ็เพจไดอ้ยา่งถูกตอ้ง 

  2. สร้างขอ้ความลงบนเวบ็เพจไดอ้ยา่งถูกตอ้ง 

  3. นาํความรู้เก่ียวกบัการสร้างขอ้ความไปใชใ้นชีวติประจาํวนัไดอ้ยา่งถูกตอ้งเหมาะสม 
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3. สาระการเรียนรู้ 

 3.1 สาระการเรียนรู้แกนกลาง 

  1) การจดัทาํขอ้มูลเพื่อการนาํเสนอตอ้งพิจารณาแนวคิดของขอ้มูลให้เหมาะสมกบัการส่ือ

ความหมายที่เขา้ใจง่าย  และชดัเจน เช่น กราฟ ตาราง แผนภาพ รูปภาพ 

2) การใชซ้อฟตแ์วร์นําเสนอ  เช่น  การสร้างสไลด์  การตกแต่งสไลด์ การกาํหนดเทคนิค

พเิศษในการนาํเสนอ  

3) การเลือกใชซ้อฟตแ์วร์ประยกุตใ์หเ้หมาะสมกบัรูปแบบการนาํเสนอ เช่น นาํเสนอรายงาน 

เอกสารโดยใชซ้อฟตแ์วร์ประมวลคาํ นาํเสนอแบบบรรยายโดยใชซ้อฟตแ์วร์นาํเสนอ 

4. กิจกรรมการเรียนรู้ 

ข้ันที่ 1 ศึกษาค้นคว้า เพื่อสร้างให้เป็นบุคคลรอบรู้ (Personal Mastery) 

1. นาํเขา้สู่บทเรียนโดยการกระตุน้เร้าด้วยการให้นักเรียนศึกษารูปแบบเว็บไซตด์้วย

โปรแกรมเวบ็บราวเซอร์ เพือ่ใหน้กัเรียนมีความกระตือรือร้น เกิดความสนใจในบทเรียน 

2. นักเรียนเขา้ไปศึกษา บทเรียนผ่านสมาร์ทโฟน เร่ืองการพฒันาเว็บไซต์ สําหรับ

นกัเรียน ชั้นประถมศึกษาปีที่ 6 โดยศึกษาขั้นตอนวธีิการเขา้ใชง้าน จากคู่มือการใชง้าน 

3. นักเรียนดูผลงานเวบ็ไซต ์ท่ีมีการสร้างขอ้ความบนเวบ็เพจ เพื่อสร้างแรงจูงใจและ

ความสนใจใฝ่เรียนรู้ใหน้กัเรียนเกิดความสนใจ 

4.  นกัเรียนทาํแบบทดสอบก่อนเรียน เร่ือง การใส่ขอ้ความลงบนเวบ็เพจ จาํนวน 5 ขอ้ 

5. ดาํเนินกิจกรรมตามบทเรียนผ่านสมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้               

ในทุกขั้นตอน นักเรียนจะมีการแลกเปล่ียนเรียนรู้กับเพื่อนร่วมเรียนรู้ และขอคาํแนะนําจากครู         

ผา่นทางหอ้งสนทนาอิเล็กทรอนิกส์ (Chat Room) และกระดานเสวนา (Web board) โดยมีขั้นตอนดงัน้ี 

 5.1 เลือกและระบุกิจกรรมที่ตอ้งการเรียนรู้ 

 นักเรียนเลือกศึกษาเน้ือหาของบทเรียนตามที่ตนเองสนใจ จากบทเรียน              

ที่กาํหนดให ้ 

ข้ันที่ 2 ข้ันเขียนแผนผังความคดิเพื่อสร้างกรอบแนวคดิ (Mental Models) 

นกัเรียนสรุปแผนผงัความคิดการสร้างขอ้ความลงบนเวบ็เพจ  

ข้ันที่ 3 ข้ันแสดงวิสัยทัศน์ร่วมกัน (Shared Vision) 

นัก เ รียนแลกเป ล่ียนความรู้  ประสบการณ์  การสร้างข้อความลงบนเว็บ เพจ                  

ผา่นช่องทางหอ้งสนทนาอิเล็กทรอนิกส์ (Chat Room) กระดานเสวนา (Web board)  
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ข้ันที่ 4 ข้ันเรียนรู้ร่วมกันเป็นทีม (Team Learning) 

1. กาํหนดหนา้ที่การทาํงานเป็นทีม นกัเรียนมีการผลดัเปล่ียนหน้าที่กนั โดยให้นักเรียน

ระบุวา่นกัเรียนทาํหนา้ที่อะไร เช่น 

1.1 คน้ควา้หาขอ้มูลการสร้างขอ้ความลงเวบ็เพจ   

1.2 รวบรวม เรียบเรียงขอ้มูลการสร้างขอ้ความลงเวบ็เพจ  

1.3 สรุปแผนผงัความคิดการสร้างขอ้ความลงบนเวบ็เพจ  

1.4 แลกเปล่ียนความรู้การสร้างขอ้ความลงบนเว็บเพจผ่านช่องทางห้องสนทนา

อิเล็กทรอนิกส์ (Chat Room) กระดานเสวนา (Web board) 

ข้ันที่ 5 สร้างความคดิเชิงระบบ (Systems Thinking) 

1. นักเรียนเรียนรู้ตามแผนการเรียนรู้ โดยเร่ิมจากศึกษาเน้ือหาจากบทเรียนผ่าน      

สมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้ เร่ืองการใส่ขอ้ความลงบนเวบ็เพจ หลงัจากศึกษาจนได้

คาํตอบของกิจกรรม ใหน้กัเรียนทาํกิจกรรมหลงัเรียนใหค้รบทุกขอ้ 

2. นาํเสนอผลงานการเรียนรู้ โดยส่งในช่องทางห้องสนทนาอิเล็กทรอนิกส์ (Chat 

Room) กระดานเสวนา (Web board) 

ข้ันสรุปผลการเรียนรู้ 

นักเรียนร่วมกันสรุปบทเรียน เร่ือง การใส่ข้อความลงในเว็บเพจ พร้อมทั้งร่วม

แลกเปล่ียนเรียนรู้กบัเพือ่นร่วมเรียนรู้และผูส้อน 

ข้ันประเมินผลการเรียนรู้ 

1. ผูส้อนทาํการประเมินผลงานการเรียนรู้ของนักเรียน พร้อมทั้งให้ขอ้เสนอแนะ               

กบันกัเรียน เพือ่ที่นกัเรียนจะไดน้าํไปปรับปรุงผลงานการเรียนรู้ 

2. นกัเรียนปรับปรุงผลงานการเรียนรู้ตามขอ้เสนอแนะของผูส้อน 

5.  ส่ือ/แหล่งเรียนรู้ 

 5.1 ส่ือการเรียนรู้ 

  5.1.1 บทเรียนผ่านสมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้ เ ร่ืองการพ ัฒนา

เว็บไซต์ สาํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6   

  5.1.2 กิจกรรมหลงัเรียน 

 5.2 แหล่งการเรียนรู้ 

  -   หอ้งปฏิบติัการคอมพวิเตอร์ 
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6. การวัดและประเมินผล 

วิธีการ เคร่ืองมือ เกณฑ์ 

ตรวจแบบทดสอบก่อนเรียน  แบบทดสอบก่อนเรียน  (ประเมินตามสภาพจริง) 

ตรวจผลงาน กิจกรรมหลงัเรียน ร้อยละ 60 ผา่นเกณฑ ์

ตรวจแบบบนัทึกกิจกรรม 

การเรียนรู้ 

แบบบนัทึกกิจกรรมการเรียนรู้ ระดบัคุณภาพ 2  

ผา่นเกณฑ ์
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ผลการประเมินการปฏิบัติกิจกรรม 

 

คาํช้ีแจง ใหป้ระเมินผลการปฏิบติักิจกรรมของนกัเรียน โดยทาํเคร่ืองหมาย  ตามเกณฑท์ี่กาํหนดไว ้

1) ผลการประเมินการปฏิบัติกิจกรรมการเรียนรู้ตามแนวคิดองค์กรแห่งการเรียนรู้         

ผา่นสมาร์ทโฟน 

 ดี    พอใช ้  ปรับปรุง 

   2) ผลการประเมินการปฏิบติักิจกรรมการเรียนรู้ 

 ดี    พอใช ้  ปรับปรุง 

 

เกณฑ์การประเมนิผลการปฏิบัติกิจกรรม 

       1. เกณฑ์การประเมินผลการปฏิบัติกิจกรรมการสอนผ่านสมาร์ทโฟนตามแนวคดิองค์กร 

           แห่งการเรียนรู้ 

       ดี       หมายถึง  นกัเรียนสามารถปฏิบติักิจกรรมการสอนผา่นสมาร์ทโฟนตามแนวคิด 

                                องคก์รแห่งการเรียนรู้ไดถู้กตอ้งทุกขั้นตอน  

                   พอใช ้ หมายถึง  นกัเรียนสามารถปฏิบติักิจกรรมการสอนผา่นสมาร์ทโฟนตามแนวคิด   

                                องคก์รแห่งการเรียนรู้ไดถู้กตอ้งบางขั้นตอน 

                ปรับปรุง หมายถึง นกัเรียนสามารถปฏบิติักิจกรรมการสอนผา่นสมาร์ทโฟนตามแนวคดิ    

                                              องคก์รแห่งการเรียนรู้ไดไ้ม่ถูกตอ้ง 

       2. เกณฑ์การประเมินผลการปฏิบัติกิจกรรมการเรียนรู้ 

       ดี        หมายถึง   นกัเรียนสามารถปฏิบติัตามกิจกรรมไดถู้กตอ้งทุกขอ้ 

                 พอใช ้    หมายถึง  นกัเรียนสามารถปฏิบติัตามกิจกรรมไดถู้กตอ้งเพยีงบางขอ้ 

               ปรับปรุง   หมายถึง  นกัเรียนสามารถปฏิบติัตามกิจกรรมไดไ้ม่ถูกตอ้ง 

 

 

 

 

 

 

 

 

122 



 
  

 

แผนการจัดการเรียนรู้ที่ 2 

 

หน่วยการเรียนรู้ที่  6  การพัฒนาเว็บไซต์                                                                             8  ช่ัวโมง    

แผนการจัดการเรียนรู้ที่ 2  เร่ือง การสร้างรูปภาพในหน้าเว็บเพจ       เวลาเรียน  2  ช่ัวโมง 

สอนวันที่ .........เดือน ................................. พ.ศ.2557          ภาคเรียนที่ 1/2557 

 

1. สาระสําคญั/ความคดิรวบยอด 

 การสร้างเว็บเพจ จาํเป็นตอ้งมีความรู้เบื้องตนเก่ียวกับการแทรกรูปภาพลงในเว็บเพจ การปรับ

ขนาดรูปภาพ การเขียนขอ้ความอธิบายรูปภาพ และการใส่ลูกเล่นให้กับรูปภาพ เพราะช่วยทาํให ้    

เวบ็เพจมีความสวยงาม มีสีสันที่หน้าสนใจ และส่ือความหมายไดดี้ขึ้น ดังนั้นการออกแบบเว็บเพจ    

จึงจํา เป็นต้องรู้วิ ธีการใส่รูปภาพพื้นหลังของเว็บเพจ และการใส่กรอบให้รูปภาพ เพื่อเพิ่ม             

ความสวยงามใหเ้วบ็ไซตน่์าสนใจมากยิง่ขึ้น 

 

1.  มาตรฐานการเรียนรู้/ตัวช้ีวัด 

 มาตรฐาน 3.1  เขา้ใจ เห็นคุณค่า และใชก้ระบวนการเทคโนโลยีสารสนเทศในการสืบคน้ขอ้มูล

การเรียนรู้ การส่ือสาร การแกปั้ญหา การทาํงาน และอาชีพอยา่งมีประสิทธิภาพ ประสิทธิผล มีคุณธรรม 

 ตัวช้ีวัด 

 ง3.1 ป6/4 นาํเสนอขอ้มูลในรูปแบบที่เหมาะสมโดยเลือกใชซ้อฟตแ์วร์ประยกุต ์

 

2.  จุดประสงค์การเรียนรู้ 

  1. รู้และเขา้ใจหลกัการแทรกรูปภาพ ไดอ้ยา่งถูกตอ้ง 

  2. แทรกรูปภาพและการจดัการรูปภาพ ไดอ้ยา่งถูกตอ้ง 

  3. นาํความรู้เก่ียวกบัการแทรกรูปภาพ ไปใชใ้นชีวติประจาํวนัไดอ้ยา่งเหมาะสม 

 

3. สาระการเรียนรู้ 

 3.1 สาระการเรียนรู้แกนกลาง 

  1) การจดัทาํขอ้มูลเพื่อการนําเสนอตอ้งพิจารณารูปแบบของขอ้มูลให้เหมาะสมกับการส่ือ

ความหมายที่เขา้ใจง่ายและชดัเจน เช่น กราฟ ตาราง แผนภาพ รูปภาพ 

2) การใชซ้อฟตแ์วร์นาํเสนอ  เช่น  การสร้างสไลด ์ การตกแต่งสไลด ์การกาํหนดเทคนิค 
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พเิศษในการนาํเสนอ  

3) การเลือกใชซ้อฟตแ์วร์ประยกุตใ์หเ้หมาะสมกบัรูปแบบการนาํเสนอ เช่น นาํเสนอรายงาน 

เอกสารโดยใชซ้อฟตแ์วร์ประมวลคาํ นาํเสนอแบบบรรยายโดยใชซ้อฟตแ์วร์นาํเสนอ 

 

4. กิจกรรมการเรียนรู้ 

ข้ันที่ 1 ศึกษาค้นคว้า เพื่อสร้างให้เป็นบุคคลรอบรู้ (Personal Mastery) 

1. ครูถามนกัเรียนวา่ การนาํเสนอขอ้มูลดว้ยตวัอกัษรกบัการนาํเสนอขอ้มูลดว้ยรูปภาพ 

การนาํเสนอขอ้มูลแบบใดที่น่าสนใจมากกวา่กนั 

2. ครูสุ่มเรียกนักเรียน 2-3 คน แสดงความคิดเห็น หากนักเรียนคนใดตอบเลือก          

การนาํเสนอดว้ยรูปภาพ ใหอ้ธิบายเหตุผลเพิม่เติมดว้ย 

3. ให้นักเรียนศึกษารูปแบบของไฟล์รูปภาพมีประเภทใดบ้าง ด้วยโปรแกรม                        

เวบ็บราวเซอร์ เพือ่ใหน้กัเรียนมีความกระตือรือร้น เกิดความสนใจในบทเรียน 

4. การดําเนินกิจกรรมการสอนผ่านสมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้                

ในทุกขั้นตอน นักเรียนจะมีการแลกเปล่ียนเรียนรู้กับเพื่อนร่วมเรียนรู้ และขอคาํแนะนําจากครู        

ผา่นทางหอ้งสนทนาอิเล็กทรอนิกส์ (Chat Room) และกระดานเสวนา (Web board) โดยมีขั้นตอนดงัน้ี 

 4.1 เลือกและระบุกิจกรรมที่ตอ้งการเรียนรู้ 

         นักเรียนเลือกศึกษาเน้ือหาของบทเรียนตามที่ตนเองสนใจ  จากบทเรียน              

ที่กาํหนดให ้ 

ข้ันที่ 2 ข้ันเขียนแผนผังความคดิเพื่อสร้างกรอบแนวคดิ (Mental Models) 

นกัเรียนสรุปแผนผงัความคิดการแทรกรูปภาพลงบนเวบ็เพจ  

ข้ันที่ 3 ข้ันแสดงวิสัยทัศน์ร่วมกนั (Shared Vision) 

นัก เ รี ยนแลกเป ล่ี ยนความ รู้  ประสบการณ์  การแทรกรู ปภาพลงบนเว็บ เพจ                        

ผา่นช่องทางหอ้งสนทนาอิเล็กทรอนิกส์ (Chat Room) กระดานเสวนา (Web board)  

ข้ันที่ 4 ข้ันเรียนรู้ร่วมกันเป็นทีม (Team Learning) 

1. กาํหนดหนา้ที่การทาํงานเป็นทีม นกัเรียนมีการผลดัเปล่ียนหน้าที่กนั โดยให้นักเรียน

ระบุวา่นกัเรียนทาํหนา้ที่อะไร เช่น 

1.1 คน้ควา้หาขอ้มูลการแทรกรูปภาพลงเวบ็เพจ   

1.2 รวบรวม เรียบเรียงขอ้มูลการแทรกรูปภาพลงเวบ็เพจ 

1.3 สรุปแผนผงัความคิดการแทรกรูปภาพลงบนเวบ็เพจ 
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1.4 แลกเปล่ียนความรู้การแทรกรูปภาพลงบนเว็บเพจผ่านช่องทางห้องสนทนา

อิเล็กทรอนิกส์ (Chat Room) กระดานเสวนา (Web board) 

ข้ันที่ 5 สร้างความคดิเชิงระบบ (Systems Thinking) 

1. นักเรียนเรียนรู้ตามแผนการเรียนรู้ โดยเร่ิมจากศึกษาเน้ือหาจากบทเรียนผ่าน               

สมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้ เร่ืองการใส่รูปภาพลงบนเว็บเพจ หลังจากศึกษา                       

จนไดค้าํตอบของกิจกรรม ใหน้กัเรียนทาํกิจกรรมหลงัเรียนใหค้รบทุกขอ้ 

2. นาํเสนอผลงานการเรียนรู้ โดยส่งในช่องทางห้องสนทนาอิเล็กทรอนิกส์ (Chat 

Room) กระดานเสวนา (Web board) 

ข้ันสรุปผลการเรียนรู้ 

นักเรียนร่วมกันสรุปบทเรียน เร่ือง การใส่รูปภาพลงในเว็บเพจ พร้อมทั้งร่วม

แลกเปล่ียนเรียนรู้กบัเพือ่นร่วมเรียนรู้และผูส้อน 

ข้ันประเมินผลการเรียนรู้ 

1. ผูส้อนทาํการประเมินผลงานการเรียนรู้ของนักเรียน พร้อมทั้งให้ขอ้เสนอแนะ        

กบันกัเรียน เพือ่ที่นกัเรียนจะไดน้าํไปปรับปรุงผลงานการเรียนรู้ 

2. นกัเรียนปรับปรุงผลงานการเรียนรู้ตามขอ้เสนอแนะของผูส้อน 

5.  ส่ือ/แหล่งเรียนรู้ 

 5.1 ส่ือการเรียนรู้ 

  5.1.1 บทเรียนผ่านสมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้ เ ร่ืองการพ ัฒนา

เว็บไซต์ สาํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6   

  5.1.2 กิจกรรมหลงัเรียน 

 5.2 แหล่งการเรียนรู้ 

  -   หอ้งปฏิบติัการคอมพวิเตอร์ 

6. การวัดและประเมินผล 

วิธีการ เคร่ืองมือ เกณฑ์ 

ตรวจผลงาน ใบกิจกรรม ร้อยละ 60 ผา่นเกณฑ ์

ประเมินการนาํเสนอผลงาน แบบประเมินการนาํเสนอผลงาน ระดบัคุณภาพ 2  

ผา่นเกณฑ ์

ตรวจแบบบนัทึกกิจกรรม 

การเรียนรู้ 

แบบบนัทึกกิจกรรมการเรียนรู้ ระดบัคุณภาพ 2  

ผา่นเกณฑ ์
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ผลการประเมินการปฏิบัติกิจกรรม 

 

คาํช้ีแจง ใหน้กัเรียนประเมินผลการปฏิบติักิจกรรมของนกัเรียน โดยทาํเคร่ืองหมาย  ตามเกณฑท์ี่

กาํหนดไว ้

1) ผลการประเมินการปฏิบัติกิจกรรมการเรียนรู้ตามแนวคิดองค์กรแห่งการเรียนรู้         

ผา่นสมาร์ทโฟน 

 ดี    พอใช ้  ปรับปรุง 

   2) ผลการประเมินการปฏิบติักิจกรรมการเรียนรู้ 

 ดี    พอใช ้  ปรับปรุง 

 

เกณฑ์การประเมนิผลการปฏิบัติกิจกรรม 

       1. เกณฑ์การประเมินผลการปฏิบัติกิจกรรมการสอนผ่านสมาร์ทโฟนตามแนวคดิองค์กร 

           แห่งการเรียนรู้ 

       ดี       หมายถึง  นกัเรียนสามารถปฏิบติักิจกรรมการสอนผา่นสมาร์ทโฟนตามแนวคิด 

                                องคก์รแห่งการเรียนรู้ไดถู้กตอ้งทุกขั้นตอน  

                   พอใช ้ หมายถึง  นกัเรียนสามารถปฏิบติักิจกรรมการสอนผา่นสมาร์ทโฟนตามแนวคิด   

                                องคก์รแห่งการเรียนรู้ไดถู้กตอ้งบางขั้นตอน 

                ปรับปรุง หมายถึง นกัเรียนสามารถปฏบิติักิจกรรมการสอนผา่นสมาร์ทโฟนตามแนวคดิ    

                                              องคก์รแห่งการเรียนรู้ไดไ้ม่ถูกตอ้ง 

       2. เกณฑ์การประเมินผลการปฏิบัติกิจกรรมการเรียนรู้ 

       ดี        หมายถึง   นกัเรียนสามารถปฏิบติัตามกิจกรรมไดถู้กตอ้งทุกขอ้ 

                 พอใช ้    หมายถึง  นกัเรียนสามารถปฏิบติัตามกิจกรรมไดถู้กตอ้งเพยีงบางขอ้ 

               ปรับปรุง   หมายถึง  นกัเรียนสามารถปฏิบติัตามกิจกรรมไดไ้ม่ถูกตอ้ง 
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แผนการจัดการเรียนรู้ที่  3 

 

หน่วยการเรียนรู้ที่  6  การพัฒนาเว็บไซต์                                                                              8  ช่ัวโมง    

แผนการจัดการเรียนรู้ที่ 3  เร่ือง การแทรกส่ือแบบมัลติมีเดียลงในเว็บเพจ      เวลาเรียน  2  ช่ัวโมง 

สอนวันที่ .........เดือน ................................. พ.ศ.2557           ภาคเรียนที่ 1/2557 

 

1. สาระสําคญั/ความคดิรวบยอด 

  การสร้างเวบ็ไซต์ใน สามารถแทรกมลัติมีเดียในเว็บไซตใ์นหน้าเวบ็เพจได ้คือการแทรกวีดีโอ 

เสียงเพลง ตัวหนังสือแบบแฟลช ซ่ึงทาํให้เว็บเพจที่เราสร้างขึ้นได้ มีความสวยงามและมีความ

น่าสนใจแก่ผูเ้ยีย่มชมมากยิง่ขึ้น  

 

1.  มาตรฐานการเรียนรู้/ตัวช้ีวัด 

 มาตรฐาน 3.1  เขา้ใจ เห็นคุณค่า และใชก้ระบวนการเทคโนโลยีสารสนเทศในการสืบคน้ขอ้มูล

การเรียนรู้ การส่ือสาร การแกปั้ญหา การทาํงาน และอาชีพอยา่งมีประสิทธิภาพ ประสิทธิผล มีคุณธรรม 

 ตัวช้ีวัด 

 ง3.1 ป6/4 นาํเสนอขอ้มูลในรูปแบบที่เหมาะสมโดยเลือกใชซ้อฟตแ์วร์ประยกุต ์

 

2.  จุดประสงค์การเรียนรู้ 

  1. รู้และเขา้ใจการแทรกส่ือแบบมลัติมีเดียในเวบ็เพจ ไดอ้ยา่งถูกตอ้ง 

  2. การแทรกส่ือแบบมลัติมีเดียในเวบ็เพจ ไดอ้ยา่งถูกตอ้ง 

  3. แทรกส่ือแบบมลัติมีเดียในเวบ็เพจ ไปใชใ้นชีวติประจาํวนัไดอ้ยา่งถูกตอ้ง 

 

3. สาระการเรียนรู้ 

 3.1   สาระการเรียนรู้แกนกลาง 

  1) การจดัทาํขอ้มูลเพื่อการนําเสนอตอ้งพิจารณารูปแบบของขอ้มูลให้เหมาะสมกับการส่ือ

ความหมายที่เขา้ใจง่ายและชดัเจน เช่น กราฟ ตาราง แผนภาพ รูปภาพ 

2) การใชซ้อฟตแ์วร์นําเสนอ  เช่น  การสร้างสไลด์  การตกแต่งสไลด์ การกาํหนดเทคนิค

พเิศษในการนาํเสนอ  

3) การเลือกใชซ้อฟตแ์วร์ประยกุตใ์หเ้หมาะสมกบัรูปแบบการนาํเสนอ เช่น นาํเสนอรายงาน 
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เอกสารโดยใชซ้อฟตแ์วร์ประมวลคาํ นาํเสนอแบบบรรยายโดยใชซ้อฟตแ์วร์นาํเสนอ 

 

4. กิจกรรมการเรียนรู้ 

ข้ันที่ 1 ศึกษาค้นคว้า เพื่อสร้างให้เป็นบุคคลรอบรู้ (Personal Mastery) 

1. นกัเรียนตอบคาํถามกระตุน้ความคิด 

2. ครูถามนกัเรียนวา่ในเวบ็ไซตข์องเรามีขอ้ความ มีรูปภาพ แลว้น่าจะมีอะไรไดอี้กบา้ง

ที่น่าสนใจกวา่น้ี แลว้ใหน้กัเรียนยกตวัอยา่งและอธิบายพร้อมวา่เพราะอะไร 

3. ให้นักเรียนศึกษาไฟล์ประเภทมัลติมีเดียชนิดใดบา้ง ดว้ยโปรแกรมเว็บบราวเซอร์ 

เพือ่ใหน้กัเรียนมีความกระตือรือร้น เกิดความสนใจในบทเรียน 

4. การดําเนินกิจกรรมการสอนผ่านสมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้                

ในทุกขั้นตอน นักเรียนจะมีการแลกเปล่ียนเรียนรู้กับเพื่อนร่วมเรียนรู้ และขอคาํแนะนําจากครู        

ผา่นทางหอ้งสนทนาอิเล็กทรอนิกส์ (Chat Room) และกระดานเสวนา (Web board) โดยมีขั้นตอนดงัน้ี 

 4.1 เลือกและระบุกิจกรรมที่ตอ้งการเรียนรู้ 

         นักเรียนเลือกศึกษาเน้ือหาของบทเรียนตามที่ตนเองสนใจ  จากบทเรียน              

ที่กาํหนดให ้ 

ข้ันที่ 2 ข้ันเขียนแผนผังความคดิเพื่อสร้างกรอบแนวคดิ (Mental Models) 

นกัเรียนสรุปแผนผงัความคิดการแทรกส่ือแบบมลัติมีเดีย  

ข้ันที่ 3 ข้ันแสดงวิสัยทัศน์ร่วมกนั (Shared Vision) 

นักเรียนแลกเปล่ียนความรู้ ประสบการณ์ การแทรกส่ือแบบมัลติมีเดียลงบนเว็บเพจ                        

ผา่นช่องทางหอ้งสนทนาอิเล็กทรอนิกส์ (Chat Room) กระดานเสวนา (Web board)  

ข้ันที่ 4 ข้ันเรียนรู้ร่วมกันเป็นทีม (Team Learning) 

1. กาํหนดหนา้ที่การทาํงานเป็นทีม นกัเรียนมีการผลดัเปล่ียนหน้าที่กนั โดยให้นักเรียน

ระบุวา่นกัเรียนทาํหนา้ที่อะไร เช่น 

1.1 คน้ควา้หาขอ้มูลการแทรกส่ือแบบมลัติมีเดียลงเวบ็เพจ   

1.2 รวบรวม เรียบเรียงขอ้มูลการแทรกส่ือแบบมลัติมีเดียลงเวบ็เพจ 

1.3 สรุปแผนผงัความคิดการแทรกส่ือแบบมลัติมีเดียลงบนเวบ็เพจ 

1.4 แลกเปล่ียนความรู้การแทรกส่ือแบบมัลติมีเดียลงบนเว็บเพจผ่านช่องทาง                  

หอ้งสนทนาอิเล็กทรอนิกส์ (Chat Room) กระดานเสวนา (Web board) 
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ข้ันที่ 5 สร้างความคดิเชิงระบบ (Systems Thinking) 

1. นักเรียนเรียนรู้ตามแผนการเรียนรู้ โดยเร่ิมจากศึกษาเน้ือหาจากบทเรียนผ่าน               

สมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้ เร่ือง การแทรกส่ือแบบมัลติมีเดียลงบนเว็บเพจ  

หลงัจากศึกษาจนไดค้าํตอบของกิจกรรม ใหน้กัเรียนทาํกิจกรรมหลงัเรียนใหค้รบทุกขอ้ 

2. นําเสนอผลงานการเรียนรู้  โดยส่งในช่องทางห้องสนทนาอิเล็กทรอนิกส์                         

(Chat Room) กระดานเสวนา (Web board) 

ข้ันสรุปผลการเรียนรู้ 

นักเรียนร่วมกันสรุปบทเรียน เ ร่ือง การแทรกส่ือแบบมัลติมีเดียลงในเว็บเพจ              

พร้อมทั้งร่วมแลกเปล่ียนเรียนรู้กบัเพือ่นร่วมเรียนรู้และผูส้อน 

ข้ันประเมินผลการเรียนรู้ 

1. ผูส้อนทาํการประเมินผลงานการเรียนรู้ของนักเรียน พร้อมทั้งให้ขอ้เสนอแนะ        

กบันกัเรียน เพือ่ที่นกัเรียนจะไดน้าํไปปรับปรุงผลงานการเรียนรู้ 

2. นกัเรียนปรับปรุงผลงานการเรียนรู้ตามขอ้เสนอแนะของผูส้อน 

 

5.  ส่ือ/แหล่งเรียนรู้ 

 5.1 ส่ือการเรียนรู้ 

  5.1.1 บทเรียนผ่านสมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้ เ ร่ืองการพ ัฒนา

เว็บไซต์ สาํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6   

  5.1.2 กิจกรรมหลงัเรียน 

 5.2 แหล่งการเรียนรู้ 

  -   หอ้งปฏิบติัการคอมพวิเตอร์ 

   

6. การวัดและประเมินผล 

วิธีการ เคร่ืองมือ เกณฑ์ 

ตรวจใบงานที่ 3 ใบงานที่ 3 ร้อยละ 60 ผา่นเกณฑ ์

ประเมินการนาํเสนอผลงาน แบบประเมินการนาํเสนอผลงาน ระดบัคุณภาพ 2  

ผา่นเกณฑ ์

ตรวจแบบบนัทึกกิจกรรม 

การเรียนรู้ 

แบบบนัทึกกิจกรรมการเรียนรู้ ระดบัคุณภาพ 2  

ผา่นเกณฑ ์
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ผลการประเมินการปฏิบัติกิจกรรม 

 

คาํช้ีแจง ใหน้กัเรียนประเมินผลการปฏิบติักิจกรรมของนกัเรียน โดยทาํเคร่ืองหมาย  ตามเกณฑท์ี่ 

กาํหนดไว ้

1) ผลการประเมินการปฏิบัติกิจกรรมการเรียนรู้ตามแนวคิดองค์กรแห่งการเรียนรู้         

ผา่นสมาร์ทโฟน 

 ดี    พอใช ้  ปรับปรุง 

   2) ผลการประเมินการปฏิบติักิจกรรมการเรียนรู้ 

 ดี    พอใช ้  ปรับปรุง 

 

เกณฑ์การประเมนิผลการปฏิบัติกิจกรรม 

       1. เกณฑ์การประเมินผลการปฏิบัติกิจกรรมการสอนผ่านสมาร์ทโฟนตามแนวคดิองค์กร 

           แห่งการเรียนรู้ 

       ดี       หมายถึง  นกัเรียนสามารถปฏิบติักิจกรรมการสอนผา่นสมาร์ทโฟนตามแนวคิด 

                                องคก์รแห่งการเรียนรู้ไดถู้กตอ้งทุกขั้นตอน  

                   พอใช ้ หมายถึง  นกัเรียนสามารถปฏิบติักิจกรรมการสอนผา่นสมาร์ทโฟนตามแนวคิด   

                                องคก์รแห่งการเรียนรู้ไดถู้กตอ้งบางขั้นตอน 

                ปรับปรุง หมายถึง นกัเรียนสามารถปฏบิติักิจกรรมการสอนผา่นสมาร์ทโฟนตามแนวคดิ    

                                              องคก์รแห่งการเรียนรู้ไดไ้ม่ถูกตอ้ง 

       2. เกณฑ์การประเมินผลการปฏิบัติกิจกรรมการเรียนรู้ 

       ดี        หมายถึง   นกัเรียนสามารถปฏิบติัตามกิจกรรมไดถู้กตอ้งทุกขอ้ 

                 พอใช ้    หมายถึง  นกัเรียนสามารถปฏิบติัตามกิจกรรมไดถู้กตอ้งเพยีงบางขอ้ 

               ปรับปรุง   หมายถึง  นกัเรียนสามารถปฏิบติัตามกิจกรรมไดไ้ม่ถูกตอ้ง 
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แผนการจัดการเรียนรู้ที่  4 

 

หน่วยการเรียนรู้ที่  6  การพัฒนาเว็บไซต์                                                                              8  ช่ัวโมง    

แผนการจัดการเรียนรู้ที่ 4  เร่ือง การสร้างตารางลงในเว็บเพจ       เวลาเรียน  2  ช่ัวโมง 

สอนวันที่ .........เดือน ................................. พ.ศ.2557           ภาคเรียนที่ 1/2557 

 

1. สาระสําคญั/ความคดิรวบยอด 

 การสร้างหนา้เวบ็เพจ มีขั้นตอนการทาํงานที่หลากหลาย ส่ิงที่ควรรู้เก่ียวกบัการสร้างหน้าเวบ็เพจ 

คือ การสร้างตาราง การใส่ขอ้มูล และคาํสั่งต่างๆ ท่ีใชใ้นการตกแต่งตารางซ่ึงขอ้ดีการสร้างเวบ็เพจ   

ด้วยตารางคือ  หน้า เว็บเพจเป็นระเบียบเ รียบร้อย ทําให้การจัดหน้า เว็บ เพจเป็ นสัดส่วน                         

ง่ายต่อการออกแบบเวบ็เพจและสามารถสร้างเวบ็เพจไดอ้ยา่งมีประสิทธิภาพมากยิง่ขึ้น  

 

1.  มาตรฐานการเรียนรู้/ตัวช้ีวัด 

 มาตรฐาน 3.1  เขา้ใจ เห็นคุณค่า และใชก้ระบวนการเทคโนโลยีสารสนเทศในการสืบคน้ขอ้มูล

การเรียนรู้ การส่ือสาร การแกปั้ญหา การทาํงาน และอาชีพอยา่งมีประสิทธิภาพ ประสิทธิผล มีคุณธรรม 

 ตัวช้ีวัด 

 ง3.1 ป6/4 นาํเสนอขอ้มูลในรูปแบบที่เหมาะสมโดยเลือกใชซ้อฟตแ์วร์ประยกุต ์

 

2.  จุดประสงค์การเรียนรู้ 

  1.  รู้และเขา้ใจการสร้างตารางลงในเวบ็เพจไดอ้ยา่งถูกตอ้ง 

  2. ใชค้าํสัง่สร้างตารางลงในเวบ็เพจไดอ้ยา่งถูกตอ้ง 

  3. นาํความรู้เก่ียวกบัการสร้างตารางลงในเวบ็เพจไดอ้ยา่งเหมาะสมกบัสถานการณ์ 

 

3. สาระการเรียนรู้ 

 3.1  สาระการเรียนรู้แกนกลาง 

  1) การจดัทาํขอ้มูลเพือ่การนาํเสนอตอ้งพจิารณารูปแบบของขอ้มูลใหเ้หมาะสม 

2) การใชซ้อฟตแ์วร์นาํเสนอ  เช่น การสร้างสไลด ์การตกแต่งสไลด ์การกาํหนดเทคนิคพเิศษ 

3) การเลือกใชซ้อฟตแ์วร์ประยกุตใ์หเ้หมาะสมกบัรูปแบบการนาํเสนอ  
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4. กิจกรรมการเรียนรู้ 

ข้ันที่ 1 ศึกษาค้นคว้า เพื่อสร้างให้เป็นบุคคลรอบรู้ (Personal Mastery) 

1. นกัเรียนตอบคาํถามกระตุน้ความคิด 

2. นักเรียนร่วมกันแสดงความคิดเห็นว่า ถ้าต้องการจัดวางข้อมูลให้เป็นระเบียบ

เรียบร้อย ควรจะตอ้งทาํอยา่งไร ใหน้กัเรียนอธิบายเหตุผล 

3. ให้นักเรียนศึกษารูปแบบเว็บไซต์ที่มีการสร้างตารางบนเว็บเพจ ด้วยโปรแกรม                 

เวบ็บราวเซอร์ เพือ่ใหน้กัเรียนมีความกระตือรือร้น เกิดความสนใจในบทเรียน 

4. การดําเนินกิจกรรมการสอนผ่านสมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้                

ในทุกขั้นตอน นักเรียนจะมีการแลกเปล่ียนเรียนรู้กับเพื่อนร่วมเรียนรู้ และขอคาํแนะนําจากครู        

ผา่นทางหอ้งสนทนาอิเล็กทรอนิกส์ (Chat Room) และกระดานเสวนา (Web board) โดยมีขั้นตอนดงัน้ี 

 4.1 เลือกและระบุกิจกรรมที่ตอ้งการเรียนรู้ 

         นักเรียนเลือกศึกษาเน้ือหาของบทเรียนตามที่ตนเองสนใจ  จากบทเรียน              

ที่กาํหนดให ้ 

ข้ันที่ 2 ข้ันเขียนแผนผังความคดิเพื่อสร้างกรอบแนวคดิ (Mental Models) 

นกัเรียนสรุปแผนผงัความคิดการสร้างตาราง  

ข้ันที่ 3 ข้ันแสดงวิสัยทัศน์ร่วมกนั (Shared Vision) 

นักเรียนแลกเปล่ียนความรู้ ประสบการณ์ การสร้างตารางลงบนเวบ็เพจ ดว้ยโปรแกรม      

อะโดบี ดรีมวีฟเวอร์ CS5 ผ่านช่องทางผ่านทางห้องสนทนาอิเล็กทรอนิกส์ (Chat Room) กระดาน

เสวนา (Web board)  

ข้ันที่ 4 ข้ันเรียนรู้ร่วมกันเป็นทีม (Team Learning) 

1. กาํหนดหนา้ที่การทาํงานเป็นทีม นกัเรียนมีการผลดัเปล่ียนหน้าที่กนั โดยให้นักเรียน

ระบุวา่นกัเรียนทาํหนา้ที่อะไร เช่น 

1.1 คน้ควา้หาขอ้มูลการสร้างตารางลงเวบ็เพจ   

1.2 รวบรวม เรียบเรียงขอ้มูลการสร้างตารางลงเวบ็เพจ  

1.3 สรุปแผนผงัความคิดการสร้างตารางลงบนเวบ็เพจ  

1.4 แลกเปล่ียนความรู้การสร้างตารางลงบนเวบ็เพจ  ผา่นช่องทางผา่นทางห้องสนทนา

อิเล็กทรอนิกส์ (Chat Room) กระดานเสวนา (Web board) 
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ข้ันที่ 5 สร้างความคดิเชิงระบบ (Systems Thinking) 

1. นักเรียนเรียนรู้ตามแผนการเรียนรู้ โดยเร่ิมจากศึกษาเน้ือหาจากบทเรียนผ่าน               

สมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้ เร่ืองการสร้างตารางลงบนเวบ็เพจ หลงัจากศึกษา                

จนไดค้าํตอบของกิจกรรม ใหน้กัเรียนทาํกิจกรรมหลงัเรียนใหค้รบทุกขอ้ 

2. นําเสนอผลงานการเรียนรู้  โดยส่งในช่องทางห้องสนทนาอิเล็กทรอนิกส์                         

(Chat Room) กระดานเสวนา (Web board) 

ข้ันสรุปผลการเรียนรู้ 

นักเรียนร่วมกันสรุปบทเรียน เร่ือง การสร้างตารางลงในเว็บเพจ พร้อมทั้งร่วม

แลกเปล่ียนเรียนรู้กบัเพือ่นร่วมเรียนรู้และผูส้อน 

ข้ันประเมินผลการเรียนรู้ 

1. ผูส้อนทาํการประเมินผลงานการเรียนรู้ของนักเรียน พร้อมทั้งให้ขอ้เสนอแนะ        

กบันกัเรียน เพือ่ที่นกัเรียนจะไดน้าํไปปรับปรุงผลงานการเรียนรู้ 

2. นกัเรียนปรับปรุงผลงานการเรียนรู้ตามขอ้เสนอแนะของผูส้อน 

 

5.  ส่ือ/แหล่งเรียนรู้ 

 5.1 ส่ือการเรียนรู้ 

  5.1.1 บทเรียนผ่านสมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้ เ ร่ืองการพ ัฒนา

เว็บไซต์ สาํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6   

  5.1.2 กิจกรรมหลงัเรียน 

 5.2 แหล่งการเรียนรู้ 

  -   หอ้งปฏิบติัการคอมพวิเตอร์ 

 

6. การวัดและประเมินผล 

วิธีการ เคร่ืองมือ เกณฑ์ 

ตรวจผลงาน ใบกิจกรรม ร้อยละ 60 ผา่นเกณฑ ์

ประเมินการนาํเสนอผลงาน แบบประเมินการนาํเสนอผลงาน ระดบัคุณภาพ 2 ผา่นเกณฑ ์

ตรวจแบบบนัทึกกิจกรรมการ

เรียนรู้ 

แบบบนัทึกกิจกรรมการเรียนรู้ ระดบัคุณภาพ 2 ผา่นเกณฑ ์
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ผลการประเมินการปฏิบัติกิจกรรม 

 

คาํช้ีแจง ใหน้กัเรียนประเมินผลการปฏิบติักิจกรรมของนกัเรียน โดยทาํเคร่ืองหมาย  ตามเกณฑท์ี่ 

กาํหนดไว ้

1) ผลการประเมินการปฏิบัติกิจกรรมการเรียนรู้ตามแนวคิดองค์กรแห่งการเรียนรู้         

ผา่นสมาร์ทโฟน 

 ดี    พอใช ้  ปรับปรุง 

   2) ผลการประเมินการปฏิบติักิจกรรมการเรียนรู้ 

 ดี    พอใช ้  ปรับปรุง 

 

เกณฑ์การประเมนิผลการปฏิบัติกิจกรรม 

       1. เกณฑ์การประเมินผลการปฏิบัติกิจกรรมการสอนผ่านสมาร์ทโฟนตามแนวคดิองค์กร 

           แห่งการเรียนรู้ 

       ดี       หมายถึง  นกัเรียนสามารถปฏิบติักิจกรรมการสอนผา่นสมาร์ทโฟนตามแนวคิด 

                                องคก์รแห่งการเรียนรู้ไดถู้กตอ้งทุกขั้นตอน  

                   พอใช ้ หมายถึง  นกัเรียนสามารถปฏิบติักิจกรรมการสอนผา่นสมาร์ทโฟนตามแนวคิด   

                                องคก์รแห่งการเรียนรู้ไดถู้กตอ้งบางขั้นตอน 

                ปรับปรุง หมายถึง นกัเรียนสามารถปฏบิติักิจกรรมการสอนผา่นสมาร์ทโฟนตามแนวคดิ    

                                              องคก์รแห่งการเรียนรู้ไดไ้ม่ถูกตอ้ง 

       2. เกณฑ์การประเมินผลการปฏิบัติกิจกรรมการเรียนรู้ 

       ดี        หมายถึง   นกัเรียนสามารถปฏิบติัตามกิจกรรมไดถู้กตอ้งทุกขอ้ 

                 พอใช ้    หมายถึง  นกัเรียนสามารถปฏิบติัตามกิจกรรมไดถู้กตอ้งเพยีงบางขอ้ 

               ปรับปรุง   หมายถึง  นกัเรียนสามารถปฏิบติัตามกิจกรรมไดไ้ม่ถูกตอ้ง 
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แผนการจัดการเรียนรู้ที่  5 

 

หน่วยการเรียนรู้ที่  6  การพัฒนาเว็บไซต์                                                                             8  ช่ัวโมง    

แผนการจัดการเรียนรู้ที่ 5  เร่ือง การเช่ือมโยงเว็บเพจ             เวลาเรียน  2  ช่ัวโมง 

สอนวันที่ .........เดือน ................................. พ.ศ.2557           ภาคเรียนที่ 1/2557 

 

1. สาระสําคญั/ความคดิรวบยอด 

 การสร้างเวบ็ไซต ์มีส่ิงที่สาํคญัที่สุดในการสร้างเวบ็เพจ คือการสร้างลิงคห์รือการเช่ือมโยงระหว่าง

เวบ็เพจ เพือ่การศึกษาขอ้มูลของผูเ้ขา้ชมเวบ็ไซตมี์ความต่อเน่ือง โดยกรสร้างลิงค ์(Link) ในเวบ็ไซต์

จะมีอยูท่ ั้งหมด 3 แบบ คือการสร้างลิงคข์อ้ความ การสร้างลิงค์จากรูปภาพ และการสร้างลิงคไ์ปยงั

เวบ็ไซตอ่ื์น  

 

1.  มาตรฐานการเรียนรู้/ตัวช้ีวัด 

 มาตรฐาน 3.1  เขา้ใจ เห็นคุณค่า และใชก้ระบวนการเทคโนโลยีสารสนเทศในการสืบคน้ขอ้มูล

การเรียนรู้ การส่ือสาร การแกปั้ญหา การทาํงาน และอาชีพอยา่งมีประสิทธิภาพ ประสิทธิผล มีคุณธรรม 

 ตัวช้ีวัด 

 ง3.1 ป6/4 นาํเสนอขอ้มูลในรูปแบบที่เหมาะสมโดยเลือกใชซ้อฟตแ์วร์ประยกุต ์

 

2.  จุดประสงค์การเรียนรู้ 

  1.  รู้และเขา้ใจการเช่ือมโยงลงในเวบ็เพจ ไดอ้ยา่งถูกตอ้ง 

  2. ใชค้าํสัง่การเช่ือมโยงลงในเวบ็เพจ ไดอ้ยา่งถูกตอ้ง 

  3. นาํความรู้เก่ียวกบัการเช่ือมโยงลงในเวบ็เพจ ไดอ้ยา่งเหมาะสมกบัสถานการณ์ 

 

3. สาระการเรียนรู้ 

 3.1  สาระการเรียนรู้แกนกลาง 

  1) การจดัทาํขอ้มูลเพือ่การนาํเสนอตอ้งพจิารณารูปแบบของขอ้มูลใหเ้หมาะสม 

2) การใชซ้อฟตแ์วร์นาํเสนอ เช่น การสร้างสไลด ์การตกแต่งสไลด ์การกาํหนดเทคนิคพเิศษ 

3) การเลือกใชซ้อฟตแ์วร์ประยกุตใ์หเ้หมาะสมกบัรูปแบบการนาํเสนอ  
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4. กิจกรรมการเรียนรู้ 

ข้ันที่ 1 ศึกษาค้นคว้า เพื่อสร้างให้เป็นบุคคลรอบรู้ (Personal Mastery) 

1. ครูถามนกัเรียนวา่ การนาํเสนอขอ้มูลหลายๆหน้า ควรจะนาํเสนอดว้ยวิธีไหน เพราะ

เหตุใด แลว้มีประโยชน์อยา่งไร 

2. ให้นักเรียนศึกษาการเช่ือมโยงเว็บรูปแบบต่างๆ ด้วยโปรแกรมเว็บบราวเซอร์                   

เพือ่ใหน้กัเรียนมีความกระตือรือร้น เกิดความสนใจในบทเรียน 

3. ครูนาํตวัอยา่งเวบ็เพจที่มีการเช่ือมโยง (Link) ให้นักเรียนชม เพื่อสร้างแรงจูงใจให้

เกิดความสนใจ 

4. การดําเนินกิจกรรมการสอนผ่านสมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้                

ในทุกขั้นตอน นักเรียนจะมีการแลกเปล่ียนเรียนรู้กับเพื่อนร่วมเรียนรู้ และขอคาํแนะนําจากครู        

ผา่นทางหอ้งสนทนาอิเล็กทรอนิกส์ (Chat Room) และกระดานเสวนา (Web board) โดยมีขั้นตอนดงัน้ี 

 4.1 เลือกและระบุกิจกรรมที่ตอ้งการเรียนรู้  

         นักเรียนเลือกศึกษาเน้ือหาของบทเรียนตามที่ตนเองสนใจ  จากบทเรียน              

ที่กาํหนดให ้ 

ข้ันที่ 2 ข้ันเขียนแผนผังความคดิเพื่อสร้างกรอบแนวคดิ (Mental Models) 

นกัเรียนสรุปแผนผงัความคิดการเช่ือมโยง  

ข้ันที่ 3 ข้ันแสดงวิสัยทัศน์ร่วมกนั (Shared Vision) 

นักเรียนแลกเปล่ียนความรู้ ประสบการณ์ การเช่ือมโยงลงบนเว็บเพจผ่านช่องทาง               

หอ้งสนทนาอิเล็กทรอนิกส์ (Chat Room) กระดานเสวนา (Web board)  

ข้ันที่ 4 ข้ันเรียนรู้ร่วมกันเป็นทีม (Team Learning) 

1. กาํหนดหนา้ที่การทาํงานเป็นทีม นกัเรียนมีการผลดัเปล่ียนหน้าที่กนั โดยให้นักเรียน

ระบุวา่นกัเรียนทาํหนา้ที่อะไร เช่น 

1.1 คน้ควา้หาขอ้มูลการเช่ือมโยงลงเวบ็เพจ   

1.2 รวบรวม เรียบเรียงขอ้มูลการเช่ือมโยงลงเวบ็เพจ   

1.3 สรุปแผนผงัความคิดการเช่ือมโยงลงบนเวบ็เพจ  

1.4 แลกเปล่ียนความรู้การเช่ือมโยงลงบนเวบ็เพจ  ผ่านช่องทางผ่านทางห้องสนทนา

อิเล็กทรอนิกส์ (Chat Room) กระดานเสวนา (Web board) 
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ข้ันที่ 5 สร้างความคดิเชิงระบบ (Systems Thinking) 

1. นักเรียนเรียนรู้ตามแผนการเรียนรู้ โดยเร่ิมจากศึกษาเน้ือหาจากบทเรียนผ่าน               

สมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้ เร่ืองการเช่ือมโยงลงบนเว็บเพจ หลังจากศึกษา                

จนไดค้าํตอบของกิจกรรม ใหน้กัเรียนทาํกิจกรรมหลงัเรียนใหค้รบทุกขอ้ 

2. นําเสนอผลงานการเรียนรู้  โดยส่งในช่องทางห้องสนทนาอิเล็กทรอนิกส์                         

(Chat Room) กระดานเสวนา (Web board) 

ข้ันสรุปผลการเรียนรู้ 

นกัเรียนร่วมกนัสรุปบทเรียน เร่ือง การเช่ือมโยงลงในเวบ็เพจ พร้อมทั้งร่วมแลกเปล่ียน

เรียนรู้กบัเพือ่นร่วมเรียนรู้และผูส้อน 

ข้ันประเมินผลการเรียนรู้ 

1. ผูส้อนทาํการประเมินผลงานการเรียนรู้ของนักเรียน พร้อมทั้งให้ขอ้เสนอแนะ        

กบันกัเรียน เพือ่ที่นกัเรียนจะไดน้าํไปปรับปรุงผลงานการเรียนรู้ 

2. นกัเรียนปรับปรุงผลงานการเรียนรู้ตามขอ้เสนอแนะของผูส้อน 

 

5.  ส่ือ/แหล่งเรียนรู้ 

 5.1 ส่ือการเรียนรู้ 

  5.1.1 บทเรียนผ่านสมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้ เ ร่ืองการพ ัฒนา

เว็บไซต์ สาํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6   

  5.1.2 กิจกรรมหลงัเรียน 

 5.2 แหล่งการเรียนรู้ 

  -   หอ้งปฏิบติัการคอมพวิเตอร์ 

 

6.  การวัดและประเมินผล 
 

วิธีการ เคร่ืองมือ เกณฑ์ 

ตรวจแบบทดสอบหลงัเรียน  แบบทดสอบหลงัเรียน  (ประเมินตามสภาพจริง) 

ตรวจผลงาน ใบกิจกรรม ร้อยละ 60 ผา่นเกณฑ ์

ประเมินการนาํเสนอผลงาน แบบประเมินการนาํเสนอผลงาน ระดบัคุณภาพ 2 ผา่นเกณฑ ์

ตรวจแบบบนัทึกกิจกรรมการ

เรียนรู้ 

แบบบนัทึกกิจกรรมการเรียนรู้ ระดบัคุณภาพ 2 ผา่นเกณฑ ์
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ผลการประเมินการปฏิบัติกิจกรรม 

 

คาํช้ีแจง ใหน้กัเรียนประเมินผลการปฏิบติักิจกรรมของนกัเรียน โดยทาํเคร่ืองหมาย  ตามเกณฑท์ี่ 

กาํหนดไว ้

1) ผลการประเมินการปฏิบัติกิจกรรมการเรียนรู้ตามแนวคิดองค์กรแห่งการเรียนรู้         

ผา่นสมาร์ทโฟน 

 ดี    พอใช ้  ปรับปรุง 

   2) ผลการประเมินการปฏิบติักิจกรรมการเรียนรู้ 

 ดี    พอใช ้  ปรับปรุง 

 

เกณฑ์การประเมนิผลการปฏิบัติกิจกรรม 

       1. เกณฑ์การประเมินผลการปฏิบัติกิจกรรมการสอนผ่านสมาร์ทโฟนตามแนวคดิองค์กร 

           แห่งการเรียนรู้ 

       ดี       หมายถึง  นกัเรียนสามารถปฏิบติักิจกรรมการสอนผา่นสมาร์ทโฟนตามแนวคิด 

                                องคก์รแห่งการเรียนรู้ไดถู้กตอ้งทุกขั้นตอน  

                   พอใช ้ หมายถึง  นกัเรียนสามารถปฏิบติักิจกรรมการสอนผา่นสมาร์ทโฟนตามแนวคิด   

                                องคก์รแห่งการเรียนรู้ไดถู้กตอ้งบางขั้นตอน 

                ปรับปรุง หมายถึง นกัเรียนสามารถปฏบิติักิจกรรมการสอนผา่นสมาร์ทโฟนตามแนวคดิ    

                                              องคก์รแห่งการเรียนรู้ไดไ้ม่ถูกตอ้ง 

       2. เกณฑ์การประเมินผลการปฏิบัติกิจกรรมการเรียนรู้ 

       ดี        หมายถึง   นกัเรียนสามารถปฏิบติัตามกิจกรรมไดถู้กตอ้งทุกขอ้ 

                 พอใช ้    หมายถึง  นกัเรียนสามารถปฏิบติัตามกิจกรรมไดถู้กตอ้งเพยีงบางขอ้ 

               ปรับปรุง   หมายถึง  นกัเรียนสามารถปฏิบติัตามกิจกรรมไดไ้ม่ถูกตอ้ง 
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ภาคผนวก ง 

แผนผงัการออกแบบบทเรียนผ่านสมาร์ทโฟน 

 

-  แผนผงัการออกแบบบทเรียนผ่านสมาร์ทโฟนตามแนวคดิ 

   องค์กรแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต์ ช้ันประถมศึกษาปีที่ 6 

 

 

 



 

แผนผงัการออกแบบบทเรียนผ่านสมาร์ทโฟนตามแนวคดิองค์กรแห่งการเรียนรู้  

เร่ือง การพฒันาเวบ็ไซต์ ช้ันประถมศึกษาปีที ่6 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ลงทะเบียน 

รายการหลกั 

แบบทดสอบหลงัเรียน 

คาํช้ีแจง 

 

หนา้หลกั 

จุดประสงคก์ารเรียนรู้ 

ศึกษาเน้ือหา 

แบบทดสอบก่อนเรียน 

ศึกษาเน้ือหา 

แบบฝึกระหวา่งเรียน 

จบ 

จุดประสงคก์ารเรียนรู้ 

ผลงานนกัเรียน 

เกมฝึกทกัษะ 

ครูผูส้อน 
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ภาคผนวก  จ 

แบบประเมินคุณภาพสําหรับผู้เช่ียวชาญ 

 

-  แบบประเมินคุณภาพแบบสอบถามความคดิเห็นของผู้เช่ียวชาญที่มีต่อบทเรียน  

   ผ่านสมาร์ทโฟนตามแนวคดิองค์กรแห่งการเรียนรู้ เร่ือง การพัฒนาเว็บไซต์   

   ช้ันประถมศึกษาปีที่ 6 

-  แบบประเมินคุณภาพด้านวัดและประเมินผล ที่มีต่อบทเรียนผ่านสมาร์ทโฟน 

ตามแนวคดิองค์กรแห่งการเรียนรู้ เร่ือง การพฒันาเว็บไซต์ ช้ันประถมศึกษา 

ปีที่ 6 

-  แบบประเมินคุณภาพของแบบสอบถามความคดิเห็นเกีย่วกับความพึงพอใจ  

   ของนักเรียนที่มีต่อบทเรียนผ่านสมาร์ทโฟนตามแนวคดิองค์กรแห่งการเรียนรู้  

   เร่ือง การพฒันาเวบ็ไซต์ ช้ันประถมศึกษาปีที่ 6 สําหรับผู้เรียน  

 

 



 

แบบประเมินคุณภาพ 

แบบสอบถามความคดิเห็นของผู้เช่ียวชาญที่มีต่อ 

บทเรียนผ่านสมาร์ทโฟนตามแนวคดิองค์กรแห่งการเรียนรู้  

เร่ือง การพัฒนาเว็บไซต์ ช้ันประถมศึกษาปีที่ 6 

คาํช้ีแจง  โปรดแสดงความคิดเห็นของท่าน โดยใส่เคร่ืองหมาย () ลงในช่องความคิดเห็นพร้อม

เขียนขอ้เสนอแนะที่เป็นประโยชน์ในการนาํไปพจิารณาแกไ้ขปรับปรุงในลาํดบัต่อไป 

ขอ้กาํหนดของความคิดเห็น กาํหนดให ้

  +1  หมายถึง    แน่ใจวา่สอดคลอ้งกบัส่ิงที่ตอ้งการศึกษา 

    0 หมายถึง   ไม่แน่ใจวา่สอดคลอ้งกบัส่ิงที่ตอ้งการศึกษา 

  - 1 หมายถึง   ไม่สอดคลอ้งกบัส่ิงที่ตอ้งการศึกษา 

 

ที่ รายการประเมิน ความเห็นของ

ผู้เช่ียวชาญ 

ข้อเสนอ

แนะ 

+1 0 -1 

1 เป็นการเรียนรู้ดว้ยตนเอง โดยยดึผูเ้รียนเป็นสาํคญั     

2 ช่วยพฒันาความสามารถในการคิดวเิคราะห์ของนกัเรียน     

3 ทาํใหมี้ประสบการณ์ในการใชเ้คร่ืองคอมพวิเตอร์มากขึ้น     

4 สอนตามจุดประสงคข์องการเรียน     

5 มีแหล่งสนบัสนุนการเรียนที่เหมาะสม เช่น การติดต่อผูส้อน 

กระดานแลกเปล่ียนเรียนรู้ แหล่งเรียนรู้ 

    

6 เปิดโอกาสใหผู้เ้รียนติดต่อกบัผูส้อนใหมี้ปฏิสมัพนัธร์ะหวา่ง 

ผูเ้รียน กบัผูส้อน ผูเ้รียนกบัผูเ้รียน และผูเ้รียนกบัส่ือ 

    

7 นาํเสนอเน้ือหาเป็นระบบ ช่วยใหเ้ห็นความต่อเน่ืองของ

เน้ือหา 

    

8 สามารถทบทวนเน้ือหาไดจ้นเขา้ใจ ตามความสามารถของ

ผูเ้รียน 
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ที่ รายการประเมิน ความเห็นของ

ผู้เช่ียวชาญ 

ข้อเสนอ

แนะ 

+1 0 -1 

9 กิจกรรมระหวา่งเรียนและการฝึกทกัษะช่วยใหผู้เ้รียนมีความ

เขา้ใจ เน้ือหาในบทเรียน 

    

10 เปิดโอกาสใหผู้เ้รียนมีส่วนร่วมในบทเรียน     

11 มีความสะดวกในการเขา้ถึงบทเรียนหรือการคน้หา 

ขอ้มูลตา่ง ๆ 

    

12 กระตุน้ใหผู้เ้รียนอยากเรียนรู้ในเน้ือหาตอนต่อไป     

13 ผลการประเมินต่างๆ สามารถโตต้อบไดท้นัท ี     

14 ภาพประกอบและภาพเคล่ือนไหว มีส่วนช่วยให้เขา้ใจเน้ือหา  

ไดดี้ขึ้น 

    

15 ศึกษาและทบทวนบทเรียนไดไ้ม่จาํกดัเวลาและมีอิสระ 

ในการเรียน 

    

 

ความคิดเห็นเพิม่เติม  

.................................................................................................................................................................  

.................................................................................................................................................................  

.................................................................................................................................................................  

.................................................................................................................................................................  

.................................................................................................................................................................  
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แบบประเมินคุณภาพด้านวัดและประเมินผล 

ที่มีต่อบทเรียนผ่านสมาร์ทโฟนตามแนวคดิองค์กรแห่งการเรียนรู้  

เร่ือง การพัฒนาเว็บไซต์ ช้ันประถมศึกษาปีที่ 6 

 

คาํช้ีแจง       ท่า น ผู เ้ ชี ่ยว ชา ญ ไ ด ้โ ป ร ด ก รุณ า แ ส ด ง ค ว า ม ค ิด เห็น ข อ ง ท ่า น ที ่ม ีต ่อ บทเ รียน             

ผ่านสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้  เร่ือง การพฒันาเวบ็ไซต ์ชั้นประถมศึกษาปีที่ 6   

โดยใส่เคร่ืองหมาย  ( )  ลงในช่องความคิดเห็นของท่านพร้อมเขียนขอ้เสนอแนะที่เป็นประโยชน์

ในการนาํไปพจิารณาแกไ้ขปรับปรุงในลาํดบัต่อไป  โดยที่ขอ้กาํหนดของความคิดเห็นกาํหนดให้เป็น

ดงัต่อไปน้ี 

+1   หมายถึง   แน่ใจวา่การสอนบนเวบ็มีความสอดคลอ้งกบัจุดประสงคก์ารเรียนรู้ 

 0     หมายถึง   ไม่แน่ใจวา่การสอนบนเวบ็มีความสอดคลอ้งกบัจุดประสงคก์ารเรียนรู้  

-1     หมายถึง   แน่ใจวา่การสอนบนเวบ็ไม่สอดคลอ้งกบัจุดประสงคก์ารเรียนรู้ 

 

จุดประสงค์การเรียนรู้ ข้อที่ จํานวน

ข้อ 

1. จดัขอ้ความวางในตาํแหน่งที่ตอ้งการได ้ 1 – 20 20 

2. นาํรูปภาพมาใส่ในเวบ็เพจได ้ 21- 40 15 

3. นาํส่ือแบบ Multimedia ได ้ 41 - 60 20 

4. สร้างตารางในเวบ็เพจได ้ 61 - 80 20 

5. สร้างจุดเช่ือมโยงเวบ็เพจได ้ 81 - 93 18 
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ข้อสอบ 

 

ความคดิเห็น ข้อเสนอแนะ 

+1 0 -1 

1. การเคาะเวน้วรรคมากกวา่ 1 คร้ัง จะใชค้าํสัง่ใด 

ก.  Ctrl + Space bar  

ข.  Shift + Space bar  

ค.  Alt + Shift + Space bar  

ง.  Ctrl + Shift + Space bar 

    

2. คาํสัง่ขอ้ใดที่เพิม่รูปแบบตวัอกัษรใหม่ในโปรแกรม 

ก.  File > Page Properties  

ข.  Edit > Page Properties  

ค.  Insert > Page Properties  

ง.  View > Page Properties 

    

3. การขึ้นบรรทดัใหม่ภายในยอ่หนา้ใชค้าํสัง่ใด 

ก.  Ctrl+Spacebar  

ข.  Shift+Spacebar  

ค.  Alt+Ctrl+Spacebar  

ง.  Ctrl+Shift+Spacebar 

    

4. ขอ้ใดเป็นการจดัตาํแหน่งก่ึงกลาง 

ก.  Ctrl+Shift+C  

ข.  Ctrl+Alt+Shift+J  

ค.  Ctrl+Alt+Shift+C  

ง.  Ctrl+Alt+Shift+L 

    

5. ขอ้ใดแสดงหนา้ต่าง Advanced Layout 

ก.  Window>Layers 

ข.  Window>Edit>Layers 

ค.  Window>Others>Insert 

ง.  Window>Others>Layers 
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ข้อสอบ 

 

ความคดิเห็น ข้อเสนอแนะ 

+1 0 -1 

6. ปุ่ ม                                                         ใชท้าํส่ิงใด 

ก.  เปล่ียนขนาดตวัอกัษร 

ข.  เปล่ียนรูปร่างตวัอกัษร 

ค.  เปล่ียนลกัษณะตวัอกัษร 

ง.  เปล่ียนรูปแบบตวัอกัษร 

    

7. การ กด Shift พร้อมกบักด Enter แสดงผลอยา่งไร 

ก.  กด Ctrl 

ข.  การทาํใหบ้รรทดัชิดกนั 

ค.  กด Ctrl พร้อมกบักด Enter  

ง.  การให้เวน้ที่วา่งเม่ือขึ้นบรรทดัใหม่ 

    

8.  ขอ้ใดแสดง การจาํลองเวบ็ที่สร้างบนบราวเซอร์ 

ก.  <F9> 

ข.  <F10> 

ค.  <F11> 

ง.  <F12> 

    

9.  ปุ่ ม                               ใชท้าํส่ิงใด 

ก.  เปล่ียนสีเงา 

ข.  เปล่ียนสีสามมิติ 

ค.  เปล่ียนสีตวัอกัษร 

ง.  เปล่ียนสีลกัษณะพเิศษ 

    

10. คาํสัง่ใดเป็นการแทรกช่องวา่งเพือ่เวน้วรรค 

ก.  Ctrl+Spacebar 

ข.  Shift+Spacebar 

ค.  Alt+Ctrl+Spacebar 

ง.  Ctrl+Shift+Spacebar 
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ข้อสอบ 

 

ความคดิเห็น ข้อเสนอแนะ 

+1 0 -1 

11. รูปแบบตวัอกัษร(ภาษาไทย) นิยมใชฟ้อนตอ์ะไร 

ก.  MS Sans Serif, Tahoma  

ข.  Arial, Helvetica, sans-serif  

ค.  Times New Roman, Times, serif  

ง.  Courier New, Courier, monospace 

    

12. การใส่ขอ้ความลงในเวบ็เพจ เลือกขอ้ใด 

ก.  Text 

ข.  Common 

ค.  Favorites 

ง.  Application 

    

13. ขอ้ใดคือ Mode การผสมสีใหม่ตามตอ้งการ 

ก.  Color Cube 

ข.  Color Palette 

ค.  Color Grayscale 

ง.  Color Continuous 

    

14. คียล์ดัที่ใชก้ารเลือกขอ้ความทั้งหมดในหนา้เวบ็เพจ  

ก.  Ctrl + A 

ข.  Ctrl + B 

ค.  Ctrl + C 

ง.  Ctrl + V 

    

15. ขอ้ใดคือ Mode การเลือกดูดสีจากภาพในเวบ็ 

ก.  Eye Safe  

ข.  Eye Web 

ค.  Eye Tone 

ง.  Eye Cropper 
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ข้อสอบ 

 

ความคดิเห็น ความคดิเห็น 

+1 0 -1 

16. การลบขอ้ความทีไ่ม่ตอ้งการออกจากหนา้เวบ็เพจ 

      กดปุ่ มใดบนแป้นพมิพ ์ 

ก.  Enter  

ข.  Home 

ค.  Num Lock 

ง.  Backspace 

    

17. คาํสัง่  Text > Indent  แสดงผลอยา่งไร 

ก.  ขอ้ความถูกลบ 

ข.  ขอ้ความกลายเป็นสีขาว 

ค.  วตัถุเยือ้งเขา้ไปหน่ึงระยะ 

ง.  ขอ้ความถูกจดัก่ึงกลางหนา้เวบ็เพจ 

    

18. ขอ้ใดคือการจดัตวัอกัษรแบบชิดซา้ย 

 

ก. 

ข. 

ค. 

ง. 

    

19. รูปแบบตวัอกัษรภาษาไทยรูปแบบใดที่นิยมใช ้

ก.  Encoding 

ข.  Windows-874 

ค.  Thai(windows) 

ง.  Unicode(UTF-8) 

    

20. การกาํหนดค่าตวัอกัษรตอ้งกาํหนดส่วนใด 

ก.  Property 

ข.  Edit font 

ค.  Css style 

ง.  Text font 
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ข้อสอบ 

 

ความคดิเห็น ความคดิเห็น 

+1 0 -1 

21. การใส่รูปภาพเป็นพื้นหลงัใชค้าํสัง่ใด 

ก. Edit > Page Properties 

ข. File > Page Properties 

ค. Insert > Page Properties 

ง. Modify > Page Properties 

    

22. คาํสัง่ Menu ตวัใดที่ใชใ้นการแทรกรูปภาพ 

ก. Menu File 

ข. Menu Edit 

ค. Menu View 

ง. Menu Insert 

    

23. การแทรกรูปภาพลงบนหนา้เวบ็เพจทาํไดโ้ดยวธีิใด 

ก. Edit >Insert 

ข. File > Picture 

ค. Insert > Image 

ง. View > Picture 

    

24. การจดัวางตาํแหน่งภาพ กาํหนดค่าที่ช่องใดใน 

      หนา้ต่าง   Properties 

ก. Align 

ข. Target 

ค. Border 

ง. LowSrc 

    

 

 

25.  การกาํหนดเสน้ขอบของรูปภาพตอ้งใส่ค่าที่เป็น      

     ตวัเลขในช่องใด 

ก. Alt 

ข. Ctrl 

ค. Class 

ง. Boder 
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ข้อสอบ 

 

ความคดิเห็น ข้อเสนอแนะ 

+1 0 -1 

26. การใส่รูปภาพใหก้บัเวบ็เพจ เพือ่อะไร 

ก. เพือ่ง่ายต่อการเช่ือมโยงเวบ็เพจ 

ข. เพือ่ช่วยสร้างสีสนัใหก้บัเวบ็เพจ 

ค. เพือ่ง่ายต่อการจดัเฟรมใหก้บัเวบ็เพจ 

ง. เพือ่ช่วยสร้างความเป็นระเบียบใหก้บัเวบ็เพจ 

    

27. รูปภาพเคล่ือนไหวควรใชน้ามสกุลใด 

ก. นามสกุล .GIF 

ข. นามสกุล .PNG 

ค. นามสกุล .PND 

ง. นามสกุล .JPEG 

    

28. หนา้เวบ็เพจที่มีรูปภาพประกอบเป็นจาํนวนมาก 

      จะเกิดปัญหาดา้นในมากที่สุด 

ก. ทาํใหล้ายตามาก 

ข. ทาํใหดู้ไม่สวยงาม 

ค. สร้างความสบัสนใหก้บัผูเ้ขา้ใช ้

ง. ทาํใหแ้สดงผลในเวบ็เบรวเ์ซอร์ (Web browser) ชา้ 

    

29. ภาพขนาดเล็กที่นาํมาเป็นภาพพื้นหลงัของเวบ็เพจ  

       ผลที่เกิดขึ้นจะมีลกัษณะตามขอ้ใด 

ก. ภาพกลายเป็นสีดาํ 

ข. พื้นหลงัจะมีภาพขนาดเล็กหลาย ๆ ภาพ 

ค. จะมีภาพขนาดใหญ่เพยีงภาพเดียวเท่านั้น 

ง. จะมีภาพขนาดเล็กทีอ่ยูต่รงกลางเวบ็เพจเพยีงภาพ 

    เดียวเท่านั้น 
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ข้อสอบ 

 

ความคดิเห็น ข้อเสนอแนะ 

+1 0 -1 

30. เพราะเหตุใดจึงนิยมนําไฟล์ภาพ .JPG   มาใช้ใน 

      การทาํเวบ็เพจ 

ก. เป็นไฟลภ์าพที่ใชสี้สูงสุดไดม้ากถึง 16.7 ลา้นสี 

ข. สามารถจดัเก็บขอ้มูลไดท้ั้งแบบ 8 บิต 24 บิต และ  

32 บิต 

ค. สนบัสนุนการบีบอดัขอ้มูลทีมี่ภาพโปร่งแสง และ  

ภาพเคล่ือนไหว 

ง.  แสดงผลไดเ้ร็วที่สุด คือเร่ิมแสดงผลเม่ือขอ้มูลถูก 

    โหลดเขา้มา 1 ใน 64 ส่วน 

    

31. ความละเอียดของภาพมีหน่วยเป็นอะไร 

ก.  Pixels 

ข.  Kilogram 

ค.  Millimeter 

ง.  Centimetre 

    

32. รูปภาพที่มีนามสกุลใดไม่นิยมนาํมาสร้างเวบ็ 

ก. .GIF 

ข. .PNG 

ค. .bmp 

ง. .JPEG 

    

33. ถา้ตอ้งการแสดงภาพเป็นพื้นหลงัเวบ็เพจ  ควรเลือก 

      ภาพแบบใด 

ก. ภาพทิวทศัน์ 

ข. ภาพลายการ์ตูน 

ค. ภาพสะทอ้นแสง 

ง. ภาพสีไม่เขม้และไม่รกตา 
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ข้อสอบ 

 

ความคดิเห็น ข้อเสนอแนะ 

+1 0 -1 

34.  ขอ้ใดต่อไปน้ีกล่าวไม่ถูกตอ้งเก่ียวกบัการนาํรูปภาพ 

        มาใชใ้นการสร้างเวบ็เพจ 

ก. รูปภาพสามารถใส่เสน้ขอบได ้

ข. รูปภาพที่แทรกเขา้มานั้นไม่สามารถขยายได ้

ค. รูปภาพนาํมาสร้างเป็นพื้นหลงัของเวบ็เพจได ้

ง. การกาํหนดคุณสมบติัของรูปภาพสามารถกาํหนด

ที่  Properties Inspector  ได ้

   

 

35. การปรับระยะห่างระหวา่งรูปภาพกบัขอ้ความ จะ   

      กาํหนดค่าในส่วนใดของ Properties Image 

ก. Map และ Src 

ข. Border และ Align 

ค. farger และ Original 

ง. V Spece  และ H Spece 

    

36. ขอ้ใดคือขั้นตอนการแทรกเสียงลงบนเวบ็เพจ 

ก. Insert/Media/Flash 

ข. Insert/Media/Applet 

ค. Insert/Media/plugin 

ง. Insert/Media/ActiveX 

    

37. เม่ือตอ้งการออกแบนเนอร์โฆษณาใหส้ามารถ    

    เคล่ือนไหวได ้ควรเลือกใชโ้ปรแกรมใดในการ  

    ออกแบบ 

ก. Flash 

ข. Photoshop 

ค. Affter Effect 

ง. Photoshop Image Ready 
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ข้อสอบ 
ความคดิเห็น ข้อเสนอแนะ 

+1 0 -1 

38.           เป็นปุ่ มที่ใชใ้นการทาํส่ิงใด 

ก. แทรกไฟลว์ดีิโอ 

ข. แทรกไฟล ์Flash 

ค. แกไ้ขไฟล ์Flash 

ง. แทรก Java Script 

   

 

39. ขอ้ใดคือขั้นตอนการแทรก Flash ลงบนเวบ็เพจ 

ก. Insert/Media/Photo 

ข. Insert/Media/VDO 

ค. Insert/Media/SWF 

ง. Insert/Media/Animation 

    

40. การเร่ิมเล่นโดยอตัโนมติั กาํหนดค่าที่ช่องใดใน 

    หนา้ต่าง Properties 

ก. Play 

ข. Scale 

ค. Loop 

ง. Quality 

    

41. ไฟลว์ดีีโอจาก Flash เป็นไฟลป์ระเภทใด 

ก. AVI 

ข. FLV 

ค. SWF 

ง. JPEG 

    

42. การแทรกไฟล ์Shockwave ไดจ้ากปุ่ มใด 

ก. ปุ่ ม   

ข. ปุ่ ม   

ค. ปุ่ ม 

ง. ปุ่ ม 
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ข้อสอบ 
ความคดิเห็น ข้อเสนอแนะ 

+1 0 -1 

43.           เป็นปุ่ มที่ใชใ้นการทาํส่ิงใด 

ก.  แทรกกลอ้งวดีีโอ 

ข.  แทรกไฟล ์Flash 

ค.  แกไ้ขไฟล ์Flash Video 

ง.  แทรกไฟล ์Flash Video 

    

44. ไฟล ์Flash ชนิดใดที่สามารถเปิดและแกไ้ขดว้ย 

    โปรแกรม Flash ได ้

ก.  ไฟล ์Flash (.fla) 

ข.  ไฟล ์Flash (.flv) 

ค.  ไฟล ์Flash (.psd) 

ง.  ไฟล ์Flash (.gif) 

    

45. ไฟล ์Flash ชนิดใดที่ถูกบีบอดัเพือ่นาํมาใชแ้สดงผล  

       บนเวบ็บราวเซอร์ 

ก.  ไฟล ์Flash (.fla) 

ข.  ไฟล ์Flash (.swf) 

ค.  ไฟล ์Flash (.swc) 

ง.  ไฟล ์Flash (.swt) 

    

46. ใชข้นาดตามไฟล ์Flash Video กาํหนดค่าที่คาํสัง่ใด 

ก. Size  

ข. Skin 

ค. Browse  

ง. Detect Size 

    

47. การแทรกไฟลว์ดีีโอไดจ้ากปุ่ มในขอ้ใด 

ก. ปุ่ ม   

ข. ปุ่ ม   

ค. ปุ่ ม 

ง. ปุ่ ม 
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48. การวนรอบเล่นไปเร่ือยๆ กาํหนดค่าที่ช่องใดใน 

      หนา้ต่าง Properties 

ก. Auto 

ข. Play 

ค. Autoplay 

ง. AutoLoop 

ความคดิเห็น ข้อเสนอแนะ 

+1 0 -1 

49. การเล่นทนัทีที่เปิดหนา้เวบ็ กาํหนดค่าที่ช่องใดใน       

      หนา้ต่าง Properties 

ก. FLV 

ข. Skin  

ค. Play 

ง. Auto play 

    

50. การเล่นแบบวนรอบไปเร่ือยๆ กาํหนดค่าที่ช่องใดใน 

      หนา้ต่าง Properties 

ก. Help 

ข. Video 

ค. Play Video 

ง. Auto rewind 

    

51. ทาํไม Flash นิยมในการสร้างภาพเคล่ือนไหวบนเวบ็ 

ก. ใชง้านง่าย 

ข. จะไดภ้าพเป็น Bitmap 

ค. ไฟลมี์ขนาดเล็ก และใชเ้วลาในการโหลดนอ้ย 

ง. ภาพเคล่ือนไหวที่ไดมี้รูปแบบที่สวยงามกวา่ที่อ่ืน 

    

52. หากเราทาํการสร้างภาพเคล่ือนไหว  และปุ่มโตต้อบ 

      กบัผูแ้บบมลัติมีเดีย เราควรเลือกใชโ้ปรแกรมใด 

ก. Flash 

ข. Snagit 

ค. Photoshop 

ง. Dreamweaver 
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ข้อสอบ 

 

ความคดิเห็น ข้อเสนอแนะ 

+1 0 -1 

53. การแทรกไฟลม์ลัติมีเดียรูปแบบต่าง บนเวบ็เพจ   

      สามารถเลือกใชง้านจากกลุ่มเคร่ืองมือใด 

ก. Script 

ข. Layout 

ค. Common 

ง. Application 

    

54. ขอ้ใดไม่ใช่ไฟลม์ลัติมีเดียที่ใชใ้นโปรแกรม 

       Dreamweaver 

ก. AVI 

ข. SWF 

ค. Shockwave 

ง. Java Applet 

    

55. การสร้างขอ้ความที่ใชใ้นการเช่ือมโยงโดยเม่ือนาํเมาส์ 

     ไปวางที่ขอ้ความน้ี สีของขอ้ความจะเปล่ียนไปเป็น 

      ลกัษณะการสร้างขอ้ความในแบบใด 

ก. Flash Text 

ข. Flash Button 

ค. Firework Text 

ง. Firework Button 

    

56. คาํสัง่ในขอ้ใดเป็นการสร้างตาราง 

ก. Site>Table 

ข. Insert>Table 

ค. Modify>Table 

ง. Commands>Table 
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ข้อสอบ 
ความคดิเห็น ข้อเสนอแนะ 

+1 0 -1 

57. ขอ้ใดไม่ใช่ ขอ้ดีของการออกแบบเวบ็เพจดว้ยตาราง 

ก. ออกแบบไดง่้าย 

ข. มีความซบัซอ้นหลายขั้นตอน 

ค. เพือ่ใหห้นา้เวบ็เพจเป็นระเบียบ 

ง. จดัหนา้เวบ็ไดอ้ยา่งเป็นสดัส่วน 

    

58. ถา้ตอ้งการรวมเซลลต์ารางตอ้งใชเ้มนูคาํสัง่ใด 

ก. Modify > Table > Split Cell 

ข. Modify > Table > Merge Cell  

ค. Modify > Table > Delete Low 

ง. Modify > Table > Insert Column 

    

59. การเปล่ียนขนาดของเสน้ขอบถา้ตอ้งการใหซ่้อน 

    เสน้ขอบจะใส่เลขใด 

ก.  0 

ข.  1 

ค.  2 

ง.  5 

    

60. Table Width  คือการกาํหนดคา่อะไรของตาราง 

ก.  เสน้ขอบตาราง 

ข.  ความสูงของตาราง 

ค.  ความกวา้งของตาราง 

ง.  จาํนวนแถวของตาราง 

    

61. คาํสัง่ใดใชใ้นการแบ่งเซลล ์

ก. Splits 

ข. Insert 

ค. Merges 

ง. Total Cell 
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ข้อสอบ 
ความคดิเห็น ข้อเสนอแนะ 

+1 0 -1 

62. การสร้างตารางตอ้งใชก้ลุ่มเคร่ืองมือในขอ้ใด 

ก. Text 

ข. Forms 

ค. HTML 

ง. Common 

    

63.  ขอ้ใดกล่าวถึงการซอ้นตารางไดถู้กตอ้ง 

ก. สร้างตารางซอ้นตารางได ้

ข. สร้างตารางซอ้นตารางไม่ได ้

ค. ซอ้นตารางไดน้อกเซลลข์องตาราง 

ง. ซอ้นตารางได ้1 แถว 1 คอลมัน์เท่านั้น 

    

64.  ขอ้ใดกล่าวไม่ถูกตอ้งเก่ียวกบัการใชต้ารางใน 

     การสร้างเวบ็เพจ 

ก. สามารถใส่สีเสน้ขอบตารางได ้

ข. ตารางสามารถพมิพข์อ้ความลงได ้

ค. ตารางสามารถผสานและแบ่งเซลลไ์ด ้

ง. ตารางไม่สามารถแทรกรูปภาพใส่ไปได ้

    

65.  วธีิการพมิพข์อ้ความลงในตาราง  คือขอ้ใด 

ก. ใส่เสน้ขอบตารางก่อน 

ข. คลิกเมนูคาํสัง่ Insert   ก่อนทุกคร้ัง 

ค. คลิกเลือกตารางที่ตอ้งการพมิพข์อ้ความ 

ง. คลิกเลือกเซลลท์ี่ตอ้งการจะพมิพข์อ้ความ 

    

66. การจดัวางตาํแหน่งของตารางสามารถจดัวางไดก่ี้ 

      รูปแบบ 

ก.  2 รูปแบบ 

ข.  3 รูปแบบ 

ค.  4 รูปแบบ 

ง.  5 รูปแบบ 
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ข้อสอบ 

 

ความคดิเห็น ข้อเสนอแนะ 

+1 0 -1 

67. ขั้นตอนในขอ้ใดแสดงผลเพือ่ลบตาราง 

ก. เลือกตารางที่ตอ้งการแลว้กดปุ่ม  Alt  บนแป้นพมิพ ์

ข. เลือกตารางที่ตอ้งการแลว้กดปุ่ ม Ctrl  บนแป้นพมิพ ์

ค. เลือกตารางที่ตอ้งการแลว้กดปุ่ ม Delete  บน 

    แป้นพมิพ ์

ง. เลือกตารางที่ตอ้งการแลว้กดปุ่ ม  Shift   

     บนแป้นพมิพ ์

    

67. Rows หมายถึงอะไร 

ก. จาํนวนแถวที่ตอ้งการ 

ข. จาํนวนคอลมัน์ที่ตอ้งการ 

ค. ระยะระหวา่งแต่ละเซลลใ์นตาราง 

ง. ระยะระหวา่งขอ้ความกบัขอบตาราง 

    

69. Cell Padding หมายถึงอะไร 

ก. ความกวา้งของตาราง 

ข. ความหนาของขอบตาราง 

ค. ระยะระหวา่งแต่ละเซลลใ์นตาราง 

ง. ระยะระหวา่งขอ้ความกบัขอบตาราง 

    

70. Width  หมายถึงอะไร 

ก. ความกวา้งของตาราง 

ข. จาํนวนแถวที่ตอ้งการ 

ค. จาํนวนคอลมัน์ที่ตอ้งการ 

ง. ความหนาของขอบตาราง 

    

71. ถา้ตอ้งการแทรกแถวใหก้บัตารางใชค้าํสัง่ใด 

ก. Modify > Table > Insert Spry 

ข. Modify > Table > Insert Row 

ค. Modify > Table > Insert Forms  

ง. Modify > Table > Insert Layout 
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ข้อสอบ 

 

ความคดิเห็น ข้อเสนอแนะ 

+1 0 -1 

72. การกาํหนดเสน้ขอบใหก้บัตารางใชค้าํสัง่ใด 

ก. Properties > Align 

ข. Properties > Border 

ค. Properties > Cellpad 

ง. Properties > CellSpace 

    

73. กาํหนดสีพื้นหลงัใหต้าราง ตอ้งใชค้าํสัง่ใด 

ก. Color 

ข. BG Color 

ค. Table Color 

ง. Border Color 

    

74. Split Cell ในการสร้างตารางคืออะไร 

ก. การลบเซลล ์

ข. การเพิม่เซลล ์

ค. การแยกเซลล ์

ง. การรวมเซลล ์

    

75. ปุ่ ม            ใชใ้นการทาํส่ิงใด 

ก. แทรกตาราง 

ข. แทรกเลเยอร์ 

ค. แทรกกล่องขอ้ความ 

ง. แทรกรูปส่ีเหล่ียมหลายรูป 

    

76.  การลิงคเ์พือ่เช่ือมโยงหนา้เวบ็เพจมีกี่รูปแบบ 

ก. 2 รูปแบบ 

ข. 3 รูปแบบ 

ค. 4 รูปแบบ 

ง. 5 รูปแบบ 
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ข้อสอบ 

 

ความคดิเห็น ข้อเสนอแนะ 

+1 0 -1 

77. ช่อง Target ขอ้ความ "_Blank" เป็นการลิงคไ์ปที่ใด 

ก. การแสดงเวบ็เพจ โดยจะไม่มีเฟรม 

ข. การแสดงเวบ็เพจในเฟรมเดียวกบัตน้ทาง 

ค. การแสดงเวบ็เพจปลายทางในหนา้ต่างเดิม 

ง. การแสดงเวบ็เพจปลายทางในหนา้ต่างใหม่ 

    

78. การลิงคข์อ้มูลบนหนา้เวบ็เพจทาํไดโ้ดยวิธีใด 

ก. เลือก File > New 

ข. เลือก Edit > Copy 

ค. เลือก Insert > Table 

ง. เลือก Modife> Make Link 

    

79. การลิงคไ์ปยงัเวบ็ไซตอ่ื์นจะพมิพเ์วบ็ไซตท์ี่ใด 

ก. URL 

ข. LINK 

ค. LOOK IN 

ง. TARGET 

    

80. เราใชค้าํสัง่ใดในการกาํหนดลกัษณะของเพจใหม่ 

    ที่เช่ือมโยง 

ก. Ctrl + T 

ข. Ctrl + L 

ค. Insert > Hyperlink 

ง. Modify > Link Target 

    

81. การลิงค(์Link ) หมายถึงอะไร 

ก. การใส่วนัที่หนา้เวบ็เพจ 

ข. การเช่ือมโยงหนา้เวบ็เพจ 

ค. การแทรกตารางหนา้เวบ็เพจ 

ง. การแทรกรูปภาพหนา้เวบ็เพจ 
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ข้อสอบ 

 

ความคดิเห็น ข้อเสนอแนะ 

+1 0 -1 

82. คาํสัง่ E-Mail LINK ไปสู่ E Mail คือขอ้ใด 

ก. mailto: 

ข. Link Mail : 

ค. Mail go to: 

ง. Up Load to: 

    

83. ขอ้ใดเป็นการพมิพช่ื์อเวบ็ไซตท์ี่ถูกตอ้งใน 

    การเช่ือมโยงไปยงัเวบ็ไซตอ่ื์น 

ก. //google.com 

ข. www.google.com 

ค. http://google.com 

ง. http://www.google.com 

    

84. ขอ้ใด ไม่ใช่ ลกัษณะของการเช่ือมโยงแบบ Rollover  

       Image 

ก. การใชรู้ปภาพ 2 รูป 

ข. การดาวน์โหลดไฟล ์

ค. การนาํเมาส์ไปวางเหนือรูปภาพเดิม 

ง. การช่วยใหเ้วบ็เพจมีความน่าสนใจยิง่ขึ้น 

    

85. จงบอกประโยชน์ของการเช่ือมโยงดว้ยอีเมลล ์

ก.  สาํคญัเหมือนการเช่ือมโยงดว้ยแบบอ่ืน 

ข.  เป็นการเช่ือมโยงที่ช่วยให้เวบ็เพจน่าสนใจยิง่ขึ้น 

ค.  ช่วยให้ผูช้มสามารถแสดงความคิดเห็นมายงั 

ผูเ้ขียนเวบ็ได ้

ง.  เป็นการเช่ือมโยงที่เป็นการดาวน์โหลดไฟล์

โปรแกรมประเภทแชร์แวร์ 
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ข้อสอบ 

 

ความคดิเห็น ข้อเสนอแนะ 

+1 0 -1 

86.  คาํสัง่ที่ใชก้ารกาํหนดคุณสมบติัของการเช่ือมโยง  

       ไปที่เมนูใด 

ก. Modify > Page Properties เลือก Link 

ข. Modify > Page Properties เลือก Headings 

ค. Modify > Page Properties เลือก Appearance 

ง. Modify > Page Properties เลือก Title/Encoding 

    

87. ขอ้ใดคือช่ือ URL  ที่ถูกตอ้ง 

ก. ppu.ac.th/ 

ข. www.ppu.ac.th/ 

ค. http://ppu.ac.th/ 

ง. http://www.ppu.ac.th 

    

88. การเช่ือมโยงดว้ย  Map Link  หมายถึงขอ้ใด 

ก. การเช่ือมโยงภาพ 

ข. การเช่ือมโยงขอ้ความ 

ค. การเช่ือมโยงแผนที่ 

ง. การเช่ือมโยงภาพเฉพาะจุด 

    

89. การทาํลิงคเ์ช่ือมไฟลใ์ชน้ามสกลุอะไร 

ก. .psd 

ข. .dwt 

ค. .swf 

ก. ง. .html 

    

90. ขอ้ใดคือบริการใหเ้ช่าพื้นที่ฝากขอ้มูลบนเวบ็ไซต ์

ก. Web Service 

ข. Web Sharing 

ค. Web Hosting  

ง. Web Saving 
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ขอ้คิดเห็นและขอ้เสนอแนะเพิม่เติม 

……………………………………………………………………………………………...…

……...………………………………………………………………………………………… 

……………………………………………………………………………...………………… 

 

ลงช่ือ...........................................................ผูป้ระเมิน 

                                                                       (.............................................................) 

ข้อสอบ 
ความคดิเห็น ข้อเสนอแนะ 

+1 0 -1 

91. การกาํหนด Target   แบบ _self  เม่ือตอ้งการใหก้าร 

      เช่ือมโยงเป็นแบบใด 

ก. ใหเ้ปิดเพจที่เช่ือมโยงในเฟรมเดิม 

ข. ใหเ้ปิดเพจที่เช่ือมโยงในหนา้ต่างบราวเซอร์เดิม 

ค. ใหเ้ปิดเพจที่เช่ือมโยงในหนา้ต่างบราวเซอร์ใหม่

อีกหนา้ต่าง 

ง. ใหเ้ปิดเพจที่เช่ือมโยง ในหนา้ต่างบราวเซอร์เดิม 

โดยจดัใหเ้ตม็เฟรม 

    

92. การนาํเวบ็ไซตเ์ผยแพร่บนอินเทอร์เน็ตควรทาํ 

      อยา่งไร 

ก. Upload 

ข. Update 

ค. Upgrade 

ง. Download 

    

93. การ Update หมายถึงอะไร 

ก. การตั้งวนัที่ 

ข. การสร้างเวบ็ไซต ์

ค. การยกเลิกเวบ็ไซต ์

ง. การปรับปรุงเวบ็ไซต ์
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แบบประเมินคุณภาพของแบบสอบถามความคดิเห็น 

เกี่ยวกับความพึงพอใจของนักเรียนที่มีต่อบทเรียนผ่านสมาร์ทโฟนตามแนวคดิองค์กรแห่งการเรียนรู้  

เร่ือง การพัฒนาเว็บไซต์ ช้ันประถมศึกษาปีที่ 6 สําหรับผู้เรียน   

คาํช้ีแจง   กรุณาทาํเคร่ืองหมาย    ลงในช่องวา่งใหต้รงกบัความคิดเห็นของท่านมากที่สุด 

                และกรุณาเขียนคาํแนะนาํลงในช่องขอ้เสนอแนะ 

+1   หมายถึง   แน่ใจวา่ขอ้คาํถามและรูปแบบของภาษามีความเหมาะสม 

 0     หมายถึง   ไม่แน่ใจวา่ขอ้คาํถามและรูปแบบของภาษามีความเหมาะสม 

-1     หมายถึง   แน่ใจวา่ขอ้คาํถามและรูปแบบของภาษาไม่มีความเหมาะสม 

 

ที่ รายการประเมิน ความเห็นของ

ผู้เช่ียวชาญ 

+1 0 -1 

1 ดา้นเน้ือหา    

 1.1 เน้ือหาวชิาในบทเรียนการสอนผา่นเวบ็มีความสอดคลอ้งกบั

วตัถุประสงคก์ารเรียนรู้ 

ขอ้เสนอแนะ………………………………………………………. 
   

 1.2 การลาํดบัเน้ือหาเรียงจากง่ายไปหายาก 

ขอ้เสนอแนะ……………………………………………………… 

   

 1.3 ผูเ้รียนสามารถเขา้ถึงเน้ือหาไดร้วดเร็ว 

ขอ้เสนอแนะ……………………………………………………….… 
   

 1.4 ผูเ้รียนเขา้ใจเน้ือหาในบทเรียนไดง่้าย 

ขอ้เสนอแนะ……………………………………………………….…    

1.5  ผูเ้รียนนาํความรู้ที่ไดไ้ปประยกุตใ์ชใ้นชีวติประจาํวนัได ้

ขอ้เสนอแนะ……………………………………………………….… 
   

 1.6  ผูเ้รียนตระหนกัถึงคุณค่าและประโยชน์ของความรู้ที่ไดรั้บ 

ขอ้เสนอแนะ……………………………………………………….…    
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ที่ รายการประเมิน ความเห็นของ

ผู้เช่ียวชาญ 

+1 0 -1 

2 ดา้นการนาํเสนอดว้ยภาพ สี เสียงประกอบ และการเช่ือมโยงเน้ือหา 
   

 2.1  ภาพประกอบสอดคลอ้งกบัเน้ือหา 

ขอ้เสนอแนะ……………………………………………………….… 
   

 2.2  ภาพประกอบมีความน่าสนใจสามารถส่ือสารไดช้ดัเจน 

ขอ้เสนอแนะ……………………………………………………….…    

 2.3  มีภาพไอคอนสวยงามน่าสนใจ ส่ือความหมายชดัเจน 

ขอ้เสนอแนะ……………………………………………………….…    

 2.4  การเช่ือมโยงเน้ือเพือ่สร้างปฏิสมัพนัธร์ะหว่างผูเ้รียนกบับทเรียน 

ขอ้เสนอแนะ……………………………………………………….…    

 2.5  การเช่ือมโยง (Link) เน้ือหาของการสอนผา่นเวบ็ไดง่้าย 

ขอ้เสนอแนะ……………………………………………………….… 
   

3.  ดา้นแบบทดสอบและการประเมินผล 
   

 3.1  การสอนผา่นเวบ็มีแบบทดสอบหลงัเรียนช่วยให้ผูเ้รียนได ้

        ตรวจสอบความเขา้ใจในเน้ือหาบทเรียนไดเ้หมาะสม 

ขอ้เสนอแนะ……………………………………………………….… 

   

3.2 คาํถามมีความชัดเจน  

ขอ้เสนอแนะ……………………………………………………….…    

3.3  แบบทดสอบสอดคล้องกับวัตถุประสงค์ 

ขอ้เสนอแนะ……………………………………………………….… 
   

3.4  ความยากง่ายของแบบทดสอบเหมาะสม  

ขอ้เสนอแนะ……………………………………………………….…    

3.5  สรุปผลคะแนนท้ายบทเรียนชัดเจน  

ขอ้เสนอแนะ……………………………………………………….… 
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ที่ รายการประเมิน ความเห็นของ

ผู้เช่ียวชาญ 

+1 0 -1 

4.  ด้านส่ิงอาํนวยความสะดวก  
   

 4.1  การติดต่อ ส่ือสารผ่านกระดานเสวนา

ขอ้เสนอแนะ……………………………………………………….… 
   

4.2 การติดต่อ ส่ือสารผ่านห้องสนทนาอิ เล็กทรอนิกส์  

ขอ้เสนอแนะ……………………………………………………….…    

4.3 การติดต่อ ส่ือสารผ่านจดหมายอิ เล็กทรอนิกส์  

ขอ้เสนอแนะ……………………………………………………….… 
   

4.4 การส่งขอ้ความ (Send Massage)โดยใชโ้ปรแกรมเฟรชบุค 

(Facebook) 

ขอ้เสนอแนะ……………………………………………………….… 
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ภาคผนวก  ฉ 

แบบสอบถามความความคดิเห็น 

 

- แบบสอบถามความความคดิเห็นเกีย่วกบัความต้องการในการจัดสภาพแวดล้อม

ทางการเรียนด้วยบทเรียนผ่านสมาร์ทโฟนตามแนวคดิองค์กรแห่งการเรียนรู้  

เร่ือง การพัฒนาเว็บไซต์  สําหรับนักเรียนช้ันประถมศึกษาปีที่ 6 

 



 

 
แบบสอบถามความความคดิเห็นเกีย่วกับความต้องการในการจัดสภาพแวดล้อมทางการเรียน 

ด้วยบทเรียนผ่านสมาร์ทโฟนตามแนวคดิองค์กรแห่งการเรียนรู้  

เร่ือง การพัฒนาเว็บไซต์ สําหรับนักเรียนช้ันประถมศึกษาปีที่ 6   

 

คาํช้ีแจง   

               แบบสอบถามความความคิดเห็นเกี่ยวกบัความตอ้งการในการจดัสภาพแวดลอ้มทางการเรียน

ดว้ยบทเรียนผ่านสมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์ สาํหรับ

นกัเรียนชั้นประถมศึกษาปีที่  6  ในการวจิยัคร้ังน้ีมีวตัถุประสงคข์องการวจิยั ดงัต่อไปน้ี 

1.  เพื่อหาประสิทธิภาพของบทเรียนผ่านสมาร์ทโฟนตามแนวคิดองคก์รแห่งการเรียนรู้

เร่ือง การพฒันาเวบ็ไซต ์สาํหรับนกัเรียนชั้นประถมศึกษาปีที่ 6   

   2.  เพื่อเปรียบเทียบผลสัมฤทธ์ิก่อนเรียนและหลังเรียนของนักเรียนท่ีเรียนจากการสอน  

ผ่านสมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้ เร่ือง การพฒันาเว็บไซต์ สําหรับนักเรียน                  

ชั้นประถมศึกษาปีที่  6  

   3.  เพือ่หาความพงึพอใจของนกัเรียนชั้นประถมศึกษาปีที่ 6 ที่ใชบ้ทเรียนผ่านสมาร์ทโฟน 

ตามแนวคิดองค์กรแห่งการเรียนรู้ เร่ืองการพฒันาเว็บไซต์ 

แบบสอบถามคร้ังน้ีมี  3  ส่วน ไดแ้ก่  

ส่วนที่ 1 ขอ้มูลทัว่ไปเก่ียวกบัผูเ้ช่ียวชาญ 

ส่วนที่ 2 สภาพปัญหาการจดัการเรียนการสอนเร่ือง การพฒันาเวบ็ไซตใ์นปัจจุบนั 

ส่วนที่ 3 ลกัษณะสภาพการจดัการเรียนการสอนของการออกแบบการสอนผ่านสมาร์ทโฟน 

เร่ือง การพฒันาเวบ็ไซต ์ ที่พงึประสงค ์

ในการน้ีผูว้ิจัยจะเก็บความคิดเห็นของท่านเป็นความลับแต่จะนําความคิดเห็นของท่าน         

มาใช้ประโยชน์ในการการจัดสภาพแวดล้อมทางการเรียนที่ เหมาะสมกับการสร้างบ ทเรียน         

ผ่านสมาร์ทโฟนตามแนวคิดองค์กรแห่งการเรียนรู้ เร่ือง การพฒันาเวบ็ไซต ์สําหรับนักเรียน     

ชั้ นประถมศึกษาปีที่  6  จึงขอความอนุเคราะห์ให้ท่านตอบแบบสอบถามความคิดเห็นตาม             

ความเป็นจริงที่สุด  และขอกราบขอบพระคุณท่านที่ใหค้วามร่วมมือเป็นอยา่งดีมาไว ้ ณ โอกาสน้ีดว้ย 
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คาํช้ีแจง  โปรดแสดงความคิดเห็นของท่านโดยทาํเคร่ืองหมาย   ลงในช่องที่ตรงกบัความคิดเห็น 

               ของท่านมากที่สุด 
 

ส่วนที่ 1 ข้อมูลทั่วไปเกี่ยวกับผู้เช่ียวชาญ 

1. สถานะ  ครูที่จบเอกคอมพวิเตอร์    ครูที่ไม่จบเอกคอมพวิเตอร์  

2. เพศ      ชาย       หญิง  

3. ระดบัการศึกษา   ปริญญาตรี            ปริญญาโท สูงกวา่ปริญญาโท 

4. อาย ุ      20 – 30  ปี    31 – 40  ปี    41 -50  ปี 

   51-60    ปี   
 

เกณฑ์การให้คะแนน ใน ส่วนที่ 2  และส่วนที่ 3  

ระดบัคะแนน     5 หมายถึง  เห็นดว้ยอยา่งยิง่ 

ระดบัคะแนน     4 หมายถึง  เห็นดว้ยมาก 

ระดบัคะแนน     3  หมายถึง  เห็นดว้ย 

ระดบัคะแนน     2 หมายถึง  เห็นดว้ยนอ้ย 

ระดบัคะแนน     1 หมายถึง  เห็นดว้ยนอ้ยท่ีสุด 
 

ส่วนที่ 2 สภาพปัญหาการจัดการเรียนการสอนเร่ือง การพัฒนาเว็บไซต์ ในปัจจุบัน 
 

 

 

รายการประเมิน 

ระดับความพึงพอใจ 

5 4 3 2 1 

1. เวลาในการใชง้านและเรียนรู้ในสถานศึกษามีนอ้ย  

    เกินไป 

     

2. นกัเรียนไม่สามารถทบทวนบทเรียนนอกเวลาได ้      

3. นกัเรียนเนน้ความสนุกสนาน ขาดการใฝ่รู้      

4. นกัเรียนมุ่งเนน้การเขา้หาส่ิงบนัเทิง เกม หรือการ  

    เขา้สงัคมการพดูคุยมากกวา่จะเขา้สู่ดา้นการเรียนรู้ 

     

5. นกัเรียนขาดความตั้งใจในการเขา้เรียนรู้      

6. นกัเรียนใชเ้คร่ืองมือในการสืบคน้ขอ้มูลไม่ถูกตอ้ง  

    และไม่เหมาะสม 
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ส่วนที่ 2 สภาพปัญหาการจัดการเรียนการสอนเร่ือง การพัฒนาเว็บไซต์ ในปัจจุบัน (ต่อ) 

รายการประเมิน ระดับความพึงพอใจ 

5 4 3 2 1 

7. การจัดการเรียนการสอนบทเรียนผ่านสมาร์ทโฟน  เร่ือง การพัฒนาเว็บไซต์  ดังต่อไปนี้ท่าน      

    มีความคดิเห็นอยู่ในระดับใด 

   7.1 การพฒันาทกัษะกระบวนการที่ส่งเสริมการคิด 

วเิคราะห์ 
     

   7.2 การจดัการเรียนการสอนอย่างต่อเน่ืองจากง่าย   

ไปยาก 
     

    7.3 การเตรียมการสอนล่วงหนา้      

    7.4 การแจง้วตัถุประสงคใ์นเน้ือหาสาระวชิาที่สอน      

    7.5 การพฒันาการสอนแบบใหม่        

8. รูปแบบการสอนบทเรียนบนเว็บ  วิชา คอมพวิเตอร์ 

    8.1 การสอนแบบการทาํงานเป็นทีม      

    8.2  การสอนตามรูปแบบองคก์รแห่งการเรียนรู้      

    8.3  การสอนแบบแกปั้ญหา      

    8.4 การสอนแบบสาธิต      

    8.5 การสอนแบบสถานการณ์จาํลอง      

    8.6 การสอนแบบการเรียนรู้ดว้ยตนเอง      
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ส่วนที่ 3 ลักษณะสภาพการจัดการเรียนการสอนของการออกแบบบทเรียนผ่านสมาร์ทโฟน  เร่ือง   

การพัฒนาเว็บไซต์ ที่พึงประสงค์ 
 

 

รายการประเมิน 

ระดับความพึงพอใจ 

5 4 3 2 1 

1. ท่านตอ้งการใหใ้ชส่ื้อประกอบการจดัการเรียนการสอน ดงัต่อไปน้ี อยูใ่นระดบัใด 

   1.1 การสอนดว้ยบทเรียนผา่นสมาร์ทโฟน      

   1.2 การสอนดว้ยส่ือบทเรียนคอมพวิเตอร์ช่วยสอน  

         ออฟไลน ์
     

1.3 วดีีทศัน์, โทรทศัน์      

1.4 เคร่ืองฉายภาพน่ิง      

1.5 เคร่ืองเล่นแผน่เสียง      

2. กิจกรรมการเรียนการสอนด้วยบทเรียนผ่านสมาร์ทโฟน  ดงัต่อไปน้ีอยูใ่นระดบัใด 

     2.1 เรียนดว้ยตนเอง      

     2.2 การอภิปรายกลุ่ม (Chat Room)      

     2.3 การระดมความคิด      

     2.4 ทาํงานเป็นกลุ่ม      

     2.5 การสร้างผลงาน      

3. ท่านต้องการออกแบบบทเรียนผ่านสมาร์ทโฟน เร่ือง การพฒันาเว็บไซต์ ให้มีลักษณะ

ดงัต่อไปน้ี อยูใ่นระดบัใด 

    3.1 เน้ือหามีความถูกตอ้งชดัเจนเหมาะสม  

          กบัระดบัชั้น 
     

   3.2 เน้ือหาบทเรียนครอบคลุมวตัถุประสงค ์      

   3.3  การจดัลาํดบัเน้ือหาเหมาะสม      

   3.4 ความน่าสนใจของเน้ือหาในบทเรียน      

   3.5 การลาํดบัเน้ือหาจากง่ายไปหายาก      

   3.6 ปริมาณของเน้ือหาแต่ละหน่วยเหมาะสม      

   3.7 คาํถามมีความชดัเจน      

   3.8 แบบทดสอบสอดคลอ้งกบัวตัถุประสงค ์      
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ส่วนที่ 3  ลักษณะสภาพการจัดการเรียนการสอนของการออกแบบบทเรียนผ่านสมาร์ทโฟน  เร่ือง   

การพัฒนาเว็บไซต์ ที่พึงประสงค์ (ต่อ) 

 

รายการประเมิน 

ระดับความพึงพอใจ 

5 4 3 2 1 

   3.9 ความยากง่ายของแบบทดสอบเหมาะสม      

   3.10 ความถูกตอ้งของภาษาที่ใช ้      

   3.11 สรุปผลคะแนนทา้ยบทเรียนชดัเจน      

   3.12 การนาํเสนอดึงดูดความสนใจ      

   3.13 การนาํเสนอตามลาํดบัขั้นตอน      

   3.14 การเร้าความสนใจดว้ยเสียงประกอบบทเรียน      

   3.15 ความสอดคลอ้งระหวา่งภาพกบัคาํบรรยาย      

   3.16 ความเหมาะสมของภาพในการส่ือความหมาย      

   3.17 ความชดัเจนของภาพที่นาํมาใช ้      

   3.18 ความเหมาะสมในการใชเ้ทคนิคการนาํเสนอ      

   3.19 รูปแบบการนาํเสนอที่จูงใจ      

   3.20 รูปแบบอกัษรที่ใชน้าํเสนอเน้ือหาอ่านง่าย      

   3.21 ขนาดตวัอกัษรในการนาํเสนอเหมาะสม      

   3.22 การเลือกใชสี้ตวัอกัษรเหมาะสม      

   3.23 การใชสี้พื้นจอภาพเหมาะสม      

   3.24 สีตวัอกัษรที่ใชเ้ช่ือมโยงแต่ละหนา้จอ      

4. ท่านมีความคิดเห็นวา่ตอ้งการจดัการเรียนการสอนผ่านสมาร์ทโฟน เร่ือง การพฒันาเวบ็ไซต์

ในหวัขอ้ดงัต่อไปน้ี อยูใ่นระดบัใด 

   4.1 การรับและส่งไปรษณียอิ์เล็กทรอนิกส์ (E-mail)       

   4.2 การถ่ายโอนแฟ้มขอ้มูล (File Transfer)       
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ส่วนที่ 3  ลักษณะสภาพการจัดการเรียนการสอนของการออกแบบบทเรียนผ่านสมาร์ทโฟน  เร่ือง   

การพัฒนาเว็บไซต์ ที่พึงประสงค์ (ต่อ) 

 

รายการประเมิน 

ระดับความพึงพอใจ 

5 4 3 2 1 

   4.3 การเช่ือมต่อเขา้ใชง้าน (Log In)        

   4.4 การคน้หาขอ้มูล (Search Engine)       

   4.5 วดีิโอคอนเฟอร์เร้น (video conference)       

   4.6 กระดานอิเลก็ทรอนิกส์ (Electronic Boards)      

   4.7 การส่งขอ้ความ (Send Massage) โดยใช ้ 

        โปรแกรมเฟรชบุค (Facebook) 
     

   4.8 การส่งขอ้ความ (Send Massage) โดยใช ้ 

         โปรแกรมทวสิเตอร์ (Twister)          
     

   4.9 การติดต่อส่ือสารดว้ยโปรแกรม Skype  

         (สไกป์)  
     

 

 

ข้อเสนอแนะ 

.................................................................................................................................................................  

................................................................................................................................................................. 
 
  

                 ผูป้ระเมิน………………….………... 

                                                            (……...................................................) 

                                ตาํแหน่ง.................................................. 

                                วนัที่.........../......................../.................. 
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ภาคผนวก  ช 

ผลการประเมินของผู้เช่ียวชาญ 

 

-  แบบประเมินสภาพปัญหาการจัดการเรียนการสอน เร่ือง การพฒันาเวบ็ไซต์ 

-  ตารางภาคผนวก 

    ตารางที ่ 1  จาํนวนและร้อยละของสถานภาพผู้ตอบแบบสอบถาม 

    ตารางที ่ 2  สภาพปัญหาการจดัการเรียนการสอน เร่ือง การพฒันาเวบ็ไซต์ ในปัจจุบัน 

    ตารางที ่ 3  ลกัษณะสภาพการจดัการเรียนการสอนวชิาคอมพวิเตอร์ทีพ่งึประสงค์ของ   

                       การออกแบบบทเรียนการสอนผ่านสมาร์ทโฟน เร่ือง การพฒันาเวบ็ไซต์ 

    ตารางที ่4   ความคดิเห็นของผู้เช่ียวชาญด้านวดัและประเมนิผล เพือ่หาดชันีความ  

                       สอดคล้อง (IOC) ของแบบทดสอบก่อนและหลงัเรียน 

    ตารางที ่5   ผลวเิคราะห์ค่าความยากง่าย อาํนาจจาํแนก และความเช่ือมัน่ของ  

                       แบบทดสอบ 
    ตารางที่ 6  ความคดิเห็นของผู้เช่ียวชาญเพือ่หาค่าดัชนีความสอดคล้อง (IC) ของ               

ข้อคาํถาม เพือ่สร้างแบบสอบถามความคดิเห็นสําหรับผู้เช่ียวชาญ เกีย่วกบั

บทเรียนผ่านสมาร์ทโฟนตามแนวคดิองค์กรแห่งการเรียนรู้ เร่ือง การพฒันา

เวบ็ไซต์ สําหรับนักเรียนช้ันประถมศึกษาปีที ่6 

    ตารางที ่7  ความคดิเห็นของผู้เช่ียวชาญเพือ่หาค่าดชันีความสอดคล้อง (IC) ของ           

ข้อคาํถามเพือ่สร้างแบบสอบถามประเมนิความพงึพอใจของนักเรียน            

ช้ันประถมศึกษาปีที ่6 ทีม่ต่ีอบทเรียนผ่านสมาร์ทโฟนตามแนวคดิองค์กร

แห่งการเรียนรู้เร่ืองการพฒันาเวบ็ไซต์ 

    ตารางที ่8 รายงานสรุปผลการหาประสิทธิภาพของการสอนผ่านสมาร์ทโฟนตาม

แนวคดิองค์กรแห่งการเรียนรู้ สําหรับนักเรียนช้ันประถมศึกษาปีที ่6  

    ตารางที ่ 9  คะแนนก่อนและหลงัการสอนผ่านเสมาร์ทโฟนของนักเรียนทั้งหมด  30  คน 



แบบประเมินสภาพปัญหาการจัดการเรียนการสอน เร่ือง การพัฒนาเว็บไซต์ 

ตารางที่ 1  จํานวนและร้อยละของสถานภาพผู้ตอบแบบสอบถาม 

สถานภาพ จํานวน ร้อยละ 

1. สถานะ 

    -  ครูที่จบเอกคอมพวิเตอร์ 

    -  ครูที่ไม่จบเอกคอมพวิเตอร์ 

 

57 

- 

 

100 

- 

รวม 57 100 

2.  เพศ 

    -  ชาย 

    -  หญิง 

 

37 

20 

 

64.91 

35.09 

รวม 57 100 

3.  ระดับการศึกษา 

    -  ปริญญาตรี         

     -  ปริญญาโท 

     -  สูงกวา่ปริญญาโท 

 

44 

13 

- 

 

77.19 

22.81 

- 

รวม 57 100 

4.  อาย ุ

     -  20 – 30  ปี 

     -  31 – 40  ปี  

     -  41 -50  ปี 

     -  51-60   ปี 

 

33 

17 

7 

- 

 

57.89 

29.82 

12.28 

- 

รวม 57 100 

จากตารางที่ 1 พบว่าผูต้อบแบบสอบถามเป็นครูท่ีจบเอกคอมพิวเตอร์ คิดเป็นร้อยละ 100  

ส่วนใหญ่เป็นเพศชาย คิดเป็นร้อยละ  64.91 ระดบัการศึกษาส่วนใหญ่จบการศึกษาระดบัปริญญาตรี 

คิดเป็นร้อยละ 77.19 รองลงมาคือระดับปริญญาโท คิดเป็นร้อยละ 22.81 และผูต้อบแบบสอบถาม

ส่วนใหญ่มีอาย ุ20-30 ปี  คิดเป็นร้อยละ 57.89 รองลงมาคือ อายุ 31-40 ปี คิดเป็นร้อยละ 29.82 และ

อาย ุ41-50 ปี คิดเป็นร้อยละ 12.28   
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ตารางที่  2  สภาพปัญหาการจัดการเรียนการสอน เร่ือง การพัฒนาเว็บไซต์ ในปัจจุบัน 

รายการประเมิน Χ  S.D. แปลผล 

1. การทาํงานของเคร่ืองคอมพวิเตอร์ในหอ้งเรียน  

    ที่ค่อนขา้งชา้ 
2.93 0.80 ปานกลาง 

2. นกัเรียนไม่สามารถทบทวนบทเรียนนอกเวลาได ้ 4.49 0.73 มาก 

3. เวลาในการใชง้านและเรียนรู้ในสถานศึกษามีนอ้ยเกินไป 4.14 0.81 มาก 

4. นกัเรียนมุ่งเนน้การเขา้หาส่ิงบนัเทิง เกม หรือการเขา้  

    สงัคม การพดูคุยมากกวา่จะเขา้สู่ดา้นการเรียนรู้ 

4.32 0.74 มาก 

5. นกัเรียนขาดความตั้งใจในการเขา้เรียนรู้ 4.49 0.78 มาก 

6. นกัเรียนใชเ้คร่ืองมือในการสืบคน้ขอ้มูลไม่ถูกตอ้ง  

    และไม่เหมาะสม 

4.49 

 

0.63 มาก 

7. การจัดการเรียนการสอนดังต่อไปนีท่้านมีความคดิเห็น อยู่ในระดับใด 

   7.1 การพฒันาทกัษะกระบวนการท่ีส่งเสริมการคิดวเิคราะห์ 4.84 0.49 มากที่สุด 

   7.2 การจดัการเรียนการสอนอยา่งต่อเน่ืองจากง่ายไปยาก 4.63 0.59 มากที่สุด 

    7.3 การเตรียมการสอนล่วงหนา้ 4.54 0.71 มากที่สุด 

    7.4 การแจง้วตัถุประสงคใ์นเน้ือหาสาระวชิาที่สอน 4.79 0.45 มากที่สุด 

    7.5 การพฒันาการสอนแบบใหม่   4.51 0.71 มากที่สุด 

    7.6 การทาํวจิยัชั้นเรียนเพือ่พฒันาความสามารถของ  

          นกัเรียนเป็นรายบุคคล 

4.56 

 

0.71 มากที่สุด 

8. รูปแบบการสอนบทเรียนผ่านสมาร์ทโฟน เร่ืองการพัฒนาเว็บไซต์ 

    8.1 การสอนแบบการทาํงานเป็นทีม 4.05 0.81 มาก 

    8.2  การสอนตามรูปแบบองคก์รแห่งการเรียนรู้ 4.95 0.29 มากที่สุด 

    8.3  การสอนแบบแกปั้ญหา 1.28 0.45 นอ้ยที่สุด 

    8.4 การสอนแบบสาธิต 1.44 0.54 นอ้ยที่สุด 

    8.5 การสอนแบบสถานการณ์จาํลอง 1.33 0.55 นอ้ยที่สุด 

    8.6 การสอนแบบการเรียนรู้ดว้ยตนเอง 3.63 0.79 มาก 

ค่าเฉลี่ยรวม 3.86  มาก 
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จากตารางที่ 2 แสดงระดบัความคิดเห็นของครูคอมพิวเตอร์ที่มีต่อสภาพปัญหาการจดัการ

เรียนการสอนเร่ืองการพฒันาเว็บไซต์ ในปัจจุบนั โดยมีรายการประเมินค่าเฉล่ียโดยรวม อยูท่ี่ 3.86  

ซ่ึงแปลผลออกมาได้ว่าอยู่ในระดับเห็นด้วยมาก  โดยสภาพปัญหาที่พบมากที่สุดคือ นักเรียน                     

ไม่สามารถทบทวนบทเรียนนอกเวลาได้ นักเรียนขาดความตั้งใจในการเขา้เรียนรู้ และนักเรียนใช้

เคร่ืองมือในการสืบคน้ขอ้มูลไม่ถูกตอ้งและไม่เหมาะสม  ส่วนในดา้นการจดัการเรียนการสอนส่วน

ใหญ่จะเห็นดว้ยมากที่สุดกบัการสอนตามรูปแบบองคก์รแห่งการเรียนรู้  
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ตารางที่  3  ลักษณะสภาพการจัดการเรียนการสอนวิชาคอมพิวเตอร์ที่พงึประสงค์ของการออกแบบ

บทเรียนการสอนผ่านสมาร์ทโฟน เร่ือง การพัฒนาเว็บไซต์ 
 

รายการประเมิน Χ  S.D. แปลผล 

1. ท่านต้องการให้ใช้ส่ือประกอบการจัดการเรียนการสอน ดังต่อไปนี้ อยู่ในระดับใด 
1.1 การสอนดว้ยบทเรียนผา่นสมาร์ทโฟน 4.77 0.42 มากที่สุด 

1.2 การสอนดว้ยส่ือบทเรียนคอมพวิเตอร์ช่วยสอน 

      ออฟไลน ์

2.04 0.78 นอ้ย 

    1.3 การสอนดว้ยบทเรียนคอมพวิเตอร์ออนไลน์ 4.81 0.40 มากที่สุด 

1.4 การสอนดว้ยส่ือสองมิติ (แผนภาพ, แผนภูมิ, แผนที่)  1.42 0.50 นอ้ยที่สุด 

1.5 การสอนดว้ยส่ือสามมิติ (ของจาํลอง, ของจริง) 1.33 0.48 นอ้ยที่สุด 

1.6 การสอนดว้ยส่ือส่ิงพมิพ ์(หนงัสือแบบเรียน, 

      เอกสาร) 

1.23 0.42 นอ้ยที่สุด 

    1.7 กระดาน, ชอลค์ 1.18 0.38 นอ้ยที่สุด 

    1.8 บตัรคาํ, ภาพการ์ตูน 1.60 0.53 นอ้ย 

    1.9 เคร่ืองฉายภาพน่ิง 1.84 0.37 นอ้ย 

    1.10 วดีีทศัน์, โทรทศัน์ 1.44 0.50 นอ้ยที่สุด 

    1.11 เคร่ืองเล่นแผน่เสียง 1.39 0.49 นอ้ยที่สุด 

ค่าเฉลี่ยรวม     2.09  นอ้ย 

2. กิจกรรมการเรียนการสอน ดังต่อไปนีอ้ยู่ในระดับใด    

     2.1 ทาํงานเป็นกลุ่ม 4.74 0.48 มากที่สุด 

     2.2 ศึกษาคน้ควา้ดว้ยตนเอง 4.74 0.48 มากที่สุด 

     2.3 นิทรรศการ 4.32 0.57 มาก 

     2.4 การสาธิต 4.26 0.55 มาก 

     2.5 การอภิปรายกลุ่ม 4.56 0.57 มากที่สุด 

     2.6 การระดมความคิด 4.47 0.54 มาก 

     2.7 การสร้างผลงาน 4.74 0.44 มากที่สุด 

ค่าเฉลี่ยรวม       4.55  มากที่สุด 
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รายการประเมิน Χ  S.D. แปลผล 

2. กิจกรรมการเรียนการสอน ดังต่อไปนีอ้ยู่ในระดับใด    

     2.1 ทาํงานเป็นกลุ่ม 4.74 0.48 มากที่สุด 

     2.2 ศึกษาคน้ควา้ดว้ยตนเอง 4.74 0.48 มากที่สุด 

     2.3 นิทรรศการ 4.32 0.57 มาก 

     2.4 การสาธิต 4.26 0.55 มาก 

     2.5 การอภิปรายกลุ่ม 4.56 0.57 มากที่สุด 

     2.6 การระดมความคิด 4.47 0.54 มาก 

     2.7 การสร้างผลงาน 4.74 0.44 มากที่สุด 

ค่าเฉลี่ยรวม       4.55  มากที่สุด 

3. ท่านต้องการให้จัดการเรียนการสอนในรูปแบบ ดังต่อไปนี้ อยู่ในระดับใด 

    3.1 การเรียนรู้ตามรูปแบบองคก์รแห่งการเรียนรู้ 4.70 0.50 มากที่สุด 

    3.2 สอนแบบบรรยาย 1.25 0.43 นอ้ยที่สุด 

    3.3 สอนแบบใชเ้ทคโนโลย ี 4.33 0.66 มาก 

    3.4 สอนแบบเกม 3.84 0.75 มาก 

    3.5 สอนแบบบูรณาการ 4.37 0.59 มาก 

    3.6 การเรียนรู้แบบกลุ่มร่วมมือ แบบ  STAD   4.14 0.64 มาก 

    3.7 การจดัการศึกษาเฉพาะบุคคล 3.82 0.78 มาก 

    3.8 การจดัการศึกษาแบบการเรียนร่วม 4.19 0.67 มาก 

    3.9 การเรียนรู้แบบมีส่วนร่วม 3.82 0.87 มาก 

    3.10 การแสดงบทบาทสมมติ 1.16 0.37 นอ้ยที่สุด 

    3.11 การบูรณาการเน้ือหาความรู้ (Content Integration) 3.79 0.92 มาก 

    3.12 การเรียนที่เนน้เน้ือหาความรู้มากกวา่กระบวน 

             การคิด 

1.09 0.29 นอ้ยที่สุด 

    3.13 การเรียนการสอนที่เนน้ครูผูส้อนเป็นศูนยก์ลางของ 

            การเรียนรู้ 

1.02 0.13 นอ้ยที่สุด 

    3.14 การเรียนแบบใชปั้ญหาเป็นหลกั 1.86 0.88 นอ้ย 

    3.15 การเรียนการสอนแบบใชห้อ้งเรียนเสมือนจริง 1.82 0.83 นอ้ย 
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รายการประเมิน Χ  S.D. แปลผล 

    3.16 ฝึก ย ํ้า ซํ้ า ทวน อยูเ่สมอเพือ่ใหน้กัเรียนเกิดทกัษะ

ที่สุดในการเรียนรู้ที่คงทน 

2.91 0.71 นอ้ย 

                                     ค่าเฉลี่ยรวม                                                3.01                           ปานกลาง 

4. ท่านต้องการให้ส่ือการเรียนการสอนใน เร่ือง การพัฒนาเว็บไซต์ มีลักษณะดังต่อไปนี้             

อยู่ในระดับใด 

    4.1 เน้ือหามีความถูกตอ้งชดัเจนเหมาะสมกบัระดบัชั้น 4.65 0.52 มากที่สุด 

    4.2 เน้ือหาบทเรียนครอบคลุมวตัถุประสงค ์ 4.54 0.57 มากที่สุด 

    4.3  การจดัลาํดบัเน้ือหาเหมาะสม 4.60 0.53 มากที่สุด 

    4.4 ความน่าสนใจของเน้ือหาในบทเรียน 4.53 0.54 มากที่สุด 

    4.5 การลาํดบัเน้ือหาจากง่ายไปหายาก 4.70 0.50 มากที่สุด 

    4.6 ปริมาณของเน้ือหาแต่ละหน่วยเหมาะสม 4.67 0.58 มากที่สุด 

    4.7 คาํถามมีความชดัเจน 4.75 0.43 มากที่สุด 

    4.8 แบบทดสอบสอดคลอ้งกบัวตัถุประสงค ์ 4.72 0.49 มากที่สุด 

    4.9 ความยากง่ายของแบบทดสอบเหมาะสม 4.47 0.68 มากที่สุด 

    4.10 ความถูกตอ้งของภาษาที่ใช ้ 4.61 0.53 มากที่สุด 

    4.11 สรุปผลคะแนนทา้ยบทเรียนชดัเจน 4.58 0.53 มากที่สุด 

    4.12 การนาํเสนอดึงดูดความสนใจ 4.82 0.38 มากที่สุด 

    4.13 การนาํเสนอตามลาํดบัขั้นตอน 4.72 0.49 มากที่สุด 

    4.14 การเร้าความสนใจดว้ยเสียงประกอบบทเรียน 4.63 0.25 มากที่สุด 

    4.15 ความสอดคลอ้งระหวา่งภาพกบัคาํบรรยาย 4.65 0.61 มากที่สุด 

    4.16 ความเหมาะสมของภาพในการส่ือความหมาย 4.77 0.42 มากที่สุด 

    4.17 ความชดัเจนของภาพที่นาํมาใช ้ 4.88 0.33 มากที่สุด 

    4.18 ความเหมาะสมในการใชเ้ทคนิคการนาํเสนอ 4.91 0.29 มากที่สุด 

    4.19 รูปแบบการนาํเสนอที่จูงใจ 4.82 0.43 มากที่สุด 

    4.20 รูปแบบอกัษรที่ใชน้าํเสนอเน้ือหาอ่านง่าย 4.84 0.37 มากที่สุด 

    4.21 ขนาดตวัอกัษรในการนาํเสนอเหมาะสม 4.93 0.26 มากที่สุด 

    4.22 การเลือกใชสี้ตวัอกัษรเหมาะสม 4.86 0.35 มากที่สุด 
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    4.23 การใชสี้พื้นจอภาพเหมาะสม 4.82 0.47 มากที่สุด 

    4.24 สีตวัอกัษรที่ใชเ้ช่ือมโยงแต่ละหนา้จอ 4.88 0.33 มากที่สุด 

                                   ค่าเฉลี่ยรวม                                          4.72  มากที่สุด 

5. ท่านมีความคดิเห็นว่าต้องการจัดการเรียนการสอนผ่านสมาร์ทโฟน ในหัวข้อดังต่อไปนี ้อยู่ใน

ระดับใด 

   5.1 การรับและส่งไปรษณียอิ์เล็กทรอนิกส์ (E-mail)  4.40 0.49 มาก 

   5.2 การถ่ายโอนแฟ้มขอ้มูล (File Transfer)  4.68 0.47 มากที่สุด 

   5.3 การเช่ือมต่อเขา้ใชง้าน (Log In)   4.74 0.44 มากที่สุด 

   5.4 การคน้หาขอ้มูล (Search Engine)  4.72 0.45 มากที่สุด 

   5.5 การอภิปรายและการประชุมทางไกล  

        (Discussion and Teleconference)  

3.98 0.67 มาก 

   5.6 วดีิโอคอนเฟอร์เร้น (video conference)  4.07 0.73 มาก 

   5.7 กิจกรรมแบบประวงิเวลา (delay)  4.16 0.86 มาก 

   5.8 กิจกรรมลิสเซิร์ฟ (LISTSERV)  4.04 0.60 มาก 

   5.9 ยสูเน็ต (USENET)  3.96 0.60 มาก 

   5.10 กระดานอิเล็กทรอนิกส์ (Electronic Boards) 4.68 0.51 มากที่สุด 

   5.11 การติดต่อส่ือสารแบบโตต้อบทนัที (Real Time)  

          ผา่นโปรแกรมทอลก์ (Talk)  

3.95 0.69 มาก 

    5.12 การส่งขอ้ความ (Send Massage) โดยใช ้ 

            โปรแกรมไอซีคิว (ICQ) 

4.16 0.59 มาก 

    5.13 การส่งขอ้ความ (Send Massage) โดยใช ้ 

            โปรแกรมเฟรชบุค (Facebook) 

4.77 0.50 มากที่สุด 

      5.14 การส่งขอ้ความ (Send Massage) โดยใช ้ 

              โปรแกรมทวสิเตอร์ (Twister)          

4.46 0.50 มาก 

     5.15 โทรศพัทผ์า่นระบบเครือข่ายอินเทอร์เน็ต  

               (Internet phone)  

3.98 0.79 มาก 

ค่าเฉลี่ยรวม 4.32  มาก 
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จากตารางที่ 3  ผูต้อบแบบสอบถามส่วนใหญ่ต้องการสอนด้วยบทเรียนคอมพิวเตอร์

ออนไลน์เป็นส่ือประกอบการจดัการเรียนการสอน กิจกรรมการเรียนการสอนส่วนใหญ่ตอ้งการให้

นักเรียนทาํงานเป็นกลุ่ม ศึกษาคน้ควา้ดว้ยตนเองและสร้างผลงาน ตอ้งการให้จดัการเรียนการสอน

ตามรูปแบบองค์กรแห่งการเรียนรู้ มากที่สุด และต้องการจดัการเรียนการสอนผ่านสมาร์ทโฟน          

ในหวัขอ้การส่งขอ้ความ (Send Massage) โดยใชโ้ปรแกรมเฟรชบุค (Facebook) มากที่สุด 
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ตารางที่ 4  ความคดิเห็นของผู้เช่ียวชาญด้านวัดและประเมินผล เพื่อหาดัชนีความสอดคล้อง (IOC) 

ของแบบทดสอบก่อนและหลังเรียน   

 

จุดประสงค์

ข้อที่ 

ข้อสอบ

ข้อที่ 

คะแนนความคดิเห็น 

ของผู้เช่ียวชาญ 

∑R  IOC สรุป 

คนที่1 คนที่2 คนที่3 

1 1 +1 +1 +1 +3 1 ใชไ้ด ้

2 +1 +1 +1 +3 1 ใชไ้ด ้

3 0 +1 +1 +2 0.7 ใชไ้ด ้

4 +1 +1 0 +2 0.7 ใชไ้ด ้

5 0 +1 +1 +2 0.7 ใชไ้ด ้

6 +1 +1 +1 +3 1 ใชไ้ด ้

7 +1 +1 +1 +3 1 ใชไ้ด ้

8 0 +1 +1 +2 0.7 ใชไ้ด ้

9 +1 +1 0 +2 0.7 ใชไ้ด ้

10 +1 +1 0 +2 0.7 ใชไ้ด ้

11 +1 +1 0 +2 0.7 ใชไ้ด ้

12 0 +1 +1 +2 0.7 ใชไ้ด ้

13 +1 +1 +1 +3 1 ใชไ้ด ้

14 +1 +1 +1 +3 1 ใชไ้ด ้

15 +1 +1 +1 +3 1 ใชไ้ด ้

16 0 +1 +1 +2 0.7 ใชไ้ด ้

17 +1 +1 +1 +3 1 ใชไ้ด ้

18 +1 +1 +1 +3 1 ใชไ้ด ้

19 +1 +1 +1 +3 1 ใชไ้ด ้

20 +1 +1 +1 +3 1 ใชไ้ด ้

2 21 +1 +1 +1 +3 1 ใชไ้ด ้

22 +1 +1 +1 +3 1 ใชไ้ด ้

23 0 0 0 0 0 ใชไ้ม่ได ้
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จุดประสงค์

ข้อที่ 

ข้อสอบ

ข้อที่ 

คะแนนความคดิเห็น 

ของผู้เช่ียวชาญ 

∑R  IOC สรุป 

คนที่1 คนที่2 คนที่3 

 24 +1 +1 +1 +3 1 ใชไ้ด ้

25 +1 +1 +1 +3 1 ใชไ้ด ้

26 +1 +1 +1 +3 1 ใชไ้ด ้

27 +1 +1 0 +2 0.7 ใชไ้ด ้

28 +1 0 0 +1 0.3 ใชไ้ม่ได ้

29 0 0 0 0 0 ใชไ้ม่ได ้

30 0 0 +1 +1 0.3 ใชไ้ม่ได ้

31 0 +1 +1 +2 0.7 ใชไ้ด ้

32 +1 0 +1 +2 0.7 ใชไ้ด ้

33 +1 0 0 +1 0.3 ใชไ้ม่ได ้

34 +1 +1 +1 +3 1 ใชไ้ด ้

35 +1 +1 +1 +3 1 ใชไ้ด ้

3 36 +1 0 +1 +2 0.7 ใชไ้ด ้

37 +1 +1 +1 +3 1 ใชไ้ด ้

38 +1 +1 0 +2 0.7 ใชไ้ด ้

39 0 +1 +1 +2 0.7 ใชไ้ด ้

40 +1 +1 +1 +3 1 ใชไ้ด ้

41 +1 +1 +1 +3 1 ใชไ้ด ้

42 +1 +1 +1 +3 1 ใชไ้ด ้

43 +1 +1 +1 +3 1 ใชไ้ด ้

44 +1 +1 +1 +3 1 ใชไ้ด ้

45 +1 +1 +1 +3 1 ใชไ้ด ้

46 +1 +1 +1 +3 1 ใชไ้ด ้
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จุดประสงค์

ข้อที่ 

ข้อสอบ

ข้อที่ 

คะแนนความคดิเห็น 

ของผู้เช่ียวชาญ 

∑R  IOC สรุป 

คนที่1 คนที่2 คนที่3 

 

47 +1 +1 +1 +3 1 ใชไ้ด ้

48 +1 +1 +1 +3 1 ใชไ้ด ้

49 +1 +1 +1 +3 1 ใชไ้ด ้

50 +1 +1 +1 +3 1 ใชไ้ด ้

51 +1 +1 +1 +3 1 ใชไ้ด ้

52 +1 0 +1 +2 0.7 ใชไ้ด ้

53 +1 +1 0 +2 0.7 ใชไ้ด ้

54 0 +1 +1 +2 0.7 ใชไ้ด ้

55 +1 +1 +1 +3 1 ใชไ้ด ้

4 56 +1 0 +1 +2 0.7 ใชไ้ด ้

57 +1 0 +1 +2 0.7 ใชไ้ด ้

58 +1 0 +1 +2 0.7 ใชไ้ด ้

59 +1 0 +1 +2 0.7 ใชไ้ด ้

60 0 +1 +1 +2 0.7 ใชไ้ด ้

61 +1 +1 +1 +3 1 ใชไ้ด ้

62 +1 +1 +1 +3 1 ใชไ้ด ้

63 +1 0 +1 +2 0.7 ใชไ้ด ้

64 +1 +1 +1 +3 1 ใชไ้ด ้

65 +1 +1 +1 +3 1 ใชไ้ด ้

66 +1 +1 +1 +3 1 ใชไ้ด ้

67 +1 +1 +1 +3 1 ใชไ้ด ้

68 +1 +1 +1 +3 1 ใชไ้ด ้
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จุดประสงค์

ข้อที่ 

ข้อสอบ

ข้อที่ 

คะแนนความคดิเห็น 

ของผู้เช่ียวชาญ 

∑R  IOC สรุป 

คนที่1 คนที่2 คนที่3 

 

69 +1 +1 +1 +3 1 ใชไ้ด ้

70 +1 +1 +1 +3 1 ใชไ้ด ้

71 +1 +1 0 +2 0.7 ใชไ้ด ้

72 +1 +1 0 +2 0.7 ใชไ้ด ้

73 0 +1 +1 +2 0.7 ใชไ้ด ้

74 +1 +1 +1 +3 1 ใชไ้ด ้

75 +1 +1 +1 +3 1 ใชไ้ด ้

5 76 0 0 0 0 0 ใชไ้ม่ได ้

77 +1 +1 +1 +3 1 ใชไ้ด ้

78 +1 +1 +1 +3 1 ใชไ้ด ้

79 +1 0 +1 +2 0.7 ใชไ้ด ้

80 +1 +1 +1 +3 1 ใชไ้ด ้

81 +1 +1 +1 +3 1 ใชไ้ด ้

82 +1 +1 0 +2 0.7 ใชไ้ด ้

83 +1 +1 +1 +3 1 ใชไ้ด ้

84 +1 +1 +1 +3 1 ใชไ้ด ้

85 +1 +1 +1 +3 1 ใชไ้ด ้

86 +1 +1 +1 +3 1 ใชไ้ด ้

87 +1 +1 +1 +3 1 ใชไ้ด ้

89 +1 +1 +1 +3 1 ใชไ้ด ้

90 +1 +1 +1 +3 1 ใชไ้ด ้

91 +1 +1 +1 +3 1 ใชไ้ด ้
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จุดประสงค์

ข้อที่ 

ข้อสอบ

ข้อที่ 

คะแนนความคดิเห็น 

ของผู้เช่ียวชาญ 

∑R  IOC สรุป 

คนที่1 คนที่2 คนที่3 

 
92 +1 +1 +1 +3 1 ใชไ้ด ้

93 +1 +1 +1 +3 1 ใชไ้ด ้
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ตารางที่ 5  ผลวิเคราะห์ค่าความยากง่าย อาํนาจจําแนก และความเช่ือมั่นของแบบทดสอบ  
                                   

ข้ อ  ( p )  ความหมาย ( r )  ความหมาย 

ส รุ ป ผ ล  

ก า ร

วิ เ ค ร า ะ ห์

ข้ อ ส อ บ  

1 0.40 ขอ้สอบที่คอ่นขา้งยาก 0.40 อาํนาจจาํแนกสูง ใชไ้ด ้

2 0.83 ขอ้สอบที่ง่าย 0.07 อาํนาจจาํแนกตํ่า ใชไ้ม่ได ้

3 0.67 ขอ้สอบที่คอ่นขา้งง่าย 0.27 อาํนาจจาํแนกคอ่นขา้งตํ่า ใชไ้ด ้

4 0.43 ขอ้สอบที่ยาก – ง่ายพอเหมาะดี 0.47 อาํนาจจาํแนกสูง ใชไ้ด ้

5 0.37 ขอ้สอบที่คอ่นขา้งยาก -0.07 อาํนาจจาํแนกตํ่า ใชไ้ม่ได ้

6 0.63 ขอ้สอบที่คอ่นขา้งง่าย 0.20 อาํนาจจาํแนกคอ่นขา้งตํ่า ใชไ้ด ้

7 0.57 ขอ้สอบที่ยาก – ง่ายพอเหมาะดี 0.33 อาํนาจจาํแนกปานกลาง ใชไ้ด ้

8 .043 ขอ้สอบที่ยาก – ง่ายพอเหมาะดี 0.47 อาํนาจจาํแนกสูง ใชไ้ด ้

9 0.37 ขอ้สอบที่คอ่นขา้งยาก 0.47 อาํนาจจาํแนกสูง ใชไ้ด ้

10 0.53 ขอ้สอบที่ยาก – ง่ายพอเหมาะดี 0.27 อาํนาจจาํแนกคอ่นขา้งตํ่า ใชไ้ด ้

11 0.20 ขอ้สอบที่คอ่นขา้งยาก 0.13 อาํนาจจาํแนกตํ่า ใชไ้ม่ได ้

12 0.43 ขอ้สอบที่ยาก – ง่ายพอเหมาะดี 0.33 อาํนาจจาํแนกปานกลาง ใชไ้ด ้

13 0.43 ขอ้สอบที่ยาก – ง่ายพอเหมาะดี 0.20 อาํนาจจาํแนกคอ่นขา้งตํ่า ใชไ้ด ้

14 0.43 ขอ้สอบที่ยาก – ง่ายพอเหมาะดี 0.33 อาํนาจจาํแนกปานกลาง ใชไ้ด ้

15 0.43 ขอ้สอบที่ยาก – ง่ายพอเหมาะดี 0.60 อาํนาจจาํแนกสูง ใชไ้ด ้

16 0.40 ขอ้สอบที่คอ่นขา้งยาก 0.40 อาํนาจจาํแนกสูง ใชไ้ด ้

17 0.67 ขอ้สอบที่คอ่นขา้งง่าย 0.13 อาํนาจจาํแนกตํ่า ใชไ้ม่ได ้

18 0.43 ขอ้สอบที่ยาก – ง่ายพอเหมาะดี 0.47 อาํนาจจาํแนกสูง ใชไ้ด ้

19 0.47 ขอ้สอบที่ยาก – ง่ายพอเหมาะดี 0.53 อาํนาจจาํแนกสูง ใชไ้ด ้

20 0.17 ขอ้สอบที่ยาก -0.07 อาํนาจจาํแนกตํ่า ใชไ้ม่ได ้

21 0.43 ขอ้สอบที่ยาก – ง่ายพอเหมาะดี 0.47 อาํนาจจาํแนกสูง ใชไ้ด ้
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ข้ อ  ( p )  ความหมาย ( r )  ความหมาย ส รุ ป ผ ล  

ก า ร

วิ เ ค ร า ะ ห์

ข้ อ ส อ บ  

22 0.83 ขอ้สอบที่ง่าย -0.20 อาํนาจจาํแนกตํ่า ใชไ้ม่ได ้

23 0.43 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.33 อาํนาจจาํแนกปานกลาง ใชไ้ด ้

24 0.57 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.47 อาํนาจจาํแนกสูง ใชไ้ด ้

25 0.43 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.33 อาํนาจจาํแนกปานกลาง ใชไ้ด ้

26 0.37 ขอ้สอบที่คอ่นขา้งยาก 0.47 อาํนาจจาํแนกสูง ใชไ้ด ้

27 0.30 ขอ้สอบที่คอ่นขา้งยาก 0.33 อาํนาจจาํแนกปานกลาง ใชไ้ด ้

28 0.47 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.27 อาํนาจจาํแนกคอ่นขา้งตํ่า ใชไ้ด ้

29 0.47 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.40 อาํนาจจาํแนกสูง ใชไ้ด ้

30 0.87 ขอ้สอบที่ง่าย 0.00 อาํนาจจาํแนกตํ่า ใชไ้ม่ได ้

31 0.50 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.33 อาํนาจจาํแนกปานกลาง ใชไ้ด ้

32 0.50 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.47 อาํนาจจาํแนกสูง ใชไ้ด ้

33 0.50 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.33 อาํนาจจาํแนกปานกลาง ใชไ้ด ้

34 0.30 ขอ้สอบที่คอ่นขา้งยาก 0.07 อาํนาจจาํแนกตํ่า ใชไ้ม่ได ้

35 0.53 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.40 อาํนาจจาํแนกสูง ใชไ้ด ้

36 0.47 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.40 อาํนาจจาํแนกสูง ใชไ้ด ้

37 0.33 ขอ้สอบที่คอ่นขา้งยาก 0.00 อาํนาจจาํแนกตํ่า ใชไ้ม่ได ้

38 0.47 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.40 อาํนาจจาํแนกสูง ใชไ้ด ้

39 0.53 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.40 อาํนาจจาํแนกสูง ใชไ้ด ้

40 0.43 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.33 อาํนาจจาํแนกปานกลาง ใชไ้ด ้

41 0.33 ขอ้สอบที่คอ่นขา้งยาก 0.00 อาํนาจจาํแนกตํ่า ใชไ้ม่ได ้

42 0.47 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.40 อาํนาจจาํแนกสูง ใชไ้ด ้
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ข้ อ  ( p )  ความหมาย ( r )  ความหมาย ส รุ ป ผ ล  

ก า ร

วิ เ ค ร า ะ ห์

ข้ อ ส อ บ  

43 0.40 ขอ้สอบที่คอ่นขา้งยาก 0.40 อาํนาจจาํแนกสูง ใชไ้ด ้

44 0.53 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.53 อาํนาจจาํแนกสูง ใชไ้ม่ได ้

45 0.27 ขอ้สอบที่คอ่นขา้งยาก 0.00 อาํนาจจาํแนกตํ่า ใชไ้ม่ได ้

46 0.60 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.00 อาํนาจจาํแนกตํ่า ใชไ้ด ้

47 0.53 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.40 อาํนาจจาํแนกสูง ใชไ้ด ้

48 0.23 ขอ้สอบที่คอ่นขา้งยาก -0.07 อาํนาจจาํแนกตํ่า ใชไ้ม่ได ้

49 0.50 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.33 อาํนาจจาํแนกปานกลาง ใชไ้ด ้

50 0.50 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.07 อาํนาจจาํแนกตํ่า ใชไ้ม่ได ้

51 0.57 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.33 อาํนาจจาํแนกปานกลาง ใชไ้ด ้

52 0.47 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.27 อาํนาจจาํแนกคอ่นขา้งตํ่า ใชไ้ด ้

53 0.47 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.40 อาํนาจจาํแนกสูง ใชไ้ด ้

54 1.00 ขอ้สอบที่ง่าย 0.00 อาํนาจจาํแนกตํ่า ใชไ้ม่ได ้

55 0.53 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.40 อาํนาจจาํแนกสูง ใชไ้ด ้

56 0.57 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.47 อาํนาจจาํแนกสูง ใชไ้ด ้

57 0.33 ขอ้สอบที่คอ่นขา้งยาก 0.13 อาํนาจจาํแนกตํ่า ใชไ้ม่ได ้

58 0.47 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.27 อาํนาจจาํแนกคอ่นขา้งตํ่า ใชไ้ด ้

59 0.40 ขอ้สอบที่คอ่นขา้งยาก 0.53 อาํนาจจาํแนกสูง ใชไ้ด ้

60 0.37 ขอ้สอบที่คอ่นขา้งยาก 0.33 อาํนาจจาํแนกปานกลาง ใชไ้ด ้

61 0.37 ขอ้สอบที่คอ่นขา้งยาก 0.47 อาํนาจจาํแนกสูง ใชไ้ด ้

62 0.40 ขอ้สอบที่คอ่นขา้งยาก 0.27 อาํนาจจาํแนกคอ่นขา้งตํ่า ใชไ้ด ้

63 0.83 ขอ้สอบที่ง่าย 0.20 อาํนาจจาํแนกคอ่นขา้งตํ่า ใชไ้ม่ได ้

64 0.30 ขอ้สอบที่คอ่นขา้งยาก 0.07 อาํนาจจาํแนกตํ่า ใชไ้ม่ได ้
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ข้ อ  ( p )  ความหมาย ( r )  ความหมาย ส รุ ป ผ ล  

ก า ร

วิ เ ค ร า ะ ห์

ข้ อ ส อ บ  

65 0.47 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.53 อาํนาจจาํแนกสูง ใชไ้ด ้

66 0.37 ขอ้สอบที่คอ่นขา้งยาก 0.07 อาํนาจจาํแนกตํ่า ใชไ้ม่ได ้

67 0.30 ขอ้สอบที่คอ่นขา้งยาก 0.20 อาํนาจจาํแนกคอ่นขา้งตํ่า ใชไ้ม่ได ้

68 0.47 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.40 อาํนาจจาํแนกสูง ใชไ้ด ้

69 0.57 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.33 อาํนาจจาํแนกปานกลาง ใชไ้ด ้

70 0.57 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.60 อาํนาจจาํแนกสูง ใชไ้ด ้

71 0.43 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.33 อาํนาจจาํแนกปานกลาง ใชไ้ด ้

72 0.43 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.33 อาํนาจจาํแนกปานกลาง ใชไ้ด ้

73 0.37 ขอ้สอบที่คอ่นขา้งยาก 0.20 อาํนาจจาํแนกคอ่นขา้งตํ่า ใชไ้ม่ได ้

74 0.50 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.60 อาํนาจจาํแนกสูง ใชไ้ด ้

75 0.73 ขอ้สอบที่คอ่นขา้งง่าย 0.27 อาํนาจจาํแนกคอ่นขา้งตํ่า ใชไ้ด ้

76 0.33 ขอ้สอบที่คอ่นขา้งยาก 0.27 อาํนาจจาํแนกคอ่นขา้งตํ่า ใชไ้ม่ได ้

77 0.50 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.60 อาํนาจจาํแนกสูง ใชไ้ด ้

78 0.50 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.20 อาํนาจจาํแนกคอ่นขา้งตํ่า ใชไ้ด ้

79 0.57 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.60 อาํนาจจาํแนกสูง ใชไ้ด ้

80 0.30 ขอ้สอบที่คอ่นขา้งยาก 0.20 อาํนาจจาํแนกคอ่นขา้งตํ่า ใชไ้ม่ได ้

81 0.50 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.47 อาํนาจจาํแนกสูง ใชไ้ด ้

82 0.50 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.33 อาํนาจจาํแนกปานกลาง ใชไ้ด ้

83 0.47 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.40 อาํนาจจาํแนกสูง ใชไ้ด ้

84 0.33 ขอ้สอบที่คอ่นขา้งยาก 0.27 อาํนาจจาํแนกคอ่นขา้งตํ่า ใชไ้ม่ได ้

85 0.43 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.47 อาํนาจจาํแนกสูง ใชไ้ด ้

86 0.50 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.33 อาํนาจจาํแนกปานกลาง ใชไ้ด ้
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ข้ อ  ( p )  ความหมาย ( r )  ความหมาย ส รุ ป ผ ล  

ก า ร

วิ เ ค ร า ะ ห์

ข้ อ ส อ บ  

87 0.40 ขอ้สอบที่คอ่นขา้งยาก 0.40 อาํนาจจาํแนกสูง ใชไ้ด ้

88 0.27 ขอ้สอบที่คอ่นขา้งยาก 0.27 อาํนาจจาํแนกคอ่นขา้งตํ่า ใชไ้ม่ได ้

89 0.43 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.33 อาํนาจจาํแนกปานกลาง ใชไ้ด ้

90 0.43 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.33 อาํนาจจาํแนกปานกลาง ใชไ้ด ้

91 0.30 ขอ้สอบที่คอ่นขา้งยาก 0.20 อาํนาจจาํแนกคอ่นขา้งตํ่า ใชไ้ม่ได ้

92 0.40 ขอ้สอบที่คอ่นขา้งยาก 0.53 อาํนาจจาํแนกสูง ใชไ้ด ้

93 0.47 ขอ้สอบที่ยาก-ง่ายพอเหมาะดี 0.53 อาํนาจจาํแนกสูง ใชไ้ด ้

KR-20 0.75 

 

หมายเหตุ    ค่า  p  ระหวา่ง  0.20 – 00.40.80 

       ค่า  r  เท่ากบั  0.20 ขึ้นไป 
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ตารางที่  6  ความคดิเห็นของผู้เช่ียวชาญเพื่อหาค่าดัชนีความสอดคล้อง (IC) ของข้อคําถามเพื่อสร้าง

แบบสอบถามความคิดเห็นสําหรับผู้เช่ียวชาญ เกี่ยวกับบทเรียนผ่านสมาร์ทโฟน                    

ตามแนวคิดองค์กรแห่งการ เ รียน รู้  เ ร่ืองการพัฒนาเว็บไซต์ สํ าหรับนัก เ รียน                             

ช้ันประถมศึกษาปีที่ 6 
 

รายการ 

ระดับความสอดคล้อง 

ผู้เ
ชี่ย

วช
าญ

  1
 

ผู้เ
ชี่ย

วช
าญ

  2
 

ผู้เ
ชี่ย

วช
าญ

  3
 

ค่า
คว

าม
สอ

ดค
ล้อ

ง 

ห
มา

ยเ
ห

ตุ 

1. เป็นการเรียนรู้ดว้ยตนเอง โดยยดึผูเ้รียนเป็นสาํคญั 1 1 1 1  

2. ช่วยพฒันาความสามารถในการคิดวเิคราะห์ของนกัเรียน 1 1 0 0.66  

3. ทาํใหมี้ประสบการณ์ในการใชเ้คร่ืองคอมพวิเตอร์มากขึ้น 1 0 1 0.66  

4. สอนตามจุดประสงคข์องการเรียน 1 1 1 1  

5. มีแหล่งสนบัสนุนการเรียนที่เหมาะสม เช่น การติดต่อ  

    ผูส้อน กระดานแลกเปล่ียนเรียนรู้ แหล่งเรียนรู้ 

1 1 1 1  

6. เปิดโอกาสใหผู้เ้รียนติดต่อกบัผูส้อนใหมี้ปฏิสัมพนัธ ์ 

    ระหวา่ง ผูเ้รียนกบัผูส้อน ผูเ้รียนกบัผูเ้รียน และผูเ้รียนกบั  

    ส่ือ 

1 1 1 1  

7. นาํเสนอเน้ือหาเป็นระบบ ช่วยใหเ้ห็นความต่อเน่ือง  

    ของเน้ือหา 

0 1 1 0.66  

8. สามารถทบทวนเน้ือหาไดจ้นเขา้ใจ ตามความสามารถ  

    ของผูเ้รียน 

1 1 1 1  

9. กิจกรรมระหวา่งเรียนและการฝึกทกัษะช่วยใหผู้เ้รียนมี  

    ความเขา้ใจเน้ือหาในบทเรียน 

1 1 1 1  

10. เปิดโอกาสใหผู้เ้รียนมีส่วนร่วมในบทเรียน 1 1 1 1  
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รายการ 

ระดับความสอดคล้อง 

ผู้เ
ชี่ย

วช
าญ

  1
 

ผู้เ
ชี่ย

วช
าญ

  2
 

ผู้เ
ชี่ย

วช
าญ

  3
 

ค่า
คว

าม
สอ

ดค
ล้อ

ง 

ห
มา

ยเ
ห

ตุ 

11. มีความสะดวกในการเขา้ถึงบทเรียนหรือการคน้หา  

      ขอ้มูลต่าง ๆ 

1 1 0 1  

12. กระตุน้ใหผู้เ้รียนอยากเรียนรู้ในเน้ือหาตอนต่อไป 1 0 1 0.66  

13. ผลการประเมินต่างๆ สามารถโตต้อบไดท้นัที 1 1 1 1  

14. ภาพประกอบและภาพเคล่ือนไหว มีส่วนช่วยใหเ้ขา้ใจ  

      เน้ือหาไดดี้ขึ้น 

1 1 0 0.66  

15. ศึกษาและทบทวนบทเรียนไดไ้ม่จาํกดัเวลาและมีอิสระ  

      ในการเรียน 

1 1 1 1  

ค่าเฉลี่ยรวม 0.93 0.86 0.80 0.87  

ผลจากการประเมินได้ค่าดัชนีความสอดคล้อง เท่ากับ 0.87  ไม่มีขอ้คาํถามที่มีค่าความ

สอดคลอ้งของความตรงของเน้ือหา ความเหมาะสมของคาํถามและรูปแบบภาษา ที่มีค่าต ํ่ากวา่ 0.5  
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ตารางที่ 7  ความคดิเห็นของผู้เช่ียวชาญเพื่อหาค่าดัชนีความสอดคล้อง (IC) ของข้อคําถามเพื่อสร้าง

แบบสอบถามประเมินความพึงพอใจของนักเรียนช้ันประถมศึกษาปีที่ 6 ที่มีต่อบทเรียน

ผ่านสมาร์ทโฟนตามแนวคดิองค์กรแห่งการเรียนรู้เร่ืองการพัฒนาเว็บไซต์ 
 

รายการ 

ระดับความสอดคล้อง 

ผู้เ
ชี่ย

วช
าญ

  1
 

ผู้เ
ชี่ย

วช
าญ

  2
 

ผู้เ
ชี่ย

วช
าญ

  3
 

ค่า
คว

าม
สอ

ดค
ล้อ

ง 

ห
มา

ยเ
ห

ตุ 

1. ดา้นเน้ือหา 

    1.1 เน้ือหาวชิาในบทเรียนการสอนผา่นเวบ็มีสอดคลอ้งกบั  

         วตัถุประสงคก์ารเรียนรู้ 

1 1 1 1 

 

 

    1.2 การลาํดบัเน้ือหาเรียงจากง่ายไปหายาก 1 1 1 1  

    1.3 ผูเ้รียนสามารถเขา้ถึงเน้ือหาไดร้วดเร็ว 1 0 1 0.66  

    1.4 ผูเ้รียนเขา้ใจเน้ือหาในบทเรียนไดง่้าย 1 1 1 1  

    1.5 ผูเ้รียนนาํความรู้ที่ไดไ้ปประยกุตใ์ชใ้นชีวิตประจาํวนั  

          ได ้

1 1 1 1  

    1.6 ผูเ้รียนตระถึงคุณค่าและประโยชน์ของความรู้ที่ไดรั้บ 1 1 1 1  

ค่าเฉลี่ยรวมด้านเนื้อหา 1 0.83 1 0.94  

2. ดา้นการนาํเสนอดว้ยภาพ สี เสียงประกอบ และการเช่ือมโยงเน้ือหา 

     2.1  ภาพประกอบสอดคลอ้งกบัเน้ือหา 1 0 1 0.66  

     2.2  ภาพประกอบมีความน่าสนใจสามารถส่ือสารได ้ 

           ชดัเจน 

1 1 1 1  

     2.3  มีภาพไอคอนสวยงามน่าสนใจ ส่ือความหมาย  

            ชดัเจน 

1 1 0 0.66  

     2.4  การเช่ือมโยงเน้ือเพือ่สร้างปฏิสมัพนัธร์ะหวา่ง  

            ผูเ้รียนกบับทเรียน 

1 0 1 0.66  

     2.5  การเช่ือมโยง (Link) เน้ือหาของการสอนผา่นเวบ็           

           ไดง่้าย 

1 1 0 0.66  
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รายการ 

ระดับความสอดคล้อง 

ผู้เ
ชี่ย

วช
าญ

  1
 

ผู้เ
ชี่ย

วช
าญ

  2
 

ผู้เ
ชี่ย

วช
าญ

  3
 

ค่า
คว

าม
สอ

ดค
ล้อ

ง 

ห
มา

ยเ
ห

ตุ 

ค่าเฉลี่ยรวมด้านการนําเสนอด้วยภาพ สี เสียงประกอบ  

และการเช่ือมโยงเนื้อหา 

1 0.66 0.66 0.73  

3.  ดา้นแบบทดสอบและการประเมินผล 

      3.1  การสอนผา่นเวบ็มีแบบทดสอบหลงัเรียนช่วยให ้ 

             ผูเ้รียนไดต้รวจสอบความเขา้ใจในเน้ือหาบทเรียน  

             ไดเ้หมาะสม 

1 1 1 1  

     3.2  คาํถามมีความชดัเจน 1 1 1 1  

     3.3  แบบทดสอบสอดคลอ้งกบัวตัถุประสงค ์ 1 1 1 1  

     3.4  ความยากง่ายของแบบทดสอบเหมาะสม 1 1 1 1  

     3.5  สรุปผลคะแนนทา้ยบทเรียนชดัเจน 1 0 1 0.66  

ค่าเฉลี่ยรวมด้านแบบทดสอบและการประเมินผล 1 0.8 1 0.93  

4.  ดา้นส่ิงอาํนวยความสะดวก 

     4.1  การติดต่อส่ือสารผา่นกระดานเสวนา 1 1 1 1  

     4.2  การติดต่อส่ือสารผา่นหอ้งสนทนาอิเล็กทรอนิกส์ 1 1 1 1  

     4.3  การติดต่อส่ือสารผา่นจดหมาอิเล็กทรอนิกส์ 1 1 1 1  

     4.4  การส่งขอ้ความ (Send Massage)โดยใชโ้ปรแกรม 

            เฟรชบุค (Facebook) 

1 0 1 0.66  

ค่าเฉลี่ยรวมด้านส่ิงอํานวยความสะดวก 1 0.75 1 0.91  

 

           ผลจากการประเมินไดค้่าเฉล่ียความสอดคลอ้งดา้นเน้ือหา = 0.94 ดา้นการนาํเสนอดว้ยภาพ สี 

เสียงประกอบ และการเช่ือมโยงเน้ือหา = 0.73 ดา้นแบบทดสอบและการประเมินผล = 0.93  และดา้น

ส่ิงอาํนวยความสะดวก  = 0.91 ไม่มีขอ้คาํถามที่มีค่าความสอดคลอ้งของความตรงของเน้ือหา ความ

เหมาะสมของคาํถามและรูปแบบภาษาที่มีค่าต ํ่ากวา่ 0.5  
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ตารางที่  8  รายงานสรุปผลการหาประสิทธิภาพของการสอนผ่านสมาร์ทโฟนตามแนวคิดองค์กร    

แห่งการเรียนรู้ เร่ือง การพัฒนาเว็บไซต์ สําหรับนักเรียนช้ันประถมศึกษาปีที่ 6  

คนที่ ร้อยละของคะแนนระหว่างกิจกรรม (E1) ร้อยละของคะแนนแบบทดสอบ (E2) 

  1 90.00 75.00 

2 84.00 80.00 

3 78.00 75.00 

4 86.00 70.00 

5 74.00 90.00 

6 72.00 75.00 

7 86.00 75.00 

8 92.00 85.00 

9 68.00 75.00 

10 84.00 90.00 

11 88.00 90.00 

12 74.00 65.00 

13 80.00 75.00 

14 82.00 90.00 

15 76.00 65.00 

16 84.00 70.00 

17 70.00 80.00 

18 80.00 90.00 

19 88.00 85.00 

20 90.00 90.00 

21 84.00 75.00 

22 76.00 90.00 

23 94.00 90.00 

  198 



คนที่ ร้อยละของคะแนนระหว่างกิจกรรม (E1) ร้อยละของคะแนนแบบทดสอบ (E2) 

24 88.00 85.00 

25 74.00 70.00 

26 90.00 90.00 

27 78.00 85.00 

28 84.00 85.00 

29 78.00 80.00 

30 90.00 80.00 

เฉลี่ยร้อยละ                 (E1)    82.07           (E2)      80.67 

 

จากตารางที่ 8   แสดงการหาประสิทธิภาพจากคะแนนร้อยละของการทาํกิจกรรมระหว่าง

ระหว่างเรียนรู้และค่าคะแนนร้อยละของแบบทดสอบหลังการเรียนรู้ด้วยบทเรียนผ่านสมาร์ทโฟน            

ตามรูปแบบองคก์รแห่งการเรียนรู้ เร่ืองการพฒันาเวบ็ไซต ์ของกลุ่มทดลอง จาํนวน 30 คน โดยพบว่า

ค่า  E1/E2 เท่ากบั 82.07/80.67 ซ่ึงถือวา่ สูงกวา่สมมติฐานที่ตั้งไวน้ัน่ก็คือ 80/80  
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ตารางที่   9  คะแนนก่อนและหลังการสอนผ่านเสมาร์ทโฟนของนักเรียนทั้งหมด  30  คน 

คนที่ คะแนนก่อนเรียน คะแนนหลังเรียน 

  1 9.00 15.00 

2 7.00 16.00 

3 11.00 15.00 

4 11.00 14.00 

5 10.00 18.00 

6 11.00 15.00 

7 9.00 15.00 

8 12.00 17.00 

9 10.00 15.00 

10 7.00 18.00 

11 10.00 18.00 

12 9.00 13.00 

13 11.00 15.00 

14 7.00 18.00 

15 12.00 13.00 

16 8.00 14.00 

17 11.00 16.00 

18 12.00 18.00 

19 8.00 17.00 

20 12.00 18.00 

21 10.00 15.00 

22 11.00 18.00 

23 12.00 18.00 

24 10.00 17.00 
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คนที่ คะแนนก่อนเรียน คะแนนหลังเรียน 

25 9.00 14.00 

26 9.00 18.00 

27 12.00 17.00 

28 10.00 17.00 

29 10.00 16.00 

30 11.00 16.00 
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ภาคผนวก  ซ 

แบบทดสอบ 

 

- แบบทดสอบก่อนเรียน/หลงัเรียน 

 



 

แบบทดสอบก่อนเรียน/หลังเรียน 

คาํช้ีแจง  แบบทดสอบน้ีมีทั้งหมด  20 ขอ้ ใหน้กัเรียนใส่เคร่ืองหมาย    ในช่อง  ก.  ข.  ค.  และ  ง.  

เพือ่เลือกคาํตอบทีถู่กตอ้งที่สุด 

1.  การขึ้นบรรทดัใหม่ภายในยอ่หนา้ใชค้าํสัง่ใด 

ก. Ctrl +Spacebar 

ข. Shift + Spacebar  

ค. Alt + Ctrl + Spacebar 

ง. Ctrl + Shift + Spacebar 

2.  ปุ่ ม                                                            ใชท้าํส่ิงใด 

ก. เปล่ียนขนาดตวัอกัษร 

ข. เปล่ียนรูปร่างตวัอกัษร 

ค. เปล่ียนรูปแบบตวัอกัษร 

ง. เปล่ียนลกัษณะตวัอกัษร 

3.  การกด Shift พร้อมกบักด Enter แสดงผลอยา่งไร 

ก. กด Ctrl  

ข. การทาํใหบ้รรทดัชิดกนั 

ค. กด Ctrl พร้อมกบักด Enter 

ง. การใหเ้วน้ที่วา่งเม่ือขึ้นบรรทดัใหม่ 

4.  ขอ้ใดคือการจดัตวัอกัษรแบบชิดซา้ย 

ก.  

ข.  

ค.  

ง.  

5.  การแทรกรูปภาพลงบนหนา้เวบ็เพจทาํไดโ้ดยวธีิใด 

ก. Edit >Insert 

ข. File > Picture 

ค. Insert > Image 

ง. View > Picture 
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6.  การกาํหนดเสน้ขอบของรูปภาพตอ้งใส่ค่าท่ีเป็นตวัเลขในช่องใด  

ก. Alt 

ข. Ctrl 

ค. Class 

ง. Border 

7.  รูปภาพเคล่ือนไหวควรใชน้ามสกุลใด 

ก. นามสกุล .GIF 

ข. นามสกุล .PNG 

ค. นามสกุล .PND 

ง. นามสกุล .JPEG 

8.  ความละเอียดของภาพมีหน่วยเป็นอะไร  

ก. Pixels 

ข. Kilogram  

ค. Millimeter  

ง. Centimeter 

9.  ขอ้ใดคือขั้นตอนการแทรกเสียงลงบนเวบ็เพจ 

ก. Insert/Media/Flash  

ข. Insert/Media/plugin 

ค. Insert/Media/Applet 

ง. Insert/Media/ActiveX 

10.           เป็นปุ่ มที่ใชใ้นการทาํส่ิงใด 

ก. แทรกกลอ้ง Video 

ข. แทรกไฟล ์Flash 

ค. แกไ้ขไฟล ์Flash Video 

ง. แทรกไฟล ์Flash Video  
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11. การเล่นทนัทีที่เปิดหนา้เวบ็ กาํหนดค่าท่ีช่องใดในหนา้ต่าง Properties 

ก. FLV  

ข. SKIN  

ค. PLAY 

ง. AUTO PLAY 

12. ทาํไม Flash จึงเป็นที่นิยมในการสร้างภาพเคล่ือนไหวบนเวบ็ 

ก. ใชง้านง่ายไฟล ์

ข. จะไดภ้าพเป็น Bitmap 

ค. มีขนาดเล็ก และใชเ้วลาในการโหลดนอ้ย 

ง. ภาพเคล่ือนไหวที่ไดมี้รูปแบบที่สวยงามกวา่ที่อ่ืน 

13. Table Width คือการกาํหนดค่าอะไรของตาราง  

ก. เสน้ขอบตาราง 

ข. ความสูงของตาราง 

ค. ความกวา้งของตาราง 

ง. จาํนวนแถวของตาราง 

14. การสร้างตารางตอ้งใชก้ลุ่มเคร่ืองมือในขอ้ใด  

ก. TEXT 

ข. HTML  

ค. FORMS 

ง. COMMON 

15. Split Cell ในการสร้างตารางคืออะไร 

ก. การลบเซลล ์

ข. การรวมเซลล ์

ค. การเพิม่เซลล ์

ง. การแยกเซลล ์
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16. ปุ่ ม           ใชใ้นการทาํส่ิงใด 

ก. แทรกตาราง 

ข. แทรกเลเยอร์ 

ค. แทรกกล่องขอ้ความ 

ง. แทรกรูปส่ีเหล่ียมหลายรูป 

17. การลิงค ์(Link) หมายถึงอะไร 

ก. การใส่วนัที่หนา้เวบ็เพจ 

ข. การเช่ือมโยงหนา้เวบ็เพจ 

ค. การแทรกตารางหนา้เวบ็เพจ 

ง. การแทรกรูปภาพหนา้เวบ็เพจ 

18. การทาํลิงคเ์ช่ือมไฟลใ์ชน้ามสกลุอะไร 

ก. .swf 

ข. .psd 

ค. .dwt 

ง. .html 

19. ขอ้ใดคือบริการใหเ้ช่าพื้นที่ฝากขอ้มูลบนเวบ็ไซต ์

ก. Web Saving  

ข. Web Hosting 

ค. Web Service 

ง. Web Sharing 

20. การ Update หมายถึงอะไร 

ก. การสร้างเวบ็ไซต ์

ข. การยกเลิกเวบ็ไซต ์

ค. การตั้งวนัที่เวบ็ไซต ์

ง. การปรับปรุงเวบ็ไซต ์
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ภาคผนวก  ฌ 

แบบประเมินความพงึพอใจของนักเรียน 

 

- แบบประเมินความพงึพอใจของนักเรียนช้ันประถมศึกษาปีที่ 6 ที่มีต่อ                    

บทเรียนผ่านสมาร์ทโฟนตามแนวคดิองค์กรแห่งการเรียนรู้ เร่ือง การพฒันา 

เวบ็ไซต์ 

 



 
 

แบบประเมินความพึงพอใจของนักเรียนช้ันประถมศึกษาปีที ่6 

ที่มีต่อบทเรียนผ่านสมาร์ทโฟนตามแนวคดิองค์กรแห่งการเรียนรู้ เร่ือง การพัฒนาเว็บไซต์ 

คําช้ีแจง  ให้นักเรียนแสดงความคิดเห็นที่มีต่อบทเรียนผ่านสมาร์ทโฟนตามแนวคิดองคก์รแห่งการ

เรียนรู้ เร่ือง การพฒันาเวบ็ไซต์ สาํหรับนักเรียนชั้นประถมศึกษาปีท่ี 6 โดยทาํเคร่ืองหมาย ลงใน

ช่องวา่งความคิดเห็นของนกัเรียน โดยกาํหนดระดบัความพงึพอใจเป็นดงัต่อไปน้ี 

5 หมายถึง มีความพงึพอใจอยูใ่นระดบั มากที่สุด 

4 หมายถึง มีความพงึพอใจอยูใ่นระดบั มาก 

3 หมายถึง มีความพงึพอใจอยูใ่นระดบั ปานกลาง 

2 หมายถึง มีความพงึพอใจอยูใ่นระดบั นอ้ย 

1 หมายถึง มีความพงึพอใจอยูใ่นระดบั นอ้ยที่สุด 

 

รายการประเมิน ระดับความพึงพอใจ 

5 4 3 2 1 

1. ด้านเนื้อหา 

1.1 เน้ือหาวชิาในการสอนผา่นสมาร์ทโฟนมีสอดคลอ้งกบั

วตัถุประสงคก์ารเรียนรู้    

  

1.2 การลาํดบัเน้ือหาเรียงจากง่ายไปหายาก      

1.3 ผูเ้รียนสามารถเขา้ถึงเน้ือหาไดร้วดเร็ว      

1.4 ผูเ้รียนเขา้ใจเน้ือหาในบทเรียนไดง่้าย 
   

  

1.5 ผูเ้รียนนาํความรู้ที่ไดไ้ปประยกุตใ์ชใ้นชีวติประจาํวนัได ้      

1.6 ผูเ้รียนตระถึงคุณค่าและประโยชน์ของความรู้ที่ไดรั้บ      

2.  ด้านการนําเสนอด้วยภาพ สี เสียงประกอบ และการเช่ือมโยงเนื้อหา 

     2.1  ภาพประกอบสอดคลอ้งกบัเน้ือหา      

     2.2  ภาพประกอบมีความน่าสนใจสามารถส่ือสารไดช้ดัเจน      

     2.3  มีภาพไอคอนสวยงามน่าสนใจส่ือความหมายชดัเจน      

     2.4  การเช่ือมโยงเน้ือเพือ่สร้างปฏิสมัพนัธร์ะหวา่งผูเ้รียนกบั 

            บทเรียน 
   

  

     2.5  การเช่ือมโยง (Link) เน้ือหาของบทเรียนบนเวบ็ไดง่้าย      
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รายการประเมิน ระดับความพึงพอใจ 

5 4 3 2 1 

3.  ด้านแบบทดสอบและการประเมินผล 

     3.1  การสอนผ่านสมาร์ทโฟนมีแบบทดสอบหลังเรียนช่วยให้

ผู ้เ รียนได้ตรวจสอบความเข้าใจในเน้ือหาบทเรียนได้

เหมาะสม 
   

  

     3.2  คาํถามมีความชดัเจน      

     3.3  แบบทดสอบสอดคลอ้งกบัวตัถุประสงค ์      

     3.4  ความยากง่ายของแบบทดสอบเหมาะสม 
   

  

     3.5  สรุปผลคะแนนทา้ยบทเรียนชดัเจน      

4.  ด้านส่ิงอํานวยความสะดวก 

     4.1  การติดต่อส่ือสารผา่นกระดานเสวนา      

     4.2  การติดต่อส่ือสารผา่นหอ้งสนทนาอิเล็กทรอนิกส์      

     4.3  การติดต่อส่ือสารผา่นจดหมายอิเล็กทรอนิกส์      

     4.4  การส่งขอ้ความ (Send Massage)โดยใชโ้ปรแกรมเฟสบุค๊

(Facebook) 
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ประวตัิผู้เขียน 

 

ช่ือ – นามสกลุ   นางสาวอุมาพร  แกว้ทา 

วัน เดือน ปีเกิด   7  กุมภาพนัธ ์ พ.ศ. 2525 

ที่อยู่    บา้นเลขที่  90/3724  หมู่  6  หมู่บา้นเอ้ืออาทรซอยคุณพระ   

ตาํบลคลองหน่ึง  อาํเภอคลองหลวง  จงัหวดัปทุมธานี 12120 

การศึกษา   ปริญญาตรี  บริหารธุรกิจบณัฑิต  สาขาวชิา  คอมพวิเตอร์ธุรกิจ 

    มหาวทิยาลยัราชภฏัวไลยอลงกรณ์ ปทุมธานี   

    ปริญญาโท  ศึกษาศาสตรมหาบณัฑิต    

สาขาวชิา เทคโนโลยแีละส่ือสารการศึกษา 

มหาวทิยาลยัเทคโนโลยรีาชมงคลธญับุรี 

ประสบการณ์การทํางาน   

พ.ศ. 2552-ปัจจุบนั    โรงเรียนโชคชยัรังสิต 

โทรศัพท์หมายเลข  08-9241-1404 

อีเมล์    umaporn.kaewtha@gmail.com 
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